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<Organization of This User’s Guide>
The User’s Guide for this system comprises Volumes 1 to 3.

Volume 1
The volume comprises the following chapters.
Chapter 1 MVS-6000 Functions
Chapter 2 Menus and Control Panel
Chapter 3 Signal Selection and Transitions
Chapter 4 Keys
Chapter 5 Wipes
Chapter 6 DME Wipes
Chapter 7 Frame Memory
Chapter 8 Color Backgrounds, Copy and Swap, and Other Settings
Chapter 9 Color Corrector
Chapter 10 Special Functions
Appendix (Volume 1)

• Wipe Pattern List
• DME Wipe Pattern List
• Resizer DME Wipe Pattern List
• Menu Tree

Index

Volume 2
This book. For the contents of this volume, see “Table of Contents” at the front.
Chapter 11 DME Operations
Chapter 12 External Devices
Chapter 13 Keyframe Effects
Chapter 14 Snapshots
Chapter 15 Utility/Shotbox
Chapter 16 Macros
Chapter 17 Files
Appendix (Volume 2)

• SpotLighting
• Functional Differences With Models of DME
• Macro File Editing Rules
• About the Macro Attachment List Display
• Menu Operations Not Recorded in a Menu Macro

Index

Volume 3
The volume comprises the following chapters.
Chapter 18 System Setup (System)
Chapter 19 Control Panel Setup (Panel)
Chapter 20 Switcher Setup (Switcher)
Chapter 21 DME Setup (DME)
Chapter 22 DCU Setup (DCU)
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Chapter 23 Setup Relating to Router Interface and Tally (Router/Tally)
Chapter 24 Simple Connection of the MKS-8080/8082 AUX Bus Remote 

Panel
Chapter 25 DIAGNOSIS
Appendix (Volume 3)

• Data Saved by [Setup Define] and [Initial Status Define]
• Error Messages

Index
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DME (Digital Multi Effects) allows you to add three-dimensional effects such 
as image movement, rotation, magnification and shrinking, as well as a wide 
variety of special effects. DME is the general name for all of these effects.
You can use up to six channels as dedicated DME channels. 
Each channel can be used on its own or in combination with other channels, 
which allows you to create advanced effects with more complexity.

Note
To carry out DME function requires the MKS-6470 DME Board Set or the 
MVE-8000A/9000 DME Processor.
When using the switcher with the MVE-8000A or MVE-9000, the connection 
is through the SDI interface only.

Functions that can be used differ with the models of DME. For details, see 
“Functional Differences With Models of DME” (page 478).

MVE-8000A Multi Format DME Processor
The MVE-8000A is a “Digital Multi Effects” with multi-format support.
To connect the switcher, install an optional MKE-8021A Input/Output Board 
in the MVE-8000A and use an SDI interface.
Also following operation is required.

• You must set the input signals from the switcher to the MVE-8000A (AUX 
bus outputs), and signals returned to the switcher as primary inputs (reentry 
inputs). However, “Ext In” cannot be set for the DME channel.

See “Setting the Interface Between the DME and the Switcher” in Chapter 
20 (Volume 3).

• Select the combiner channels in the Global Effect menu.

See “Combiner Settings” (page 176).

MVE-9000 Multi Format DME Processor
The MVE-9000 is a “Digital Multi Effects” with multi-format support.
To connect the switcher, install an optional MKE-9021A Input/Output Board 
in the MVE-9000 and use an SDI interface.
Also the following operation is required.
15DME
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• You must set the input signals from the switcher to the MVE-9000 (AUX bus 
outputs), and signals returned to the switcher as primary inputs (reentry 
inputs).

See “Setting the Interface Between the DME and the Switcher” in Chapter 
20 (Volume 3).

• Select the combiner channels in the Global Effect menu.

See “Combiner Settings” (page 176).

Three-Dimensional Transformations

Transformation is the process of placing a video image in a three-dimensional 
DME coordinate space and subjecting it to manipulations such as movement, 
rotation, magnification or shrinking.

Three-dimensional coordinate space

Source coordinate space and target coordinate space
Images are placed in one of two types of coordinate space: source coordinate 
space and target coordinate space.
• The source coordinate space is a three-dimensional coordinate space with 

reference to the image itself. The x- and y-axes are defined parallel to the 
plane of the image, and the z-axis is defined perpendicular to the plane of the 
image. When you move the image, the coordinate axes also move.

• The target coordinate space is a three-dimensional coordinate space with 
reference to the output monitor screen. The x- and y-axes are defined parallel 
to the plane of the monitor screen, and the z-axis is defined perpendicular to 
the plane of the monitor screen. The coordinates do not move even if the 
image moves.

Source coordinate space and target coordinate space

Z
Y

X X

Y

Z

Source coordinate space Target coordinate space
DME
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For example, as shown in the following figure, the image moves in a different 
direction when you move it along the x-axis of the source coordinate space and 
along the x-axis of the target coordinate space. 

Movement along the x-axes of the source 
coordinate space and target coordinate space

Local coordinate space and global coordinate space
The coordinates of an individual DME channel are called its local coordinate 
space. The coordinates common to all channels are called the global coordinate
space.
By switching from local to global coordinate space, you can add new 
movement to the movement of images in individual channels, and also apply 
transformation effects to multiple channels that have been combined by Global 
effects (page 175).

Local coordinate space and global coordinate space

Three-dimensional parameters
Three-dimensional parameters are x, y, and z values which define the position 
of an image, its axis of rotation, the position of an imaginary point of view on 
the image, and so on. 

Source coordinate space Target coordinate space

Rotation around y-axis in 
local coordinate space

Rotation around y-axis in 
global coordinate space
17DME
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The standard values of parameters are as follows, depending on the aspect ratio 
of your monitor (4:3 or 16:9).

Values for 4:3 mode
• Origin at center of image (source coordinate space) or center of monitor 

(target coordinate space)
x = 0.00, y = 0.00, z = 0.00

• Upper right corner of image or monitor
When using SD format signals: x = 4.00, y = 3.00, z = 0.00
When using HD format signals: x = 12.00, y = 9.00, z = 0.00

• Lower left corner of image or monitor
When using SD format signals: x = –4.00, y = –3.00, z = 0.00
When using HD format signals: x = –12.00, y = –9.00, z = 0.00

Values for x-, y-, and z-axes (4:3 mode)

Values for 16:9 mode
• Origin at center of image (source coordinate space) or center of monitor 

(target coordinate space)
x = 0.00, y = 0.00, z = 0.00

• Upper right corner of image or monitor
When using SD format signals: x = 4.00, y = 2.25, z = 0.00
When using HD format signals: x = 16.00, y = 9.00, z = 0.00

–4(–12) a)

+4(+12) a)

+3(+9) a)

–3(–9) a)

x-axis

z-axis –
y-axis

y-axis
z-axis +

The plus direction on the 
z-axis is depth into the 
image or monitor screen.

a) The value in parentheses is for HD format.

x-axis
DME
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• Lower left corner of image or monitor

When using SD format signals: x = −4.00, y = −2.25, z = 0.00
When using HD format signals: x = −16.00, y = −9.00, z = 0.00

Values for x-, y- and z-axes (16:9 mode)

Limits of three-dimensional parameters
The following table shows the limits of three-dimensional transformation 
parameters.
The three-dimensional parameters of an image change when you use the 
trackball or Z-ring to execute a transformation. You can also execute a 
transformation by entering parameter values from the numeric keypad control 
block.

 

Operation mode Limits of three-dimensional transformation parameters

Location XYZ HD format:  –999.9999 to +999.9999 

SD 
format:

4:3 –333.3333 to +333.3333

16:9 –250.0000 to +250.0000

Rotation, Spin –999.9999 to +999.9999

Axis Location HD format:  –999.9999 to +999.9999 

SD 
format:

4:3 –333.3333 to +333.3333

16:9 –250.0000 to +250.0000

Location Size 0.0000 to +999.9999

Aspect 0.0000 to +2.0000

Perspective (x, y) HD format:  –999.9999 to +999.9999 

SD 
format:

4:3 –333.3333 to +333.3333

16:9 –250.0000 to +250.0000

Perspective (z) 0.0000 to 999.9999

–4.00 (–16.00)a)

+4.00 (+16.00)a)

+2.25 (+9.00)a)

–2.25 (–9.00)a)

x-axis

z-axis –

y-axis

y-axis

z-axis +

The plus direction on the z-axis is depth 
into the image or monitor screen.

x-axis

a) The value in parentheses is for HD format.
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Detents
The system defines points called detents at regular intervals on the three-
dimensional space. Pressing the [CTR] button (see page 30) in the device 
control block sets the current three-dimensional parameter values to the closest 
detent points.
The following table shows the interval between successive detents for each 
transformation operation mode (see page 21).

a) When a value is smaller than 1, 1/Aspect or 1/Perspective (z) is adjusted to an integral value.

Three-dimensional parameter default values
Each of the transformation operation modes has default values for three-
dimensional parameters. If required, you can return the current value to the 
defaults by pressing the [CTR]  button (see page 30) in the device control block 
twice in rapid succession. 
The following table shows the default parameter values for each 
transformation operation mode.

Skew –9.9999 to +9.9999

Operation mode Limits of three-dimensional transformation parameters

Operation mode Detent interval

Location XYZ 1.0000

Rotation, Spin 0.2500

Axis Location 1.0000

Location Size 0.2500

Aspect 1.0000 a)

Perspective (x, y)
Perspective (z)

1.0000
1.0000 a)

Skew 0.1000

Operation mode Default value

Location XYZ 0.0000

Rotation, Spin 0.0000

Axis Location 0.0000

Location Size 1.0000

Aspect 1.0000

Perspective (x, y)
Perspective (z)

0.0000
1.0000

Skew 0.0000
DME
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Resetting of parameter values set in the source coordinate space

In some transformation operation modes, if you switch to the target coordinate 
space after setting up a three-dimensional transformation in the source 
coordinate space, the setting values in the source coordinate space (three-
dimensional parameter values) are converted to values in the target coordinate 
space (source/target conversion).
Once a conversion has taken place, the original source coordinate space 
parameters do not return to their original values when you switch back to the 
source coordinate space. They are reset to zeros.
Source/target conversion occurs in the following operation modes: 
• Location XYZ
• Rotation

Transformation Operation Modes

The following operation modes are available for three-dimensional DME 
transformations. These operations are carried out in the device control block 
(trackball or joystick). (For details, see “Three-Dimensional Transformation 
Operations” (page 28).)

Location XYZ
Moves the image on the x-axis, y-axis, or z-axis. The direction of movement 
differs depending on whether you are manipulating the image in the source 
coordinate space or the target coordinate space.

Image movement in the source coordinate space

Movement on the x-axis Movement on the y-axis Movement on the z-axis
21DME
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Image movement in the target coordinate space

Rotation
Rotates the image on the x-axis, y-axis, or z-axis. The type of rotation differs 
depending on whether you are manipulating the image in the source coordinate 
space or the target coordinate space.

Image rotation in the source coordinate space

Image rotation in the target coordinate space

Spin
When rotating the image in Rotation mode, it may not always be possible to 
achieve the kind of rotation around an axis that you want. Combining Rotation 
mode with Spin mode creates an effect that rotates the image around a specified 
axis. The type of rotation differs depending on whether you are manipulating 

Movement on the x-axis Movement on the y-axis Movement on the z-axis

Rotation around the y-axis Rotation around the x-axis Rotation around the z-axis

Rotation around the y-axis Rotation around the x-axis Rotation around the z-axis
DME
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the image in the source coordinate space or the target coordinate space. (The 
way the image rotates around an axis is the same as in Rotation mode.)

Axis Location
Moves an axis of rotation in the source coordinate space.

Axis movement

Location Size
Changes the size of the whole image. 
• Because shrinking and magnification of the image in the source coordinate 

space is done in three-dimensional space, magnifying the image emphasizes 
the sense of perspective.

• Because shrinking and magnification of the image in the target coordinate 
space is a conversion of the two-dimensional image displayed on the 
monitor, shrinking and magnification does not change the shape of the 
image.

Magnification and shrinking in the source coordinate space

Z Y Z' Y' Z

X

Z'

X'

Y X

Y' X'

Movement on the x-axis Movement on the y-axis Movement on the z-axis
23DME
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Magnification and shrinking in the target coordinate space

Aspect
In the source coordinate space, changes the aspect ratio in the x-axis direction 
and y-axis direction, either independently or simultaneously.

Perspective
In the target coordinate space, changes the perspective on the image by 
changing an imaginary view point, without changing the position of the image.
The x-axis and y-axis values define the position of the view point. The z-axis 
value defines its distance from the image.

Change of aspect ratio in 
x-axis direction

Change of aspect ratio in 
y-axis direction

Simultaneous change 
aspect ratio in x-axis 
direction and y-axis direction

Change of view point on 
x-axis

Change of view point on y-
axis

Change of distance from 
view point to image
DME
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Skew

In the source coordinate space, change the skew of the image on the x-axis or 
y-axis.

Graphics Display

Graphics display is a function that allows you to display wire frames, 
coordinate axes and a grid over the current DME image, to make it easier to 
create effects in three-dimensional coordinate space.
Graphics displayed by this function can also be output to the monitor output 
connector.

Note
When using MKS-6470, these graphics are output to the monitor signal of the 
switcher.

To make graphics display settings, use the DME menu. (For details, see 
“Graphics Display Operation” (page 36).)
You can display the following kinds of graphics.

Wire frames
A wire frame displays an image enclosed in a frames, so that you can check the 
position and size of the image. If there is a shadow (see page 188), a frame is 
shown for the shadow as well.

Coordinate axes
This is a three-dimensional display of coordinates in local or global coordinate 
space. You can check the origin of the axes and the directions of the x-, y-, and 
z-axes.

Change of skew on x-axis Change of skew on y-axis
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Channel ID
This displays the channel number so that you can check which channel you are 
using, a useful feature when you are working with multiple channels.
Channel IDs are displayed differently in local and global coordinate space.
• In local coordinate space, the channel number is displayed along with “F” or 

“B” to indicate whether you are looking at the front (F) or back (B) of the 
current wire frame. For example, “1F” means the front of the wire frame on 
channel 1 in local coordinate space.

• In global coordinate space, the channel number is displayed along with “G” 
to indicate global. For example, “G2” means channel 2 in global coordinate 
space.

Wire frame, local coordinate space axes, and channel ID

Grid
This is a grid pattern representing the whole of the monitor screen. The grid 
makes it easy to set the position of an image in two-dimensional coordinates.

Grid (SD format, 4:3 mode)

Shrinking the graphics display
You can shrink the graphics display so that you can see beyond the range 
displayed on the normal monitor screen. This makes it possible to visually set 
the location of images in a larger space. The range displayed on a normal 
monitor screen is indicated by a frame.

Wire frame

Local coordinate space axes

Channel ID

Y

XZ
1F

–4 –3 –2 –1 0 +1 +2 +3 +4
+3

+2

+1

0

–1

–2

–3
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To automatically erase the graphic display
Turn Auto Erase on. The graphic display is erased automatically whenever a 
keyframe is executed. It is displayed again after the keyframe ends, after the 
time set in Recovery Time.

Flex Shadow center axis
When using the Flex Shadow function (see page 70), turn Flex Shadow Axis 
on to display the Flex Shadow center axis. This is an effective aid in making 
settings for this function.

Note
The Flex Shadow center axis function is not supported on the MVE-8000A and 
MKS-6470.

Three-Dimensional Parameter Display

You can display a three-dimensional parameter list for the currently controlled 
image. When more than one DME channel is selected, the status of the 
reference channel is displayed.

For the method of displaying a parameter list and an example display, see 
“Viewing the three-dimensional parameter details” (page 34).

Range displayed 
on normal monitor 
screen

Wire frame
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Three-Dimensional Transformation 
Operations

Use the device control block to carry out three-dimensional DME 
transformations.

For details of three-dimensional DME coordinate space, see “Three-
Dimensional Transformations” (page 16).

Basic Operations 

This section explains how to use the device control block (trackball) to carry 
out three-dimensional transformations.

Function assignment buttons

Operating buttons Z-ring

DEVUSERM/E1

DME1

DME5

MENU

SHIFT

M/E2

DME2

DME6

ASP
PERS
ROT

AXIS
LOC
WIPE

LOCAL
K1

CB1

CLR
WORK
BUFR

M/E3

DME7

X

P/P

DME8

Y Z CTR

RUN
CTRL

LOC
SIZE
ASP

LOC
XYZ
LOC

ROT
POS

RSZR

SRC
K3

GLB
K2

TRGT
K4

RSZR
CTRL

Region selection buttons (DME1, 2 and 5 to 8)

Trackball
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Buttons used when the three-dimensional transform operation 
mode is enabled

LOCAL: Enable operations in the DME local coordinate space. 
GLB (global): Enable operations in the DME global coordinate space.

The [LOCAL] and [GLB] buttons can be selected at the same time.
SRC (source): Enable operations in the DME source coordinate space.
TRGT (target): Enable operations in the DME target coordinate space.

The [SRC] and [TRGT] buttons cannot be selected at the same time. When 
these buttons are held down, trackball and Z-ring operation is switched to 
a finer control. (fine mode)

AXIS LOC (location): When this button is lit, the trackball moves the 
rotational axis of the image in the x-axis and y-axis directions, and the Z-
ring moves the axis in the z-axis direction.

ASP PERS (aspect/perspective): When the [SRC] button is lit, pressing this 
button enables the trackball to control the x-axis and y-axis directions 
independently, and the Z-ring controls the x-axis and y-axis directions 
together, to vary the aspect ratio. When the [SHIFT] button is held down 
and this button is pressed, the trackball controls the skew of the image in 
the x-axis and y-axis directions.
When the [TRGT] button is lit, pressing this button enables the trackball 
to control the perspective of the image in the x-axis and y-axis directions.
The Z-ring controls the distance to the viewpoint.

LOC (location) SIZE: When this button is lit, the Z-ring controls the image 
size.
The trackball moves the image in the x-axis and y-axis directions.

LOC (location) XYZ: When this button is lit, the trackball moves the image 
in the x-axis and y-axis directions, and the Z-ring moves the image in the 
z-axis direction.

SHIFT: While holding down this button, pressing the [ASP PERS] button or 
[ROT] button switches to the shifted version of the corresponding 
function.

CLR WORK BUFR (clear work buffer): Press this button once to clear only 
the three-dimensional transform parameters of the information held in the 
work buffer. Press twice in rapid succession to clear all of the parameters, 
and return to the default state.

ROT (rotation): When this button is lit, the trackball rotates the image about 
the x- and y-axes, and the Z-ring rotates the image about the z-axis.
Pressing this while holding down the [SHIFT] button enables rotation of 
the image in the “Spin” mode. The trackball and Z-ring operate in the same 
manner.

X, Y, Z: These restrict which axes the trackball and Z-ring can control. You 
can select more than one.
When one of these buttons is selected, you can enter the parameter value 
for the corresponding axis using the numeric keypad control block.
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CTR (center): Pressing this button changes the values of the three-
dimensional parameters currently controlled by the trackball and Z-ring to 
the closest detent values.
Pressing twice in rapid succession returns the parameter values to their 
defaults.

Transforming an image in three-dimensional coordinate space

1 With the region selection buttons, select the target channel of the 
operation.

You can press several of the buttons simultaneously to select several 
channels. In this case, the button that you pressed first lights in green, 
while buttons pressed subsequently light in amber.

2 With the function assignment buttons, select the three-dimensional 
coordinate space in which to perform the transformation.

LOCAL button: Selects local coordinate space.
GLB button: Selects global coordinate space. You can select this button 

and the [LOCAL] button simultaneously.
SRC button: Selects the source coordinate space.
TRGT button: Selects the target coordinate space.
([SRC] and [TRGT] cannot be selected at the same time.)

3 Press the button for the operation you want to do, turning it on, to select 
the transformation mode.

The trackball and Z-ring are assigned to the selected three-dimensional 
coordinate space transformation mode.

For details of the three-dimensional transformation operation modes, see 
“Transformation Operation Modes” (page 21).

To move the image: Press the [LOC XYZ] button, turning it on.
You can move the image on the x- and y-axes with the trackball and 
move it on the z-axis with the Z-ring. Pressing the [LOC SIZE] button 
instead of the [LOC XYZ] button, turning it on, makes it possible to 
move the image on the x- and y-axes.

To rotate the image: Press the [ROT] button, turning it on.
You can rotate the image on the x- and y-axes with the trackball and 
rotate it on the z-axis with the Z-ring. 
To rotate the image in Spin mode, press the [ROT] button, turning it 
on, while holding down the [SHIFT] button. You can operate in the 
same way with the trackball and Z-ring.

To move an axis of rotation: With the [SRC] button selected in step 2, 
press the [AXIS LOC] button, turning it on.
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You can move the axis of rotation of the image on the x- and y-axes of 
the image with the trackball, and on the z-axis with the Z-ring. 

To magnify or shrink the image: Press the [LOC SIZE] button, turning 
it on.
You can magnify and shrink the image with the Z-ring. Rotate 
counterclockwise to shrink, and clockwise to magnify.

To change the aspect ratio of the image: With the [SRC] button selected 
in step 2, press the [ASP PERS] button, turning it on.
You can change the aspect ratio independently on the x- and y-axes 
with the trackball, and change it simultaneously on both the x- and y-
axes with the Z-ring.

To change the perspective on the image: With the [TRGT] button 
selected in step 2, press the [ASP PERS] button, turning it on.
You can change the perspective of the image on the x- and y-axes with 
the trackball, and change the distance to the view point with the Z-
ring.

To change the skew of the image: With the [SRC] button selected in step 
2, press the [ASP PERS] button, turning it on, while holding down the 
[SHIFT] button.
You can change the skew of the image along the x- and y-axes with 
the trackball.

4 Depending on the axis of the change, operate the trackball and Z-ring as 
follows.

• To change on the x-axis, rotate the trackball horizontally.
Parameter values increase as you rotate to the right, and decrease as you 
rotate to the left.

• To change on the y-axis, rotate the trackball vertically.
Parameter values increase as you rotate upward, and decrease as you 
rotate downward.
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• To change on the z-axis, rotate the Z-ring.
Parameter values increase as you rotate clockwise, and decrease as you 
rotate counterclockwise.
However, when you have pressed the [LOC XYZ] button to move the 
image, z-axis parameters increase as you rotate counterclockwise, and 
decrease as you rotate clockwise.

To reduce the rate of change of the parameters (fine mode)
Carry out the trackball or Z-ring operations while holding down the [SRC] 
or [TRGT] button.

5 To restrict the change in the transformation to a specific axis, press the [X], 
[Y], or [Z] button, tuning it on. 

This enables the trackball and Z-ring operations on the selected axis only.

Functions assignable to trackball and Z-ring operations

Button Usable coordinate 
space

Trackball x-
direction

Trackball y-
direction

Z-ring

LOC XYZ Source, target Move image on x-
axis

Move image on y-
axis

Move image on z-
axis

ROT Source, target Rotate image on y-
axis

Rotate image on x-
axis

Rotate image on z-
axis

SHIFT+ 
ROT

Source, target Rotate image on y-
axis (Spin mode)

Rotate image on x-
axis (Spin mode)

Rotate image on z-
axis (Spin mode)

AXIS LOC Source Move x-axis of 
rotation

Move y-axis of 
rotation

Move z-axis of 
rotation

LOC SIZE Source, target Move image on x-
axis

Move image on y-
axis

Magnify and shrink 
image 
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Three-Dimensional Parameter Display

You can check the values of the three-dimensional parameters in the DME 
menu.

Displaying the three-dimensional parameters in the DME menu
In the menu control block, select the top menu selection button [DME].
The DME menu appears. The status area shows the three-dimensional 
parameters currently controlled by the device control block.
• When multiple DME channels are selected, this shows the parameters for the 

reference channel.
• When both Global and Local are selected, the three-dimensional parameters 

are shown for the channel (the reference channel) for which the button is lit 
green.

ASP PERS Source Change aspect ratio 
on x-axis

Change aspect ratio 
on y-axis

Change aspect ratio 
on x- and y-axes 
simultaneously

Target Shift view point on x-
axis

Shift view point on y-
axis

Change distance 
from view point to 
image

SHIFT+ ASP 
PERS

Source Change skew on x-
axis

Change skew on y-
axis

Change aspect ratio 
on x- and y-axes 
simultaneously

Functions assignable to trackball and Z-ring operations

Button Usable coordinate 
space

Trackball x-
direction

Trackball y-
direction

Z-ring
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Example three-dimensional parameter display (DME menu)

Viewing the three-dimensional parameter details
In the DME menu, press the menu title button (the [DME] in the upper left part 
of the screen).
The Status menu appears. This menu shows the three-dimensional parameters 
for the DME reference channel currently selected in the device control block.

Type of three-dimensional space a)

Operation mode for three-dimensional 
transforms b)

Value of X

Value of Y

Value of Z

a) This shows one of Local Target, Local Source, Global Target, and Global 
Source.

b) This shows one of Loc XYZ, Loc Size, Rot, Spin, Axis Loc, Skew, Asp, and 
Pers.
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Example three-dimensional parameter details

Entering Three-Dimensional Parameter Values 

In addition to setting three-dimensional parameter values with the trackball and 
Z-ring, you can enter them directly from the numeric keypad control block.

Entering three-dimensional parameter values

1 In the device control block, press the [X], [Y], or [Z] button, turning it on.

The numeric keypad control block enters a mode in which you can enter 
parameters for the selected axis.

2 Enter a parameter value with the numeric keypad.

The number of significant digits after a decimal point is 4. 

3 Press the [ENTER] button.

The parameter value is changed, and the image changes.
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To enter difference values
You can enter difference values by pressing the [+/–] button, entering the 
difference from the current value, and pressing the [TRIM] button to confirm. 
The [+/–] button toggles between “+” (plus) and “–” (minus) each time it is 
pressed.

Resetting three-dimensional parameter values
Pressing the [CTR] button in the device control block sets the current three-
dimensional parameter values to the closest detent points (page 20).
To reset three-dimensional parameter values to the defaults (page 20) for the 
current transformation operation mode, press the [CTR] button twice in rapid 
succession. 

Clearing the working buffer
The working buffer is memory that holds the instantaneous state of an effect. 
To clear (initialize) only the three-dimensional transform parameters in the 
working buffer, press the [CLR WORK BUFR] button in the device control 
block.
To clear all of the parameters in the working buffer and initialize the DME 
system, press the [CLR WORK BUFR] button twice in rapid succession. It is 
necessary to do this for both the local coordinate space and global coordinate 
space.
As the initial DME state, you can specify whether to use the factory default 
settings or user settings in the Setup menu. (See “Selecting the State After 
Powering On (Start Up Menu)” in Chapter 18 (Volume 3).)

Graphics Display Operation

Use the DME menu to make graphics display settings. You can make separate 
settings for separate channels. To select a target DME channel, use the device 
control block. For the types of graphics displayed, see “Graphics Display” 
(page 25).

Displaying graphics

1 In the menu control block, select the top menu selection button [DME]. 

The DME menu appears. 

2 Select VF6 ‘Input/Output’ and HF4 ‘Graphic.’ 

The Graphic menu appears. 
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3 Turn [Graphic] on.

The system enters graphics display mode, enabling graphics to be 
displayed in the monitor screen.

4 Turn on the buttons of the graphics you want to show.

To show axes: Turn [Axis] on.
To show axis names: Turn [Axis Name] on. 
To show the channel ID: Turn [Ch ID] on. 
To show a wire frame: Turn [Wire Frame] on.
To show the grid: Turn [Grid] on. 
To show the flex shadow axis: Turn [Flex Shadow Axis] on.

The selected graphics appear in the monitor screen.

Note
The flex shadow axis function is not supported on the MVE-8000A and 
MKS-6470.

5 If you want to shrink the graphics display to show the range not displayed 
on a normal monitor, turn [Scale] on and set the following parameters.

As the value of the setting grows, the monitor shrinks further toward the 
center point.

6 To automatically erase the graphic display while the keyframes are 
executing, press [Auto Erase], turning it on, and then set the following 
parameter.

Outputting graphics to the monitor output connector
In the Graphic menu, press [Monitor Out] to turn it on.
Graphics are displayed on the device connected to the monitor output 
connector.

Knob Parameter Adjustment Setting values

1 Scale Degree to which the graphics 
display is shrunk

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Recover Time Time until graphic display 
appears again after keyframe 
execution

0 to 300 (frames)
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Note
When using MKS-6470, graphics are displayed on the monitor signal of the 
switcher.

For details, see “Superimposing the graphic display on the monitor signal” 
(page 38).

When the MKE-8021A is installed in the MVE-8000A to provide an SDI 
interface or when the MVE-9000 is used, it is possible to output graphics to the 
Monitor Out connector.

Superimposing the graphic display on the monitor signal

Note
When using the MKS-6470, the graphic display is superimposed on the 
monitor signal (DME MON V, DME MON K).

In the Graphic menu, press [Monitor Out], turning it on.
The graphic display appears on the monitor signal to which the DME output is 
assigned.

You can select which DME channel output is assigned to the monitor signal. 
For details, see “Applying a DME Effect to a Key” in Chapter 4 (Volume 1).

Canceling Virtual Images

When a transformation is executed with an extreme degree of perspective, the 
part of the image which is beyond the imaginary view point can wrap around 
and show on the other side. The wrapped-around portion is referred to as a 
virtual image.
Using the DME menu, you can make a setting not to show the virtual images.

Canceling virtual images

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 ‘Video/Key.’

The Video/Key menu appears.

2 Press [Wrap Around], turning it on.

The virtual image disappears.
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[Wrap Around] on

Virtual image
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DME Special Effect Operations

You can use DME to add a variety of special effects. 

Usable function differs  depending on the model. For details, see “Functional 
Differences With Models of DME” (page 478).

Special Effects

Edge effects

Name Effect/Image

Border
(See page 54.)

Adds a border to the image frame. You can adjust the width (or thickness) of 
the border, its color, and the softness of the border edges.

Crop
(See page 56.)

Crops away the edges of the image. You can crop the top, bottom, left, and 
right sides individually or all together. You can also soften the cropped 
edges.
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Beveled Edge
(See page 59.)

Gives an image a beveled edge. You can set the edge width and color. The 
inner edge softness and edge boundary softness can also be set.

Key Border
(See page 61.)

Adds borders to keys or gives a key consisting of an outline only.

Name Effect/Image

Color Lights
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Art Edge
(See page 62.)

Adds edges to the inner and outer side of the input image.
The following items can be set.
• Art edge width and position
• Separate softening of the art edge inner and outer sides
• Color of art edges 
Examples of Art Edge source

Name Effect/Image

Gradation Matte Radial Gradation

Rainbow Matte Radial Rainbow

Examples of Art Edge source [Rainbow Matte]
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Flex Shadow
(See page 70.)

Allows a shadow to be added to the image using only one DME channel.
The following settings can be made for the shadow.
• The signal to use for the shadow

- External: Generate shadow using input key signal.
- Internal: Generate shadow using an internally generated, full-size DME 

key signal.
• Shadow shrinking and magnification
• Shadow position
• Shadow color and density
• Center axis of deformation
• Shadow slant and perspective

Drop Shadow
(See page 77.)

Allows a shadow to be added to the image using only one DME channel.
The following settings can be made for the shadow.
• Shadow position
• Shadow density
• Shadow color
• Edge soft function

Wipe Crop
(See page 78.)

Crops the video image to be visible inside or outside a wipe pattern.

Name Effect/Image

Rainbow Matte Radial Rainbow

Background

Video image When Invert is On
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Effects for entire image

Effects for video image

Name Effect/Image

Defocus
(See page 84.)

Defocuses the whole image. The degree of defocusing can be set 
simultaneously or separately for video and key signals. (However, when the 
DME dedicated interface is used, the degree of defocusing can be set for 
video signals only.) You can also cancel the black level leaking that occurs at 
the edge of the screen when the Defocus effect is used.

Blur
(See page 87.)

Applies a rounded blurring to the whole image.

Multi Move
(See page 89.)

Shrinks the image and lines up a number of copies vertically and 
horizontally. You can specify the center point of the shrinking, the shrinking 
ratio, and the aspect ratio of the image screen.

Name Effect/Image

Sepia
(See page 90.)

Overlays a specified color onto the image. You can adjust the sepia color 
that is overlaid, and specify the degree of mixing between the original image 
and the sepia image.

Mono
(See page 90.)

Converts the image into a monochrome image.

Posterization
(See page 91.)

Coarsens the luminance gradations of the image, for a paintinglike effect. 

Solarization
(See page 91.)

Coarsens the chroma gradations of the image, for a paintinglike effect.
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Nega
(See page 92.)

Reverses the luminance or chroma of the image.

Contrast
(See page 92.)

Changes the contrast of the luminance and chroma of the image.

Mosaic
(See page 93.)

Divides the image into small tiles so that it looks like a mosaic. You can 
specify the size and aspect ratio of the tiles.

Mask
(See page 100.)

Masks part of the picture, so that special effects are applied only inside a 
selected pattern.

Name Effect/Image

MASK (NORMAL) MASK (INVERT)

Video 
image

Effect video 
image (Mosaic)

Video 
image

Effect video 
image (Mosaic)
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Sketch
(See page 94.)

Provides a sketch-like effect based on the outlines of the image, using 
different touches such as sketch, edge color, drawing, relief, and sharp. 

Metal
(See page 96.)

Provides a metallic gloss like that from gold, silver, or a rainbow colored 
surface. A metallic gloss can also be given to a freely selected color.

Dim and Fade
(See page 97.)

The Dim effect makes the image darker as it recedes into the distance. The 
Fade effect makes the image fade into the background as it recedes into the 
distance.

Glow
(See page 99.)

Softens the edges of highlights, giving an effect like being struck by a soft 
light.

Name Effect/Image

SKETCH

FADE
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Freeze effects

Freezes the input video. The video can also be freezed at a specified interval 
(see page 102). 

Nonlinear effects

Name Effect/Image

Wave
(See page 105.)

Produces a wave-like effect in the image.

Mosaic Glass
(See page 109.)

Makes the image rougher and finer at a 
specified interval.

Flag
(See page 110.)

Applies an effect like a flag waving in the 
wind.

Twist
(See page 110.)

Twists the image.

Ripple
(See page 111.)

Applies an effect like ripples moving across 
the image.
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Rings
(See page 116.)

Partitions the image into rings that rotate 
while moving in the same direction.

Broken Glass
(See page 117.)

Partitions the image like broken glass, with 
shards flying outward.

Flying Bar
(See page 117.)

Divides the image into bars which peel off in 
two blocks as they move.

Blind
(See page 118.)

Divides the image into bars or wedges, with 
blocks rotating like the slats of venetian 
blinds.

Split
(See page 119.)

Splits the image upper and lower, left and 
right.

Split Slide
(See page 120.)

Divides the image into bars which slide 
alternately in reverse directions.

Name Effect/Image
DME Special Effect Operations



  C
hapter 11 

D
M

E
 O

perations
Mirror
(See page 121.)

Partitions the image vertically and 
horizontally, creating an image like a 
reflection in a mirror.

Multi Mirror
(See page 122.)

Divides the image into originals and 
reflections, lining them up vertically and 
horizontally.

Kaleidoscope
(See page 122.)

Creates an image like a view into a 
kaleidoscope.

Lens
(See page 123.)

Creates an image like a view through a lens.

Circle
(See page 125.)

Makes a circle with the image.

Panorama
(See page 125.)

Curves the upper and lower edges of the 
image to emphasize the sense of 
perspective.

Name Effect/Image
49DME Special Effect Operations



   C
hapter 11 

D
M

E
 O

perations

50
Page Turn
(See page 126.)

Turns the image like a turning page.

Roll
(See page 127.)

Rolls the image up.

Cylinder
(See page 127.)

Winds the whole image onto a cylinder.

Sphere
(See page 128.)

Winds the whole image onto a sphere.

Explosion
(See page 128.)

Divides the image into fragments which 
expand as they fly out.

Swirl
(See page 129.)

Swirls the image.

Name Effect/Image
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Lighting effects

Melt
(See page 130.)

Melts the image away from a specified part.

Character Trail
(See page 132.)

Extends the edge of the image like a trail.

Name Effect/Image

Lighting
(See page 133.)

Provides the effect of light striking the image.  

Spotlighting
(See page 148.)

Creates the effect of a spotlight striking the surface of the image.

Name Effect/Image

Normal

Mat

Specular
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Recursive effects

Background color
Adds a color or inputs an external signal to the background of the image (See 
page 166). 

Separate sides (effects for front and back sides)
Applies separate video signals and key signals to the front and back of the 
image (See page 167). 

Name Effect/Image

Trail
(See page 138.)

Recursively freezes the input video at 
regular intervals so that a trail of 
afterimages is created. You can make the 
afterimages stardust trails.

Motion Decay
(See page 142.)

Blurs the motion of a moving video by 
creating afterimages of the moving video. 
You can make the afterimages stardust 
trails.

Keyframe Strobe
(See page 144.)

Freezes the video each time the effect passes a keyframe. You can make 
the afterimages stardust trails.

Wind
(See page 146.)

Strobes the image at regular intervals, and 
moves the frozen image in a fixed 
direction, leaving an afterimage.
DME Special Effect Operations



  C
hapter 11 

D
M

E
 O

perations
Front and back sides

Signal inversion (Invert effect)
Inverts the input video signal and/or key signal horizontally or vertically. You 
can make separate settings for the front and back (see page 170).

Inversion of input signal

Key density adjustment
Adjusts the key density for the key signal input to the DME (see page 170). 

Key source selection
Selects either the key signals received from the switcher or the key signals 
generated in the DME for application to the front and back of the image  (see 
page 170).

Color mix setting
This is a combination of two colors with a pattern generator. This color mix 
signal can be used to fill parts such as a background or border (see page 82). 

Front Back

Horizontal inversion Input signal Vertical inversion
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Operations common to all DME special effects

In this section, explanations of the operating procedures for individual special 
effects begin with selections from the DME menu. The following are common 
operations that you must do prior to selecting from the DME menu.

1 In the device control block, select the target DME channel.

2 In the menu control block, select the top menu selection button [DME].

The DME menu appears.

Border Settings

Adding a border

1 In the DME menu, select VF1 ‘Edge’ and HF1 ‘Border/Crop.’

The Border/Crop menu appears.

2 Press [Border], turning it on.

The Border effect is enabled. You can adjust the border width parameters 
with the knobs.

3 Set the parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

Color 2

Color 1
DME Special Effect Operations



  C
hapter 11 

D
M

E
 O

perations

• 4:3 mode

• 16:9 mode

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Border width on left and right 
sides

Left value shown

2 V Border width on top and bottom 
sides

Top value shown

3 All Border width on all sides Left value shown

5 Density Border density 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Border width on top side –6.00 to +6.00 (SD)
–18.00 to +1800 (HD)

2 Left Border width on left side –8.00 to +8.00 (SD)
–24.00 to +24.00 (HD)

3 Right Border width on right side –8.00 to +8.00 (SD)
–24.00 to +24.00 (HD)

4 Bottom Border width on bottom side –6.00 to +6.00 (SD)
–18.00 to +18.00 (HD)

5 Density Border density 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Border width on left and right 
sides

Left value shown

2 V Border width on top and bottom 
sides

Top value shown

3 All Border width on all sides Left value shown

5 Density Border density 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Border width on top side –4.50 to +4.50 (SD)
–18.00 to +18.00 (HD)

2 Left Border width on left side –8.00 to +8.00 (SD)
–32.00 to +32.00 (HD)

3 Right Border width on right side –8.00 to +8.00 (SD)
–32.00 to +32.00 (HD)

4 Bottom Border width on bottom side –4.50 to +4.50 (SD)
–18.00 to +18.00 (HD)

5 Density Border density 0.00 to 100.00
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Setting the border color
The operation differs depending on the DME used (MVE-8000A/MKS-6470 
or MVE-9000).

When the MVE-8000A/MKS-6470 is used
Press [Border Color], turning it on, and set the following parameters.

When the MVE-9000 is used
Use the buttons in the <Border Fill> group to select the signal to insert in the 
border.
Flat Color: single color
Mix Color: mix color signal set in the Color Mix menu (see page 82)
Ext Video: an external video signal input to the Ext IN connector

If Flat Color is selected, adjust the following parameters.

If Mix Color or Ext Video selected, the border color changes according to the 
mix color signal or external video signal.

Softening the border edges
Press [Border Soft], turning it on, and set the following parameters.

Crop Settings

Cropping the image

1 In the DME menu, select VF1 ‘Edge’ and HF1 ‘Border/Crop.’

The Border/Crop menu appears.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Soft Softness of inner side of border 0.00 to 100.00
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2 Press [Crop], turning it on.

The Crop effect is enabled. You can adjust degree of cropping with the 
knobs.

3 Set the parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

• 16:9 mode

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Crop positions on left and right 
sides

Left value shown

2 V Crop positions on top and 
bottom sides

Top value shown

3 All Crop positions on all sides Left value shown

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Crop position on top side –3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

2 Left Crop position on left side –4.00 to +4.00 (SD)
–12.00 to +12.00 (HD)

3 Right Crop position on right side –4.00 to +4.00 (SD)
–12.00 to +12.00 (HD)

4 Bottom Crop position on bottom side –3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Crop positions on left and right 
sides

Left value shown

2 V Crop positions on top and 
bottom sides

Top value shown

3 All Crop positions on all sides Left value shown

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Crop position on top side –2.25 to +2.25 (SD)
–9.00 to +9.00 (HD)
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Signs of numeric settings
For H, V, and All settings, the sign (+/–) of the setting need not be 
considered. For example, in the case of an H setting, the value for Left is 
automatically regarded as a negative value, and the value for Right as a 
positive value, to display the image.
The following is an example of these settings.

4 To soften the edges of the image, press [Edge Soft], turning it on, and set 
the following parameter.

Note
Edges cannot be softened when the Crop effect is disabled.

To specify whether to invert the crop area when inverting the video 
image
In the <Invert/Crop Process> group, select either of the following.
Crop –> Invert: Set an axis of symmetry at the center of the input video, and 

invert both the desired area of video and the crop area horizontally and 
vertically around that axis of symmetry. The order of effect application is 
Crop > Invert.

Invert –> Crop: Set an axis of symmetry at the center of the input video, and 
invert only the desired area of video horizontally and vertically around that 
axis of symmetry. The order of effect application is Invert > Crop.

2 Left Crop position on left side –4.00 to +4.00 (SD)
–16.00 to +16.00 (HD)

3 Right Crop position on right side –4.00 to +4.00 (SD)
–16.00 to +16.00 (HD)

4 Bottom Crop position on bottom side –2.25 to +2.25 (SD)
–9.00 to +9.00 (HD)

Parameter group [2/2]

Knob Parameter Adjustment Setting values

Parameter Entered 
value

Setting

H 1.5 Left=–1.50

Right=1.50

–1.5 Left=–1.50

Right=1.50

Knob Parameter  Adjustment Setting values

1 Soft Softness of edges 0.00 to 100.00
DME Special Effect Operations



  C
hapter 11 

D
M

E
 O

perations
Beveled Edge Settings

Applying a beveled edge

1 In the DME menu, select VF1 ‘Edge’ and HF2 ‘Beveled Edge.’

The Beveled Edge menu appears.

2 Press [Beveled Edge], turning it on.

This enables the beveled edge, and you can now use the knobs to adjust the 
parameters.

Note
When the border is enabled, the edge soft function (see page 56) is not 
available.

3 Set the parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

• 16:9 mode

4 In the <Edge Mode> group, select the type of edge.

Light: effect of light striking the edge

Knob Parameter Adjustment Setting values

1 H Simultaneously adjust width of left 
and right edges

0.00 to 4.00 (SD)
0.00 to 12.00 (HD)

2 V Simultaneously adjust width of top 
and bottom edges

0.00 to 3.00 (SD)
0.00 to 9.00 (HD)

3 All Simultaneously adjust width of all 
four edges

Value of H shown

Knob Parameter Adjustment Setting values

1 H Simultaneously adjust width of left 
and right edges

0.00 to 4.00 (SD)
0.00 to 16.00 (HD)

2 V Simultaneously adjust width of top 
and bottom edges

0.00 to 2.25 (SD)
0.00 to 9.00 (HD)

3 All Simultaneously adjust width of all 
four edges

Value of H shown
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Color: colored edges. When this is selected, set the following parameters 
in the <Color Adjust> group.

• To set the density

• To set the colors for each edge (Top, Left, Right, Bottom, All)

a) For the All adjustment, the value for Left is shown.

5 To soften the inside of the edges and the boundaries between adjacent 
edges, turn on [Edge Soft], and adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Top Adjust luminance of top edge –100.00 to +100.00

2 Left Adjust luminance of left edge –100.00 to +100.00

3 Right Adjust luminance of right edge –100.00 to +100.00

4 Bottom Adjust luminance of bottom edge –100.00 to +100.00

5 All Simultaneously adjust luminance of 
all four edges

Value of Left shown

Knob Parameter Adjustment Setting values

1 Density Adjust the color density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00 a)

2 Saturation Saturation 0.00 to 100.00 a)

3 Hue Hue 359.99 to 0.00 a)

Knob Parameter Adjustment Setting values

1 Inner Soft Softness of the inside of edges 0.00 to 100.00

2 Bound Soft Softness of the edge boundaries 0.00 to 100.00

Bound Soft

Inner Soft
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Key Border Settings

Note
The Key Border function is not supported on the MVE-8000A and MKS-6470.

Applying key borders

1 In the DME menu, select VF1 ‘Edge’ and HF3 ‘Key Border.’

The Key Border menu appears.

2 Press [Key Border], turning it on.

This enables key borders, and you can now use the knobs to adjust the 
parameters.

Note
The key border function and Glow function (see page 99) cannot be turned 
on at the same time. Only the one most recently turned on is effective.

3 Set the following parameters.

4 To set the key border color, press [Flat Color] and adjust the following 
parameters.

To select an outline only key
Press [Outline], turning it on.
The outline only effect is enabled.

Knob Parameter Adjustment Setting values

1 H Simultaneously adjust width of left 
and right key borders

0.00 to 100.00

2 V Simultaneously adjust width of top 
and bottom key borders

0.00 to 100.00

3 All Simultaneously adjust width of all 
four key borders

Value of H shown

4 Soft Softness of the key borders 0.00 to 100.00

5 Density Density of the key borders 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Art Edge Settings

Note
The Art Edge function is not supported on the MVE-8000A and MKS-6470.

Applying art edges

1 In the DME menu, select VF1 ‘Edge’ and HF4 ‘Art Edge.’

The Art Edge menu appears.

2 Press [Art Edge], turning it on.

This enables art edges, and you can now use the knobs to adjust the 
parameters.

Note
The Defocus, Blur, Key Border, and Glow effects cannot be applied to the 
Art Edge sections.

3 Set the parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Simultaneously adjust width of left 
and right edges

Value of Left shown

2 V Simultaneously adjust width of top 
and bottom edges

Value of Top shown

3 All Simultaneously adjust width of all 
four edges

Value of Left shown

5 Density Density of edges 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Width of top edge 0.00 to 6.00 (SD)
0.00 to 1800 (HD)

2 Left Width of left edge 0.00 to 8.00 (SD)
0.00 to 24.00 (HD)
DME Special Effect Operations



  C
hapter 11 

D
M

E
 O

perations
• 16:9 mode

Adjusting the position of art edges

1 In the Art Edge menu, press [Edge Position], turning it on.

2 Adjust the following parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

3 Right Width of right edge 0.00 to 8.00 (SD)
0.00 to 24.00 (HD)

4 Bottom Width of bottom edge 0.00 to 6.00 (SD)
0.00 to 18.00 (HD)

5 Density Density of edges 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Simultaneously adjust width of left 
and right edges

Value of Left shown

2 V Simultaneously adjust width of top 
and bottom edges

Value of Top shown

3 All Simultaneously adjust width of all 
four edges

Value of Left shown

5 Density Density of edges 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Width of top edge 0.00 to 4.50 (SD)
0.00 to 18.00 (HD)

2 Left Width of left edge 0.00 to 8.00 (SD)
0.00 to 32.00 (HD)

3 Right Width of right edge 0.00 to 8.00 (SD)
0.00 to 32.00 (HD)

4 Bottom Width of bottom edge 0.00 to 6.00 (SD)
0.00 to 18.00 (HD)

5 Density Density of edges 0.00 to 100.00
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• 4:3 mode

• 16:9 mode

Softening the inner and outer sides of art edges

1 In the Art Edge menu, press [Soft], turning it on.

2 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Top Position of top edge –3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

2 Left Position of left edge –4.00 to +4.00 (SD)
–12.00 to +12.00 (HD)

3 Right Position of right edge –4.00 to +4.00 (SD)
–12.00 to +12.00 (HD)

4 Bottom Position of bottom edge –3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

5 All Adjust the position of all four 
edges

Value of H shown

Knob Parameter Adjustment Setting values

1 Top Position of top edge –2.25 to +2.25 (SD)
–9.00 to +9.00 (HD)

2 Left Position of left edge –4.00 to +4.00 (SD)
–16.00 to +16.00 (HD)

3 Right Position of right edge –4.00 to +4.00 (SD)
–16.00 to +16.00 (HD)

4 Bottom Position of bottom edge –2.25 to +2.25 (SD)
–9.00 to +9.00 (HD)

5 All Adjust the position of all four 
edges

Value of H shown

Top

Left Right

Bottom

Example: Moving the right edge position in the “minus” direction.

Art edge portion Position before 
moving

Position after 
moving

Moving in the 
minus direction
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Setting the way in which art edge colors change

1 In the <Art Edge Source> group of the Art Edge menu, select the color 
pattern to apply to the art edges.

Flat Color: Uses Color 1 (see page 68) as a flat color.
Gradation Matte: Color 1 changes to Color 2 (see page 68) at the border 

lines (see step 2).
Rainbow Matte: The color set as Color 1 changes hue into color on the 

border lines.
Radial Gradation: Color 1 on the inner side is mixed into Color 2 on the 

outer side, according to the shape of the art edge.
Radial Rainbow: The hue of Color 1 on the inner side changes into Color 

2 on the outer side, according to the shape of the art edge.
Rainbow Gradation: Color 3 (see page 66) overwrites Radial Rainbow, 

giving a gradation effect.

Knob Parameter Adjustment Setting values

1 Inner H Simultaneously adjust softness of 
left and right inner edges

0.00 to 100.00

2 Inner V Simultaneously adjust softness of 
top and bottom inner edges

0.00 to 100.00

3 Outer H Simultaneously adjust softness of 
left and right outer edges

0.00 to 100.00

4 Outer V Simultaneously adjust softness of 
top and bottom outer edges

0.00 to 100.00

5 All Simultaneously adjust softness of 
all inner and outer edges.

Value of Outer H 
shown

Flat Color Gradation Matte Rainbow Matte

Radial Gradation Radial Rainbow Rainbow Gradation
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2 When you select other than [Flat Color], set the gradation border lines for 
the selected pattern.

Border line parameters for Gradation Matte and Rainbow Matte
The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

• 16:9 mode

Radial Gradation and Radial Rainbow parameters 

Rainbow Gradation parameters
The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

Knob Parameter Adjustment Setting values

1 H  Position of gradation border in 
horizontal direction

–8.00 to +8.00 (SD)
–24.00 to +24.00 (HD)

2 V Position of gradation border in 
vertical direction

–6.00 to +6.00 (SD)
–18.00 to +18.00 (HD)

3 Soft Softness of gradation border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H  Position of gradation border in 
horizontal direction

–8.00 to +8.00 (SD)
–32.00 to +32.00 (HD)

2 V Position of gradation border in 
vertical direction

–4.50 to +4.50 (SD)
–18.00 to +18.00 (HD)

3 Soft Softness of gradation border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

3 Soft Softness of gradation border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H  Position of gradation border in 
horizontal direction

–8.00 to +8.00 (SD)
–24.00 to +24.00 (HD)

2 V Position of gradation border in 
vertical direction

–6.00 to +6.00 (SD)
–18.00 to +18.00 (HD)

3 RBW Soft Softness of rainbow border region 0.00 to 100.00
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• 16:9 mode

3 When Gradation Matte or Rainbow Matte is selected, set modifiers as 
required.

• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) –1.00 is one rotation in counterclockwise direction. +1.00 is one rotation in clockwise 
direction. 0.00 is no rotation.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a specified speed

a) –100.00 is four rotations per second in counterclockwise direction. +100.00 is four 
rotations per second in clockwise direction. 0.00 is no rotation.

4 GRD Soft Softness of gradation border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 H  Position of gradation border in 
horizontal direction

–8.00 to +8.00 (SD)
–32.00 to +32.00 (HD)

2 V Position of gradation border in 
vertical direction

–4.50 to +4.50 (SD)
–18.00 to +18.00 (HD)

3 RBW Soft Softness of rainbow border region 0.00 to 100.00

4 GRD Soft Softness of gradation border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Angle Rotation angle of pattern –8.00 to +8.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation speed of pattern –100.00 to +100.00 a)
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Setting art edge colors

1 In the Art Edge menu, turn on the button (Color 1 to Color 3) for the color 
for which you want to make settings in the <Color Adjust> group.

2 Adjust the following parameters.

• Color 1 settings 

• Color 2 settings

Note
Color 2 cannot be set when [Flat Color] is selected in the <Art Edge 
Source> group.

V V

HH

Color 1Color 1

Color 2 Color 2

Position determined by 
H and V values (When 
Angle (see step 3) is 0.)

Determined by the value of 
Angle (see step 3). 

Border

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Offset Hue range –540.0 to +540.0
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• Color 3 settings

Note
Color 3 can be set only when [Rainbow Gradation] is selected in the <Art 
Edge Source> group.

Relationship between Hue and Hue Offset
For example, when the Hue value of Color 1 is 180.00, and the Hue Offset 
value of Color 2 is –540.00, the relationship is as shown below, with the 
hue changing within the Hue Offset range of Color 1 and Color 2. 

Rounding art edge corners
Press [Round Corner], turning it on.
The art edge corners on the inner and outer sides are rounded.

Note
This function is available only when [Soft] is on.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Offset Hue range –540.0 to +540.0

540

360

180

0

-180

-360

-540

Color 1

Hue

Offset

Color 2

Hue setting 
range

Hue Offset 
setting range
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Flex Shadow Settings

Notes
• The Flex Shadow function is not supported on the MVE-8000A and MKS-

6470.
• “Mix Color” or “Ext Video”can only be applied to one of the background 

(see page 166), flex shadow, trail (see page 138), and wind (see page 146) 
effects.
If you select “Mix Color” or “Ext Video” in one of these settings, a selection 
of “Mix Color” or “Ext Video” in any of the other effects is disabled, and 
“Flat Color” is selected in its place.

• When executing combining four channels of DME images, “Mix Color” and 
“Ext Video” in the flex shadow and background effects cannot be selected.

Applying a flex shadow

1 In the DME menu, select VF1 ‘Edge’ and HF5 ‘Flex Drop Shadow.’

The Flex Shadow menu appears.

2 Press [Flex Shadow], turning it on.

This enables flex shadows, and you can now use the knobs to adjust the 
parameters.

Notes
The Flex shadow function cannot be enabled when the following functions 
are enabled.
• Any nonlinear effect
• Brick
• Shadow

3 Adjust the following parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

Knob Parameter Adjustment Setting values

1 H Move shadow horizontally –8.00 to +8.00 (SD)
–24.00 to +24.00 (HD)

2 V Move shadow vertically –6.00 to +6.00 (SD)
–18.00 to +18.00 (HD)
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a) The Soft parameter is valid only when [Internal] is selected in the <Flex Shadow Source> 
group.

• 16:9 mode

a) The Soft parameter is valid only when [Internal] is selected in the <Flex Shadow Source> 
group.

4 In the <Flex Shadow Source> group, select the signal to use for the flex 
shadow.

External: Generate the shadow using an input signal.
Internal: Generate the shadow using a full-size key signal.

5 In the <Flex Shadow Fill> group, select the signal to insert in the flex 
shadow.

Flat Color: single color
Mix Color: mix color signal set in the Color Mix menu (see page 82)
Ext Video: an external video signal input to the Ext IN connector

6 Only if Flat Color is selected in step 5, adjust the following parameters.

3 Size All Enlarge or shrink horizontally and 
vertically

Value of Size H (see 
page 72) shown

4 Soft a) Softness of shadow 0.00 to 100.00

5 Density Density of shadow 0.00 to 100.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 H Move shadow horizontally –8.00 to +8.00 (SD)
–32.00 to +32.00 (HD)

2 V Move shadow vertically –4.50 to +4.50 (SD)
–18.00 to +18.00 (HD)

3 Size All Enlarge or shrink horizontally and 
vertically

Value of Size H (see 
page 72) shown

4 Soft a) Softness of shadow 0.00 to 100.00

5 Density Density of shadow 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Adjusting the size of the flex shadow

1 In the Flex Drop Shadow menu, press [Size], turning it on.

2 Set the following parameters.

a) The Soft parameter is valid only when [Internal] is selected in the <Flex Shadow Source> 
group.

Setting the center point of the flex shadow

1 In the Flex Drop Shadow menu, press [Axis Loc], turning it on.

2 Adjust the following parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

• 16:9 mode

Knob Parameter Adjustment Setting values

1 Size H Enlarge or shrink horizontally 0.00 to 2.00

2 Size V Enlarge or shrink vertically 0.00 to 2.00

3 Size All Enlarge or shrink horizontally and 
vertically 

Value of Size H 
shown

4 Soft a) Softness of shadow 0.00 to 100.00

5 Density Density of shadow 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Axis Loc H Move the shadow center axis 
horizontally 

–8.00 to +8.00 (SD)
–24.00 to +24.00 (HD)

2 Axis Loc V Move the shadow center axis 
vertically

–6.00 to +6.00 (SD)
–18.00 to +18.00 (HD)

Knob Parameter Adjustment Setting values

1 Axis Loc H Move the shadow center axis 
horizontally 

–8.00 to +8.00 (SD)
–32.00 to +32.00 (HD)

2 Axis Loc V Move the shadow center axis 
vertically

–4.50 to +4.50 (SD)
–18.00 to +18.00 (HD)
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The flex shadow central axis appears when the [Flex Shadow Axis] function is 
enabled in the Graphic menu. 

For details, see “Graphics Display Operation” (page 36).

Skewing the flex shadow

1 In the Flex Drop Shadow menu, press [Skew], turning it on.

2 Adjust the following parameters.

Adding perspective to the flex shadow

1 In the Flex Drop Shadow menu, press [Perspective], turning it on.

2 Adjust the following parameters.

When the default Axis Loc setting is used

Picture

Flex shadow

Axis Loc position

Shadow skewed 
with Axis Loc set at 
the lower left corner 
of the picture

Shadow size and 
perspective adjusted 
with default Axis Loc 
setting

Shadow skewed with 
Axis Loc set at the 
midpoint on the left 
edge of the picture

Axis Loc H

Axis Loc V

Knob Parameter Adjustment Setting values

1 Skew H Skew horizontally –100.00 to +100.00

2 Skew V Skew vertically –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Perspective H Add horizontal perspective –100.00 to +100.00
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Inverting the flex shadow
In the <Invert> group of the Flex Drop Shadow menu, select the direction to 
invert the shadow.
H: Invert the shadow in the horizontal direction. The inversion is applied 

around the axis of the knob 2 parameter Axis Loc V set with [Axis Loc].
V: Invert the shadow in the vertical direction. The inversion is applied around 

the axis of the knob 1 parameter Axis Loc H set with [Axis Loc].

Setting a combine shadow
When there are several images, adds a flex shadow in the depth of an image or 
overlays multiple flex shadows.

2 Perspective V Add vertical perspective –100.00 to +100.00

Knob Parameter Adjustment Setting values

Perspective 
H = –100

Perspective 
H = +100

Perspective 
V = –100

Perspective 
V = +100

Picture

When H is enabled When V is enabled

Flex shadow

Before inversion

Before inversion

After inversion

After inversion
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1 In the Flex Drop Shadow menu, press [Combine Shadow], turning it on.

OverOver UnderUnderOver Under

Video Video

Example 1: When Flex Shadow is enabled on both of two channels.

OverOver UnderUnderOver Under OverOver UnderUnderOver Under

Combine shadow is enabled.
Density is set to 100.00.

Combine shadow is enabled.
Density is set to 0.00. 

Shadow Shadow
No combine shadow is set.

OverOver UnderUnderOver Under

Video Video

Example 2: Flex Shadow is enabled on one channel only.

OverOver UnderUnderOver Under OverOver UnderUnderOver Under

Combine shadow is enabled.
Density is set to 100.00.

Combine shadow is enabled.
Density is set to 0.00. 

Shadow

No combine shadow is set.
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2 Adjust the following parameter.

Notes
• The Combine Shadow effect is applied to all shadows, not only the 

sections where shadows overlap.
• Combine Shadow is enabled when the Flex Shadow effect and the global 

effect Combiner are enabled. In this state, Combine Shadow remains 
enabled even if the global effect is disabled.

• In Combine Shadow, the settings for the channel with the lowest number 
among the channels being combined are enabled.

Flex shadow creation example
The flow of flex pattern creation will be explained using the following pattern 
as an example.

1 Press [Flex Shadow], turning it on.

2 In the <Flex Shadow> group, select [External].

3 Turn [Axis Loc] on and use knob 2 to set the Axis Loc V parameter so that 
the center of the flex shadow deformation is at the bottom of the picture.
(For HD format and 16: 9 mode: Axis Loc V = –9.00)

The following steps will be easier if you display the flex shadow axis 
graphic by pressing [Flex Shadow Axis] in the Graphic menu.

4 Press [V] in the <Invert> group, turning it on, to invert the flex shadow 
horizontally.

5 Turn [Size] on and use knob 2 to set the Size V parameter so that the 
shadow extends vertically.

Knob Parameter Adjustment Setting values

1 Density Density of combine shadow 0.00 to 100.00
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(For HD format and 16: 9 mode: Size V = 1.50)

6 Press [Skew], turning it on, and use knob 1 to set the Skew H parameter so 
that the parallel lines appear to emerge from the depth at the right.

(For HD format and 16:9 mode: Skew H = –50.00)

Drop Shadow Settings

Notes
• Drop shadow effect is available for MKS-6470 only.
• It is not possible to use drop shadow simultaneously with the trail, motion 

decay, or keyframe strobe function.

1 In the DME menu, select VF1 ‘Edge’ and HF5 ‘Flex/Drop Shadow.’

The Flex/Drop Shadow menu appears.

2 Press [Drop Shadow], turning it on.

This enables drop shadow, and you can now adjust the parameters with the 
knobs.

3 Adjust the following parameters.

The parameter ranges depend on the combination of signal format (SD/
HD) and aspect ratio (4:3/16:9) selected for the system as follows.

• In 4:3 mode

• In 16: 9 mode

Knob Parameter Adjustment Setting values

1 H Move shadow horizontally – 8.00  to + 8.00(SD)
– 24.00  to + 24.00(HD)

2 V Move shadow vertically – 6.00 to 0.00(SD)
– 18.00 to 0.00(HD)

5 Density Shadow density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Move shadow horizontally – 8.00 to + 8.00(SD)
– 32.00 to + 32.00(HD)

2 V Move shadow vertically – 4.50 to 0.00(SD)
– 18.00 to 0.00(HD)

5 Density Shadow density 0.00 to 100.00
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4 To change the shadow color, press [Drop Shdw Color], then adjust the 
following parameters.

5 To soften the edges, turn [Shadow Soft] on.

Wipe Crop Settings

Notes
• The wipe crop function is not supported on the MVE-8000A and MKS-6470.
• When wipe crop is on, any mask that was on is turned off.
• When brick is on, wipe crop cannot be turned on. To turn wipe crop on, it is 

first necessary to turn brick off.
• In the <Shaped Video> group of the Video/Key menu, when [Output] is off, 

unless you set [Bkgd] in the HF1 ‘Bkgd’ menu to on, the wipe crop effect 
will not function.

Applying the wipe crop effect

To select the pattern

1 In the DME menu, select VF1 ‘Edge’ and HF6 ‘Wipe Crop.’

The Wipe Crop menu appears.

2 Press [Wipe Crop], turning it on.

3 Press [Pattern Select].

The Pattern Select menu appears.

4 From the displayed patterns (standard wipe patterns 1 to 24 and 304), press 
any pattern to select it.

In this state, you can use the knobs to adjust the size of the pattern. (For 
details of parameters, see the next item.)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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To set the pattern size and position

1 In the Wipe Crop menu, press [Position/Size].

2 Set the following parameters.

The setting range for the parameters depends on the signal format (SD/
HD) and aspect ratio (4:3/16:9) selected in the system, as follows.

• For SD format

a) For 4:3 mode
b) For 16:9 mode

Note
When pattern number 304 is selected, the effect of settings in the <Edge> 
group varies with the Size setting.

• For HD format

a) For 4:3 mode
b) For 16:9 mode

Note
When pattern number 304 is selected, the effect of settings in the <Edge> 
group varies with the Size setting.

To invert the regions of the cropping
In the Wipe Crop menu, press [Invert], turning it on.

Knob Parameter Adjustment Setting values

1 H Horizontal position –8.00 to +8.00

2 V Vertical position –6.00 to +6.00 a)

–4.50 to +4.50 b)

3 Size Pattern size 0.00 to 100.00

5 Pattern Pattern number 1 to 24, 304

Knob Parameter Adjustment Setting values

1 H Horizontal position –24.00 to +24.00 a)

–32.00 to +32.00 b)

2 V Vertical position –18.00 to +18.00

3 Size Pattern size 0.00 to 100.00

5 Pattern Pattern number 1 to 24, 304
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Setting the aspect ratio of the wipe crop pattern (Aspect)

1 In the Wipe Crop menu, press [Aspect], turning it on.

2 Set the following parameter.

a) When set to a negative value, the image is stretched vertically, to become taller. 
When set to a positive value, the image is stretched horizontally, to become wider.

Rotating the wipe crop pattern (Rotation)

1 In the <Rotation> group of the Wipe Crop menu, select one of the 
following.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate the pattern at a fixed speed.

2 Depending on the selection in step 1, set the following parameter.

• When Angle is selected

a)  –1.00 represents a whole turn counterclockwise, and +1.00 represents a whole turn 
clockwise. 0.00 is the original state.

• When Speed is selected

a) –100.00 represents a speed of four whole turns counterclockwise per second, and +100.00 
represents a speed of four whole turns clockwise per second. 0.00 is the stationary state.

Applying modulation to the wipe crop pattern (Modulation)

1 In the <Modulation> group of the Wipe Crop menu, select one of the 
following.

H (horizontal modulation): Modulate the pattern to apply waving in the 
horizontal direction.

V (vertical modulation): Modulate the pattern to apply waving in the 
vertical direction.

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –8.00 to +8.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)
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2 Set the following parameters.

Replicating the wipe crop pattern (Multiplication)

1 In the Wipe Crop menu, press [Multi], turning it on.

2 Set the following parameters.

a) See the following figure

Modifying the wipe crop pattern edge
You can apply a border to the wipe crop pattern, or soften the boundary.

1 In the <Edge> group of the Wipe Crop menu, select one of the following.

Border: border
Soft: soft edge 
Soft Border: soft border

2 Depending on the selection in step 1, set the following parameters.

• When Border is selected

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of 
pattern horizontally

1 to 63

2 V Multi Number of repetitions of 
pattern vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

1 2 3 4
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• When Soft is selected

• When Soft Border is selected

Selecting the signal or color to be inserted in the wipe crop 
border

When you are applying a border or soft border to the wipe crop, you can select 
the signal or color to be inserted in the border.

1 In the <Border Fill> group of the Wipe Crop menu, select one of the 
following.

Flat Color: flat color
Mix Color: a mix color signal combining color 1 and color 2 (see the next 

section, “Color Mix Settings”)
Ext Video: an external video signal input to the Ext IN connector

2 When Flat Color is selected in step 1 only, adjust the following parameters.

Color Mix Settings

Note 
The color mix function is not supported on the MVE-8000A and MKS-6470.

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Outer Soft Border outer softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Creating a color combination pattern

To select the pattern

1 In the DME menu, select VF1 ‘Edge’ and HF7 ‘Color Mix.’

The Color Mix menu appears.

2 Press [Mix Pattern Select].

The Mix Pattern Select menu appears.

3 Press any of the displayed patterns (standard wipe patterns 1 to 24) to 
select it.

In this state, you can adjust the pattern size and border softness with the 
knobs.

(For details of the parameters, see the next item.)

To set the pattern size and position

1 In the Color Mix menu, press [Position/Size].

2 Set the following parameters.

The setting range for the parameters depends on the system selected signal 
format (SD/HD) and aspect ratio (4:3/16:9), as follows.

• For SD format

a) For 4:3 mode
b) For 16:9 mode

• For HD format

Knob Parameter Adjustment Setting values

1 H Horizontal position –8.00 to +8.00

2 V Vertical position –6.00 to +6.00 a)

–4.50 to +4.50 b)

3 Size Pattern size 0.00 to 100.00

4 Soft Softness of the pattern 0.00 to 100.00

5 Pattern Pattern number 1 to 24

Knob Parameter Adjustment Setting values

1 H Horizontal position –24.00 to +24.00 a)

–32.00 to +32.00 b)
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a) For 4:3 mode
b) For 16:9 mode

To invert the regions of the two colors
In the Color Mix menu, press [Color Invert], turning it on.

Adjusting the color 1 and color 2

1 In the Color Mix menu, to adjust color 1 press [Color1], and to adjust color 
2 press [Color2].

2 Set the following parameters.

Modifying the color combination pattern

See the following pages.

• “Setting the aspect ratio of the wipe crop pattern (Aspect)” (page 80)
• “Replicating the wipe crop pattern (Multi)” (page 81)
• “Rotating the wipe crop pattern (Rotation)” (page 80)
• “Applying modulation to the wipe crop pattern (Modulation)” (page 80)

Defocus Settings

Applying the Defocus effect 

1 In the DME menu, select VF2 ‘Video Modify’ and HF1 ‘Defocus/Blur.’

The Defocus/Blur menu appears.

2 V Vertical position –18.00 to +18.00

3 Size Pattern size 0.00 to 100.00

4 Soft Softness of the pattern 0.00 to 100.00

5 Pattern Pattern number 1 to 24

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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2 Press [Defocus], turning it on.

The Defocus effect is enabled. You can adjust the defocusing of video and 
key signals with the knobs.

Note 
On the MVE-8000A and MKS-6470, the Defocus and Glow effects cannot 
be enabled at the same time. The effect which was turned on most recently 
is enabled.

3 In the <Defocus Mode> group, select the signal to which to apply the 
defocus effect.

Video/Key: Video signal and key signal
Video: Video signal only 
Key: Key signal only

 

Note 
“Key” can be selected only when the MVE-8000A/MVE-9000 is 
connected through an SDI interface.

4 Set the parameters.

• When Video/Key is selected (with MKS-6470)

• When Video/Key is selected (with SDI-interfaced MVE-8000A/
MVE-9000)

Knob Parameter Adjustment Setting values

1 H Horizontal defocusing of video 
and key signals

0.00 to 100.00

2 V Vertical defocusing of video and 
key signals

0.00 to 100.00

3 All Horizontal and vertical 
defocusing of video and key 
signals

H value shown

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 V/K H Horizontal defocusing of video 
and key signals

Video H value shown

2 V/K V Vertical defocusing of video and 
key signals

Video V value shown

3 V/K All Horizontal and vertical 
defocusing of video and key 
signals

Video H value shown

4 Video All Horizontal and vertical 
defocusing of video signal

Video H value shown
85DME Special Effect Operations



   C
hapter 11 

D
M

E
 O

perations

86
• When Video is selected
.

• When Key is selected (with SDI-interfaced MVE-8000A/MVE-9000)

5 To cancel black level leaking that can occur at the edge of the screen when 
the Defocus effect is enabled, press [Clean Defocus], turning it on.

Masking the Defocus effect with a selected pattern
Press [Mask] to display the Mask menu, and set the pattern type and modifiers.

For details, see “Mask Settings” (page 100).

5 Key All Horizontal and vertical 
defocusing of  key signal

Key H value shown

Parameter group [1/2]

Knob Parameter Adjustment Setting values

Parameter group [2/2]

Knob Parameter Adjustment Settings values

1 Video H Horizontal defocusing of video 
signal

0.00 to 100.00

2 Video V Vertical defocusing of video 
signal

0.00 to 100.00

3 Key H Horizontal defocusing of key 
signal

0.00 to 100.00

4 Key V Vertical defocusing of key signal 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Horizontal defocusing of video 
signal

0.00 to 100.00

2 V Vertical defocusing of video 
signal

0.00 to 100.00

3 All Horizontal and vertical 
defocusing of video signal

H value shown

Knob Parameter Adjustment Settings values

1 H Horizontal defocusing of key 
signal

0.00 to 100.00

2 V Vertical defocusing of key signal 0.00 to 100.00

3 All Horizontal and vertical 
defocusing of key signal

H value shown
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Blur Settings

Applying the Blur effect 

1 In the DME menu, select VF2 ‘Video Modify’ and HF1 ‘Defocus/Blur.’

The Defocus/Blur menu appears.

2 Press [Blur], turning it on.

The Blur effect is enabled. You can adjust the blurring of video and key 
signals with the knobs.

Note
On the MVE-8000A and MKS-6470, the Glow and Blur effects cannot be 
enabled at the same time. The effect which was turned on most recently is 
enabled.

3 When the MVE-8000A/MVE-9000 is connected through an SDI interface, 
in the <Blur Mode> group, select the signal to which you want apply the 
Blur effect.

Video/Key: Video signal and key signal
Video: Video signal only
Key: Key signal only

4 Set the parameters.

• When MKS-6470 is used

• When Video/Key is selected (with SDI-interfaced MVE-8000A/
MVE-9000)

Knob Parameter Adjustment Setting values

1 H Horizontal defocusing of video 
and key signals

0.00 to 100.00

2 V Vertical defocusing of video and 
key signals

0.00 to 100.00

3 All Horizontal and vertical 
defocusing of video and key 
signals

H value shown

Parameter group [1/2]

Knob Parameter Adjustment Settings values

1 V/K H Horizontal defocusing of video 
and key signals

Video H value shown
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• When video is selected (with SDI-interfaced MVE-8000A/MVE-
9000)

• When Key is selected (with SDI-interfaced MVE-8000A/MVE-9000)

Masking the Blur effect with a selected pattern
Press [Mask] to display the Mask menu, and set the pattern type and modifiers.

For details, see “Mask Settings” (page 100).

2 V/K V Vertical defocusing of video and 
key signals

Video V value shown

3 V/K All Horizontal and vertical 
defocusing of video and key 
signals

Video H value shown

4 Video All Horizontal and vertical 
defocusing of video signal

Video H value shown

5 Key All Horizontal and vertical 
defocusing of  key signal

Key H value shown

Parameter group [1/2]

Knob Parameter Adjustment Settings values

Parameter group [2/2]

Knob Parameter Adjustment Settings values

1 Video H Horizontal defocusing of video 
signal

0.00 to 100.00

2 Video V Vertical defocusing of video 
signal

0.00 to 100.00

3 Key H Horizontal defocusing of key 
signal

0.00 to 100.00

4 Key V Vertical defocusing of key signal 0.00 to 100.00

Knob Parameter Adjustment Settings values

1 H Horizontal defocusing of video 
signal

0.00 to 100.00

2 V Vertical defocusing of video 
signal

0.00 to 100.00

3 All Horizontal and vertical 
defocusing of video signal

H value shown

Knob Parameter Adjustment Setting values

1 H Horizontal defocusing of key 
signal

0.00 to 100.00

2 V Vertical defocusing of key signal 0.00 to 100.00

3 All Horizontal and vertical 
defocusing of key signal

H value shown
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Multi Move Settings

Applying the Multi Move effect

1 In the DME menu, select VF2 ‘Video Modify’ and HF2 ‘Multi Move.’

The Multi Move menu appears.

2 Press [Multi Move], turning it on.

The Multi Move effect is enabled. You can adjust the center point of 
shrinking, the ratio of shrinking, and the aspect ratio of the shrunken 
images with the knobs.

3 Set the parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

a) Specify minus values to stretch the image in the vertical direction, and plus values to 
stretch the image in the horizontal direction.

• 16:9 mode

a) Specify minus values to stretch the image in the vertical direction, and plus values to 
stretch the image in the horizontal direction.

Knob Parameter Adjustment Setting values

1 Center X x-value of shrinking center point –4.00 to +4.00 (SD)
–12.00 to +12.00 (HD)

2 Center Y y-value of shrinking center point –3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

3 Size Shrinking ratio 0.00 to 100.00

4 Aspect Aspect ratio of shrunken images –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Center X x-value of shrinking center point –4.00 to +4.00 (SD)
–16.00 to +16.00 (HD)

2 Center Y y-value of shrinking center point –2.25 to +2.25(SD)
–9.00 to +9.00 (HD)

3 Size Shrinking ratio 0.00 to 100.00

4 Aspect Aspect ratio of shrunken images –100.00 to +100.00 a)
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Sepia Settings

Applying the Sepia effect

1 In the DME menu, select VF2 ‘Video Modify’ and HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Sepia], turning it on.

The Sepia effect is enabled. You can adjust the degree of mixing between 
the sepia image and the original image with the knobs.

3 Set the following parameters.

4 To set the color of the sepia image, press [Sepia Color], turning it on, and 
adjust the parameters. 

Masking the Sepia effect with a selected pattern
Press [Mask] to display the Mask menu, and set the pattern type and modifiers.

For details, see “Mask Settings” (page 100).

Mono Settings

Applying the Mono effect

1 In the DME menu, select VF2 ‘Video Modify’ and HF3 ‘Color Modify.’

The Color Modify menu appears.

Knob Parameter Adjustment Setting values

1 Mix Y Y signal mix amount 0.00 to 100.00

2 Mix C Chroma signal mix amount 0.00 to 100.00

3 Mix All Y signal and chroma signal mix 
amount

Mix Y value shown

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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2 Press [Mono], turning it on.

The Mono effect is enabled. The color image changes to monochrome.

Masking the Mono effect with a selected pattern
Press [Mask] to display the Mask menu, and set the pattern type and modifiers.

For details, see “Mask Settings” (page 100).

Posterization and Solarization Settings

You can specify the degree of luminance coarsening.
You can specify the degree of chroma coarsening.

Applying the Posterization or Solarization effect

1 In the DME menu, select VF2 ‘Video Modify’ and HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Poster/Solar], turning it on.

The Posterization and Solarization effects are enabled. You can adjust the 
coarseness of the gradations with the knobs.

3 Set the parameters.

Masking the Posterization or Solarization effect with a selected 
pattern

Press [Mask] to display the Mask menu, and set the pattern type and modifiers.

For details, see “Mask Settings” (page 100).

Knob Parameter Adjustment Setting values

1 Poster Coarseness of luminance 
gradations (Posterization 
parameter)

0.00 to 100.00

2 Solar Coarseness of chroma 
gradations (Solarization 
parameter)

0.00 to 100.00
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Nega Settings

Applying the Nega effect

1 In the DME menu, select VF2 ‘Video Modify’ and HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Nega Y] or [Nega C], turning it on, or press both buttons, turning 
them on.

Nega Y: Reverse the luminance.
Nega C: Reverse the chroma.

Masking the Nega effect with a selected pattern
Press [Mask] to display the Mask menu, and set the pattern type and modifiers.

For details, see “Mask Settings” (page 100).

Contrast Settings

Applying the Contrast effect

1 In the DME menu, select VF2 ‘Video Modify’ and HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Contrast], turning it on.

The Contrast effect is enabled. You can adjust the luminance and chroma 
contrast with the knobs.

3 Set the parameters.

Knob Parameter Adjustment Setting values

1 Y Clip Luminance clip level +109.59 to –7.31

2 Y Gain Luminance contrast gradient –100.00 to +100.00

3 Y Offset Luminance offset level 
increment

–100.00 to +100.00

4 C Gain Chroma contrast gradient –100.00 to +100.00
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Clip, Gain, Offset

Masking the Contrast effect with a selected pattern
Press [Mask] to display the Mask menu, and set the pattern type and modifiers.

For details, see “Mask Settings” (page 100).

Mosaic Settings

Applying the Mosaic effect

1 In the DME menu, select VF2 ‘Video Modify’ and HF4 ‘Mosaic.’

The Mosaic menu appears.

2 Press [Mosaic], turning it on.

The Mosaic effect is enabled. You can adjust the size and aspect ratio of 
the mosaic tiles with the knobs.

3 Set the following parameters.

a) Specify minus values to stretch the tiles in the vertical direction, and plus values to stretch 
the tiles in the horizontal direction.

Masking the Mosaic effect with a selected pattern
Press [Mask] to display the Mask menu, and set the pattern type and modifiers.

Clip

Gain

Offset

Video output level

Video input 
level

Video output level

Video input 
level

Knob Parameter Adjustment Setting values

1 Size Size of tiles 0.00 to 100.00

2 Aspect Aspect ratio of tiles –100.00 to +100.00 a)
93DME Special Effect Operations



   C
hapter 11 

D
M

E
 O

perations

94
For details, see “Mask Settings” (page 100).

Sketch Settings

Applying the Sketch effect

1 In the DME menu, select VF7 ‘Enhanced Video Modify’ and HF1 
‘Sketch.’

The Sketch menu appears. 

2 Press [Sketch], turning it on.

The Sketch effect is enabled. 

3 Select the method for applying outlines in the <Sketch Mode> group.

Sketch: Apply an effect like a sketch.
Edge Color: Enhance the outlines.
Draw: Apply an effect like a line drawing.
Relief: Apply a bas-relief effect.
Sharp: Increase the apparent sharpness. 

4 Set the following parameters, according to the method selected in step 3.

• When Sketch is selected

a) 100.00 gives an image completely transformed by the Sketch effect. 0.00 is the original 
input image. 

b) The larger the Clip value, the narrower the outline width. 

• When Edge Color is selected 

Knob Parameter Adjustment Setting values

1 Mix Mix amount for Sketch video and 
input video

0.00 to 100.00 a)

2 Clip Reference level for outline 
extraction

–100.00 to +100.00 b)

3 Gain Image gain for outline extraction –100.00 to +100.00

4 C Gain Chroma gain of input video –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Mix Mix amount for Edge Color video 
and input video

0.00 to 100.00 a)

2 Clip Reference level for outline 
extraction

–100.00 to +100.00 b)
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a) 100.00 gives an image completely transformed by the Sketch effect. 0.00 is the original 

input image. 
b) The larger the Clip value, the narrower the outline width. 

• When Draw is selected 

a) 100.00 gives an image completely transformed by the Sketch effect. 0.00 is the original 
input image. 

b) The larger the Clip value, the narrower the outline width. 

• When Relief is selected

a) 100.00 gives an image completely transformed by the Sketch effect. 0.00 is the original 
input image. 

• When Sharp is selected 

5 If you selected other than Sharp in step 3, depending on the necessity, 
proceed as follows.

• To adjust the outline color for Edge Color or Draw
Turn [Edge Matte] on and set the following parameters to set the outline 
color. 

Knob Parameter Adjustment Setting values

1 Mix Mix amount for Draw video and 
input video

0.00 to 100.00 a)

2 Clip Reference level for outline 
extraction

–100.00 to +100.00 b)

3 Gain Image gain for outline extraction –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Mix Mix amount for Relief video and 
input video

0.00 to 100.00 a)

2 Offset Relief luminance level –100.00 to +100.00 

3 Gain Image gain for outline extraction –100.00 to +100.00

4 Angle Direction of relief image light 
source 

–8.00 to +8.00

Knob Parameter Adjustment Setting values

1 H Simultaneously adjust the left and 
right resolution

0.00 to 100.00

2 V Simultaneously adjust the top and 
bottom resolution

0.00 to 100.00

3 All Simultaneously adjust the 
resolution of all four sides

0.00 to 100.00

5 Coring Minimum value of edge to 
emphasize

0.00 to 100.00
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• To set the color of the sections other than the outlines for Draw
Press [Matte], turning it on, and adjust the following parameters to set the 
color of the sections other than the outlines.

• To select the signal to mix with the relief pattern for Relief
In the <Chroma Type> group, select the signal to mix with the relief 
pattern. 
Matte: Select a single color. The following parameters can be adjusted. 

Video: Select the input video signal. 

6 To invert white and black in the extracted video, or to invert the outlines 
and the sections other than the outlines, press [Nega], turning it on.

Masking the Sketch effect with a selected pattern
Press [Mask] to display the Mask menu and set the type of pattern and 
modifiers. 

For details, see “Mask Settings” (page 100). 

Metal Settings

Applying the Metal effect

1 In the DME menu, select VF7 ‘Enhanced Video Modify’ and HF2 ‘Metal.’

The Metal menu appears. 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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2 Press [Metal], turning it on.

This enables the Metal effect.

3 Set the parameters.

4 In the <Metal Mode> group, select the type of metallic gloss. 

Gold: Give a gold gloss to the input video. 
Silver: Give a silver gloss to the input video.
Rainbow: Give a rainbow color gloss to the input video.
Variable: Give a metallic gloss to the input video in any color by adjusting 

the following parameters. 

Masking the Metal effect with a selected pattern
Press [Mask] to display the Mask menu and set the type of pattern and 
modifiers. 

For details, see “Mask Settings” (page 100). 

Dim and Fade Settings

Note
The Dim and Fade function are not supported on the MVE-8000A and MKS-
6470.

Applying the Dim effect

1 In the DME menu, select VF7 ‘Enhanced Video Modify’ and HF3 ‘Dim & 
Fade.’

Knob Parameter Adjustment Setting values

1 Mix Ratio Mix amount for Metal video and 
input video

0.00 to 100.00

2 Y Clip Clip level of input signal Y level 0.00 to 100.00

3 Y Gain Amount of gain for clip adjusted 
input signal Y level

–100.00 to +100.00

4 Y Offset Offset added to clip and gain 
adjusted input Y signal

0.00 to 100.00

Knob Parameter Adjustment Setting values

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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The Dim & Fade menu appears. 

2 Press [Dim], turning it on.

This enables the Dim effect. 

3 Set the following parameters.

4 Press [Flat Color] and set the parameters for the color of the depths of the 
picture.

Applying the Fade effect

1 In the DME menu, select VF7 ‘Enhanced Video Modify’ and HF3 ‘Dim & 
Fade.’

The Dim & Fade menu appears. 

2 Press [Fade], turning it on.

This enables the Fade effect. 

3 Set the parameters.

Knob Parameter Adjustment Setting values

1 Start Point where dimming starts (dim 
start point)

–100.00 to +100.00

2 Gain Degree of dimming 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Start Point where fading starts (fade 
start point)

–100.00 to +100.00

2 Gain Degree of fading 0.00 to 100.00
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Glow Settings

Applying the Glow effect

1 In the DME menu, select VF7 ‘Enhanced Video Modify’ and HF4 ‘Glow.’

The Glow menu appears. 

2 Press [Glow], turning it on.

This enables the Glow effect. 

Notes 
• On the MVE-9000, the key border function and Glow function cannot be 

turned on at the same time. The function most recently turned on is 
effective.

• On the MVE-8000A and MKS-6470, the Defocus and Glow effects or 
the Blur and Glow effects cannot be turned on at the same time. The 
effect most recently turned on is effective.

3 Set the parameters.

4 Press [Matte] and set the glow color. 

Inverting the highlight areas
Press [Glow Invert], turning it on.
The highlight and non-highlight areas are inverted. 

Masking the Glow effect with a selected pattern
Press [Mask] to display the Mask menu and set the type of pattern and 
modifiers. 

Knob Parameter Adjustment Setting values

1 Clip Reference level for highlight 
detection

0.00 to 100.00

2 Gain Amount of gain for highlights –100.00 to +100.00

3 Soft Softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
99DME Special Effect Operations



   C
hapter 11 

D
M

E
 O

perations

100
For details, see “Mask Settings” (page 100). 

Mask Settings

The mask function is applied in units made up of the groups.

Applying masks

1 In the DME menu, select VF2 ‘Video Modify’ and HF7 ‘Mask.’

The Mask menu appears.

2 In the <Mask> group, press the button for the group of the effect to which 
you want to apply the mask, turning it on.

Effect Gp 1: Posterization, Solarization, Nega, Sepia, Mono, Contrast, 
Mosaic, Sketch, Metal

Effect Gp 2: Defocus, Blur, Glow

Note 
On the MVE-8000A and MKS-6470, Effect Gp 1 and Effect Gp 2 cannot 
be turned on at the same time.

3 Press [Position/Size].

4 Set the mask source parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• 4:3 mode

a) This setting value is not supported on the MVE-8000A and MKS-6470.

Knob Parameter Adjustment Setting values

1 H Horizontal position –8.00 to +8.00 (SD)
–24.00 to +24.00 (HD)

2 V Vertical position –6.00 to +6.00 (SD)
–18.00 to +18.00 (HD)

3 Size Size of mask 0.00 to 100.00

4 Soft Softness of mask 0.00 to 100.00

5 Pattern Pattern number 21, 24, 304 a)
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• 16:9 mode

a) This setting value is not supported on the MVE-8000A and MKS-6470.

5 To invert the mask source, press [Invert], turning it on.

6 As required, set the modifiers for the mask pattern.

• When turning [Aspect] on and adjusting the pattern aspect ratio

a) When a minus value is specified, the picture is extended in the vertical direction. When a 
plus value is specified, the picture is extended in the horizontal direction. 

• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) –1.00 is one rotation in counterclockwise direction. +1.00 is one rotation in clockwise 
direction. 0.00 is no rotation.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a specified speed

a) –100.00 is four rotations per second in counterclockwise direction. +100.00 is four 
rotations per second in clockwise direction. 0.00 is no rotation.

Notes on applying a mask effect with a DME (only when using the 
MVE-9000)
In the <Mask> group of the DME >Video Modify >Mask menu, if [Effect Gp1] 
and [Effect Gp2] are simultaneously set to On, then the border or beveled edge 
is also masked.
The following explains this with the example of using a circular mask pattern.

Knob Parameter Adjustment Setting values

1 H Horizontal position –8.00 to +8.00 (SD)
–32.00 to +32.00 (HD)

2 V Vertical position –4.50 to +4.50 (SD)
–18.00 to +18.00 (HD)

3 Size Size of mask 0.00 to 100.00

4 Soft Softness of mask 0.00 to 100.00

5 Pattern Pattern number 21, 24, 304 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Rotation angle of pattern –8.00 to +8.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation speed of pattern –100.00 to +100.00 a)
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m

m
In the state corresponding to image 2, if you switch [Effect Gp2] to On, then 
the mask should be applied to portion 2 only, but in fact the border or beveled 
edge is also masked.

Freeze Settings

Freezes the input video. The following types are available:
Hard Freeze: Freezes the input video at an arbitrary timing.

Image 1: Image before applying mask

Border or 
beveled edge

Image with 
‘Mono(chrome)’ or 
‘Defocus’ applied

1

2

Image 2: State with [Effect Gp1] only set to On

Portion 2 has ‘Mono’ 
masked, and ‘Defocus’ 
only applied.

Portion 1 has both 
‘Mono’ and ‘Defocus’ 
applied.

1

2

Image 3: State with [Effect Gp1] and [Effect Gp2] set to On

The border or beveled 
edge effect is also 
masked.
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Time Strobe: Freezes the input video at specified intervals for a specified 

length.
Film: Slows the apparent frame rate, for an effect like film. You can specify 

the ratio of advancement.
For Hard Freeze and Time Strobe, you can select the first field or the frame as 
the freeze timing.

Note 
When 720P signal format is used, the Film mode cannot be selected.

To apply a Freeze effect, start by displaying the Freeze menu. In the DME 
menu, select VF3 ‘Freeze’ and HF1 ‘Freeze.’

Applying the Hard Freeze effect

1 In the <Freeze Timing> group, select the signal freeze timing.

Frame: Freeze one frame of signal.
Field 1: Freeze the first field of signal.

2 In the <Freeze> group, press [Hard Freeze], turning it on.

The Hard Freeze is executed, displaying a still image.

Applying the Time Strobe effect

1 In the <Freeze Timing> group, select the signal freeze timing.

Frame: Freeze one frame of signal.
Field 1: Freeze the first field of signal.

Note
The freeze timing setting is not required when the following signal formats 
are being used. 

Signal formats: 720P/59.94, 720P/50

2 In the <Freeze> group, press [Time Strobe], turning it on.

The Time Strobe freeze is enabled. You can adjust the freeze interval and 
the ratio of live video inserted between freeze images.

3 Set the parameters.

Knob Parameter Adjustment Setting values

1 Duration Freeze interval 1 to 255 (frames)
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Applying the Film effect

Note 
When 720P signal format is used, the Film mode cannot be selected.

1 In the <Freeze> group, press [Film], turning it on.

The Film freeze is enabled. You can adjust the ratio of frame advance.

2 Set the parameter.

Nonlinear Effect Settings 

You can add a variety of effects, including effects that change the shape of the 
image as a whole.

Note
Nonlinear effects are possible using a second DME.
Use the following procedure.

1 In the DME menu, select VF4 ‘Non Linear’ and HF1 ‘Type.’

A menu for selecting the various effects appears.

2 Display the menu for the effect that you want to apply by pressing its 
button.

The effect displayed is enabled.

3 Make the settings for the selected effect.

Notes
• It is not possible to apply two or more nonlinear effects at the same time. 

Turning any nonlinear effect on automatically turns all other nonlinear 
effects off.

2 Live Ratio of live video inserted 
between freeze images

0.00 to 100.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Film Ratio of frame advance 0.00 to 100.00
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• The Flex Shadow function cannot be enabled when any of the nonlinear 

effects Page Turn, Roll, Cylinder, and Sphere is enabled. 
However, the Flex Shadow function is not supported on the MVE-
8000A and MKS-6470.

To turn an effect off
In the setting menu, press the button for the effect name, turning it off, or in the 
Type menu press [OFF] in the lower right part of the window.

Wave settings
There are two modes: H&V and Size. You can set the size and frequency of the 
waves, the wave form, the amount of wave movement, and the range. In H&V 
mode, you can also set the wave angle.

To apply the Wave effect
With the Wave menu displayed, use the following procedure.

1 In the <Mode> group, select the wave modulation mode.

H&V: Modulate vertically and horizontally without changing the size of 
the image. This mode allows waves to be created in both the vertical 
and horizontal directions at the same time.

Size: Create waves by reducing and expanding the image. This mode 
allows waves to be created in one direction only.

1

H&V

SIZE

2

1 2
Before modulation

Size not modulated.
1 and 2 are same size.

Create waves by reducing 1 
and expanding 2 the image.
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2 Set the following parameters, according to the selected mode.

• When H&V is selected

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

• When Size is selected

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Amp H Amplitude of waves in horizontal 
direction

0.00 to 100.00

2 Freq H Frequency of waves in horizontal 
direction

0.00 to 100.00

3 Offset H a) Horizontal direction in which to 
offset wave phase and amount of 
movement

–16.00 to +16.00 c)

–64.00 to +64.00 d)

4 Speed H b) Horizontal direction and speed of 
waves

–100.00 to +100.00

5 Slant Slant of waves –8.000 to +8.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Amp V Amplitude of waves in vertical 
direction

0.00 to 100.00

2 Freq V Frequency of waves in vertical 
direction

0.00 to 100.00

3 Offset V a) Vertical direction in which to offset 
wave phase and amount of 
movement

–16.00 to +16.00 c)

–64.00 to +64.00 d)

4 Speed V b) Vertical direction and speed of 
waves

–100.00 to +100.00

5 Slant Slant of waves –8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Amp H Amplitude of waves 0.00 to 100.00

2 Freq H Frequency of waves 0.00 to 100.00

3 Offset H a) Direction in which to offset wave 
phase and amount of movement

–16.00 to +16.00 c)

–64.00 to +64.00 d)

4 Speed H b) Direction and speed of waves –100.00 to +100.00

5 Slant Slant of waves –8.00 to +8.00
DME Special Effect Operations



  C
hapter 11 

D
M

E
 O

perations

d) Setting for HD 4:3, HD 16:9

To stop the waves
Press [Lock], turning it on.
With each press, the waves alternately stop and start moving again.

To select the waveform
Press [Form] and set the following parameters.

• When H&V mode is selected

• When Size mode is selected

a) 1 (SINE): Sine wave
2 (PARABOLA): Parabola wave
3 (TRIANGLE): Triangular wave
4 (RECTANGLE): Rectangular wave
5 (CIRCLE): Circular wave
6 (CUBIC): Cubic wave

To randomize the modulated waveform

1 Press [Random], turning it on.

2 Set the following parameters.

Offset

Amp

Knob Parameter Adjustment Setting values

1 Form H Waveform in horizontal direction 1 to 6 a)

2 Form V Waveform in vertical direction 1 to 6 a)

Knob Parameter Adjustment Setting values

1 Form H Waveform 1 to 6 a)
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• When H&V mode is selected

• When Size mode is selected

To limit the wave range

1 Press [Range], turning it on.

2 Set the following parameters.

• When H&V mode is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

• When Size mode is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Knob Parameter Adjustment Setting values

1 Random H Degree of randomness in 
horizontal waveform modulation

0.00 to 100.00

2 Random V Degree of randomness in vertical 
waveform modulation

0.00 to 100.00

3 Random All Degree of randomness in both 
vertical and horizontal directions

Random H value 
shown

Knob Parameter Adjustment Setting values

1 Random H Degree of randomness in 
waveform modulation

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size H Amount of horizontal wave 
modulation

0.00 to 100.00

2 Offset H Center point of horizontal 
modulation range

–8.000 to +8.000 a)

–32.000 to +32.000 b)

3 Size V Amount of vertical wave 
modulation

0.00 to 100.00

4 Offset V Center point of vertical 
modulation range

–8.000 to +8.000 a)

–32.000 to +32.000 b)

Knob Parameter Adjustment Setting values

1 Size H Amount of wave modulation 0.00 to 100.00

2 Offset H Center point of modulation 
range

–8.000 to +8.000 a)

–32.000 to +32.000 b)
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To smooth the range envelope when the wave range is limited

1 Press [Range Envelope], turning it on.

2 Set the following parameters.

• When H&V mode is selected
 

• When Size mode is selected

To reverse the wave range
To reverse the horizontal wave range set with [Range]: Press [Range Rev 

H], turning it on.
To reverse the vertical wave range set with [Range]: Press [Range Rev V], 

turning it on.

Mosaic Glass settings
There are two modes: H&V and Size. You can set the size and frequency of 
waves in the image, the wave form, the amount of wave movement, and the 
range. In H&V mode, you can also set the wave angle.

To apply the Mosaic Glass effect
Display the Mosaic Glass menu.

Envelope

Size

Offset

Knob Parameter Adjustment Setting values

1 Envelope H Smoothness of envelope in 
horizontal direction

0.00 to 100.00

2 Envelope V Smoothness of envelope in vertical 
direction

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Envelope H Smoothness of envelope 0.00 to 100.00
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The items displayed in the Mosaic Glass menu and the functions of the knobs 
are the same as for the Wave menu.

For more information about how to make settings, see “Wave settings” (page 
105).

Flag settings
There are two modes: H&V and Size. You can set the size and frequency of 
waves in the image, the wave form, the amount of wave movement, and the 
range. In H&V mode, you can also set the wave angle.

To apply the Flag effect
Display the Flag menu.
The items displayed in the Flag menu and the functions of the knobs are the 
same as for the Wave menu.

For more information about how to make settings, see “Wave settings” (page 
105).

Twist settings
You can twist the image in the horizontal or vertical direction.
You can set the size and frequency of waves in the image, the wave form, the 
amount of wave movement, and other parameters.

To apply the Twist effect
With the Twist menu displayed, set the following parameters.

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Amp V Amplitude of twist in vertical direction 0.00 to 100.00

2 Freq V Frequency of twist in vertical direction 0.00 to 100.00

3 Offset V a) Amount of movement in twist phase 
in the vertical direction

–16.00 to +16.00 c)

–64.00 to +64.00 d)

4 Speed V b) Speed and direction of twist 
movement in vertical direction

–100.00 to +100.00

5 Slant Slant of twist –8.000 to +8.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Amp H Amplitude of twist in horizontal 
direction 

0.00 to 100.00

3 Offset H a) Amount of movement in twist phase 
in the horizontal direction

–100.00 to +100.00
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a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

To stop the waves
Press [Lock], turning it on.
With each press, the waves alternately stop and start moving again.

To select the waveform
Press [Form] and set the following parameters.

 

a) 1 (SINE): Sine wave
2 (PARABOLA): Parabola wave
3 (TRIANGLE): Triangular wave
4 (RECTANGLE): Rectangular wave
5 (CIRCLE): Circular wave
6 (CUBIC): Cubic wave

Ripple settings
There are four modes: Radial, Angular, Both, and Shape. The direction of 
modulation differs depending on the mode. You can set the size and frequency 
of the ripples, their direction and speed, their center point, and other 
parameters. In Shape mode, you can select ripple shapes other than circles 
(stars, etc.). 

To apply the Ripple effect
With the Ripple menu displayed, use the following procedure.

1 In the <Mode> group, select the ripple modulation mode.

Radial: Points on radii of the same length from the center of the ripples 
behave in the same way.

Angular: Points at the same angle from the center of the ripples behave in 
the same way.

Both: Both Radial and Angular ripples are applied.
Shape: The ripples can have shapes such as stars or hearts in addition to 

circles.

5 Slant Slant of twist –8.000 to +8.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Form H Waveform in horizontal direction 1 to 6 a)

2 Form V Waveform in vertical direction 1 to 6 a)
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Modulation modes and directions

2 Set the following parameters, depending on the selected modulation mode.

• When Radial mode is selected

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

• When Angular mode is selected

a) Set when Lock is on.
b) Set when Lock is off.

Modulation along radii 
(Radial mode)

Modulation along periphery 
(Angular mode)

Knob Parameter Adjustment Setting values

1 Amp R Ripple amplitude along radius 0.00 to 100.00

2 Freq R Ripple frequency along radius 0.00 to 100.00

3 Offset R a) Direction along radius in which 
to offset ripple phase and 
amount of movement

–8.000 to +8.000 c)

–32.000 to +32.000 d)

4 Speed R b) Ripple direction along radius 
and speed

–100.00 to +100.00

5 Amp A Ripple amplitude along 
periphery

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Amp A Ripple amplitude along periphery 0.00 to 100.00

2 Freq A Ripple frequency along periphery 0.00 to 100.00

3 Offset A a) Direction along periphery in which 
to offset ripple phase and amount 
of movement

–8.000 to +8.000

4 Speed A b) Ripple direction along periphery 
and speed

–100.00 to +100.00

5 Amp R Ripple amplitude along radius 0.00 to 100.00
DME Special Effect Operations



  C
hapter 11 

D
M

E
 O

perations

• When Both mode is selected

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

• When Shape mode is selected

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Amp R Ripple amplitude along radius 0.00 to 100.00

2 Freq R Ripple frequency along radius 0.00 to 100.00

3 Offset R a) Direction along radius in which to 
offset ripple phase and amount of 
movement

–8.000 to +8.000 c)

–32.000 to +32.000 d)

4 Speed R b) Ripple direction along radius and 
speed

–100.00 to +100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Amp A Ripple amplitude along periphery 0.00 to 100.00

2 Freq A Ripple frequency along periphery 0.00 to 100.00

3 Offset A a) Direction along periphery in 
which to offset ripple phase and 
amount of movement

–8.000 to +8.000 

4 Speed A b) Ripple direction along periphery 
and speed

–100.00 to +100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Amp R Ripple amplitude 0.00 to 100.00

2 Freq R Ripple frequency 0.00 to 100.00

3 Offset R a) Direction in which to offset ripple 
phase and amount of movement

–8.000 to +8.000 c)

–32.000 to +32.000 d)

4 Speed R b) Ripple direction and speed –100.00 to +100.00

5 Shape Ripple shape 1 to 4 e)

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Aspect Ripple aspect ratio –100.00 to +100.00

2 Angle Ripple angle –8.000 to +8.000
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d) Setting for HD 4:3, HD 16:9
e) 1 (Circle): Circle

2 (Rectangle): Rectangle
3 (Star): Star
4 (Heart): Heart

To limit the direction in which modulation is applied
By pressing [Plus Only], turning it on, you can limit the direction in which 
modulation is applied (the direction in which the image expands) to the plus 
direction only.

To set the ripple center point

1 Press [Position], turning it on.

2 Set the following parameters, depending on the selected modulation mode.

• When Shape is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

• When other than Shape is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To limit the ripple range

1 Press [Range], turning it on.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 H Ripple center point in 
horizontal direction

–5.000 to +5.000 a)

–20.000 to +20.000 b)

2 V Ripple center point in vertical 
direction

–3.000 to +3.000 a)

–12.000 to +12.000 b)

Knob Parameter Adjustment Setting values

1 H Ripple center point in 
horizontal direction

–8.000 to +8.000 a)

–32.000 to +32.000 b)

2 V Ripple center point in vertical 
direction

–6.000 to +6.000 a)

–18.000 to +18.000 b)
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• When Radial or Shape mode is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

• When Angular mode is selected

• When Both mode is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To reverse the ripple range
When modulation mode is Radial, Both, or Shape: Press [Range Rev R], 

turning it on.
When modulation mode is Both or Angular: Press [Range Rev A], turning 

it on.

Other settings
You can turn [Lock], [Form], [Random], and [Range Envelope] on to do the 
following.
• Stop the waves
• Select the wave shape
• Randomize the waveform
• Smooth the range envelope when the wave range is limited

Knob Parameter Adjustment Setting values

1 Size R Amount of ripple modulation 
along radius

0.00 to 100.00

2 Offset R Center of modulation range 
along radius

–8.000 to +8.000 a)

–32.000 to +32.000 b)

Knob Parameter Adjustment Setting values

1 Size A Amount of ripple modulation along 
periphery 

0.00 to 100.00

2 Offset A Center of modulation range along 
periphery

–8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Size R Amount of ripple modulation 
along radius

0.00 to 100.00

2 Offset R Center of modulation range 
along radius

–8.000 to +8.000 a)

–32.000 to +32.000 b)

3 Size A Amount of ripple modulation 
along periphery 

0.00 to 100.00

4 Offset A Center of modulation range 
along periphery

–8.000 to +8.000
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For Lock, Form, Random, and Range Envelope functions, see “Wave settings” 
(page 105).

Rings settings
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the amount of movement, the width of the partitions, the 
degree of randomness in partition width, the center point, the starting angle, 
and other parameters.

To apply the Rings effect
With the Rings menu displayed, use the following procedure.

1 To make transition settings, press [Transition] and set the following 
parameters.

2 To set the partition method, press [Partition] and set the following 
parameters.

3 To set the ring center position, press [Position] and set the following 
parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Knob Parameter Adjustment Setting values

1 Transition Degree of transition 0.000 to 100.000

2 Random Degree of randomness in distance 
moved by each block

0.000 to 100.000

3 Spiral Amount of movement toward 
periphery accompanying transition 

–1.000 to +1.000

Knob Parameter Adjustment Setting values

1 Width Width of partition 0.000 to 100.000

2 Random Degree of randomness in partition 
width

0.000 to 100.000

3 Angle Starting angle of effect –8.000 to +8.000

Knob Parameter Adjustment Setting values

1 H Horizontal center position –5.000 to +5.000 a)

–20.000 to +20.000 b)

2 V Vertical center position –4.000 to +4.000 a)

–16.000 to +16.000 b)
DME Special Effect Operations



  C
hapter 11 

D
M

E
 O

perations

4 To partition into pixels, press [Pixel], turning it on, and set the following 

parameters.

Broken Glass settings
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the amount of movement, the width of the partitions, the 
degree of randomness in partition width, the center point, the starting angle, 
and other parameters.
You can also fix the direction in which shards scatter.

To apply the Broken Glass effect
Display the Broken Glass menu.
The functions of the knobs in the Broken Glass menu are the same as those of 
the Rings menu, with the exception of [Direction].

For details about operation, see “Rings settings” (page 116).

To fix the direction in which shards scatter
Press [Direction], turning it on.

Flying Bar settings
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the direction of movement, the width of the partitions, 
the degree of randomness in partition width, the partition angle, and other 
parameters.

To apply the Flying Bar effect
With the Flying Bars menu displayed, use the following procedure.

1 To make transition settings, press [Transition] and set the following 
parameters.

Knob Parameter Adjustment Setting values

1 Density Degree to which image disappears 
around periphery

0.00 to 100.00

2 Random Degree of jaggies at block edges 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Transition Degree of transition 0.000 to 100.000

2 Random Degree of randomness in distance 
moved by each block

–100.000 to 
+100.000

3 Angle Direction of movement –8.000 to +8.000
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2 To set the partition method, press [Partition] and set the following 
parameters.

Blind settings
There are two modes: Bar and Wedge. You can set the number of rotations by 
blocks, the perspective, the width and position of blocks, the direction, the 
center position, and other parameters. 

To apply the Blind effect
With the Blind menu displayed, use the following procedure.

1 In the <Mode> group, select [Bar] or [Wedge].

2 To make transition settings, press [Transition] and set the following 
parameters.

3 To set the partition method, press [Partition] and set the following 
parameters.

• When Bar was selected in step 1

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

• When Wedge was selected in step 1

Knob Parameter Adjustment Setting values

1 Width Width of partition 0.000 to 100.000

2 Random Degree of randomness in partition 
width

0.000 to 100.000

3 Angle Partition angle –8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Rotation Number of rotations of the blocks –8.000 to +8.000

2 Perspective Degree of randomness in distance 
moved by each block 

0.000 to 100.000

Knob Parameter Adjustment Setting values

1 Width Width of partition 0.000 to 100.000

2 Offset Degree of randomness in partition 
width

–5.000 to +5.000 a)

–20.000 to 20.000 b)

3 Angle Starting angle of effect –8.000 to +8.000

Knob Parameter Adjustment Setting values

4 No Width of blocks 0.000 to 100.000
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To set the wedge center position 
When Wedge is selected in the <Mode> group, you can set the wedge center 
position.

1 Press [Position].

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Split settings
You can set the degree to which the image is split, the split positions, and other 
parameters.

To apply the Split effect
With the Split menu displayed, use the following procedure.

1 In the <Mode> group, select the split method.

Single: Leave gaps between splits.
Double: Fill gaps between splits with the same image.

2 Set the following parameters.

To set the split position

1 Press [Position].

2 Set the following parameters.

5 Phase Partition position –8.000 to +8.000

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 H Horizontal center position –8.000 to +8.000 a)

–32.000 to +32.000 b)

2 V Vertical center position –6.000 to +6.000 a)

–18.000 to +18.000 b)

Knob Parameter Adjustment Setting values

1 Transition H Degree of left and right separation 0.000 to 100.000

2 Transition V Degree of top and bottom 
separation 

0.000 to 100.000
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a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Split Slide settings
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the degree of sliding, block width, block angle, and other 
parameters.

To apply the Split Slide effect
With the Split Slide menu displayed, set the following parameters.

To set the partition position 

1 Press [Position], turning it on.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 H Degree of left and right 
separation 

–4.000 to +4.000 a)

–16.000 to +16.000 b)

2 V Degree of top and bottom 
separation

–3.000 to +3.000 a)

–12.000 to +12.000 b)

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Transition H Degree of transition in horizontal 
direction

0.000 to 100.000

2 Random H Degree of randomness in distance 
moved by blocks in horizontal 
direction 

0.00 to 100.00

3 Skew H Degree of skew in horizontal direction 0.00 to 100.00

4 Width H Horizontal width of partition 0.00 to 100.00

5 Angle Angle of partition line –8.000 to +8.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Transition V Degree of transition in vertical 
direction

0.000 to 100.000

2 Random V Degree of randomness in distance 
moved by blocks in vertical direction 

0.00 to 100.00

3 Skew V Degree of skew in vertical direction 0.00 to 100.00

4 Width V Vertical width of partition 0.00 to 100.00

5 Angle Angle of partition line –8.000 to +8.000
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a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Mirror settings
You can choose to reflect in the directions left to right, right to left, bottom to 
top, top to bottom, or any combination of directions. You can also set the 
position of the border between original and reflections.

To apply the Mirror effect
With the Mirror menu displayed, press [Left to Right], [Right to Left], [Top to 
Bottom], or [Bottom to Top] to set the reflection method (multiple selections 
possible).
Left to Right: Reflect left side on right.
Right to Left: Reflect right side on left.
Top to Bottom: Reflect top side on bottom.
Bottom to Top: Reflect bottom side on top.

To set the position of the border between original and reflection

1 Press [Position].

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 H Horizontal partition position –5.000 to +5.000 a)

–20.000 to +20.000 b)

2 V Vertical partition position –5.000 to +5.000 a)

–20.000 to +20.000 b)

SONY
DME

SO
DM

SO
D

SO SOSO SO

Left to Right
Top to 
Bottom

Knob Parameter Adjustment Setting values

1 H Horizontal border position –8.000 to +8.000 a)

–32.000 to +32.000 b)

2 V Vertical border position –6.000 to +6.000 a)

–24.000 to +24.000 b)
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a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Multi Mirror settings
You can set the width of the original, the center position of the original, the 
offset of the image with fixed mirrors, the direction of the mirrors, and other 
parameters.

To apply the Multi Mirror effect
With the Multi Mirror menu displayed, set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To set the center position of original image

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Kaleidoscope settings
You can set the number of blocks, the partition reference point and angle, 
horizontal and vertical offsets, a reflection position, and other parameters. 

Knob Parameter Adjustment Setting values

1 Interval H Horizontal distance between 
mirrors (original width) 

0.000 to 10.000 a)

0.000 to 40.000 b)

2 Offset H Amount of horizontal offset of 
image with mirrors fixed

–4.000 to +4.000 a)

–16.000 to +16.000 b)

3 Interval V Vertical distance between mirrors 
(original width) 

0.000 to 10.000 a)

0.000 to 40.000 b)

4 Offset V Amount of vertical offset of image 
with mirrors fixed

–4.000 to +4.000 a)

–16.000 to +16.000 b)

5 Angle Mirror angle –8.000 to +8.000

Knob Parameter Adjustment Setting values

1 H Horizontal original image center 
position 

–4.000 to +4.000 a)

–16.000 to +16.000 b)

2 V Vertical original image center 
position

–4.000 to +4.000 a)

–16.000 to +16.000 b)
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To apply the Kaleidoscope effect
With the Kaleidoscope menu displayed, set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To reflect the kaleidoscope image as if in a mirror

1 To reflect in the horizontal direction, press [Mirror H], turning it on.

2 To reflect in the vertical direction, press [Mirror V], turning it on.

To set the reflection position 

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To cyclically repeat part of the original and its reflection
Press [Cyclic], turning it on.

Lens settings
You can set the shape and aspect ratio of the lens, the angle, the magnification 
ratio, the curve ratio, the size, the center position, and other parameters. 
You can also choose to display only the portion of the image that is seen 
through the lens.

Knob Parameter Adjustment Setting values

1 Number Number of blocks 0.00 to 100.00

2 Phase Angle of partition reference point –8.000 to +8.000 a)

3 Offset H Amount of horizontal offset –4.000 to +4.000 a)

–16.000 to +16.000 b)

4 Offset V Amount of vertical offset –3.000 to +3.000 a)

–12.000 to +12.000 b)

Knob Parameter Adjustment Setting values

1 H Horizontal reflection position 0.000 to 4.000 a)

0.000 to 16.000 b)

2 V Vertical reflection position 0.000 to 3.000 a)

0.000 to 12.000 b)
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To apply the Lens effect
With the Lens menu displayed, use the following procedure.

1 In the <Mode> group, select the lens shape.

• Circle
• Rectangle
• Star
• Heart
• Bar
• Cross

2 Depending on the selected lens shape, set the following parameters.

• When Circle, Rectangle, Star, or Heart is selected

• When Bar is selected

• When Cross is selected

Knob Parameter Adjustment Setting values

1 Magnify H Magnification ratio –100.00 to +100.00

2 Curve H Curve ratio –100.00 to +100.00

3 Size H Size 0.00 to 100.00

4 Angle Slant angle –8.000 to +8.000

5 Aspect Aspect ratio –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Magnify H Magnification ratio –100.00 to +100.00

2 Curve H Curve ratio –100.00 to +100.00

3 Size H Size 0.00 to 100.00

4 Angle Slant angle –8.000 to +8.000

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Magnify H Horizontal magnification ratio –100.00 to +100.00

2 Curve H Horizontal curve ratio –100.00 to +100.00

3 Size H Horizontal size 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Magnify V Vertical magnification ratio –100.00 to +100.00

2 Curve V Vertical curve ratio –100.00 to +100.00

3 Size V Vertical size 0.00 to 100.00
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To make only the lens part visible
Press [Lens Only], turning it on.
The parts of the image outside the lens are removed.

To set the lens center position 

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Circle settings
You can set the size of the circle, and make the axis of modulation vertical.

To apply the Circle effect
With the Circle menu displayed, set the following parameters.

To make the axis of modulation vertical
Press [Mod V], turning it on.
The axis of modulation when converting to the circle becomes vertical.

Panorama settings
You can set the horizontal and vertical curve ratio, and the curve center 
position.

To apply the Panorama effect
With the Panorama menu displayed, set the following parameters.

Knob Parameter Adjustment Setting values

1 H Horizontal lens center position –5.000 to +5.000 a)

–20.000 to +20.000 b)

2 V Vertical lens center position –4.000 to +4.000 a)

–16.000 to +16.000 b)

Knob Parameter Adjustment Setting values

1 Radius Size of circle 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Curve H Horizontal curve ratio –100.00 to +100.00

2 Curve V Vertical curve ratio –100.00 to +100.00

3 Position H Horizontal curve center position –4.000 to +4.000 a)

–16.000 to +16.000 b)
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a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Page Turn settings
There are four modes: H&V, H, V, and Off. You can select the turn position, 
the radius of the turned portion, the amount and angle of turning, and the input 
video for the front and back pages. 

To apply the Page Turn effect
With the Page Turn menu displayed, use the following procedure.

1 In the <Split Mode> group, select the split mode.

H&V: The image turns as it is split from the center into 4 parts: left, right, 
upper, lower.

H: The image turns as it is split from the center into 2 parts: left, right.
V: The image turns as it is split from the center into 2 parts: upper, lower.
When nothing is selected (Off): There are no splits and the image turns 

from the edge.

2 Press [Page Turn], then set the following parameters.

a) When split mode is H&V
b) When split mode is H
c) When split mode is V
d) When split mode is off

To set the input signal of the back page

1 In the <Back Video> group, select the signal input into the back page.

Self: Use the same signal as the front page.
Flat: Use a flat color.
Hue Rotation: Gradually vary the hue.

4 Position V Vertical curve center position –3.000 to +3.000 a)

–12.000 to +12.000 b)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Radius Radius of turn part 0.00 to 100.00

2 Offset Amount of turn –100.00 to +100.00

3 Angle Angle of turn –0.250 to +0.000 a)

–0.250 to +0.250 b)

–0.500 to +0.000 c)

–8.000 to +8.000 d)
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2nd Ch: Use the 2nd channel video signal.

To select “2nd Ch,” it is first necessary to select the second DME on 
the keyer using DME. 

2 Adjust the following parameters, according to the selected input signal.

• When Flat is selected

• When Hue Rotation is selected

Roll settings
There are four modes: H&V, H, V, and Off. You can select the turn position, 
the radius of the turned portion, the amount and angle of turning, and the input 
video for the front and back pages. 

To apply the Roll effect
Display the Roll menu.
The knobs in the Roll menu have the same functions as those in the Page Turn 
menu.

For details about operation, see “Page Turn settings” (page 126).

Cylinder settings
You can set the degree of winding onto the cylinder, the radius, the horizontal 
position of the wound image, and front and back side output for the image.

To apply the Cylinder effect
With the Cylinder menu displayed, set the following parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Speed Speed at which hue changes –12.00 to +12.00

Knob Parameter Adjustment Setting values

1 Radius Degree to which image is wound onto 
the cylinder 

0.00 to 100.00

2 Min R Radius of the cylinder 0.00 to 100.00

3 Offset Horizontal position of the image 
wound onto cylinder

–100.00 to +100.00
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The procedure for selecting the input signal in the <Back Video> group is the 
same as for the Page Turn menu.

For details about operation, see “Page Turn settings” (page 126).

Sphere settings
You can set the degree of winding onto the sphere, the radius, the horizontal 
position of the wound image, and front and back side output for the image.

Note
You cannot monitor the part of a rotating sphere that corresponds to its axis on 
the monitor screen.

To apply the Sphere effect
Display the Sphere menu.
The knobs in the Sphere menu have the same functions as those in the Cylinder 
menu.

For details about operation, see “Cylinder settings” (page 127).

Explosion settings
You can set the pattern shape and aspect ratio, the center position, the amount 
of movement by fragments, the curvature of the transition path, and other 
parameters.

To apply the Explosion effect
With the Explosion menu displayed, use the following procedure.

1 In the <Mode> group, select the explosion pattern.

• Circle
• Rectangle
• Star
• Heart
• Ellipse

2 Set the following parameters.

• When Circle was selected in step 1

Knob Parameter Adjustment Setting values

1 Transition Degree of transition 0.00 to 100.00

2 Curve Degree to which image periphery 
expands

0.00 to 100.00
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• When Rectangle, Star, Heart, or Ellipse was selected in step 1

To make the fragments stardust

1 Press [Pixel], turning it on.

2 Set the following parameters.

To set the explosion center point

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Swirl settings
You can set the amount of swirl, the swirl region, the amount of rotation, and 
the swirl center position.

3 Spiral Degree of curvature of transition 
path

–100.00 to +100.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Transition Degree of transition 0.00 to 100.00

2 Curve Degree to which image periphery 
expands

0.00 to 100.00

3 Aspect Aspect ratio of waveform –100.00 to +100.00

4 Angle Slant of waveform –8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Density Degree to which image 
disappears

0.00 to 100.00

2 Random Degree of randomness in flying 
out fragment positions

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Center point in horizontal 
direction

–5.000 to +5.000 a)

–20.000 to +20.000 b)

2 V Center point in vertical direction –4.000 to +4.000 a)

–16.000 to +16.000 b)
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To apply the Swirl effect
With the Swirl menu displayed, set the following parameters.

To make the tip of the swirl stardust

1 Press [Pixel], turning it on.

2 Set the following parameters.

To set the center position of the swirl

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Melt settings
You can set the degree of transition, the degree of extension in the image, the 
jaggedness of the melting sections, and the amplitude, frequency, amount of 
movement, and speed of the melting sections. You can also set the slant of the 
borders, the shape of the sections that begin to melt, and other parameters.

To apply the Melt effect
With the Melt menu displayed, use the following procedure.

Knob Parameter Adjustment Setting values

1 Transition Swirl amount 0.00 to 100.00

2 Center Amount of rotation in center of swirl –8.000 to +8.000

3 Outer Amount of rotation outside of Area –8.000 to +8.000

4 Area Region of swirl 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Density Degree to which image 
disappears

0.00 to 100.00

2 Random Trail type and amount of stardust 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Horizontal center position of swirl –8.000 to +8.000 a)

–32.000 to +32.000 b)

2 V Vertical center position of swirl –6.000 to +6.000 a)

–18.000 to +18.000 b)
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1 In the <Direction> group, select the direction in which the image melts 

away.

Up: Melting occurs upward.
Down: Melting occurs downward.

2 To make transition settings, press [Transition] and set the following 
parameters.

3 To make wave settings for melting part, press [Border] and set the 
following parameters.

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

To stop the waves in the melting part
Press [Lock], turning it on.
With each press, the waves alternately stop and start moving again.

To select the shape of the part beginning to melt
Press [Form] and set the following parameter.

a) 1 (SINE): Sine wave
2 (PARABOLA): Parabola wave
3 (TRIANGLE): Triangular wave
4 (RECTANGLE): Rectangular wave
5 (CIRCLE): Circular wave
6 (CUBIC): Cubic wave

Knob Parameter Adjustment Setting values

1 Transition Degree of transition 0.00 to 100.00

2 Curve Degree to which image stretches 0.00 to 100.00

3 Random Degree of jaggies at melted part 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Amp Amplitude of waves 0.00 to 100.00

2 Freq Frequency of waves 0.00 to 100.00

3 Offset a) Amount of wave phase offset –16.000 to +16.000 c)

–64.000 to +64.000 d)

4 Speed b) Direction and speed of waves –100.00 to +100.00

5 Slant Slant of border –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Form Waveform 1 to 8 a)
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7 (MELT1): Melting wave 1
8 (MELT2): Melting wave 2

To make the melting part stardust

1 Press [Pixel], turning it on.

2 Set the following parameters.

Character Trail settings
You can set the effect starting position, the degree of expansion, the slant angle 
of the effect region, and trail direction, the degree to which the image 
disappears, the trail type and amount of stardust, and other parameters.

To apply the Character Trail effect
With the Character Trail menu displayed, set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To make the tip of the swirl stardust

1 Press [Pixel], turning it on.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Density Degree to which image 
disappears

0.00 to 100.00

2 Random Degree to which pixel positions 
become more randomized 
further from the center

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Transition Position where effect starts –8.000 to +8.000 a)

–32.000 to +32.000 b)

2 Expand Degree of expansion 0.00 to 100.00

3 Trans Angle Angle of slanting in effect region –8.000 to +8.000

4 Trail Angle Direction of trail –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Density Degree to which image disappears 0.00 to 100.00

2 Random Trail type and amount of stardust 0.00 to 100.00
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Lighting Settings

You can specify the intensity and color of the light and the lighting pattern. The 
following lighting patterns are available:
Plane: Illumination of the entire screen.
Bar: Bar illumination. You can specify the width and angle of the bar, and its 

softness.
Preset: Lighting pattern suitable for nonlinear effects.

When Bar is selected, the following modes can be selected.
Normal: Emphasizes the bar highlight area.
Specular: An effect like light striking a surface with metallic reflections.
Mat: An effect like light striking paper, cloth, or another diffusively reflective 

surface.

Note
The function for setting the bar mode of the lighting area is not supported on 
the MVE-8000A and MKS-6470.

Applying the Lighting effect

1 In the DME menu, select VF5 ‘Light/Trail’ and HF1 ‘Lighting.’

The Lighting menu appears.

2 Press [Lighting], turning it on.

The Lighting effect is enabled.

3 In the <Light Pattern> group, select the lighting pattern Plane, Bar or 
Preset.

You can adjust the intensity of the light and other parameters with the 
knobs.

Note
For MKS-6470, the pattern Preset is not supported.

4 Set the parameters.

The parameters differ as follows, depending on the selected lighting 
pattern.
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• When Plane is selected

a) You can make the Lighting effect more effective by adjusting [Total Ambient] to lower the 
brightness of the entire image. This setting is used both by this effect and by the 
Spotlighting effect.

Note
The Total Ambient parameter is not supported on the MVE-8000A and 
MKS-6470.

• When Bar is selected

a) You can make the Lighting effect more effective by adjusting [Total Ambient] to lower the 
brightness of the entire image. This setting is used both by this effect and by the 
Spotlighting effect.

Note
The Total Ambient parameter is not supported on the MVE-8000A and 
MKS-6470.

• When Preset is selected

a) Setting is available when nonlinear effect page turn, roll, cylinder, or sphere is selected. 
b) You can make the Lighting effect more effective by adjusting [Total Ambient] to lower the 

brightness of the entire image. This setting is used both by this effect and by the 
Spotlighting effect.

Note
The Total Ambient parameter is not supported on the MVE-8000A and 
MKS-6470.

Knob Parameter Adjustment Setting values

1 Light Intensity of light in highlight area 0.00 to 100.00

5 Total Ambient Brightness of whole image 0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Light Intensity of light in highlight area 0.00 to 100.00

2 Ambient Intensity of light in ambient area 0.00 to 100.00

5 Total Ambient Brightness of whole image 0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Light Intensity of light in highlight area 0.00 to 100.00

2 Ambient Intensity of light in ambient area 0.00 to 100.00

3 Shade Intensity of light in shade area 0.00 to 100.00 a)

5 Total Ambient Brightness of whole image 0.00 to 100.00 b)
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The three regions for which the light intensity can be set

Setting the bar shape of the highlight area
When you select [Bar] or [Preset] in step 3 of “Applying the Lighting effect” 
(page 133), use the following procedure to set the shape of the bar.

1 Turn [Light Modify] on.

2 Adjust the following parameters.

a) For SD 4:3
b) For SD 16:9
c) For HD 4:3
d) For HD 16:9
e) There are some nonlinear effects for which Angle cannot be used.

Highlight area

Ambient area
Shade area

Knob Parameter Adjustment Setting values

1 X X-value of bar center point –8.00 to +8.00 a) b)

–24.00 to +24.00 c)

–32.00 to +32.00 d)

2 Y Y-value of bar center point –6.00 to +6.00 a)

–4.50 to +4.50 b)

–18.00 to +18.00 c) d)

3 Angle e) Angle of bar –8.00 to +8.00

4 Width Width of bar 0.00 to 100.00

5 Soft Softness of edges 0.00 to 100.00
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Bar shape parameters

Setting the color of the light in the highlight area

1 Turn [Light Color] on.

2 Adjust the following parameters.

Setting the bar shape of the shade area
When you select [Preset] in step 3 of “Applying the Lighting effect” (see page 
133), use the following procedure to set the bar shape of the shade area.

1 Turn [Shade Modify] on.

2 Adjust the following parameters.

a) For SD 4:3 and SD 16:9
b) For HD 4:3
c) For HD 16:9

Center point of bar

Bar width

Bar angle

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 X X-value of bar center point –8.00 to +8.00a)

–24.00 to +24.00 b)

–32.00 to +32.00 c)

4 Width Width of bar 0.00 to 100.00

5 Soft Softness of edges 0.00 to 100.00
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Setting the color of the shade in the shade area

1 Turn [Shade Color] on.

2 Adjust the following parameters.

Setting the bar mode of the highlight area
When you select [Bar] in step 3 of “Applying the Lighting effect” (see page 
133), use the following procedure to set the bar mode of the highlight area. 

Note
The bar mode of the highlight area is not supported on the MVE-8000A and 
MKS-6470.

1 Select the mode in the <Bar Light Mode> group. 

Normal: Emphasizes the bar highlight area. 
Specular: An effect like light striking a surface with metallic reflections.
Mat: An effect like light striking paper, cloth, or another diffusively 

reflective surface. 

2 Set the following parameters.

a) For SD 4:3 and SD 16:9
b) For HD 4:3
c) For HD 16:9

3 When you select Normal or Mat in step 1, press [Bar Diffuse Color], 
turning it on, and adjust the following parameters to set the color of the 
diffuse light area. 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Intensity Intensity of diffuse light area 0.00 to 100.00

2 Offset Offset of center of diffuse light 
area

–4.00 to +4.00 a)

–12.00 to +12.00 b)

–16.00 to +16.00 c)

3 Width Width of diffuse light area 0.00 to 100.00

4 Soft Softness of diffuse light area 0.00 to 100.00
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Trail Settings

Notes
• Of the three effects of trail, motion decay and keyframe strobe, only one can 

be on at a time. When one of them is on, turning another of them on 
automatically turns off the one that has been on.

• Turning Trail on when Drop Shadow, Motion Decay, Keyframe Strobe or 
Wind is on turns it off automatically.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

With no selection made in 
the <Bar Light Mode> 
group

Width

Bar Light

With a selection made in 
the <Bar Light Mode> 
group

Diffuse Light

Diffuse Light

Bar Light

Offset = 0
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Applying the Trail effect

1 In the DME menu, select VF5 ‘Light/Trail’ and HF2 ‘Trail.’

The Trail menu appears.

2 Press [Trail], turning it on.

The Trail effect is enabled. You can adjust the parameters with the knobs.

3 Set the parameters.

a) 0.00 is no trail. At 100.00, the trail does not disappear.

4 To erase the trail, press [Trail Eraser], turning it on.

Switching the priority between the current image and trail 
superimposed

In the <Priority> group, select the method of superimposition.
Over: Current image is on top.
Under: Trail is on top.

Selecting the source to create a trail
In the <Trail Source> group, select the source to create a trail.

Notes 
• “Rainbow,” “Mix Color,” and “Ext Video” are not supported on the MVE-

8000A and MKS-6470.
• “Mix Color”or “Ext Video” can only be applied to one of the background 

(see page 166), flex shadow (see page 70), trail, and wind (see page 146) 
effects.
If you select “Mix Color” or “Ext Video” in one of these settings, a selection 
of “Mix Color” or “Ext Video” in any of the other effects is disabled, and 
“Flat Color” is selected in its place.

• When executing combining four channels of DME images, “Mix Color” and 
“Ext Video” in the flex shadow and background effects cannot be selected.

Knob Parameter Adjustment Setting values

1 Decay Degree to which the trail is left 0.00 to 100.00 a)

2 Interval Freeze interval 1 to 255 (frames)

3 Live Proportion of the interval 
between two successive freeze 
images for which the video is 
run

0.00 to 100.00
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Freeze Video: Use freeze images of the input video as source of the trail.
Flat Color: Use a flat color matte as source of the trail. You can set the 

following parameters with the knobs.

Hue Rotate: Use a color matte whose hue varies slightly with each frame for 
the trail of the afterimages. You can set the following parameters with the 
knobs.

(The following are possible using a second DME.)
Mix Color: Insert a mix color signal set in the Color Mix menu (see page 82) 

in the afterimage portion.
Ext Video: Insert the external video signal input to the Ext IN connector in the 

afterimage portion.
Rainbow: Use a freeze image with the hue changing every frame in the 

afterimage portion. The difference from “Hue Rotate” is that many colors 
appear simultaneously.

For details of the Rainbow parameters, see the “Hue Rotate” item above.

Erasing the afterimages that remain in memory whenever a 
keyframe is passed

Press [Trail Eraser], turning it on. 
When the effect passes a keyframe, the afterimage is erased before writing a 
new afterimage.

Selecting the freeze timing
In the <Trail Freeze Timing> group, select the timing for freezing a trail.
Frame: freeze in frame units.
Field: freeze in field units.

Note
The freeze timing setting is not required when the following signal formats are 
being used. 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Speed Speed at which the hue 
changes

–12.00 to +12.00
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Signal formats: 720P/59.94, 720P/50

Defocusing the afterimage portion (Defocus)

Notes 
• Defocus is possible using a second DME.
• The function to defocus the trail afterimage portion is not supported on the 

MVE-8000A and MKS-6470.

1 Press [Defocus], turning it on.

2 Set the following parameters.

Applying stardust to the afterimage portion
The afterimage portion becomes stardust, and gradually disappears.

1 Press the [DUST] button, turning it on.

2 Set the following parameters.

a) The way in which the afterimage disappears is affected by both Decay and Trail Dust 
parameter adjustments.

Setting a combine process
Select whether to add the Trail effect before or after the combine. 

Notes
• The combine process function is possible using a second DME.

Knob Parameter Adjustment Setting values

1 Defocus V Defocusing of the video 
signal

0.00 to 100.00

2 Defocus K Defocusing of the key 
signal

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Trail Dust Amount of the afterimage 
disappearing as stardust a)

0.00 to 100.00

2 Dust Soft Timing with which stardust 
disappears

0.00 to 100.00

3 Dust Size Size of stardust 0.00 to 100.00

4 Dust Aspect Aspect ratio of stardust –100.00 to +100.00
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• The combine process function is not supported on the MVE-8000A and 
MKS-6470.

• When you change the selection in the <Combine Process> group, the 
afterimages which had been added up to then disappear.

• When you do not combine images, the Trail effect only is applied, regardless 
of the selection in the <Combine Process> group. 

Select one of the following in the <Combine Process> group. 
Combine –> Trail: Add the Trail effect after the combine. As the trail 

parameters, the data for the channel with the lowest number among the 
channels being combined is enabled.

Trail –> Combine: Add the Trail effect before the combine. Trails parameters 
can be set independently for each channel. 

Motion Decay Settings

Note
When you turn on motion decay, if the Drop Shadow, Trail, Keyframe Strobe 
or Wind effect is on, it automatically goes off.

Blurring image motion

1 In the DME menu, select VF5 ‘Light/Trail’ and HF3 ‘Motion Decay.’

The Motion Decay menu appears.

2 Press [Motion Decay], turning it on.

This enables motion decay, and you can now use the knobs to adjust the 
parameters.

Combine –> Trail Trail –> Combine
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3 Set the following parameter.

a) At the setting 0.00, there is no afterimage. At a setting of 100.00, the afterimage does not 
decay.

4 In the <Decay Mix Mode> group, select the way in which the video signal 
is blurred.

Soft: mix the live image and the afterimage.
Hard: show the lighter of the live image and afterimage.

5 To erase the afterimage, press [Decay Eraser], turning it on.

Erasing the afterimages that remain in memory whenever a 
keyframe is passed

Press [Decay Eraser], turning it on.
When the effect passes a keyframe, the afterimage is erased before writing a 
new afterimage.

Selecting the freeze timing
In the <Decay Freeze Timing> group, select the timing for motion decay 
freezing.
Frame: freeze in frame units.
Field: freeze in field units.

Note
The freeze timing setting is not required when the following signal formats are 
being used. 

Signal formats: 720P/59.94, 720P/50

Applying stardust to the afterimage portion
The afterimage portion becomes stardust, and gradually disappears.

1 Press the [DUST] button, turning it on.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Video Decay Degree of blurring of the video 
signal

0.00 to 100.00 a)
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a) The way in which the afterimage disappears is affected by both the Video Decay and 
Decay Dust parameter adjustments for the motion decay.

Keyframe Strobe Settings

Note
When you turn on keyframe strobe, if the Drop Shadow, Trail, Motion Decay 
or Wind effect is on, it automatically goes off. (See “Note” in the section 
“Trail.”)

Leaving a trail of afterimages of the image

1 In the DME menu, select VF5 ‘Light/Trail’ and HF4 ‘KF Strobe.’

The KF Strobe menu appears.

2 Press [KF Strobe], turning it on.

This enables the Keyframe Strobe effect, and you can now use the knobs 
to adjust the parameters.

3 Set the following parameter.

a) At the setting 0.00, there is no afterimage. At a setting of 100.00, the afterimage does not 
decay.

4 To erase the afterimage, press [KF Strobe Eraser], turning it on.

Selecting the overlay priority for movie and still images (video 
freeze image)

In the <Priority> group, select the way in which the images are overlaid.

Knob Parameter Adjustment Setting values

1 Decay Dust Amount of the afterimage 
disappearing as stardust a)

0.00 to 100.00

2 Dust Soft Timing with which stardust 
disappears

0.00 to 100.00

3 Dust Size Size of stardust 0.00 to 100.00

4 Dust Aspect Aspect ratio of stardust –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Decay Degree of blurring of the video 
signal

0.00 to 100.00 a)
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Over: the movie is on top, and the still image is underneath.
Under: the movie is underneath, and the still image is on top.
Mix: the movie and still images are mixed; adjust the following parameter with 

the knob.

a) The 0.00 setting is the same as Over, and the 100.00 is the same as Under.

Selecting the freeze timing
In the <KF Freeze Timing> group, select the timing for freezing the keyframe 
strobe.
Frame: freeze in frame units.
Field: freeze in field units.

Note
The freeze timing setting is not required when the following signal formats are 
being used. 

Signal formats: 720P/59.94, 720P/50

Erasing the afterimages that remain in memory whenever a 
keyframe is passed

Press [KF Strobe Eraser], turning it on.
When the effect passes a keyframe, the afterimage is erased before writing a 
new afterimage.

Applying stardust to the afterimage portion
The afterimage portion becomes stardust, and gradually disappears.

1 Press the [DUST] button, turning it on.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Mix Mix amount of the still image with 
respect to the movie

0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 KF Strobe 
Dust

Amount of the afterimage 
disappearing as stardust a)

0.00 to 100.00

2 Dust Soft Timing with which stardust 
disappears 

0.00 to 100.00

3 Dust Size Size of stardust 0.00 to 100.00

4 Dust Aspect Aspect ratio of stardust –100.00 to +100.00
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a) The way in which the afterimage disappears is affected by both the Decay and KF Strobe 
Dust parameter adjustments for the keyframe strobe.

Disabling the keyframe strobe afterimage
Press [KF Strobe Disable], turning it on.
If you turn this function on when creating a keyframe, even as the effect passes 
a keyframe, no afterimage remains.

Setting a combine process
Select whether to add the Keyframe Strobe effect before or after the combine. 

Notes
• The combine process function is not supported on the MVE-8000A and 

MKS-6470.
• When you change the selection in the <Combine Process> group, the 

afterimages which had been added up to then disappear.
• When you do not combine images, the Keyframe Strobe effect only is 

applied, regardless of the selection in the <Combine Process> group.

Select one of the following in the <Combine Process> group. 
Combine –> KF STRB: Add the Keyframe Strobe effect after the combine. 

As parameters, the data for the channel with the lowest number among the 
channels being combined is enabled.

KF STRB –> Combine: Add the Keyframe Strobe effect before the combine. 
Parameters can be set independently for each channel. 

Wind Settings

Notes
• The wind function is not supported on the MVE-8000A and MKS-6470.
• When wind is turned on, any of the following effects that are on are turned 

off.
– Trail
– Motion decay
– Keyframe strobe

Applying the wind effect

1 In the DME menu, select VF5 ‘Light/Trail’ and HF5 ‘Wind.’

The Wind menu appears.
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2 Press [Wind], turning it on.

This enables the wind, and you can now adjust the parameters with the 
knobs.

3 Set the following parameters.

a) 0.00 represents no afterimage, and 100.00 represents no decay in the afterimage.

4 To erase the afterimages, press [Wind Eraser], turning it on.

Selecting the signal for the afterimage portion
In the <Wind Source> group, select the image to fill the afterimage portion.

Notes
• “Mix Color”or “Ext Video”can only be applied to one of the background (see 

page 166), flex shadow (see page 70), trail (see page 138), and wind effects.
If you select “Mix Color”or “Ext Video” in the wind settings, a selection of 
“Mix Color”or “Ext Video” in any of the other effects is disabled, and “Flat 
Color” is selected in its place.

• When executing combining four channels of DME images, “Mix Color” and 
“Ext Video” cannot be selected.

Freeze Video: Freeze the input image to use as the afterimage.
Flat Color: Use a single color matte for the afterimage; you can set the 

following parameters with the knobs.

Hue Rotate: Use a single color matte with the hue changing for each frame as 
the afterimage; you can set the following parameters with the knobs.

Knob Parameter Adjustment Setting values

1 Decay Amount of afterimage 
displayed

0.00 to 100.00 a)

2 Shift H Extension in the horizontal 
direction

–100.00 to +100.00

3 Shift V Extension in the vertical 
direction

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00
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Mix Color: Insert a mix color signal (see page 82) in the afterimage portion.
Ext Video: Insert the external video signal input to the Ext IN connector in the 

afterimage portion.
Rainbow: Use a freeze image with the hue changing every frame in the 

afterimage portion. The difference from “Hue Rotate” is that many colors 
appear simultaneously.

For details of the Rainbow parameters, see the “Hue Rotate” item above.

Applying modulation to the afterimage portion (Modulation)

1 In the Wind menu, press [Modulation], turning it on.

2 Set the following parameters.

For details of Priority, Wind Freeze Timing, Wind Eraser, Defocus, Dust, and 
Combine Process in the Wind menu, see “Trail Settings” (page 138).

Spotlighting Settings

You can set up to three light sources (lights 1 to 3).

Notes
• The Spotlighting effect is not supported on the MVE-8000A and MKS-6470.
• The BZDM-9050 Texture Lighting Software (for MVE-9000) is required to 

set lights 2 and 3.
• When the global effect Combiner is enabled, the settings of the smallest-

numbered channel selected for the Combiner are used.

2 Saturation Saturation 0.00 to 100.00

3 Hue Speed Rate at which hue changes –12.00 to +12.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Amp H Horizontal amplitude of the 
wave

0.00 to 100.00

2 Freq H Horizontal frequency of the 
wave

–100.00 to +100.00

3 Amp V Vertical amplitude of the 
wave

0.00 to 100.00

4 Freq V Vertical frequency of the 
wave

–100.00 to +100.00
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Adjustments to the image surface

The following adjustments can be made to the image surface struck by the 
light.
• Adjusting the brightness of the whole image
• Selecting the image surface effect
• Test sphere function
• Adjusting the bumpiness of the image surface
• Coordinate axis on surface of image
• Texture deformations

Selecting the image surface effect
Flat: The image surface is unchanged, causing the selected light source to 

appear as the effect.
Texture: A texture appears on the surface of the image. Textures can be 

selected from among 30 patterns.

See “Texture Patterns” (page 476) for the texture patterns.

Non Linear: Spotlighting effect is applied to an area to which a DME 
nonlinear effect is applied. 

Note
The BZDM-9050 is required to enable Texture and Non Linear settings.

Test sphere function
A test sphere is a translucent sphere virtually embedded in the center of the 
input picture to provide an intuitive way for you to check the position and 
direction of the spotlight. When you change the position or direction of a light 
source, the side of the sphere closest to the light source grows brighter. You can 
easily check the position and direction of the light source by viewing the test 
sphere.

For more information about test sphere, see “Relation between test spheres 
and parallel rays” (page 153).

Coordinate axis on surface of image 
Specify where to apply the texture or test sphere on the image surface.
Move: The texture moves together with the DME image.
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Fix: The texture does not move, even if the DME image moves.

Texture deformations
You can change the texture pattern, position, and size, and use the repetition 
function.
The following figure shows examples of a texture pattern repeated in the X and 
Y directions.

Image before movement Coordinate axis = Move
Texture moves together 
with DME image.

Image before movement Coordinate axis = Fix
Texture does not move, even 
if DME image moves.

Original image

Repetition in X 
direction

Repetition in Y 
direction

Repetition in X and Y 
directions
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Setting lights

Light source types
The following type of light sources are available (see figure). 
Parallel: Parallel light source
Point: Point light source. As the light source is placed further away, the 

illuminated range becomes wider and the light become weaker.
Line: Line light source
Whole: Non-directional light source which illuminates the whole image.

Linking and unlinking image and spotlight
The spotlight can move together with a DME image, or be fixed in place.
Source: Place the light source in source coordinate space. The spotlight is 

linked and moves when the image moves.
Target: Place the light source in target coordinate space. The spotlight does 

not move, even when the image moves.

Selecting the lighted area
You can select the area lit by the spotlight.

Light source Light source Light source

Parallel Point Line Whole

Spotlight

Image before movement Coordinate axis = Source
Spotlight moves together 
with DME image.

Coordinate axis = Target
Spotlight does not move, 
even if DME image 
moves.
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FRGD: The light strikes the image foreground.
BKGD: The light strikes the image background.
Both: The light strikes both foreground and background.

Surface Flat
For the currently selected light source only, you can forcibly make the image 
surface effect flat. 
This is effective when you have selected texture as image surface effect and 
want a flat effect for one light source only.

Light shape
Creates the light shape.
• Select the shape pattern

For shape patterns, see “Shape Patterns” (page 477).

• Set the size, degree of deformation, softness, and rotation.

Ring settings
Shines the light with a hole in the middle, like a doughnut. Adjust the following 
parameters.
Offset: Distance to move the center of the ring from the initial position (the 

position set when selecting the light source in the <Spot Mode> group).
Radius: Inner side radius of the ring.
Angle: When an Offset is set, the rotation angle of the ring around the initial 

center position. 

No effect

Background

Foreground Spotlight

FRGD selected BKGD selected Both selected
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Fill blending modes
Specifies the way in which the light is blended with the image.
Mix: Light as if reflected from a mirror. The light can be given a color.
Multiply: Light as if reflected from a dull surface (diffuse reflection).

Relation between test spheres and parallel rays
The following figure shows an example of the effect of parallel rays on a test 
sphere.

The direction of a ray is defined by longitude and latitude.
• Longitude: A direction (angle), expressed as a plus value for clockwise 

rotation in the plus direction with respect to the X axis of the input picture.
• Latitude: Latitude

The following figure shows the relationships between the longitude and 
latitude of parallel rays, input picture, and test sphere.

RadiusAngle

Offset

Angle: Rotation angle
Initial center position

Test sphere

Ray
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The unit of these direction parameters is the number of rotations, with 360° 
(1 rotation) expressed as 1.00, in the same way as 3D rotation parameters.
The following relationships apply in the example shown in the figure.

The fractional part of the setting after the decimal point corresponds to an angle 
0 to 360°. If the fractional parts of two setting values are the same, the effect is 
the same even if the integral parts are different.
The integral part of a setting value is used when moving a light source with 
keyframes.
For example, when the longitude of a light source rotates in the clockwise 
direction from 0.88 (315°) to 0.12 (45°), it rotates in the counterclockwise 
direction (the angle grows smaller) if the above values are used. In this case, 
the value of the second keyframe can be set to 1.12 (360° + 45°).

Parameter Setting Angle

Longitude 0.12 45°

Latitude 0.12 45°

0.00

0.00

Parallel rays

Input picture

Z-axis
Latitude=+0.25

Latitude=−0.25

X-axis

Y-axis

Longitude

Test sphere

Latitude
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Keyframe trajectory

Setting the surface where light strikes the image

1 In the DME menu, select VF5 ‘Light/Trail’ and HF6 ‘Spot Lighting.’

The Spot Lighting menu appears.

2 Press [Spot Lighting], turning it on.

This enables Spotlighting, and you can now use the knobs to adjust the 
parameters.

3 Set the following parameter. 

• Lowering the brightness of the image makes Spotlighting more 
effective.

• The Total Ambient setting is shared with the Lighting function.

4 In the <Surface Select> group, select the state of the surface struck by the 
light.

Flat: The image surface is unchanged, causing the selected light source to 
appear as the effect.

Texture: A texture appears on the surface of the image.
Non Linear: The Spotlighting effect is applied to an area to which a DME 

nonlinear effect is applied.

KF2 = 1.12

KF2 = 0.12

KF1 = 0.88

Test sphere

Knob Parameter Adjustment Setting values

1 Total Ambient Brightness of whole image 0.00 to 100.00
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Notes
• The BZDM-9050 Texture Lighting Software (for MVE-9000) is 

required to enable Texture or Non Linear.
An install key must be entered to use the software (For details, see 
“Installation and Device Setup (Install/Unit Config Menu)” in Chapter 
18 (Volume 3).)

• The Spotlighting Non Linear setting is effective for the following 
nonlinear effects. For any other nonlinear effect, the result of selecting 
the Non Linear setting is the same as selecting Flat.

Wave, Mosaic Glass, Flag, Ripple, Lens, Panarama, Page Turn, Roll.

5 If you selected Texture or Non Linear in step 4, set the following 
parameters.

Parameters when you selected Texture

• SD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Plus emphasizes bumps in texture, minus emphasizes depressions. 0.00 is a flat surface.

• HD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Plus emphasizes bumps in texture, minus emphasizes depressions. 0.00 is a flat surface.

Knob Parameter Adjustment Setting values

1 X Movement in X-axis direction –8.00 to +8.00 a)

2 Y Movement in Y-axis direction –6.00 to +6.00 b)

3 Size X Image size in X-axis direction 0.50 to 16.00

4 Size Y Image size in Y-axis direction 0.50 to 16.00

5 Amp Emphasize bumps and 
depressions 

–100.00 to +100.00 c)

Knob Parameter Adjustment Setting values

1 X Movement in X-axis direction –32.00 to +32.00 a)

2 Y Movement in Y-axis direction –24.00 to +24.00 b)

3 Size X Image size in X-axis direction 0.50 to 16.00

4 Size Y Image size in Y-axis direction 0.50 to 16.00

5 Amp Emphasize bumps and 
depressions

–100.00 to +100.00 c)
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Parameters when you selected Non Linear

a) Light appears from Z direction. At –100.00 the light goes deepest, at +100.00 the whole 
image is lit like a flat effect.

6 If you selected Texture in step 4, select the pattern as explained in the next 
section “To select a texture pattern.”

7 If you selected Texture in step 4, select the way it is applied in the <Surface 
Axis> group.

Move: The texture moves together with the DME image.
Fix: The texture does not move, even if the DME image moves.

For the difference between these application methods, see “Coordinate 
axis on surface of image” (page 149).

Note
If Non Linear is selected in the <Surface Select> group, Fix is disabled. 
Behavior is the same as Move.

To select a texture pattern

1 In the Spot Lighting menu, press [Texture Ptn Select].

The Texture Ptn Select menu appears.
Two lists appear in the status area. The list on the left displays the number 
and name of the currently selected texture. The list on the right is for 
selecting a texture.

2 In the <Texture Pattern> group, press [User] or [Factory] to select the 
texture pattern list.

[User]: List of texture patterns created by the user. (See “Adding User 
Texture Patterns” in Chapter 18 (Volume 3).

[Factory]: List of texture patterns stored in the system when shipped from 
the factory.

3 Do one of the following to select a texture.

• Press directly on the list on the right of the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

Knob Parameter Adjustment Setting values

5 Amp Distance of light –100.00 to +100.00 a)
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a) When Factory is selected
b) When User is selected. The setting value range depends on the number of texture patterns 

installed.

4 Press [Set].

The texture selected in step 2 appears in the list on the left of the status 
area.

To set a test sphere

1 In the Spot Lighting menu, press [Test Sphere], turning it on.

A test sphere effect appears on the image surface.

2 Adjust the following parameter. 

a) Light appears from Z direction. At –100.00 the light goes deepest, at +100.00 the whole 
image is lit like a flat effect.

For details of the relationship of test spheres and light sources, see 
“Relation between test spheres and parallel rays” (page 153).

Setting light sources
Up to three light sources (Light 1 to Light 3) for Spotlighting can be set by 
menus.

Light source menu
The following three light source menus are available.

Note
The BZDM-9050 Texture Lighting Software (for MVE-9000) is required to 
enable Light 2 and Light 3.

Knob Parameter Adjustment Setting values

1 Texture No Texture 1 to 30 a)

101 and upwards b)

Knob Parameter Adjustment Setting values

5 Amp Distance of light –100.00 to +100.00 a)

Light source Menu

Light 1 DME >Light/Trail >Spot Lighting >Light 1

Light 2 DME >Light/Trail >Spot Lighting >Light 2

Light 3 DME >Light/Trail >Spot Lighting >Light 3
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An install key must be entered to use the software. (For details, see 
“Installation and Device Setup (Install/Unit Config Menu)” in Chapter 18 
(Volume 3).)

To set light source data
The following example shows how to set light source data with the Light 1 
menu.
If you use multiple light sources, use the same procedure for all light sources.

1 In the <Spot Lighting Adjust> group of the Spot Lighting menu, press 
[Light 1].

The Light 1 menu appears.

2 Press [Light 1], turning it on.

This enables the Light 1 light source, and you can now use the knobs to 
adjust the parameters.

3 Set the following parameters.

• Lowering the brightness of the image makes Spotlighting more 
effective.

• The Total Ambient setting is shared with the Lighting function.

4 In the <Spot Mode> group, select the type of light source.

Parallel: Parallel light source. The direction can be set.
Point: Point light source. The position can be set.
Line: Line light source. The position and angle can be set.
Whole: Non-directional light source which illuminates the whole image 

(no settings).

For more information about light source types, see “Light source types” 
(page 151).

5 According to the selected light source type, set the following parameters.

When you selected Parallel

Knob Parameter Adjustment Setting values

1 Total 
Ambient

Brightness of whole image 0.00 to 100.00

2 Intensity Intensity (brightness) of the light 
source

0.00 to 100.00

3 Soft Softness of the lighted area 0.00 to 100.00
159DME Special Effect Operations



   C
hapter 11 

D
M

E
 O

perations

160
a) Minus moves counterclockwise, plus moves clockwise.

When you selected Point
• SD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Minus moves forward, plus moves deeper.

• HD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Minus moves forward, plus moves deeper.

When you selected Line
• SD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Minus moves forward, plus moves deeper.
d) Minus moves counterclockwise, plus moves clockwise.

• HD format

Knob Parameter Adjustment Setting values

1 Longitude Longitude –8.00 to +8.00 a)

2 Latitude Latitude –8.00 to +8.00

Knob Parameter Adjustment Setting values

1 X Movement in X-axis direction –6.00 to +6.00 a)

2 Y Movement in Y-axis direction –6.00 to +6.00 b)

3 Z Movement in Z-axis direction –6.00 to +6.00 c)

Knob Parameter Adjustment Setting values

1 X Movement in X-axis direction –24.00 to +24.00 a)

2 Y Movement in Y-axis direction –24.00 to +24.00 b)

3 Z Movement in Z-axis direction –24.00 to +24.00 c)

Knob Parameter Adjustment Setting values

1 X Movement in X-axis direction –6.00 to +6.00 a)

2 Y Movement in Y-axis direction –6.00 to +6.00 b)

3 Z Movement in Z-axis direction –6.00 to +6.00 c)

4 Longitude Longitude –8.00 to +8.00 d)
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a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Minus moves forward, plus moves deeper.
d) Minus moves counterclockwise, plus moves clockwise.

6 In the <Axis Select> group, select the coordinate space in which to place 
the light source.

Source: Place the light source in the source coordinate space. The 
spotlight moves when the image moves.

Target: Place the light source in the target coordinate space. The spotlight 
does not move, even when the image moves.

For details of the coordinate space in which to place the light source, see 
“Linking and unlinking image and spotlight” (page 151). 

To set a test sphere

1 In the Light 1 menu, press [Test Sphere], turning it on.

A test sphere effect appears on the surface of the image.

2 Adjust the following parameter. 

a) Light appears from Z direction. At –100.00 the light goes deepest, at +100.00 the whole 
image is lit like a flat effect.

To select the lighted area
In the <Area Select> group, select one of the following.
FRGD: The light strikes the image foreground.
BKGD: The light strikes the image background.
Both: The light strikes both foreground and background.

For more information about the lighted area, see “Selecting the lighted area” 
(page 151).

Knob Parameter Adjustment Setting values

1 X Movement in X-axis direction –24.00 to +24.00 a)

2 Y Movement in Y-axis direction –24.00 to +24.00 b)

3 Z Movement in Z-axis direction –24.00 to +24.00 c)

4 Longitude Longitude –8.00 to +8.00 d)

Knob Parameter Adjustment Setting values

5 Amp Distance of light –100.00 to +100.00 a)
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Notes
• If you select [Multiply] in the <Fill Blending Mode> group of the Light 

Color Adjust menu (see page 164), the light effect is not applied to the 
background, even if you select BKGD or Both.

• If the setting of [Brilliancy] in the <Fill Source> group of the Light Color 
Adjust menu (see page 164) is 100.00, the light effect is not applied to the 
background, even if you select BKGD or Both.

• When the global effect Combiner is set to Mix or Depth, the light effect is 
not applied to the background, even if you select BKGD or Both.

To select Surface Flat
Press [Surface Flat], turning it on.
If you have selected anything other than Flat in the <Surface Select> group of 
the Spot Lighting menu, the part corresponding only to the surface being struck 
by the currently set light from the light source is shown in the same way as if 
Flat had been selected.

To set the shape of the light

1 Press [Shape], turning it on.

2 Set the following parameters.

• SD format

a) For more information about the shape patterns, see “Shape Patterns” (page 477) in the 
Appendix.

b) 0 is a round shape, and 100 is the shape itself. Smaller values make the pattern more 
rounded.

c) –1.00 is one rotation in the counterclockwise direction. +1.00 is one rotation in the 
clockwise direction.

• HD format

Knob Parameter Adjustment Setting values

1 Shape Ptn Shape pattern 1 to 2 a)

2 Size Shape size 0.00 to 6.00 

3 Deform Amount of shape deformation 0.00 to 100.00 b)

4 Soft Softness of shape pattern 0.00 to 100.00 

5 Angle Angle of shape pattern rotation –8.00 to +8.00 c)

Knob Parameter Adjustment Setting values

1 Shape Ptn Shape pattern 1 to 2 a)

2 Size Shape size 0.00 to 24.00 

3 Deform Amount of shape deformation 0.00 to 100.00 b)

4 Soft Softness of shape pattern 0.00 to 100.00 
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a) For more information about the shape patterns, see “Shape Patterns” (page 477) in the 
Appendix.

b) 0 is a round shape, and 100 is the shape itself. Smaller values make the pattern more 
rounded.

c) –1.00 is one rotation in the counterclockwise direction. +1.00 is one rotation in the 
clockwise direction.

To rotate the shape pattern

1 Press [Shape Speed], turning it on.

The display on knob 5 that was visible when [Shape] was selected changes.

2 Set the following parameter.

a) –100.00 is four rotations per second in the counterclockwise direction, and +100.00 is four 
rotations per second in the clockwise direction. 0.00 stops the rotation.

To change the light to a ring shape

Note
If you select Parallel or Whole (see page 159) in the <Spot Mode> group and 
shaping is disabled, the Ring parameter cannot be set.

1 Press [Ring], turning it on.

2 Set the following parameter.

• SD format

a) –1.00 is one rotation in the counterclockwise direction and +1.00 is one rotation in the 
clockwise direction.

Note
There is no Radius setting when Line is selected in the <Spot Mode> 
group.

5 Angle Angle of shape pattern rotation –8.00 to +8.00 c)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

5 Speed Rotation direction and speed –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Offset Offset from center position (radius) –6.00 to +6.00 

2 Radius Radius of ring 0.00 to 6.00  

3 Angle Rotation angle of ring –8.00 to +8.00 a)
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• HD format

a) –1.00 is one rotation in the counterclockwise direction and +1.00 is one rotation in the 
clockwise direction.

Note
There is no Radius setting when Line is selected in the <Spot Mode> 
group.

To rotate the ring

1 Press [Ring Speed], turning it on.

The display on knob 3 that was visible when [Ring] was selected changes.

2 Set the following parameter.

a) –100.00 is four rotations per second in the counterclockwise direction, and +100.00 is four 
rotations per second in the clockwise direction. 0.00 stops the rotation.

To invert the lighted area
Press [Light Invert], turning it on.
The lighted area is inverted.

To add color to the light source

1 In the Light 1 menu, press [Light Color Adjust].

The Light Color Adjust menu appears.

2 In the <Fill Blending Mode> group, select how the light and image should 
be blended.

Mix: Light as if reflected from a mirror.
Multiply: Light as if reflected from a dull surface (diffuse reflection).

3 If you selected Mix, select the fill color in the <Fill Source> group.

Flat Color: A monochrome matte.
Hue Rotation: Color matte with a color that gradually varies.

Knob Parameter Adjustment Setting values

1 Offset Offset from center position (radius) –24.00 to +24.00 

2 Radius Radius of ring 0.00 to 6.00  

3 Angle Rotation angle of ring –8.00 to +8.00 a)

Knob Parameter Adjustment Setting values

3 Speed Rotation speed and direction –100.00 to +100.00 a)
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4 According to the selection, set the following parameters.

• When you selected Flat Color

a) 100.00: The image beneath the light shines through.

• When you selected Hue Rotation

a) –12.00 is a 360-degree rotation every second in the counterclockwise direction. +12.00 is 
a 360-degree rotation every second in the clockwise direction.

b) 100.00: The image beneath the light shines through.

Copying or swapping light source settings
You can copy or swap the setting from one light source (Light 1 to Light 3) to 
another light source. 

1 In the Spot Lighting menu, press [Copy/Swap].

The Copy/Swap menu appears.
Two lists appear in the status area. The list on the left shows the copy or 
swap sources, and the list on the right shows the copy or swap destinations.

2 Do one of the following to select the target data.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

3 Press [Copy] to copy, or [Swap] to swap.

The data is copied or swapped.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00 

3 Hue Hue 359.99 to 0.00

4 Brilliancy Brilliance of surface struck by light 0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00 

3 Speed Speed at which hue changes –12.00 to +12.00 a)

4 Brilliancy Brilliance of surface struck by light 0.00 to 100.00 b)

Knob Parameter Adjustment Setting values

1 Left No Copy or swap source data 1 to 3

2 Right No Copy or swap destination data 1 to 3
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To undo a copy or swap
Press [Undo]. Settings are returned to their values before the copy or swap.

Background Settings

Adds a color or inputs an external signal to the background of the image.

Note 
Signal selection for this purpose is not supported on the MVE-8000A and 
MKS-6470.

Applying the Background effect

1 In the DME menu, select VF6 ‘Input/Output’ and HF1 ‘Bkgd.’

The Bkgd menu appears.

2 Press [Bkgd], turning it on.

The Background effect is enabled. Only if Flat Color is selected in the 
<Bkgd Fill> group, you can adjust the parameters with the knobs.

3 Set the following parameters.

Selecting the signal to insert in the background
When using the MVE-9000, you can select the signal to insert in the 
background.
With [Bkgd] set on, use the following procedure.

1 In the <Bkgd Fill> group, select one of the following.

Flat Color: single color
Mix Color: mix color signal set in the Color Mix menu (see page 82)
Ext Video: an external video signal input to the Ext IN connector

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Notes 
• “Mix Color”or “Ext Video” can only be applied to one of the 

background, flex shadow (see page 70), trail (see page 138), and wind 
(see page 146) effects.
If you select “Mix Color” or “Ext Video” in one of these settings, a 
selection of “Mix Color” or “Ext Video” in any of the other effects is 
disabled, and “Flat Color” is selected in its place.

• When executing combining four channels of DME images, “Mix Color” 
and “Ext Video” cannot be selected.

2 Only if Flat Color is selected in step 1, adjust the following parameters.

Separate Sides Settings

Applies separate video signals and key signals to the front and back of the
image.

Applying the Separate Sides effect

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 ‘Video/Key.’

The Video/Key menu appears.

2 Press [Separate Side], turning it on.

The Separate Sides effect is enabled. If the video and key signals currently 
being output to the monitor are the front side, you can select the front 
signals. If they are the back side, you can select the back signals. Video and 
key signals are selected with the cross-point control blocks of each M/E 
bank or the PGM/PST bank.

Shaped Video Settings

For each of the front and back sides of the image, specifies whether to handle 
input video from the switcher as shaped video (key processed signals).

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Notes
• The shaped video function is valid when using an SDI setting.
• In the case of the MKS-6470, shaped video for the first channel is always on. 

Shaped video for the second channel is always off.

Switching shaped video on or off

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 ‘Video/Key.’

The Video/Key menu appears.

2 In the <Shaped Video> group, press each of the following buttons to 
switch it on or off.

Front Input: When this is on, the front image of the input video signal is 
treated as shaped video.

Back Input: When this is on, the back image of the input video signal is 
treated as shaped video.

Output: When this is on, the output video signal is treated as shaped video.

About on and off for shaped video input (Front Input/Back Input)
Switch shaped video on and off according to the input video signals. 
For example, switch the shaped video input on when the input signal is a key 
processed image such as computer graphics.
Switch the shaped video input off when the input signal is not key processed, 
for example when a video signal taken with a camera is cut out with a title or 
other key signal.

About on and off for shaped video output
Switch the shaped video output on and off to match the on and off state of the 
switcher clean video mode.
Also, when the shaped video output is on, it is recommended that the switcher 
key type be set to linear key.

About the relationship between shaped video output and effects
When the shaped video output is off, the video signal before key processing is 
output. According to the selected effect, the following states may result.

(a) The output video signal is affected by the key signal. 
(b) When key processing is done, a different image may appear in the parts 

which are removed. 
(c) There is no change in the output video signal for effects which are applied 

to key signals only. 
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When multiple effects are applied, the order of priority is (a) > (b) > (c). 
The following explains the relationship between effects and states (a), (b), and 
(c).

(a) The output video signal is affected by the key signal 
The output video signal is affected by the key signal when the following effects 
are selected. To prevent the signal from being affected, set the DME key source 
to Int Key, or choose an appropriate input key signal. 

Page Turn, Roll, Cylinder, Sphere, Spotlighting, global effects (Combiner, 
Brick, Shadow) 

(b) When key processing is done, a different image may appear in 
the parts which are removed
The following states result, depending on the selected effect. 
Removal with the key can be checked by turning the background on. 
Border, Beveled Edge: Added also to the outer side of the cropped video 

signal (restriction of this version only). 
Trail, Keyframe Strobe: The key signal level of the afterimage portion varies 

with adjustments of the knob (Decay), but the afterimage portion of the 
video signal does not disappear until Trail Eraser (KF Strobe Eraser) is 
turned on or the effect is turned off. 

Lighting: The Lighting effect is applied to the whole picture.
Spotlighting: If BKGD or Both is selected in the <Area Select> group, light 

strikes the entire background.

(c) No change in the output video signal for effects which are 
applied to key signals only 
The following states result, depending on the selected effect. 
Removal with the key can be checked by turning the background on. 
Crop: The Copy effect is applied to the key signal only. The video signal does 

not change.
Edge Soft: The Edge Soft effect is applied to the key signal only. The video 

signal does not change. 
Shadow, Flex Shadow, Combine Shadow: The key signal density changes. 

The video signal does not change. 
Fade: The key signal changes according to depth data. The video signal does 

not change. 
Key Density: The key signal density changes. The video signal does not 

change.
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Invert Settings

Inverts the input video signal and/or key signal horizontally or vertically. You 
can make separate settings for the front and back.

Applying the Invert effect

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 ‘Video/Key.’

The Video/Key menu appears.

2 In the <Front> group (to invert front signals) or the <Back> (to invert back 
signals), press the following buttons, turning them on.

H Invert: Invert video and key signals horizontally.
V Invert: Invert video and key signals vertically.

Key Density Settings

You can adjust the key density for the key signal input to the DME.

Setting the key density

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 ‘Video/Key.’

The Video/Key menu appears.

2 Press [Key Density], turning it on.

This enables the key density function, and you can now use the knobs to 
adjust the parameters.

3 Set the following parameter.

Key Source Selection

You can select either the key signals received from the switcher or the key 
signals generated in the DME for application to the front and back of the image.

Knob Parameter Adjustment Setting values

1 Key Density Key density 0.00 to 100.00
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Selecting the key source signals

Note
When the shaped video setting (see page 167) is on, it is not possible to select 
the key source. It is fixed as “Ext Key” as listed in the following.

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 ‘Video/Key.’

The Video/Key menu appears.

2 In the <Front Key> group or <Back Key> group respectively, press one of 
the following, turning it on.

Ext Key: Use the key signal sent from the switcher as the key source.
Int Key: Use the full-size DME internal key signal as the key source.
Lum Key: Use the input video luminance signal as the key source. 

3 When Ext Key or Lum Key is selected in step 2, set the following 
parameters.

Notes
• The Ext Key and Lum Key in the <Front Key> group share clip and gain 

settings. Similarly, Ext Key and Lum Key in the <Back Key> group also 
share clip and gain settings.

• The Ext Key parameter setting is only enabled when the shaped video 
setting is off.

Interpolation Settings

Specifies the methods used for interpolation processing of input video signals 
and input key signals.

For input video signals, you can select from the following four methods.
• Detect changes in the luminance and chrominance signals separately, and 

switch automatically between fields and frames. You can select the degree of 
change detection.

• Detect changes in the luminance signal separately, and switch automatically 
between fields and frames. You can select the degree of change detection.

Knob Parameter Adjustment Setting values

1 Clip Reference level for key signal 
generation

–7.31 to +109.59

2 Gain Key sensitivity –100.00 to +100.00
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• Do interpolation in field units.
• Do interpolation in frame units.

For input key signals, you can select from the following three methods.
• Detect changes in the luminance signal separately, and switch automatically 

between fields and frames. You can select the degree of change detection.
• Do interpolation in field units.
• Do interpolation in frame units.

You can also select the number of pixels used in interpolation processing, and 
select the method used to show the picture reduced or expanded.
Further, you can apply an anti-moire filter to reduce the moire patterns created 
by interpolation.

Notes
• Interpolation processing is possible for the following signal formats and 

DME systems.
– MVE-8000A and MKS-6470: 480i/59.94, 576i/50
– MVE-9000: 480i/59.94, 576i/50, 1080i/59.94, 1080i/50, 1080i/60

• The anti-moire filter function is only effective when the MVE-8000A and 
MKS-6470 is used in an HD system.

Selecting an interpolation method for input video signals

1 In the DME menu, select VF6 ‘Input/Output’ and HF3 ‘Process.’ 

2 In the <Video Field/Frame Mode> group, select the interpolation method 
for the video signal.

Adaptive Y/C: Detect changes in the luminance and chrominance 
components of the video signal separately, and switch automatically 
between fields and frames. 

Adaptive Y: Detect changes in the luminance component of the video 
signal separately, and switch automatically between fields and frames.

Field: Do interpolation in field units. This gives natural movement, 
suitable for moving video. 

Frame: Do interpolation in frame units. This gives higher image precision, 
suitable for still pictures. 

3 When you select Adaptive Y/C or Adaptive Y in step 2, set the following 
parameter. 

Knob Parameter Adjustment Setting values

1 Mode Degree of motion detection 1 to 4
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4 In the <Key Field/Frame Mode> group, select the interpolation method for 

the key signal.

Adaptive: Detect changes in the luminance component of the key signal 
separately, and switch automatically between fields and frames.

Field: Do interpolation in field units. This gives natural movement, 
suitable for moving video. 

Frame: Do interpolation in frame units. This gives higher image precision, 
suitable for still pictures. 

5 When you select Adaptive in step 4, set the following parameter. 

6 In the <Interpolation Mode> group, set the number of pixels to use in 
interpolation. 

Multi: Use multi-point interpolation.  This gives higher picture quality. 
Linear: Use two-point interpolation.

7 In the <Filter Mode> group, select the method used to show the picture 
reduced or expanded.

Mode1 (standard): Even when the picture is reduced, add compensation 
so that it can be seen clearly. 

Mode2 (soft): Suppress aliasing when expanding or reducing the picture. 
Mode3 (sharp): Do not surpress aliasing when expanding or reducing the 

picture.

Applying the anti-moire filter
You can reduce the moire patterns created by interpolation when an image is 
enlarged, compressed, or rotated.

Note 
This function is effective only when the HD signal format is used on the MVE-
8000A and MKS-6470.

1 In the DME menu, select VF6 ‘Input/Output’ and HF3 ‘Process.’

The Process menu appears.

2 Press [Anti Moire Filter], turning it on.

Knob Parameter Adjustment Setting values

1 Mode Degree of motion detection 1 to 4
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3 Set the following parameter.

Knob Parameter Adjustment Setting values

1 Anti Moire 
Filter

Amount of moire reduction 1 to 8
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Global Effect Operations

Global effects are special effects created by combining the images of 
successive channels. The Global Effect menu is used to add these effects. The 
following types of global effects are available.

Global effects

Note
The Brick effect is not supported on the MKS-6470.

Operations common to all global effects
In this section, explanations of the operating procedures for individual global 
effects begin with selections from VF1 ‘Ch1 - Ch2’ in the Global Effect menu. 
The following are common operations that you must do prior to selecting from 
this menu.

1 In the device control block, select the target DME channel.

Name Effect/Image

Combiner Automatically combines the selected images when multiple channels are selected on 
one keyer or for one transition.

Brick Creates a rectangular 
parallelepiped from 3 
successive channels.

Shadow Gives the image a shadow.

X

Y
Z

Side V Side H

Height
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2 In the menu control block, press the top menu selection button [GLB EFF], 
then select VF1 ‘Ch1 - Ch2.’

The Global Effect >Ch1 - Ch2 menu appears.

Combiner Settings

When multiple channels are selected on one keyer or for one transition, the 
Combiner automatically combines the selected images. Up to four channels 
can be combined.
You can also control the way in which the combination is carried out, as a mix 
or an overlap with priority set automatically. For a mix, you can control the 
relative amounts of each channel.
Images can also be crossed in three dimensions. 

Notes
• Only channel 1 and 2 can be used on MKS-6470.
• Channel 5 to 8 can be used on MVE-8000A/9000.
• It is not possible to combine channel 1/2 and channel 5 to 8.
• Three-dimensional image crossing is not supported on the MVE-8000A and 

MKS-6470.
• When the Combiner is enabled on the MKS-6470, selecting Int Key as the 

key source of channel 2 prevents the effect of independent key transition to 
be applied to the channel. To apply the effect, select Ext Key as the key 
source of channel 2. For details of the key source, see “Key Source 
Selection” (page 170).

Combination of channel 1 (Ch1) and channel 2 (Ch2)

Ch1

Ch2
Ch1

1

2
1

2
Combiner
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Combination of Ch5, Ch6, and Ch7

Combination of Ch5 and Ch6 / combination of Ch7 and Ch8

Ch1

Ch2
Ch5

Ch8Ch4

5

6

Ch3 7

6 7
5

88

Combiner

Ch1

Ch2
Ch5

Ch3

Ch4

5

6 1 5
6

Ch7
2 87

7

8

Combiner

Combiner
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Combination of Ch5, Ch6, Ch7, and Ch8

Mixing Ch1 and Ch2

If the Mix1 setting is 70, the proportion of the channels in the mixed portion in 
the previous illustration is as shown in the following table.

Mixing Ch5, Ch6, and Ch7

Combination Indication in figure Ch1 Ch2

Ch1 and Ch2 30% 70%

Ch1
Ch5

5

Ch4 8

Ch2 6

Ch3 7

6 7
5

8
Combiner

Ch1

Ch2

1

2

Mix1
Ch1

Ch2

Ch1

Ch2

5

6

Mix1

Ch3 7

Mix2

Ch6

Ch5

Ch7
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If the Mix1 setting is 70 and the Mix2 setting is 40, the proportions of the 
channels in the mixed portions in the previous illustration are as shown in the 
following table.

Pairwise mixing of Ch5 and Ch6, and Ch7 and Ch8

If the Mix1 setting is 70 and the Mix2 setting is 40, the proportions of the 
channels in the mixed portions in the previous illustration are as shown in the 
following table.

Ch1 crossed with Ch2

Combination Indication in figure Ch5 Ch6 Ch7

Ch5 and Ch6 30% 70% –

Ch6 and Ch7 – 60% 40%

Ch5 and Ch7 30% – 70%

Ch5, Ch6, and Ch7 30% 42% 28%

Combination Indication in figure Ch5 Ch6 Ch7 Ch8

Ch5 and Ch6 30% 70% – –

Ch7 and Ch8 – – 60% 40%

Ch1

Ch2

5

6

Mix1
Ch5

Ch6

Ch3

Ch4

7

8

Mix2
Ch7

Ch8

Ch1

Ch2

1

2

Depth
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Setting the combiners
The setting menu differs according to the combiner usage status.
Select how the images for channels 1 and 2 are combined.

1 In the Global Effect >Ch1-Ch2 menu, select HF1 ‘Combiner Priority.’

The Combiner Priority menu appears.

2 If either [Mix] or [Auto] is On, set them to Off.

3 In the <Priority1> group, select the channel you want to be on top. 
Alternatively, in the <Priority2> group, select the channel you want to be 
underneath.

4 For a mix press [Mix], turning it to On.

5 Adjust the following parameter.

This section shows the cases of “Ch5+Ch6+Ch7” and “Ch5+Ch6, Ch7+Ch8” 
as examples.

For details of operating procedures when using an SDI interface, see 
“Procedure for combine operation when using an SDI interface” (page 181).

1 In the Global Effect >Ch1- Ch2 menu, select HF1 ‘Combiner Priority.’ 

The Combiner Priority menu appears. 

2 If [Mix], [Auto] or [Depth] is on, turn it off.

3 Set the overlap priority for “Ch5+Ch6+Ch7” or “Ch5+Ch6, Ch7+Ch8” as 
follows.

For case “Ch5+Ch6+Ch7”
Under <Priority1> to <Priority3>, press [Ch5], [Ch6], and [Ch7], 
respectively, to set the overlap priority.
Priority1: Select the channel with the highest priority. 
Priority2: Select the channel with the second highest priority. 
Priority3: Select the channel with the lowest priority.

Knob Parameter Adjustment Setting values

1 Mix1 Mix degree for channels 1 and 2 0.00 to 100.00
Global Effect Operations



  C
hapter 11 

D
M

E
 O

perations
For case “Ch5+Ch6, Ch7+Ch8”
Under <Combiner 1 Priority 1> and <Combiner 1 Priority 2>, press [Ch5] 
and [Ch6] respectively, and under <Combiner 2 Priority 1> and 
<Combiner 2 Priority 2>, press [Ch8] and [Ch7] respectively, to set the 
respective priorities for overlaying the images.

Procedure for combine operation when using an SDI interface
Use the following procedure only when the DME being used is the MVE-
8000A or MVE-9000 with an SDI interface.

Note
It is not possible to select MVE-8000A or MVE-9000 channels with buttons in 
the key control block and Multifunction Flexi Pad control block.

In the following, the example given is that channels 6 and 7 are combined, then 
channels 5+6 and channels 7+8 are combined, but other combinations are also 
possible.

1 In the Global Effect menu, select VF2 ‘Ch5-Ch8’ and HF7 ‘Combine Gp 
Select.’

The Combine Gp Select menu appears.

2 In the <Combine Gp Select> group, select the channel combination.

Priority1: Ch5
Priority2: Ch6
Priority3: Ch7

Ch5

Ch6

Ch7

Combiner1 Priority1: Ch5
Combiner1 Priority2: Ch6
Combiner2 Priority1: Ch8
Combiner2 Priority2: Ch7

Ch6

Ch5

Ch7

Ch8
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• To combine channels 6 and 7, press [Ch6+Ch7], turning it on.
• To combine the previously combined combinations of channels 5 and 6, 

and channels 7 and 8 press [Ch5+Ch6] and [Ch7+Ch8], turning them on.

Note
The only two buttons that can be selected simultaneously are the 
combination of [Ch5+Ch6] and [Ch7+Ch8].

The selected channels are combined.

To cancel a combine
When for example [Ch6+Ch7] is on, pressing [Ch6+Ch7] once more turns it 
off. Alternatively, pressing a different combination button to select it cancels 
the combine selection for the current combination.

Mixing the images of up to four consecutive channels

1 In the Combiner Priority menu, press [Mix], turning it on.

2 Adjust the following parameters.

For case “Ch5+Ch6”

a) See “Mixing Ch1 and Ch2” (page 178).

For case “Ch5+Ch6+Ch7”

a) See “Mixing Ch5, Ch6, and Ch7” (page 178).

For case “Ch5+Ch6+Ch7+Ch8|
Knobs 1 and 2 set the same parameters as “For case ‘Ch5+Ch6+Ch7’,” 
respectively. Knob 3 is additionally effective, which sets the parameter 
Mix3 (in the same setting value range as with knobs 1 and 2).

Knob Parameter Adjustment Setting values

1 Mix Mix degree 0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Mix1 Mix degree for mix of channel 5 
with result of Mix2

0.00 to 100.00 a)

2 Mix2 Mix degree for channels 6 and 7 0.00 to 100.00 a)
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Mixing pairwise the images of channels 5 and 6, and channels 7 
and 8

1 In the Combiner Priority menu, press [Combiner1 Mix], turning it on.

2 Adjust the following parameter.

a) See “Pairwise mixing of Ch5 and Ch6, and Ch7 and Ch8” (page 179).

3 Press [Combiner2 Mix], turning it on.

4 Adjust the following parameter.

a) See “Pairwise mixing of Ch5 and Ch6, and Ch7 and Ch8” (page 179).

Automatically setting the priority of overlapping images
To set the system so that the priority of overlapping images is automatically 
determined by their position on the z-axis, in the Combiner Priority menu, 
press [Auto], turning it on.

Note
It is not possible to cross images. If an image is rotated, the priority is 
determined by the position on the z-axis of the center of the image.

Crossing images from up to four consecutive channels in three 
dimensions

Note
The three-dimensional crossing function is not supported on the MVE-8000A 
and MKS-6470.

1 In the Combiner Priority menu, press [Depth], turning it on.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Mix1 Mix degree for channels 5 and 6 0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Mix2 Mix degree for channels 6 and 7 0.00 to 100.00 a)
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For case “Ch5+Ch6”

For case “Ch5+Ch6+Ch7”

For case “Ch5+Ch6+Ch7+Ch8”
Knobs 1 and 2 set the same parameters as “For case ‘Ch5+Ch6+Ch7’,” 
respectively. Knob 3 is additionally effective, which sets the parameter 
Soft3 (in the same setting value range as with knobs 1 and 2).

Crossing images from channels 5 and 6, and channels 7 and 8 in 
three dimensions

Note
The three-dimensional crossing function is not supported on the MVE-8000A 
and MKS-6470.

1 In the Combiner Priority menu, press [Combiner1 Depth], turning it on.

2 Set the following parameter.

3 Press [Combiner2 Depth], turning it on.

4 Set the following parameter.

Knob Parameter Adjustment Setting values

1 Soft Softness of edges of crossed 
section

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft1 Softness of edges of channel 5 
and channel 6 crossed section

0.00 to 100.00

2 Soft2 Softness of edges of channel 6 
and channel 7 crossed section

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft1 Softness of edges of channel 5 
and channel 6 crossed section

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft2 Softness of edges of channel 7 
and channel 8 crossed section

0.00 to 100.00
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Brick Settings

The Brick effect can combine Ch5, Ch6, and Ch7, or combine Ch6, Ch7, and 
Ch8. The three images are displayed as shown in the following figure.

Combinations of Ch5, Ch6, and Ch7
Upper side: Ch5 image
Side V: Ch6 image
Side H: Ch7 image

Combinations of Ch6, Ch7, and Ch8
Upper side: Ch6 image
Side V: Ch7 image
Side H: Ch8 image

You can adjust the height of the brick, the overlap between the three images
and the way to insert the side images.

Applying the Brick effect

1 In the Global Effect >Ch5 - Ch8 menu, select HF2 ‘Brick.’

The Brick menu appears.

2 Press [Brick], turning it on.

The Brick effect is enabled, and a rectangular parallelepiped (brick) 
showing the images of three channels appears. You can use the knobs to 
adjust parameters for the height of the brick and the overlap between the 
three images.

X

Y
Z

Side V Side H

Height
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Notes
• When the Brick effect is enabled, the z-axis position of the front image 

in the source coordinate frame is shifted by the amount of half the height. 
Therefore, the image is somewhat magnified.

• The flex shadow function cannot be enabled when Brick is enabled. 
However, the flex shadow function is not supported on the MVE-8000A 
and MKS-6470.

3 Set the parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

4 Specify the way to insert the side images when the height is changed by 
pressing one of the following buttons in the <Side V> group or the <Side 
H> group.

Crop: Crop the parts that do not fit into the side without shrinking the 
picture. You can set the following parameters. 
The valid ranges of the parameter values depend on the combination 
of signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the 
system, as follows.

• 4:3 mode

• 16:9 mode

Knob Parameter Adjustment Setting values

1 Height Height of brick 0.00 to 8.00 a)

0.00 to 32.00 b)

2 Front Overlap Front overlap –100.00 to +100.00

3 Side H Overlap Side H overlap –100.00 to +100.00

4 Side V Overlap Side V overlap –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 H Position of left crop –4.00 to +4.00 (SD)
–12.00 to +12.00 (HD)

2 V Position of top crop –3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

3 Rotation Angle of rotation, when rotated 
around the Z-axis of the source 
space

0/90/180/270°

Knob Parameter Adjustment Setting values

1 H Position of left crop –4.00 to +4.00 (SD)
–16.00 to +16.00 (HD)
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The set position becomes the upper left corner of Side V or Side H. The 
right and bottom sides of the inserted image are set automatically.

Compress: Images are inserted after being compressed. You can set the 
following parameters.
The valid ranges of the parameter values depend on the combination 
of signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the 
system, as follows.

• 4:3 mode

• 16:9 mode

The part of the image defined by Top, Left, Right, and Bottom is magnified 
or shrunk to fit into Side V or Side H.

2 V Position of top crop –2.25 to +2.25(SD)
–9.00 to +9.00 (HD)

3 Rotation Angle of rotation, when rotated 
around the Z-axis of the source 
space

0/90/180/270°

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Top Position of top crop –2.83 to +3.00 (SD)
–8.50 to +9.00 (HD)

2 Left Position of left crop –4.00 to +3.83 (SD)
–12.00 to +11.50 (HD)

3 Right Position of right crop –3.83 to +4.00 (SD)
–11.50 to +12.00 (HD)

4 Bottom Position of bottom crop –3.00 to +2.83 (SD)
–9.00 to +8.50 (HD)

5 Rotation Angle of rotation, when rotated 
around the Z-axis of the source 
space

0/90/180/270°

Knob Parameter Adjustment Setting values

1 Top Position of top crop –2.12 to +2.25 (SD)
–8.50 to +9.00 (HD)

2 Left Position of left crop –4.00 to +3.87 (SD)
–16.00 to +15.50 (HD)

3 Right Position of right crop –3.87 to +4.00 (SD)
–15.50 to +16.00 (HD)

4 Bottom Position of bottom crop –2.25 to +2.12 (SD)
–9.00 to +8.50 (HD)

5 Rotation Angle of rotation, when rotated 
around the Z-axis of the source 
space

0/90/180/270°
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To invert the image in a side face
For example, to invert the image on the front of Side H in the <Side H Front>
group, press the following buttons, turning them on.
Invert H: To invert horizontally.
Invert V: To invert vertically.

For the images on the other faces, use a similar operation in the following
groups:
• Back image of Side H: <Side H Back> group
• Front image of Side V: <Side V Front> group
• Back image of Side V: <Side V Back> group

Shadow Settings

The effect uses two successive channels. You can adjust the position and 
density of the shadow with respect to the image, and the color of the shadow. 
The channel with the largest number (for example, Ch2 in the case of Ch1 and 
Ch2) becomes the shadow.

Note 
When the Combiner function is off, the shadow effect cannot be used.

Top side

Side V

Actual size, upper left corner

Set automatically

Cropped region

Crop Compress

Magnified or 
shrunk to fitSide 

H
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Applying the Drop Shadow effect

The Shadow menu allows you to apply the Drop Shadow effect. To access the 
Shadow menu, in the Global Effect>Ch1 - Ch2 (Ch5 - Ch8) menu select HF3 
‘Shadow.’
Depending on the selected combiner channels, the valid buttons differ as 
follows.

a) Inc.: Incorporated DMEs
b) Ext.: External DMEs
Taking Ch1 Shadow as an example, the following explains the procedure for 
applying the Drop Shadow effect.

1 Press [Ch1 Shadow], turning it on.

The Drop Shadow effect is enabled, and channel 2 becomes the channel for 
the shadow to the image. You can adjust the position and density of the 
shadow with the knobs.

Note
The flex shadow function cannot be enabled when Drop Shadow is 
enabled. 
However, the flex shadow function is not supported on the MVE-8000A 
and MKS-6470.

2 Set the parameters.

a) Setting for SD 4:3, SD 16:9

Type Combiner channel 
selection

Button

Ch1 
Shadow

Ch5 
Shadow

Ch6 
Shadow

Ch5+Ch6 
Shadow

Ch6+Ch7 
Shadow

Inc. a) Ch1+Ch2 Valid

Ext. b) Ch5+Ch6 Valid

Ch6+Ch7 Valid

Ch5+Ch6+Ch7 Valid Valid Valid

Ch6+Ch7+Ch8 Valid Valid Valid

Ch5+Ch6+Ch7+Ch8 Valid Valid Valid

Knob Parameter Adjustment Setting values

1 Position H Horizontal shadow position –8.00 to +8.00 a)

–32.00 to +32.00 b)

2 Position V Vertical shadow position –8.00 to +8.00 a)

–32.00 to +32.00 b)

3 Density Density of shadow 0.00 to 100.00
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190
b) Setting for HD 4:3, HD 16:9

3 In the <Ch1 Shadow Source> group, select the shadow source signal. 

Video: Select Ch2 video input as the shadow. 
Flat Color: Select a matte color as the shadow. 

4 When you select Flat Color in step 3, adjust the parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
Global Effect Operations
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Control of External Devices

In this system, you can operate while controlling the following types of 
external device:
• Devices supporting P-Bus (Peripheral II protocol) (referred to as “P-Bus 

devices” in the manual)
• Devices supporting GPI
• VTRs
• Disk recorder (Sony disk 9-pin protocol and video disk communications 

protocol)
• Extended VTR (Abekas A53 protocol)

For details on the devices that can be connected, consult your Sony 
representative.

Use the Device menu to carry out operations for controlling above external 
devices.

To access the Device menu
In the menu control block, press the top menu selection button [DEV].

For VTRs, Extended VTRs, and disk recorders, you can also carry out 
operations using the device control block.

Notes
• To operate P-Bus devices, VTRs, Extended VTRs, and disk recorders in the 

this system, the following settings are required on the DCU 9-pin serial port.
– Device type setting
– Device name
– Setting of control panel (SCU) to be used

For details of the settings, see “Making Serial Port Settings” in Chapter 22 
(Volume 3).

• When using a disk recorder or Extended VTR, be sure to go to the Device 
>DDR/VTR >File List menu, and recall the file.

For details of the operation, see “Recalling a file” (page 229).
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Shared Functions for External Device Control

Keyframe functions
There are 99 registers, numbered 1 to 99, holding external device control data 
as keyframe data.
The following are the keyframe functions that can be used.
• RECALL (1-99), STORE (1-99), RECALL UNDO, STORE UNDO, empty 

register search, AUTO SAVE, RECALL MODE (RECALL, RECALL & 
REWIND)

• EDIT ENABLE, EDIT UNDO
• CONST DUR, EFF DUR, KF DUR, DELAY, PAUSE, INSERT BEFORE, 

INSERT AFTER, MODIFY, DELETE, COPY, PASTE BEFORE, PASTE 
AFTER, FROM TO, ALL

• PREV KF, NEXT KF, GOTO TC, GOTO KF, RUN, REWIND, FF, STOP 
NEXT KF, NORMAL, JOG, KF FADER

Note 
Actions set in a keyframe are executed only when the keyframe effect is 
executed in the normal direction. Take care when executing simultaneously 
with a switcher or DME keyframe effect, since the actions are not executed in 
the reverse direction.

The following keyframe functions cannot be used.
• KF LOOP, EFFECT LOOP, REVERSE, NORMAL/REVERSE
• PATH

Saving to registers
Set the data for controlling external devices in the Device menu. You can save 
the set data in keyframe, snapshot, or shotbox registers. You can recall the 
register in which the data is saved, and carry out operations on it with the 
keyframe control block.

Editing registers
You can carry out the following operations on the registers in which the data 
for controlling external devices is saved.
• Copy
• Move
• Swap
• Merge (this cannot be carried out for registers holding VTR, disk recorder, 

or Extended VTR control data.)
• Lock
• Name
193Control of External Devices
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File related functions
As effect data, you can save and recall, using the File menu.
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Control of P-Bus Devices

You can control P-Bus devices from this system through the 9-pin serial port 
of a DCU.

P-Bus device control modes
There are two modes of P-Bus device control, as follows.
Trigger: Operating a previously specified button outputs the command for an 

action assigned to that button.
Timeline: Carrying out a keyframe effect under the control of the center 

control panel controls external devices.

In the setup, select which of Trigger mode and Timeline mode to use.
You can set the following actions (set what action command is output to which 
device) in both modes.
• Store
• Recall
• Trigger

Creating and Editing the P-Bus Timeline

At a keyframe point on the P-Bus timeline, you can set an action. At any single 
keyframe point you can set actions for a maximum of 24 devices.

For details of keyframe creation and editing operations, see “Creating and 
Editing Keyframes” (page 269).

For the action setting (or P-Bus timeline editing), use the Device menu.
You can save the data set in the Device menu in keyframe effect registers. 
Recalling the register starts execution of the keyframe effect, and when this 
reaches the keyframe point at which actions are set, action commands are 
output to external devices through the 9-pin serial port assigned to P-Bus.

Note
Using the P-Bus timeline function requires the P-Bus control mode to be set to 
[Timeline]. Carry out this setting in the Engineering Setup >Panel >Device 
Interface menu. (For details, see “Setting the Control Mode for P-Bus 
Devices” in Chapter 19 (Volume 3).)
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Setting an action

1 In the Device menu, press VF2 ‘P-Bus Timeline.’

The Device >P-Bus Timeline menu appears.
The status area shows two lists. The left list is for setting combinations of 
devices and actions. The settings in this list will be saved as keyframe point 
data. The right list is for selecting the action.

2 Select the P-Bus device for which you want to set an action, by using any 
of the following methods to specify the device ID.

• Press directly on the list on the left of the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

3 Using either of the following methods, select the action.

• Press directly on the list on the right of the status area.
• Turn the knob.

a) 1: Off (no specification)
2: Store
3: Recall
4: Trigger

4 If in step 3 you selected 2 (Store), 3 (Recall), or 4 (Trigger), turn knob 3 to 
select the register number or trigger number.

The indication for knob 3 changes to reflect the selection of Store, Recall, 
or Trigger.

The setting is reflected in the list on the right of the status area.

5 Press [Set].

For the device selected in the list on the left of the status area, this sets the 
action specified in step 4.

Knob Parameter Adjustment Setting values

1 ID Device number 0 to 23

Knob Parameter Adjustment Setting values

2 Action No Action 1 to 4 a)

Knob Parameter Adjustment Setting values

3 Store No Register number for Store 1 to 99

3 Recall No Register number for Recall 1 to 99

3 Trigger No Trigger number 0 to 15
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Repeat steps 2 to 5 as required for other devices.

Testing an action command
To produce a test output of the action command, press [Test Fire].
The action command is output from the 9-pin serial port of the DCU according 
to the setting in the list on the left of the status area.

Clearing an action setting

To clear the setting for separate devices

1 In the list on the left of the status area, select the device for which you want 
to clear the action setting.

2 In the list on the right, select “Off.”

3 Press [Set].

To clear the action settings for all devices in a single operation
Press [All Off].

Setting the action for a rewind operation
On the P-Bus timeline, when the [REWIND] button in the keyframe control 
block is pressed the action set for the first keyframe is not executed; when the 
[RUN] button is pressed, then the first keyframe action is executed.
To execute an action when the [REWIND] button is pressed, it is necessary to 
set this action (Rewind Action). To carry out this setting, in the Device >P-Bus 
Timeline menu, press [Rewind Action] to recall the Rewind Action menu. In 
this setting screen, use the same setting method as in the screen for setting an 
action on the P-Bus timeline.

Alternatively, you can select the reverse arrangement, whereby when the 
[REWIND] button is pressed, this executes the action set for the first keyframe, 
and when the [RUN] button is pressed the first keyframe action is not executed. 
In this case, the Rewind Action setting is still valid.

For details of the setting, see “Setting the First Keyframe When a Rewind Is 
Executed” in Chapter 19 (Volume 3).

Carrying out a Direct Store
You can carry out a Learn with the register number specified for the device 
selected in the menu. 
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1 Using any of the following methods, select the device.

• Press directly on the list on the left of the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

2 In the Device >P-Bus Timeline menu, press [Direct Store].

The numeric keypad window appears.

3 Enter the register number for which you want to carry out the Learn.
The setting range is from 1 to 99.

4 Press [Enter].

This carries out a Learn with the specified register number.

P-Bus Trigger

“P-Bus trigger” is a function whereby a button operation in the numeric keypad 
control block or keyframe control block outputs an action command to a P-Bus 
device.

Note
To use the P-Bus trigger function, the P-Bus control mode must be set to 
[Trigger]. Make this setting in the Engineering Setup >Panel >Device Interface 
menu. (For details, see “Setting the Control Mode for P-Bus Devices)” in 
Chapter 19 (Volume 3).)

The relation between the operation in each of the control blocks and the action 
command output is as follows.

Action command for an operation in the numeric keypad control 
block or Multifunction Flexi Pad control block
• RECALL: Recall
• STORE: Store
This recalls the register specified in the numeric keypad control block, and a 
Recall or Store is carried out, according to the setting.

Action command for an operation in the keyframe control block or 
Multifunction Flexi Pad control block
• RUN: Trigger 1

Knob Parameter Setting Setting values

1 ID Device ID 0 to 23
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• REWIND: Trigger 4
• NEXT KF: Trigger 7
• PREV KF: Trigger 8

Outputting an action command
As an example, to output a Recall, use the following procedure.

1 In the numeric keypad control block, press the [EFF] button, turning it on.

The [RCALL] button in the numeric keypad control block lights.

2 Press the [P-BUS] button in the numeric keypad control block, turning it 
on, to select the P-Bus region.

3 Enter the number of the register to be recalled with the numeric keypad 
buttons.

4 Press the [ENTER] button in the numeric keypad control block.

This carries out the Recall.
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Control of GPI Devices

You can control GPI devices from the control panel of this system, or through 
the GPI output port of a DCU.

GPI timeline
For a keyframe effect controlled from the center control panel, the GPI timeline 
allows you to set an action (setting a trigger output from a particular GPI output 
port) at a keyframe point on the GPI timeline. At any keyframe point, you can 
make a maximum of eight GPI output port settings.

GPI timeline actions
The actions that can be used on the GPI timeline are as follows.
• Control panel GPI output port
• DCU GPI output port
For the GPI output settings (keyframe editing), use the Device menu.
The data set in the Device menu are saved in a keyframe effect register. When 
you recall this register and start execution of the keyframe effect, and advance 
the effect to the keyframe point for which the GPI output is set, a trigger pulse 
is output to the external device from the specified GPI output port.

GPI Timeline Creation and Editing

This section describes how to set GPI output ports to be registered at a 
keyframe point, and how to carry out creation and editing of the GPI timeline.

For details of keyframe creation and editing operations, see “Creating and 
Editing Keyframes” (page 269).

GPI output port settings
Set the GPI output port number of the control panel or DCU which outputs GPI 
pulses at a keyframe point on the GPI timeline.
Use the following procedure. (Use the same procedure to subsequently change 
the settings.)

1 In the Device menu, press VF1 ‘GPI Timeline.’

The Device >GPI Timeline menu appears.
The status area shows the “GPI Output” list on the left and the “GPI Port” 
list on the right.
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The “GPI Output” list (on the left) shows the relation between ports 1 to 8 
for the GPI timeline and the trigger pulse output destination ports. The 
content of this list is saved as keyframe data.
The “GPI Port” list (on the right) is for selecting the GPI trigger pulse 
output destination.

2 Using either of the following methods, select the GPI timeline port you 
want to set on the GPI Timeline.

• Press directly on the list on the left of the status area.
• Turn the knob.

3 Using either of the following methods, trigger output destination.

• Press directly on the list on the right of the status area.
• Turn the knob.

a) 1: Off (no specification)
2: Control panel (SCU) GPI port
3: DCU GPI port 

4 If in step 3 you selected 2 (SCU) or 3 (DCU), then use the knob to select 
the port number.

The indication for knob 3 depends on whether SCU or DCU is selected.

a) The number of DCU GPI ports depends on the settings in Engineering Setup.

The setting is reflected in the list on the right of the status area.

Note
For the output port you have set here, be sure to set the trigger type  to 
“Rising Edge,” “Falling Edge” or “Any Edge.” 

For details of the trigger type settings, see “Making Control Panel GPI 
Output Settings” in Chapter 19 (Volume 3) and “Making DCU GPI 
Output Settings” in Chapter 22 (Volum 3).

Knob Parameter Setting Setting values

1 GPI Output No GPI timeline port number 1 to 8

Knob Parameter Setting Setting values

2 GPI Port No SCU/DCU GPI port to be the 
trigger output destination

1 to 3 a)

Knob Parameter Setting Setting values

3 SCU Port No SCU GPI port number 1 to 8

3 DCU Port No DCU GPI port number 1 to 50 a)
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5 Press [Set].

This specifies the SCU/DCU GPI port whose number you specified in step 
4 as the pulse output destination for the GPI output port selected in the list 
on the left of the status area.

Repeat steps 1 to 5 for other GPI output ports as required.

Testing trigger output
To test the trigger output, press [Test Fire].
According to the list settings on the left of the status area, a pulse is output from 
the selected output port.

Clearing output port settings

To clear the settings for each device (GPI output port)

1 In the list on the left of the status area, select the GPI output port whose 
settings you want to clear.

2 In the list on the right, select “Off.”

3 Press [Set].

To clear the settings for all devices (GPI output ports) in a single 
operation
Press [All Off].

Setting the action for a rewind operation
On the GPI timeline, when the [REWIND] button in the keyframe control 
block (or Flexi Pad control block, or Multifunction Flexi Pad control block) is 
pressed the action set for the first keyframe is not executed; when the [RUN] 
button is pressed, then the first keyframe action is executed.
To execute an action when the [REWIND] button is pressed, it is necessary to 
set this action (Rewind Action). To carry out this setting, in the Device >GPI 
Timeline menu, press [Rewind Action] to recall the Rewind Action menu. In 
this setting screen, use the same setting method as in the screen for setting an 
action on the GPI timeline.

Alternatively, you can select the reverse arrangement, whereby when the 
[REWIND] button is pressed, this executes the action set for the first keyframe, 
and when the [RUN] button is pressed the first keyframe action is not executed. 
In this case, the Rewind Action setting is still valid.
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For details of the setting, see “Setting the First Keyframe When a Rewind Is 
Executed” in Chapter 19 (Volume 3).
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Control of VTRs, Extended VTRs, and Disk 
Recorders

In this system, for up to 12 VTRs, disk recorders or Extended VTRs connected 
to a DCU, you can carry out the following manual operations and timeline 
settings.
• Controlling manually from the device control block (trackball or search dial)
• Saving a start point, stop point, start delay time, variable speed and so on in 

a data register, then recalling the register to control automatically from the 
keyframe control block. (Cueup & Play and VTR/disk recorder/Extended 
VTR timeline)

• In the Device menu, you can check the following VTR, disk recorder and 
Extended VTR information:
– Device name
– Register number
– VTR/disk recorder/Extended VTR status
– Current time
– Start point
– Stop point
– Variable speed
– Start delay time
– Loop setting
– Recue setting

To control a VTR, Extended VTR, or disk recorder in this system, the 
following settings are required.
• Button assignment: For a VTR, Extended VTR, or disk recorder connected 

to the DCU 9-pin serial port, assign a device selection button in the device 
control block.

• Timecode source: When using a VTR, specify a reference signal used for 
determining the tape position.

For details, see “Making DCU Serial Port Settings” in Chapter 19 (Volume 3) 
and “Making Detailed Settings on the External Device Connected to the Serial 
Port” in Chapter 22 (Volume 3).

Manual Operation

In the device control block, you can carry out the following operations 
manually.
• VTR, disk recorder or Extended VTR selection
Control of VTRs, Extended VTRs, and Disk Recorders
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• Tape transport and disk drive control: You can use the following tape 

transport and disk drive control buttons:
REC, REW, PLAY, FF, CUE UP, VAR PLAY, SHTL, JOG, STANDBY 
OFF, STOP, and ALL STOP. (For details of the operation of the buttons, 
see “Device Control Block (Trackball)”, “Device Control Block 
(Joystick)” and “Device Control Block (Search Dial)”.)

Depending on the settings made in the Setup menu, the CUE UP, PLAY and 
STOP operations can be carried out from the transition control block. (For 
details of the operation of the buttons, see “Transition Control Block 
(Standard Type)” and “Transition Control Block (Compact Type)” in 
Chapter 2 “Menus and Control Panel” (Volume 1).

• Setting a start point: For each selected VTR/disk recorder/Extended VTR  
you can set the start point timecode value as keyframe data.

• Setting a stop point: For each selected VTR/disk recorder/Extended VTR  
you can set the stop point timecode value as keyframe data.

• Setting a start delay time: For each selected VTR/disk recorder/Extended 
VTR you can set the start delay as key frame data.

• Recording to VTR or disk recorder: Record video to the selected VTR/
disk recorder.

• Loop/recue a) setting: You can select loop or recue as the playback mode. 
These operate as follows.
When loop is selected: Playback repeats from the start to the end of the 

currently recalled file.
When recue is selected: When playback reaches the stop point, 

automatically cue up to the start point.

a) EVS XT server (EVS Broadcast Equipment) dedicated function

Controlling the Tape/Disk Transport

To switch to VTR/disk recorder operation mode
To control a VTR/Extended VTR/disk recorder with the device control block 
(trackball) or device control block (joystick), press the [DEV] button in the 
device control block, turning it on, to switch the device control block to the 
VTR/disk recorder operation mode. The button assignment changes as follows 
(the [SHIFT] button is disabled in VTR/disk recorder operation mode).
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Device control block in the VTR/disk recorder operation mode (trackball module)

In the device control block (search dial module), there is no such a mode 
selection button and you can directly select a device.

Buttens used when the VTR/disk recorder/frame memory 
operation mode is enabled

DELAY: Press this button, turning it on, to enter a delay value from the 
numeric keypad control block.

STB OFF (standby off): Press this button to switch to standby off mode. This 
button cannot be used for frame memory clip operations.

REC (record): Press this button at the same time as the [Y] button to start  
recording. This button cannot be used for frame memory clip operations.

STOP: Press this button to stop the tape, disk or frame memory clip.
START TC (start timecode): Press this button to set the timecode of the start 

point at that time. The timecode of the start point is updated to the current 
time each time this button is pressed.
When the device the operation applies to is a VTR/disk recorder, the start 
point updated by the setting of the [MENU] button is as follows.
When the [MENU] button is On: start point of the timeline
When the [MENU] button is Off: start point of Cueup & Play

STOP TC (stop timecode): Press this button to set the timecode of the stop 
point at that time. The timecode of the stop point is updated to the current 
time each time this button is pressed.
When the device the operation applies to is a VTR/disk recorder, the stop 
point updated by the setting of the [MENU] button is as follows.

DEVDEV1

DEV5

DEV9

MENU

DEV2

DEV6

DEV10

DEV3

DEV7

DEV11

REW

DEV4

STOPDELAY REC

DEV8

DEV12

VAR SHTL JOG

PLAY FFCUESHFT

STB
OFF

START
TC

STOP
TC

ALL
STOP

FM
LOOP

FM1
CLIP

FM2
CLIP
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When the [MENU] button is On: stop point of the timeline
When the [MENU] button is Off: stop point of Cueup & Play

VAR (variable speed playback): Pressing this button and turning the Z-ring 
plays back the tape, disk or frame memory clip at a variable speed and 
direction proportional to the rotation angle of the Z-ring. The variable 
speed range is –1 to +3 times normal playback speed.

SHTL (shuttle): Pressing this button and turning the Z-ring plays back the 
tape, disk or frame memory clip at a speed and direction proportional to the 
rotation angle of the Z-ring.

JOG: Pressing this button and turning the Z-ring plays back the tape, disk or 
frame memory clip at a speed and direction proportional to the rotation of 
the Z-ring.

CUE: Pressing this button cues the tape, disk or frame memory clip 
automatically to the start point.

REW (rewind): Press this button to rewind the tape, disk or frame memory 
clip.

PLAY: Press this button to play the tape, disk or frame memory clip.
FF: Press this button to fast forward the tape, disk or frame memory clip.
ALL STOP: Press this button to stop all tape transport/disk drive/frame 

memory operations.

Selecting a VTR/Extended VTR/disk recorder
To select the VTR/Extended VTR/disk recorder to be controlled, in the device 
selection buttons of the device control block, press a selection of those buttons 
turning them on.

For details on frame memory clip operations, see “Frame Memory Clip 
Operations” in Chapter 7 (Volume 1).

Controlling the tape/disk transport
Using the buttons in the device control block, you can control the tape transport 
or the disk transport.

For more details of the effect of buttons in VTR/disk recorder operation mode, 
see “Device Control Block (Trackball),” “Device Control Block (Joystick)” 
and “Device Control Block (Search Dial)” in Chapter 2 “Menus and Control 
Panel” (Volume 1).

If an appropriate setup setting has been made, VTR, Extended VTR, or disk 
recorder can also be operated with the transition control block (standard type 
or compact type).

For more details of the effect of buttons in VTR/disk recorder operation mode, 
see “Transition Control Block (Standard Type)” and “Transition Control 
Block (Compact Type)” in Chapter 2 “Menus and Control Panel” (Volume 1).
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For details of settings in setup, see “Setting VTR Operation Button 
Assignment” in Chapter 19 (Volume 3).

Controlling the tape/disk transport with the search dial
With the device control block, you can play back the material on an external 
device in variable speed.
This section describes the three playback modes, taking the device control 
block (search dial) as an example.
If you turn this dial during video playback, the direction and speed of playback 
depend on the direction and angle of rotation. To use this dial, press the 
[ENBL] button to the upper right of the dial, lighting it amber. This dial has 
three operation modes: jog, shuttle, and variable.
To prevent overheating, if the search dial is on continuously for 10 seconds, it 
is automatically turned off. However, in this state, if a movement of the dial is 
detected, it switches on again.

Jog mode
Press the [JOG] button, lighting the button amber, to switch the dial to jog 
mode. In this mode, you can advance material frame by frame at a speed 
proportional to the rotation angle of the dial. To show a still image, stop turning 
the search dial.

Shuttle mode
Press the [SHTL] button, lighting the button amber, to switch the dial to shuttle 
mode. In this mode, the playback speed varies in steps according to the rotation 
angle of the dial, to a maximum of 50 times normal. If the valid angle is 
exceeded, the dial makes a clicking sound. To show a still image, return the dial 
to the home position, where it stops with a clicking sound.

Reverse direction Forward direction
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Variable mode
Press the [VAR] button, lighting the button amber, to switch the dial to variable 
mode. In this mode, the playback speed varies according to the rotation angle 
of the dial from –1 to +3 times normal speed. The dial indicates the positions 
where the playback speed is –1 times normal speed, +1 times normal speed, 
and +3 times normal speed by making a clicking sound at those positions. To 
show a still image (playback speed 0%), return the dial to its home position, 
where it stops with a clicking sound.

×–1: –1 times normal speed
×+3: +3 times normal speed
×+1: +1 times normal speed

To disable the search dial and end variable mode, press the [STOP] button. 
Additionally, pressing any of the [REW], [PLAY], [FF], [STB OFF], and 
[ALL STOP] editing buttons ends the variable mode. For shuttle mode and 
variable mode, you can set the valid range of the operating angle in the 
Engineering Setup >Panel >Operation >Sensitivity menu to either of the 
followings.

Narrow operating angle
• Shuttle mode: approx. –150 to +150°
• Variable mode: approx. –120 to +210°(+1 times normal speed is +120°)

Reverse direction Forward direction

Low 
speed

Low 
speed

Maximum 
speed

Maximum 
speed

Still image 

Reverse direction Forward direction

Low 
speed

Low 
speed

×–1

Still image 

×+1
×+3
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Wide operating angle
• Shuttle mode: approx. –180 to +180°
• Variable mode: approx. –200 to +348°(+1 times normal speed is +200°)

Recording to VTRs and disk recorders
You can record to the VTR or disk recorder selected in the device control 
block. Proceed as follows.

Notes
• Recording is not possible if the VTR or disk recorder is not set to Recorder. 
• The disk recorder type must be specified to use the video disk 

communications protocol.

See “Making Detailed Settings on the External Device Connected to the 
Serial Port” in Chapter 22 (Volume 3) for more information about how to 
make this setting.

• When using a disk recorder, recording is not possible unless a new file name 
is specified.

See “Creating new files” (page 230) for more information about how to 
specify file names. 

1 Using the buttons of the device control block, select the VTR or disk 
recorder to which you want to record. 
You can select more than one button.

The first button pressed lights green to indicate the reference device, and 
the subsequent buttons light amber. 

2 While holding down the [REC] button in the device control block, press 
the [PLAY] button.

Recording starts. During recording, the [REC] button lights red and the 
[PLAY] button lights amber.

Note
Note the following points about recording to a disk recorder.
• The maximum length of time that can be recorded in one operation is 30 

minutes.
• If you want to record to a different file than the file used in the previous 

recording, use the Device >DDR/VTR >File List menu to create a new 
file. 

• If you resume recording without executing [Unload] from the Device 
>DDR/VTR >File List menu, recording starts at the position in the same 
file where recording was interrupted. 
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To stop recording 
Press the [STOP] button or the [ALL STOP] button in the device control block. 

Checking VTR/Disk Recorder/Extended VTR 
Information

You can check the VTR/disk recorder/Extended VTR information (timecode 
information and operating status) set in the device control block, in the Device 
menu display.

To check the VTR/disk recorder/Extended VTR information, press VF3 ‘VTR’ 
and HF1 ‘Cueup & Play’ or HF2 ‘Timeline’ in the Device menu.
The Device >DDR/VTR >Cueup & Play menu or Device >DDR/VTR 
>Timeline menu appears, and a list shows the timecode information and 
operating status for each device. The columns of the list show the following 
information.

DEV (device name): DEV1 to DEV12 represent respectively device 1 to 
device 12.

Reg (register): Number of the register to which settings apply.
Status: Status of each device. The meaning of the indications is as follows.

Operating 
status display

When VTR, Extended VTR, or 
Sony disk 9-pin protocol is 
used

When video disk 
communications protocol is 
used 

XXXX Communications with the 
device are being carried out 
normally, but status information 
is not received.

Not communicating, or 
communicating but the device 
type cannot be read.

Local The REMOTE/LOCAL switch 
of the device is set to LOCAL.

Port is not open.

Tape Out No tape is loaded (VTR).
No file loaded. (Sony disk 9-pin 
protocol or Extended VTR)

No file loaded.

Rec Recording. Recording.

Cue> Cueing up in the forward 
direction.

—

Cue< Cueing up in the reverse 
direction.

—

Eject Ejecting cassette. —

Stb Off Stopped in standby off mode. —

Stop Stopped in standby on mode. Stopped.

Play Playing. Playing.
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Current: Shows timecode for current device position.
Start TC: Shows timecode for start point set on device.
Stop TC: Shows timecode for stop point set on device.
Variable: Shows the variable speed set for each device.
Delay: Shows start delay time set on device.
Mode: Shows operation mode (Loop or Recue) set for the device (only when 

the EVS XT server is operated with video disk communications protocol).

Cueup & Play

You can use the device control block or Device menu to save Cueup & Play 
settings (start point timecode, stop point timecode, start delay time, and so on) 
for a VTR, disk recorder or Extended VTR in an effect register. By recalling 
this register, you can operate the following buttons in the keyframe control 
block to automatically control the VTR, disk recorder or Extended VTR.
[REWIND] button: Cue up to the start point timecode
[RUN] button: Play
With this function you can also stop the VTR, disk recorder or Extended VTR 
used for playback at the stop point timecode recalled from the same register.

Disk recorder (video disk communications protocol) operation 
when loop /recue is set
When loop is set: playback repeatedly between the start point and stop point.

FF Fast forwarding. —

Rewind Rewinding. —

Shtl> Playing in the forward direction 
in shuttle mode.

—

Shtl< Playing in the reverse direction 
in shuttle mode.

—

Var> Playing in the forward direction 
in “variable” mode.

Playing in the forward direction 
in “variable” mode.

Var< Playing in the reverse direction 
in “variable” mode.

Playing in the reverse direction 
in “variable” mode.

Jog> Playing in the forward direction 
in jog mode.

Playing in the forward direction 
in jog mode.

Jog< Playing in the reverse direction 
in jog mode.

Playing in the reverse direction 
in jog mode.

Still Playing still image. —

Operating 
status display

When VTR, Extended VTR, or 
Sony disk 9-pin protocol is 
used

When video disk 
communications protocol is 
used 
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When recue is set: when playback reaches the stop point, automatically cue 

up to the start point.

Notes
• In an effect register set on the VTR/disk recorder timeline, Cueup & Play 

settings are not possible. To add Cueup & Play settings to such a register, 
first clear the VTR/disk recorder timeline setting before carrying out the 
operation.

• When using a disk recorder with Cueup & Play, if you carry out the 
following sequence of operations, the system may freeze on the frame of the 
start point.
1. Press the [RUN] button to play to a point close to the end of a file.
2. Stop playback.
3. Press the [RUN] button once more.
In such cases, first recall a different register, then carry out the following 
sequence:
1. Recall the original register again.
2. Press the [REWIND] button.
3. Press the [RUN] button.

Making and saving settings relating to Cueup & Play

1 Press the [EFF] button in the numeric keypad control block, turning it on.

This assigns the numeric keypad control block to keyframe operations, and 
the [RCALL] button lights.

2 Press the region selection button for the region for which you want to make 
the setting, turning it on.

You can select more than one button.

3 Enter the number of the register to be recalled with the numeric keypad 
buttons.
To search for an empty register, instead of entering a number, press the [.] 
(period) button.

The display shows the register number. A letter “e” or “E” after the number 
indicates the register status, as follows:
e: This register is empty in the selected region.
E: This register is empty in all selectable regions.

4 Press the [ENTER] button.

This recalls the register you selected in step 3.
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5 When using the device control block (trackball) or device control block 
(joystick), press the [DEV] button in the device control block, turning it 
on.

Note
Check that the [MENU] button is not lit. If it is lit, press to turn it off.

6 With the device selection buttons in the device control block, select the 
VTR, Extended VTR, or disk recorder for which you want to make the 
setting.

You can select more than one button.

The first button pressed lights green to indicate the reference region, and 
the subsequent buttons light amber.

7 Set the start point.

• Using the [START TC] button:
Play the VTR, Extended VTR or disk recorder by control from the 
device control block. Find the desired start point, and press the [START 
TC] button at that position.
If using the [START TC] button, each time you press the button the start 
point timecode is overwritten.

• Using the [SET START TC]:
Press the [SET START TC] button in the device control block (search 
dial). 

The display in the numeric keypad control block shows “START TC”. 
Enter the desired timecode from the numeric keypad control block, and 
press [ENTER].

For details of timecode entry, see “Setting the start point and stop point 
with the [SET XX] buttons” (page 216).

• Setting with the Cueup & Play menu:

For details of settings in the Cueup & Play menu, see “Setting the start 
point, stop point, and start delay time in a menu” (page 218).

8 Set the stop point or duration.

When two of the start point, stop point and duration are set, the remaining 
one is automatically determined. For example, if you set the stop point in 
the following procedure, you do not need to enter the value of the duration.
• Using the [STOP TC] button:

Play the VTR, Extended VTR or disk recorder by control from the 
device control block. Find the desired stop point, and press the [STOP 
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TC] button at that point.
If using the [STOP TC] button, each time you press the button the stop 
point timecode is overwritten.

• Using the [SET STOP TC] button of the device control block (search 
dial):
Press the [SET STOP TC] button in the device control block (search 
dial). The display in the numeric keypad control block shows “STOP 
TC.” Enter the desired timecode from the numeric keypad control block, 
and press [ENTER].

• Using the [SET DUR] button of the device control block (search dial):
Press the [SET DUR] button in the device control block (search dial). 
The display in the numeric keypad control block shows “DUR” and the 
current setting. Enter the desired duration from the numeric keypad 
control block, and press [ENTER].

For details of timecode entry, see “Setting the start point and stop point 
with the [SET XX] buttons” (page 216).

• Setting with the Cueup & Play menu:

For details of settings in the Cueup & Play menu, see “Setting the start 
point, stop point, and start delay time in a menu” (page 218).

9 To set a start delay time, press the [DELAY] button in the device control 
block, and enter a value in the numeric keypad control block. 
Alternatively, make the setting in the Device >DDR/VTR >Cueup & Play 
menu.
If no setting is required, continue to step 10.

For details of settings in the Cueup & Play menu, see “Setting the start 
point, stop point, and start delay time in a menu” (page 218).

10Press the [STORE] button, turning it on, in the numeric keypad control 
block.

11Enter the number of the register in which to save the settings.

When overwriting the settings in the register recalled in step 3, continue to 
step 12 without changing the displayed register number.

12Press the [ENTER] button.

This saves the settings in the register.
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Automatically cueing up and playing VTR/Extended VTR/disk 
recorder

By recalling a register in which you have saved setting data for Cueup & Play, 
you can control the VTR/Extended VTR/disk recorder automatically in the 
same way as when automatically executing a keyframe effect.

1 In the numeric keypad control block, press the [EFF] button, turning it on.

The [RCALL] button in the numeric keypad control block lights.

2 With the region selection buttons in the numeric keypad control block, 
select the region.
You can select more than one button.

3 Enter the number of the register to be recalled with the numeric keypad 
buttons.

4 Press the [REWIND] button in the keyframe control block.

The VTR/Extended VTR/disk recorder automatically advances to the 
timecode value set as the start point.
While the VTR/Extended VTR/disk recorder is operating, the [ALL 
STOP] button in the device control block flashes amber, and when the start 
point is reached lights green.
If the operating VTR/Extended VTR/disk recorder is selected as the 
reference region in the device control block, the [CUE] button also flashes 
and lights in the same way as the [ALL STOP] button. Also, when the start 
point is reached, the [STOP] button lights amber.

5 Press the [RUN] button in the keyframe control block.

The VTR/Extended VTR/disk recorder is now controlled according to the 
keyframe data.

Setting the start point and stop point with the [SET XX] buttons
When you enter a timecode and make a setting with the [SET START TC], 
[SET STOP TC], or [SET DUR] button in the device control block (search 
dial), the timecode display changes as follows. With these buttons you can set 
the start point and stop point timecodes, and the duration (the duration is not 
displayed). When two of these values are set, the remaining one is 
automatically determined.
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Example 1

1 Press the [SET START TC] button, and enter “00000000” from the 
numeric keypad control block.

2 Press the [SET STOP TC] button, and enter “200” from the numeric 
keypad control block. This automatically sets DUR.

3 Press the [SET DUR] button, and enter “–100” from the numeric keypad 
control block.

START TC remains the same, and STOP TC changes.a)

Example 2

1 Press the [SET DUR] button, and enter “200” from the numeric keypad 
control block.

2 Press the [SET STOP TC] button, and enter “01000000” from the numeric 
keypad control block. 

This automatically sets START TC.

3 Press the [SET STOP TC] button, and without entering anything from the 
numeric keypad control block, press [Enter]. 

The STOP TC display, and the START TC display automatically 
calculated in step 2 disappear, and the setting of the DUR does not change.

START TC
STOP TC
(DUR (not displayed) 

00:00:00:00

--:--:--:--

           )

START TC
STOP TC
(DUR

00:00:00:00

00:00:02:00

    0:02:00)

START TC
STOP TC
(DUR

00:00:00:00

00:00:01:00

    0:01:00)

START TC
STOP TC
(DUR

--:--:--:--

--:--:--:--

    0:02:00)

START TC
STOP TC
(DUR

00:59:58:00

01:00:00:00

    0:02:00)
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a) If after pressing the [SET XX] button you press the [ + / – ] button in the numeric keypad 
control block, you can enter offsets from the existing setting values. Each time you press 
this button, the sign of the offset cycles through the settings “ ”(absolute value) t “+” t 
“–”... , and the sign appears in the numeric keypad control block display. If there is no 
existing setting value, then it is only possible to enter an absolute value, and not an offset 
value.

Setting the start point, stop point, and start delay time in a menu
In the Device menu, you can set the start point, stop point, and start delay time.

1 In the Device menu, press VF3 ‘DDR/VTR’ and HF1 ‘Cueup & Play.’

The Device >DDR/VTR >Cueup & Play menu appears.
The status area shows the device number, register number, status 
information, current time, start point, stop point, and start delay time.

2 Using any of the following methods, select the device.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

3 Carry out any of the following operations as required.

• To set the start point, press [Set] in the <Start TC> group.
• To set the stop point, press [Set] in the <Stop TC> group.
• To set the start delay time, press [Set] in the <Delay> group.

A timecode window appears.

4 Set the timecode value for the start point, stop point, or start delay time.

Note
You can enter a start delay time in the range that depends on the signal 
format as follows:

00:00 to 59:nn,
where nn = (number of frames per second) – 1 frame.

5 Press [Enter].

START TC
STOP TC
(DUR

--:--:--:--

--:--:--:--

    0:02:00)

Knob Parameter Adjustment Setting values

1 Dev Device number 1 to 12
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The set start point, stop point, or start delay time is reflected in the status 
area.

Clearing the start point, stop point, and start delay time settings 
in a menu

In the Device menu, use the following procedure.

1 Press VF3 ‘DDR/VTR’ and HF1 ‘Cueup & Play.’

2 Using any of the following methods, select the device for which you want 
to clear the settings.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

3 Carry out any of the following operations as required.

• To clear the start point, press [Clear] in the <Start TC> group.
• To clear the stop point, press [Clear] in the <Stop TC> group.
• To clear the start delay time, press [Clear] in the <Delay> group.

This clears the setting of the start point, stop point, or start delay time.

Selecting Loop or Recue as the playback mode
You can set the device operation mode to loop or recue.
Loop: Carry out playback from the start point of a file to the stop point, then 

indefinitely repeat playback from the start point.
Recue: Carry out playback from the start point of a file to the stop point, then 

return to the start point and stop.

Note
Loop and recue functions are only available when the EVS XT server is 
operated with the video disk communications protocol.

In the Device menu, use the following procedure.

1 Press VF3 ‘DDR/VTR’ and HF1 ‘Cueup & Play.’

The Device >DDR/VTR >Cueup & Play menu appears.

Knob Parameter Setting Setting values

1 Dev Device number 1 to 12
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The status area shows the device number, register number, status 
information, current time, start point, stop point, start delay time, and 
playback mode.

2 Using any of the following methods, select the device.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

3 In the <Mode> group, press [Loop] or [Recue], turning it on.

VTR/Disk Recorder/Extended VTR Timeline

For a keyframe effect controlled from the center control panel, the timeline 
allows you to set a VTR, disk recorder or Extended VTR action at a keyframe 
point on the timeline.

Timeline actions
The actions that can be used on the timeline are as follows.
• Start
• Stop
• Cue up
• Variable speed

Notes
• The timeline does not support loop and recue.
• For a disk recorder, the maximum number of files for a single register is 

eight.

For the action settings (VTR/disk recorder/Extended VTR timeline editing), 
use the Device menu.
The data set in the Device menu are saved in a keyframe effect register. When 
you recall this register and start execution of the keyframe effect, and advance 
the effect to the keyframe point for which the action is set, an action command 
is output to the external device through the 9-pin serial port assigned to the 
VTR, disk recorder or Extended VTR.

Note
When executing a timeline using a disk recorder or Extended VTR, note the 
following points.

Knob Parameter Adjustment Setting values

1 Dev Device number 1 to 12
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• It is not possible to use loop and recue on the timeline.
• When carrying out keyframe settings, be sure to recall the file for operation 

first.
• If the duration of the recorded video clip is less than the keyframe duration, 

after playback to the end of the clip, the remainder of the keyframe duration 
is filled with a still of the last frame of the clip (see figure below).

When executing the timeline using a disk recorder, also take note of the 
following points.
• Set the keyframe duration to at least 30 frames.
• From pressing the [RUN] button to the time when the effect actually starts 

execution may take around one second.
In order that pressing the [RUN] button after [REWIND] make the effect 
start execution as soon as possible, set cueing up of the file for operation as 
rewind operation 1). In the first keyframe 2) to be executed with [RUN], for 
the cued-up file, do not set the start point, but set only the start command.
1) If the setting when the [REWIND] button is pressed is for the first keyframe to be executed, 

then the first keyframe is executed, and otherwise the setting for the Rewind Action is carried 
out.

2) If the setting when the [REWIND] button is pressed is for the first keyframe to be executed, 
then the second keyframe is executed, and otherwise the first keyframe is executed.

• To execute an effect, be sure to carry out a Rewind.
For example, when the start command only is set for a keyframe, playback 
starts from the current position, in the same way as with a VTR (no automatic 
cue-up).

• During file playback, to play the next keyframe at variable speed, for the next 
keyframe set variable speed only, and do not set the start point (see figure 
below).

KF1 KF2 KF3

Example: When the recorded clip for keyframe 1 has a duration of 15 frames

 30 frames

 15 frames

: Interval for which clip is recorded

: Interval in which still frame is displayed

In this example, when keyframe 1 is executed, the first 15 frames consist of clip 
playback and the remaining 15 frames show the 15th frame as a still image.

 30 frames

 15 frames
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• When using a disk recorder with the VTR/disk recorder timeline, if you carry 
out the following sequence of operations, the system may freeze on the frame 
of the start point.
1. Press the [RUN] button to play to a point close to the end of a file.
2. Stop playback.
3. Press the [RUN] button once more.
In such cases, first recall a different register, then carry out the following 
sequence:
1. Recall the original register again.
2. Press the [REWIND] button.
3. Press the [RUN] button.

• Some operating limitations apply when the video disk communications 
protocol is used. These are explained with reference to the following figure, 
which illustrates creation of a timeline that plays from the video of file A to 
the video of file B. 

– Operation with no problems:

– Black video or still image appears momentarily when play switches from 
file A to file B:

KF1 action setting Operating status of file 
A

KF2 action setting

Start Playing Start

KF1 action setting Operating status of file 
A

KF2 action setting

Start Playing Cueup

Variable Speed set Playing at variable speed Cueup

Cueup Cueup Cueup

KF1 KF2 a) KF3

 Playback  Playback at set variable speed

a) In keyframe 2, set variable speed only, and do not set the start point.

KF1 KF2

A B
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– Partial operating limitation:

a) Failure to operate when variable speed is set to minus value. However, operates when the 
file B action is set to Start, and then variable speed is set to minus after file B starts playing. 

– Play does not switch from file A to file B:

If play continues to show video of file A without switching to file B, a Stop 
action is required in file A in order to switch to file B. 

VTR/disk recorder/Extended VTR timeline editing
This section describes how to set an action at a keyframe point, and how to edit 
the timeline.

For details of the operations for keyframe creation and editing, see “Creating 
and Editing Keyframes” (page 269).

To set an action in the menu

1 In the Device menu, press VF3 ‘DDR/VTR’ and HF2 ‘Timeline.’

The Device >DDR/VTR >Timeline menu appears.
The status area shows two lists. The upper list shows the device number, 
register number, keyframe number, and action type (start point, stop point, 
and variable speed) set for the keyframe.
The lower list is used for setting the action for the device selected above, 
and shows the port name, current file, current time, status information, 
start point, stop point, variable speed, and file name (for a disk recorder or 
Extended VTR).

2 Using any of the following methods, select the device for which you want 
to set the action.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

KF1 action setting Operating status of file 
A

KF2 action setting

Start Playing Variable Speed set a)

Variable Speed set Playing at variable speed Variable Speed set  a)

Cueup Cueup Variable Speed set a)

KF1 action setting Operating status of file 
A

KF2 action setting

Variable Speed set Playing at variable speed Start

Cueup Cueup Start
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3 To set the name of a file when using an Extended VTR or disk recorder, 
recall the file using the Device >DDR/VTR >File List menu.

Notes
• There is a limit of eight disk recorder files that can set on a single 

timeline.
• If you have not set the file name when using an Extended VTR, the file 

recalled in the Extended VTR when the keyframe point is passed is the 
subject of the action.

For details of settings required to recall a file, see “Sharing Disk 
Recorder/Extended VTR File Lists” in Chapter 19 (Volume 3).

When not using an Extended VTR or disk recorder, or when  the file name  
has not been set for an Extended VTR, skip to step 4.

4 In the <Action> group, select the action.

Cueup: Output a command to cue up to the currently displayed start point.
Start: Output a Play command.

Note
When the stop point and variable speed are both set, the variable speed 
setting takes priority.

Stop: Output a Stop command.

Note
Before executing the Stop command, if the timecode for the set stop 
point has been reached, or on an Extended VTR or disk recorder if the 
end of the file has been reached, then at that point the device stops.

5 To set a start point, in the <Start TC> group, press the [Set] button.

A timecode window appears.

If you do not want to set the start point, skip to step 8.

Note
For a disk recorder on which the start point is not set, the file recalled in 
the disk recorder when the keyframe point is passed is the subject of the 
action.

Knob Parameter Setting Setting values

1 Dev Device number 1 to 12
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6 Set the start point as a timecode value.

7 Press [Enter].

The new start point setting is reflected in the status area.

8 To set the stop point, in the <Stop TC> group press the [Set] button.

A timecode window appears.
If you do not want to set the stop point, skip to step 11.

9 Set the stop point as a timecode value.

10Press [Enter].

The new stop point setting is reflected in the status area.

11To set the variable speed, in the <Variable Speed> group, carry out either 
of the following.

• Press [Fit].
Without setting a speed value, this automatically carries out playback 
according to automatically calculated values for the duration and 
keyframe duration to fit the set start point and stop point.

• Press the [Set] button, and adjust the parameter with the knob. 

a) The setting range of the variable speed depends on the type of connected device.

The new variable speed setting is reflected in the status area.

Repeat steps 2 to 11 as required for other devices.

To carry out start point and stop point settings and cueing up 
operations in the device control block
With the following buttons in the device control block, you can set the start 
point or stop point of a keyframe point on the timeline, or carry out a cueing up 
operation.

Notes
• When using the device control block (trackball or joystick), check that the 

[MENU] button in the block is lit amber. If it is not lit, press it, turning it on.
• When using the device control block (search dial), check that the 

[TIMELINE] is lit amber.

Knob Parameter Setting Setting values

2 Variable Variable speed –100 to +200 a)
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[START TC] button: Set the start point of the keyframe point to the current 
time.

[STOP TC] button: Set the stop point of the keyframe point to the current 
time.

[SET START TC] button (of the device control block (search dial)): 
Enable to input the timecode of the start point of the keyframe point with 
the numeric keypad control block.

[SET STOP TC] button (of the device control block (search dial)): Enable 
to input the timecode of the stop point of the keyframe point with the 
numeric keypad control block.

[SET DUR] button (of the device control block (search dial)): Enable to 
input the duration between the start point and stop point of a keyframe 
point with the numeric keypad control block.

[CUE] button: Cue up to the start point set for the keyframe point.

To display or check the settings, use the Device >DDR/VTR >Timeline menu.

To test an action command output
To test an action command output, select the desired device from the upper list 
in the status area, and press [Test Fire].
An action command is output from the DCU 9-pin serial port, according to the 
settings in the list.

To clear the start point, stop point, and variable speed settings

1 In the upper list in the status area, select the device for which you want to 
clear the settings.

2 Carry out any of the following operations as required.

• To clear the start point setting, press [Clear] in the <Start TC> group.
• To clear the stop point setting, press [Clear] in the <Stop TC> group.
• To clear the variable speed setting, press [Clear] in the <Variable 

Speed> group.

To set the action for a rewind operation
On the VTR/disk recorder/Extended VTR timeline, when the [REWIND] 
button in the keyframe control block is pressed the action set for the first 
keyframe is not executed; when the [RUN] button is pressed, then the first 
keyframe action is executed.
To execute an action when the [REWIND] button is pressed, it is necessary to 
set this action (Rewind Action). To carry out this setting, in the Device >DDR/
VTR >Timeline menu, press [Rewind Action] to recall the Rewind Action 
menu. In this setting screen, use the same setting method as in the screen for 
setting an action on the VTR/disk recorder timeline.
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Alternatively, you can select the reverse arrangement, whereby when the 
[REWIND] button is pressed, this executes the action set for the first keyframe, 
and when the [RUN] button is pressed the first keyframe action is not executed. 
In this case, the Rewind Action setting is still valid.

For details of the setting, see “Setting the First Keyframe When a Rewind Is 
Executed” in Chapter 19 (Volume 3).

Disk Recorder/Extended VTR File Operations

Material held on a disk recorder/Extended VTR is managed in units of files. 
You can recall a file to play it back. (In the case of an Extended VTR, the 
register number is recalled.)
To carry out disk recorder/Extended VTR file operations, use the Device menu.

Accessing the file list
Before playback and suchlike operations on a disk recorder/Extended VTR, it 
is first necessary to display a list of the disk recorder files on the DCU. The file 
list includes the following information.
• File name
• Date of last update 1)

• Duration of recorded material 1)

To recall the file list, use the Device menu.

1) Not displayed in the case of an Extended VTR

Recalling a file
In the recalled list of files, select the file you want to play back, and open the file.

File list sharing
You can connect multiple DCU serial ports to a single disk recorder/Extended 
VTR.
You can share the recalled list of files between serial ports connected to the 
same disk recorder/Extended VTR.

For settings relating to file list sharing, see “Serial Port Settings (Serial Port 
Assign Menu)” in Chapter 22 (Volume 3).

File creation
To record a new file on the disk recorder, use the Device menu to create a new 
file.

Note 
In the case of an Extended VTR, it is not possible to record a new file.
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Refreshing (recalling) the disk recorder/Extended VTR file list

1 In the Device menu, press VF3 ‘DDR/VTR’ and HF3 ‘File List.’

The Device >DDR/VTR > File List menu appears.
In the status area, two lists appear.
The upper list shows the selected device name, and the currently selected 
file name (register number), and set file name.
The lower list shows a list of files for the selected device (the device 
appearing in the upper list). In this list is shown the file name (register 
number) set when the material was recorded, the length of the file data 
(timecode value), and the file update information.

Notes
• File update information is not shown when using the video disk 

communications protocol. 
• When using an Extended VTR, the length of file data and file update 

information are not shown, and the register number is shown in place of 
the file name.

2 Select the device for which you want to recall the file list, using the knob.

3 Press the [File List Update] button.

This starts the process of recalling the file list, and a message box appears.
When the file list recall is completed, the message box disappears.

To cancel recalling the file list
During the recall, press the [Cancel] button in the message box.

File list sharing
You can share the recalled file list across serial ports connected to the same 
disk recorder.

For details of file list sharing settings, see “Sharing Disk Recorder/Extended 
VTR File Lists” in Chapter 19 (Volume 3).

Sorting files in the list
You can sort the files in the list by name, number, or update date.

1 In the Device menu, press VF3 ‘DDR/VTR’ and HF3 ‘File List.’

Knob Parameter Setting Setting values

1 Dev Device number 1 to 12
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The Device >DDR/VTR >File List menu appears.

2 Select the device for which you want to recall the file list, using the knob.

3 In the <Sort> group, press one of [File Name], [File No], and [Update].

File Name: Sort in alphabetical order of file name.
File No: Sort in ascending file number order.
Update: Sort in file update date order, newest first.

Notes
• Files cannot be sorted by the file update date and time when using the 

video disk communications protocol. 
• When using an Extended VTR, it is not possible to sort files.

This sorts the files in the selected order.

Recalling a file
To recall a file from the file list, use the following procedure.

Note
Files cannot be recalled when the disk recorder is set to Recorder.

1 In the Device menu, press VF3 ‘DDR/VTR’ and HF3 ‘File List.’

The Device >DDR/VTR >File List menu appears.

2 Select the device from which you want to recall a file, using the knob.

3 Using any of the following methods, select the file you want to recall.

• Press directly on the lower list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

Knob Parameter Setting Setting values

1 Dev Device number 1 to 12

Knob Parameter Setting Setting values

1 Dev Device number 1 to 12

Knob Parameter Setting Setting values

2 No File selection 1 to 5000 a)

0 to 99 b)
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a) For disk recorders. The range of setting values depends on the total number of files.
b) For Extended VTRs. The range of setting values depends on the total number of files.

4 Press [Load].

This recalls the selected file, and the file name appears at the top of the 
status area.

Creating new files 
A file name must be specified to record to a new file on a disk recorder. 

Notes
• New files cannot be created when the disk recorder is set to Player or 

Recorder/Player.
• In the case of Extended VTRs, new files cannot be created. 

1 In the Device menu, press VF3 ‘DDR/VTR’ and HF3 ‘File List.’

The Device >DDR/VTR >File List menu appears.

2 Press [New File].

The keyboard window appears.

3 Enter a file name and press [Enter]. 

When using the Sony disk recorder 9-pin protocol: Up to 23 characters. 
When using the video disk communications protocol: Up to 8 

characters (in Fixed 8 Character mode) or 23 characters (in Variable 
Length mode)

For details of how to select the file name character count mode in the video 
disk communications protocol, see “Making Detailed Settings on the 
External Device Connected to the Serial Port” in Chapter 22 (Volume 3).

The name appears as the current file name at the top of the status area. 

When the loaded file is not a target for recording
When a file that is not a target for recording is loaded in the disk recorder, 
proceed as follows.

1 In the Device menu, press VF3 ‘DDR/VTR’ and HF3 ‘File List.’

The Device >DDR/VTR >File List menu appears.

2 Press [Unload].

The current file name at the top of the status area is cleared. 
Control of VTRs, Extended VTRs, and Disk Recorders



Chapter 13 Keyframe Effects
Regions .......................................................................................................233
Registers ....................................................................................................235
Keyframes .................................................................................................237

Effects ................................................................................................237
Saving and Recalling Effects ............................................................237
Effect Attributes ................................................................................237
Effect Editing ....................................................................................238
Time Settings .....................................................................................239
Paths ..................................................................................................243
Effect Execution ................................................................................249
Master Timelines ...............................................................................249
Sequence of Keyframe Operations ....................................................250

Displaying the Timeline Menu ................................................................251
Interpreting the Timeline Menu ........................................................251
Settings in the Timeline Menu ..........................................................253

Recalling a Register ..................................................................................255
Specifying the Region and Edit Points ....................................................264

Selecting the Region in Which Editing Applies ................................264
Setting the Edit Points .......................................................................267

Creating and Editing Keyframes ............................................................269
Creation .............................................................................................269
Insertion .............................................................................................270
Modification ......................................................................................270
Deletion .............................................................................................274
Movement ..........................................................................................275
Copying .............................................................................................276
Pause ..................................................................................................276
Keyframe Loop (Repeated Execution of a Specified Range) ...........277
Undoing an Edit Operation ................................................................280
Duration Mode Setting ......................................................................280



Transition Mode Settings for User Programmable DME ..................281
Keyframe Creation and Editing in the Multifunction Flexi Pad Control 

Block ......................................................................................281
Time Settings .............................................................................................284

Setting the Keyframe Duration ..........................................................284
Setting the Effect Duration ................................................................285
Setting the Delay ...............................................................................286

Path Setting ...............................................................................................287
Basic Procedure for Path Settings .....................................................287

Executing Effects ......................................................................................291
Executing Effects in the Keyframe Control Block ............................291
Setting the Run Mode ........................................................................293
Executing an Effect in the Flexi Pad Control Block .........................294
Executing an Effect in the Multifunction Flexi Pad Control Block ..294

Saving Effects ............................................................................................296
Creating and Saving a Master Timeline .................................................298

Creating and Saving a Master Timeline Using the Buttons in the Numeric 
Keypad Control Block ...........................................................298

Creating and Saving a Master Timeline Using the Buttons in the 
Multifunction Flexi Pad Control Block .................................300

Creating and Saving a Master Timeline With the Menu ...................302
Register Operations in the Menus ...........................................................305

Effect Attribute Settings ....................................................................305
Effect Status Display .........................................................................306
Effect Register Editing ......................................................................306
Displaying a List of Effect Registers for Editing ..............................311



  C
hapter 13 

K
eyfram

e E
ffects
Regions

The term “region” refers to some sort of functional block of the system.
When saving or recalling snapshot registers and effect registers, or creating or 
editing effects, you first select the region to which the operation applies. You 
can also select multiple regions simultaneously.

Classification of the regions
The regions are classified as follows.
• Master region
• The following 33 regions

– Switcher: M/E1, M/E2, PGM/PST, User1 to User8
– DME: DME ch1, DME ch2, DME ch5 to DME ch8 (inclusive of Global)
– External devices: P-Bus, Router, Device 1 to Device 12, GPI, Macro

Only the regions assigned to the region selection buttons of the numeric keypad 
control block or Multifunction Flexi Pad control block can be used 
simultaneously.

For details of the region assignment to the region selection buttons, see 
“Overall Control Panel Settings (Config Menu)” in Chapter 19 (Volume 3).

Regions applicable to keyframe operations
All the regions less the Router region.

Regions applicable to snapshot operations
Fifteen regions, that is, the above regions less the external devices’ regions (P-
Bus, Device 1 to Device 12, and GPI) and the Macro region.

“User” regions
You can optionally assign the following regions to the regions User1 to User8. 
The User regions shown in parenthesis are the default assignments.
• Color background 1 (User1)
• AUX1 to AUX48 (User2)
• Monitor 1 to 8 (User3)
• Frame Memory 1 to 8 (User4)
• Color correctors 1 and 2

For details of the User1 to User8 region assignment, see “Overall Control 
Panel Settings (Config Menu)” in Chapter 19 (Volume 3).

Notes on saving or recalling a frame memory still image for or by 
a snapshot/keyframe
• The saving and recalling of frame memory images for snapshots and 

keyframes is restricted to the still images or clips on the eight frame memory 
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outputs. The settings made for frame memory images in the Freeze menu, 
Composite menu or other menus do not apply to snapshots or keyframes.

• To reproduce a frame memory still image or a clip of them by recalling a 
snapshot or keyframe, you must have the same images that were present in 
the frame memory when you saved the snapshot or keyframe. Therefore, 
when saving a snapshot or keyframe using frame memory, you must also 
save the images to a storage media such as the hard disk.

Reference region
When multiple regions are selected, only one region appears in the displays for 
menu and numeric keypad operations. This is called the “reference region.”
The reference region is determined according to the following precedence.

M/E1 >P/P >User1 >User2 >User3 >User4 >User5 >User6 >User7 
>User8 >DME ch1 >DME ch2 >Device1 >Device2 >Device3 >Device4 
>Device5 >Device6 >Device7 >Device8 >Device9 >Device10 >Device11 
>Device12 >P-Bus >GPI >Router >Macro

Master region
The regions saved in a master snapshot register or master timeline register and 
the register numbers saved in such regions can be recalled at a time as the 
master region.
The master region can be saved or recalled using the numeric keypad control 
block or Multifunction Flexi Pad control block.
Regions
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A register is an area of memory in a device which holds a snapshot, keyframe, 
macro, and so on.

For details of macros, see Chapter 16 “Macros” (page 369).

Keyframe effect registers

Dedicated effect registers
There are 99 dedicated registers for keyframe effects in each region, numbered 
1 to 99.

Shared user-programmable DME registers
In addition to the 99 DME registers for each region (i.e. each channel), there 
are also shared registers for each processor as shown in the following table. 
These are used for user-programmable DME.

Note
When operating with these shared registers, be sure to select the appropriate 
regions depending on the number of channels. 

Work register
This is a temporary register used when editing keyframes.
When you recall an effect, it is read from the effect register into the work 
register, and when you save, the contents of the work register are written to the 
effect register.

Master timeline registers
There are 99 master timeline registers, numbered 1 to 99, for each control 
panel. They store keyframe effect regions and the register numbers saved in the 
regions.

Snapshot registers
These are registers for snapshots, and there are 99, numbered 1 to 99 for each
region.

Register number Register allocation

101 to 199 Shared register for one-channel effects

201 to 299 Shared register for two-channel effects
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Master snapshot registers
There are 99 master snapshot registers, numbered 1 to 99, for each control
panel. They store snapshot regions and the register numbers saved in the
regions.
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Keyframes

A keyframe represents an instantaneous state of an image; it can be saved and 
recalled for reuse.

Effects

By arranging a number of keyframes on the time axis, and interpolating 
between successive keyframes, you can create an effect in which there is a 
continuous change from each keyframe to the next.

You can save the sequence of keyframes representing a single effect in a 
register. Then by recalling this register, you can replay the same effect.

For details of keyframe effect registers, see “Regions” (page 233) and 
“Registers” (page 235).

Saving and Recalling Effects

To create a new effect, first recall an empty register, then create the keyframes 
one at a time in this register. To run an effect, it is also necessary to set the time 
and the path.
To edit an existing effect, recall the register holding the effect, then make the 
changes.
When you have finished creating or editing the effect, save it in the recalled 
register or another specified register.

Auto save function
When you recall an effect, the currently recalled effect is automatically saved 
in a register. This is called the auto save function. You can disable this function 
in a Setup menu.

Effect Attributes

An individual effect may also have attached special conditions relating to 
switcher or DME operation when the effect is recalled.
237Keyframes
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These conditions are called “attributes” of the effect, and can be added when 
the keyframe effect is saved or recalled.

Type of attribute
The attribute that can be attached to an effect is as follows.
Effect dissolve: The transition from the state before the effect recall to the state 

at the effect start point is carried out smoothly, by a dissolve. The dissolve 
duration can be set in the Effect menu.

Temporary attributes
When a keyframe is recalled, independently of the attributes held in the 
register, you can also enable or disable temporary attributes. These temporary 
attributes are set when the keyframe effect is recalled. 

Effect Editing

For editing operations such as to insert, delete, or modify a keyframe, it is 
necessary to stop the effect at the corresponding point on the time axis. This is 
termed an “edit point.”
You can edit either on a keyframe within the effect, or at any point between 
keyframes.
Insert: Insert the current image as a keyframe. Inserting a keyframe in an 

existing effect may change the duration of the effect (see page 240).
Modify: Modify a keyframe. You can modify a single keyframe or a range of 

keyframes in the effect together.
Delete: Delete a keyframe. You can delete a single keyframe or a range of 

keyframes in the effect together. Deleting keyframes from an effect 
reduces the duration of the effect (see page 241).
After deleting a keyframe, you can reinsert the keyframe with a paste 
operation.

Copy: Copy a keyframe. You can copy a single keyframe or a range of 
keyframes in the effect together.

Paste: Paste the keyframe last copied or deleted anywhere within the effect.
Pause: You can set a pause on a particular keyframe, so that when the effect is 

run it pauses on this keyframe. You can make this setting on any number 
of keyframes. To restart the paused effect, repeat the operation to run the 
effect.

KF Loop: Execute the effect the specified number of times through the 
keyframes in the specified range.

Undo an edit operation: Undo the effect of the last operation to insert, 
modify, delete, or paste a keyframe.
Keyframes



  C
hapter 13 

K
eyfram

e E
ffects
Duration modes
In keyframe editing, there are two duration modes; switch between them in the 
keyframe operation section. (See “Creating and Editing Keyframes” (page 
269).)
Variable duration mode: In this mode, inserting or deleting a keyframe 

increases or reduces the duration.
Constant duration mode: In this mode, inserting or deleting a keyframe does 

not change the duration. This is useful for keyframe editing of an effect 
with a fixed duration.

In the variable and constant duration modes, the keyframes to which a modify 
operation applies, and the effect of a paste operation are different.

Difference in keyframes to which a modify operation applies

a) A new keyframe is inserted at the effect position.

Difference in the effect of a paste operation
Variable duration mode: The copied keyframe is inserted at the specified 

position.
Constant duration mode: The copied keyframe is written over the specified 

position.

Transition mode
You can use an effect created with keyframes as a DME wipe pattern on the 
switcher. In this case, it is necessary to set the transition mode (the way in 
which the effect behaves).

For details of the setting, see “Transition Mode Settings for User 
Programmable DME” (page 281).

Time Settings

Keyframe duration and effect duration
You can determine the execution time of an effect by setting either the 
keyframe durations or the effect duration.

Effect position Variable duration mode Constant duration mode

On a keyframe Applies to currently 
selected keyframe

Applies to currently selected keyframe

Between two 
keyframes

Applies to previous 
keyframe

Modify operation not possible a)
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Keyframe duration: This is the time from the keyframe to the next keyframe. 
You can set this time in the keyframe control block. (See “Setting the 
Keyframe Duration” (page 284).)
In constant duration mode (see page 239), it is not possible to change the 
keyframe duration setting.

Effect duration: This is the total execution time of the effect, from the first 
keyframe to the last. You can set this time in the keyframe control block.
(See “Setting the Effect Duration” (page 285).)
When you change the effect duration, the keyframe duration for each 
keyframe in the effect is automatically recalculated proportionally.

Schematic view of keyframe duration and effect duration

The effect duration may also be changed by inserting or deleting keyframes.

Changes in the effect duration caused by inserting a keyframe
• When the effect is stopped on a keyframe, inserting a keyframe increases the 

effect duration by the duration of the inserted keyframe.
• When the effect is stopped between two keyframes, inserting a keyframe 

does not change the effect duration.

1 2 3 4 5   

Keyframe duration

Keyframe number

 Effect duration
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In constant duration mode (see page 239), the duration of the current keyframe 
is reduced to zero, and the new keyframe is inserted with the previous duration 
of the current keyframe. Thus the effect duration does not change.

Keyframe insertion position and the change in effect duration

Changes in the effect duration caused by deleting a keyframe
• When the effect is stopped on a keyframe, a delete operation deletes the 

keyframe, and reduces the effect duration by the duration of the deleted 
keyframe.

• When the effect is stopped between two keyframes, a delete operation 
deletes the preceding keyframe, and reduces the effect duration by the 
duration of the deleted keyframe.

Insertion position Change in effect duration

Insertion before the first 
keyframe

Insertion between two 
keyframes

Insertion at an existing 
keyframe

Insertion at the last 
keyframe

0 1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5
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Note
In constant duration mode (see page 239), the duration of the keyframe before 
the deleted keyframe is increased by the duration of the deleted keyframe. Thus 
the effect duration does not change.

Keyframe deletion position and the change in effect duration

Delay setting
You can set the delay from the time of executing an operation to run the effect, 
and the effect actually starting (that is, the delay until the first keyframe). You 
can make this setting in the keyframe control block. 
Note that changing the delay does not alter the duration of the effect.

Deletion position Change in effect duration

Deletion of the first 
keyframe

Deletion of an 
intermediate keyframe

Deletion between two 
keyframes

Deletion of the last 
keyframe

1 2 3 4

1 2 3

1 2 3 4

1 2 3

1 2 3 4

1 2 3

1 2 3 4

1 2 3
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The term “path” refers to the specification of how interpolation is carried out 
from one keyframe to the next.
Images are interpolated from an edit point to the next one according to the path 
setting.

For details of the path setting procedure, see “Path Setting” (page 287).

Switcher path settings
Carry out path settings in the Key Frame menu.
For each menu, the following settings are available.

M/E-1, M/E-2, and P/P menus

User1 to User8 menus
The items that can be adjusted depend on the settings in the Setup menu.

Item Paths that can be set

M/E1, M/E2 P/P All For each M/E and PGM/PST, path settings for 
the following items are made simultaneously.

Key1 to Key4 Overall path settings for items relating to keys 
1 to 4 are made simultaneously.

Key 1 All to Key 4 All

Source Key source path for keys 1 to 4

Fill Key fill path for keys 1 to 4

Proc Proc path for keys 1 to 4

Trans Transition path for keys 1 to 4

Bkgd/Util Overall path settings for items relating to the 
background and utility buses are made 
simultaneously.Bkgd/Util All

Bkgd A Path for background A

Bkgd B Path for background B

Util Path for utility 

DME 2nd Video Path for video to be used for second DME 
channel

Wipe/DME Wipe Overall path settings for items relating to wipes 
and DME wipes are made simultaneously.

Wipe/DME
Wipe All

Wipe Path for wipes

DME Wipe Path for DME wipes

Trans – Transition path for each M/E and P/P bank
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For details, see “Settings for Switcher Configuration (Config Menu)” in 
Chapter 20 (Volume 3).

Item Paths that can be set

User1 All to User8 All Overall path settings for the following items for 
each “User” are made simultaneously.

FM All Overall path settings for frame memory items 
are made simultaneously.

FM Src Overall path settings for frame memory source 
items are made simultaneously.

FM Src All

FM Src1 Path for frame memory source 1 and video 
process

FM Src2 Path for frame memory source 2 and video 
process

FM Proc Overall path settings relating to the signal 
processing other than frame memory source 
and frame memory freeze outputs are made 
simultaneously.

FM Proc All

FM Proc1 Path for frame memory signal processing 1

FM Proc2 Path for frame memory signal processing 2

FM Still Store Overall path settings for frame memory freeze 
image output are made simultaneously.

FM Still Store All

FM Still Store 1 to 8 Paths for frame memory freeze image outputs 
1 to 8

Aux Overall path settings for AUX buses are made 
simultaneously.

Aux All

Aux 1 to 48 Paths for Aux 1 to 48

Mon Overall path settings for monitor buses are 
made simultaneously.

Mon All

Mon 1 to 8 Paths for monitor buses 1 to 8

Color Bkgd Overall path settings for color backgrounds are 
made simultaneously.

CCR Overall path settings for color corrector

CCR All

CCR 1 Path for color corrector 1

CCR 2 Path for color corrector 2
Keyframes
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Paths relating to DME

DME 3D Trans Local menu

Item Paths that can be set

3D Trans Local All Overall path settings for local channel three-
dimensional transform items are made 
simultaneously.

Loc Size Overall path settings for items relating to 
image size changes and movement are made 
simultaneously.Loc Size All

Size Path for image size

Post Loc X, Post Loc 
Y

Paths for movement in the x- and y-axes

Post Size Path for size

Loc XYZ Overall path settings for items relating to 
image movement are made simultaneously.

Loc XYZ All

Loc X, Loc Y, Loc Z Paths for the x-, y- and z-axes

Rot Overall path settings for items relating to 
image rotation are made simultaneously.

Rot All

Rot X, Rot Y, Rot Z Paths for the x-, y- and z-axes

Spin Overall path settings for items relating to spin 
are made simultaneously.

Spin All

Spin Src X, Spin Src 
Y, Spin Src Z

Paths for the x-, y- and z-axes

Spin X, Spin Y, Spin 
Z

Paths for the x-, y- and z-axes

Asp Overall path settings for items relating to 
aspect ratio are made simultaneously.

Asp All

Rate X, Rate Y Paths for the x- and y-axes

Skew Overall path settings for items relating to skew 
are made simultaneously.

Skew All

Skew X, Skew Y Paths for the x- and y-axes

Aspect Path for aspect ratio

Pers Overall path settings for items relating to 
perspective are made simultaneously.

Pers All

Pers X, Pers Y, Pers 
Z

Paths for the x-, y- and z-axes
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DME 3D Trans Global menu

Axis Loc Overall path settings for items relating to 
image rotation axis are made simultaneously.

Axis All

Axis X, Axis Y, Axis 
Z

Paths for the x-, y- and z-axes

Item Paths that can be set

3D Trans Global All Overall path settings for three-dimensional 
transform items in the global channel are 
made simultaneously.

Loc Size Overall path settings for items relating to 
image size changes and movement are made 
simultaneously.Loc Size All

Size Path for image size

Post Loc X, Post Loc 
Y

Paths for movement in the x- and y-axes

Post Size Path for size

Loc XYZ Overall path settings for items relating to 
image movement are made simultaneously.

Loc XYZ All

Loc X, Loc Y, Loc Z Paths for the x-, y- and z-axes

Rot Overall path settings for items relating to 
image rotation are made simultaneously.

Rot All

Rot X, Rot Y, Rot Z Paths for the x-, y- and z-axes

Spin Overall path settings for items relating to spin 
are made simultaneously.

Spin All

Spin Src X, Spin Src 
Y, Spin Src Z

Paths for the x-, y- and z-axes

Spin X, Spin Y, Spin 
Z

Paths for the x-, y- and z-axes

Pers Overall path settings for items relating to 
perspective are made simultaneously.

Pers All

Pers X, Pers Y, Pers 
Z

Paths for the x-, y- and z-axes

Axis Loc Overall path settings for items relating to 
image rotation axis are made simultaneously.

Axis All

Axis X, Axis Y, Axis 
Z

Paths for the x-, y- and z-axes

Item Paths that can be set
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DME Effect menu

Item Paths that can be set

Effect All Overall path settings for DME effect items are 
made simultaneously.

Edge Overall path settings for edge items are made 
simultaneously.

Edge All

Border Path for border

Crop/Edge Soft Path for crop/edge softness

Beveled Edge Path for beveled edge

Key Border Path for key border a) b)

Art Edge Path for art edge a) b)

Flex Shadow Path for flex shadow a) b)

Drop Shadow Path for drop shadow a) c)

Wipe Crop Path for wipe crop a) b)

Color Mix Path for color mix a) b)

Video Modify Overall path settings for video modify items 
are made simultaneously.

Video Modify All

Defocus/Blur Path for defocus/blur

Multi Move Path for “multi-move”

Color Modify Path for color modify

Mosaic Path for mosaic

Mask Path for mask

Sketch Path for sketch

Metal Path for metal

Dim/Fade Path for dim/fade a)

Glow Path for glow

Freeze Path for freeze

Non-Linear Path for nonlinear effects b)

Light Overall path settings for lighting items are 
made simultaneously.

Light All

Lighting Path for lighting

Spot Lighting Path for spotlighting a)

Trail Path for trails
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a) This cannot be used on the MVE-8000A.
b) This cannot be used on the MKS-6470.
c) This is only supported by the MKS-6470.

DME Global Effect menu

a) This cannot be used on the MKS-6470

Types of path

Path types for Curve
There are five types, as follows.

OFF: Executing the effect causes no change.

Step: There is no interpolation between keyframes, so that the effect 
parameters are updated each time a keyframe is passed.

Linear: Linear interpolation between keyframes, resulting in constant 
speed movement.

S-Curve: The rate of change accelerates and decelerates before and 
after a keyframe, so that the rate of change is maximum midway 
between two keyframes.

Spline: The effect follows a smooth curved path from each keyframe to 
the next.

Path types for Hue
There are four types, as follows.

CW: The hue changes in a clockwise direction as seen on a 
Vectorscope.

CCW: The hue changes in a counterclockwise direction as seen on a 
Vectorscope.

In/Out Overall path settings for items relating to input/
output are made simultaneously.

In/Out All

Bkgd Path for background

Video/Key Path for video/key

Item Paths that can be set

Global Effect All Overall path settings for DME global effect 
items are made simultaneously.

Combine Path for combiner

Shadow Path for shadow

Brick a) Path for brick

Item Paths that can be set
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Short: The hue changes in whichever of the clockwise and 
counterclockwise directions is shorter.

Long: The hue changes in whichever of the clockwise and 
counterclockwise directions is longer.

Path types for Xpt
There are two types, as follows.

Xpt Hold off: When replaying a keyframe, change the inputs to the 
settings saved in memory.

Xpt Hold on: When replaying a keyframe, do not change the inputs.

Effect Execution

By using the [RUN] button in the keyframe control block, you can replay the 
effect as a continuous sequence of images. This is referred to as effect 
execution.

Range of execution
Each time the [RUN] button is pressed, the range of execution of the effect is 
from timecode 01:00:00:00 or the current time (the position at which the 
current effect is stopped) to the end point of the effect. However, if there is a 
pause set on a keyframe, the execution range is up to that point. Pressing the 
[RUN] button again resumes the effect, which then runs to the next pause point 
or the end of the effect.

Run mode setting
You can select from the following run modes for when the effect is executed.
DIRECTION: Specify the effect execution direction.
STOP NEXT KF: Run the effect, and stop at the next keyframe.
EFFECT LOOP: Repeat the effect in an endless loop.
Make these settings in the keyframe control block. (See “Run mode setting” 
(page 249).)

Master Timelines

You can save the regions selected for a keyframe effect and the register 
numbers saved in the regions in a master timeline register so that operation can 
be applied to two or more regions at a time.
To save master timeline registers, use the numeric keypad control block or 
menu; to recall them you can use the numeric keypad control block, menu, the 
Flexi Pad control block or the Multifunction Flexi Pad control block. 
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For more details, see “Creating and Saving a Master Timeline” (page 298).

Sequence of Keyframe Operations

The following table shows the principal operations involved in the sequence 
from creating keyframes to executing an effect. For details of each operation, 
see the page number in parenthesis.

For the overview of keyframes, see “Keyframes” in Chapter 1 (Volume 1).

v

v

v

v

v

v

Recalling a register (see page 255)
To create a new effect, recall an empty register; to edit an effect, open the 
register containing it.

Specifying the region and edit points (see page 264)
Select the region in which editing applies, and set the edit points.

Creating and editing keyframes (see page 269)
Create the keyframes that make up the effect, using operations to create, 
insert, modify, or delete keyframes.

Time settings (see page 284)
Set the overall duration of the effect or the duration of each keyframe.

Path setting (see page 287)
Set the type of interpolation used between successive keyframes.

Executing effects (see page 291)
This provides a smooth effect, based on the time and path settings.

Saving effects (see page 296)
Save a completed effect in a register.
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Displaying the Timeline Menu

By displaying the Timeline menu, you can view keyframe effects on the 
timeline for each region, and the associated information.

Recalling the Timeline menu

1 In the menu control block, press the top menu selection button 
[KEY FRAME].

2 Select HF1 ‘Time Line.’

The Time Line menu appears.

Interpreting the Timeline Menu

The following are the main parts of the menu display.

Key Frame >Timeline menu

1 Keyframe 
status

2 Region name and 
register number

3 Delay (numerical display)

5 Display start 
time

7 Delay (display 
on timeline)

8 Pause point

6 Display 
end time

0 Effect 
duration 

9 Total 
timeline 
length

qa Knob 
adjustment
display4 Keyframe 

number / 
total
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a Keyframe status
This shows the region name, register number, register name, number of 
remaining keyframes, current position and timecode with regard to the 
reference region.

b Region name and register number
This shows the region name and the number of the register recalled in this 
region.
The display color indicates the region selection as follows.
Blue: reference region
White: selected region
Gray: not selected region

c Delay (numerical display)
This shows the delay between carrying out an effect operation, and the start of 
the actual effect.

d Keyframe number / total
This shows the number of the keyframe at the cursor position, and the total 
number of keyframes in the register.

e Display start time
This shows the timecode value for the timeline display start point.

f Display end time
This shows the timecode value for the timeline display end point.

g Delay (display on timeline) 
When a delay is set, the interval is shown by a blue line.

h Pause point
A “P” appears where a pause is set.

i Total timeline length
The total time of delays and effect duration appears in white.

j Effect duration
The total duration of the effect appears in orange.

k Knob adjustment display
Turning the corresponding knob scrolls the timeline display, allowing you to 
see the timeline for regions that were previously hidden.
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Settings in the Timeline Menu

Selecting the region to be displayed
The Timeline menu shows a timeline for each region, but you can also restrict 
the regions to be shown. 

Recalling the Timeline Assign menu

1 In the menu control block, press the top menu selection button 
[KEY FRAME].  

2 Select HF5 ‘Timeline Assign.’

The Key Frame>Timeline Assign menu appears.
The right of the status area shows a list of the regions (including the global 
region) assigned to the region selection buttons in the numeric keypad 
control block. The left shows the regions in order of precedence, and 
whether each region is shown on the Timeline menu.

Deciding which regions appear on the timeline
In the Timeline Assign menu, press [Active Region], toggling it on or off.
On: The regions for which the region selection buttons in the numeric keypad 

control block are lit are shown in the precedence order (see next item) set 
in this menu, followed by the regions for which the buttons are off, in the 
same order.

Off: The regions appear according to the precedence order (see next item) and 
display on/off setting (see page 254) set in this menu.

Deciding the precedence order for timeline display
To change the precedence order, insert and delete regions in the list, in the 
desired order.

1 In the Timeline Assign menu, use any of the following methods to select 
the desired precedence order position and the region you want to insert.

• Press directly on the precedence order position in the list on the left and 
the region you want to insert in the list on the right.

• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs to make the setting.

Knob Parameter Adjustment Setting values

1 Priority Precedence order of insertion 
position

1 to upwards
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2 In the <Priority> group, press [Insert].

This inserts the selected region before the specified precedence order.
If the inserted region is already present in a different precedence order, it 
is deleted from that precedence order.

3 To delete a region from a precedence order, use any of the following 
methods to select the region.

• Press directly on the list on the left of the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

4 To carry out the deletion, press [Delete] in the <Priority> group.

This deletes the selected region from the precedence order list.

Setting the display of regions in the Timeline menu on or off
When [Active Region] is off, to select which regions are displayed in the 
Timeline menu, use the following procedure.

1 In the Timeline Assign menu, use any of the following methods to select 
the region.

• Press directly on the list on the left of the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

2 For no display, press [Display], turning it off. To display, press once more, 
turning it on.

When [Active Region] is off, regions with the “Display Off” setting are not 
displayed in the Timeline menu.

To return to the default precedence order and timeline menu 
display settings
Press [Default] in the <Priority> group.

2 Region Region to be inserted 1 to upwards

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Priority Precedence order assigned to the 
region to be deleted

1 to upwards

Knob Parameter Adjustment Setting values

1 Priority Region selection 1 to upwards
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Recalling a Register

Use the numeric keypad control block or Multifunction Flexi Pad control block 
to recall a register. For each region there are 99 registers dedicated to 
keyframes, numbered from 1 to 99.
When creating an effect as a user programmable DME, use a 3-digit register 
number which is commonly used for all DME regions (channels).

For a description of the concept of regions and registers, see “Regions” (page 
233) and “Registers” (page 235).

The master timeline can also be recalled from the standard-type Flexi Pad 
control block.

Recalling a register from the numeric keypad control block

Numeric keypad control block

1 Press the [EFF] button, turning it on.

This allocates the numeric keypad control block to keyframe operations, 
and the [RCALL] button lights.

EFF

M/E
1

USER
1

DME
1

DME
5

SNAP
SHOT

M/E
2

USER
2

DME
2

DME
6

SHOT
BOX

M/E
3

USER
3

DME
3

DME
7

MCRO

P/P

USER
4

DME
4

DME
8

TRANS
RATE

RTR

DEV
1

DEV
2

UNDO

TC

STORE
STATSMASTR ALL P-BUS GP1

STORE

RCALL

7 8 9

4 5 6

1 2 3

0

+/-
EFF

TRIM

CLR
AUTO

DISS

TRANS

ENBL
GPI

ENTER

Display

Region selection buttons RCALL button

UNDO buttonEFF button
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2 Press the button corresponding to the region you want to select, turning it 
on. 
You can also press more than one button.

[M/E 1], [M/E 2], [P/P]: These select the corresponding M/E-1, M/E-2, 
and PGM/PST regions.

[USER 1] to [USER 8]: These select the User regions.
[DME 1], [DME 2], [DME 5] to [DME 8]: These select the DME 

channels.
[DEV 1] to [DEV 12]: These select the regions Device 1 to Device 12, 

respectively.
[P-BUS]: This selects P-Bus.
[GPI]: This selects GPI.
[MCRO]: This selects Macro.
[ALL]: This selects all valid regions.
[MASTR]: This selects the master timeline (see “Creating and Saving a 

Master Timeline” (page 298)).

Note
The regions that can be selected simultaneously are those assigned to the 
region selection buttons in the Multifunction Flexi Pad control block, and 
those displayed on the memory recall section buttons when the [MORE] 
button is pressed. (See “Assigning a Region to a Region Selection Button 
in the Numeric Keypad Control Block or Multifunction Flexi Pad Control 
Block” in Chapter 19 (Volume 3).)
It is not possible to select [MASTR] and other regions simultaneously. If 
selected simultaneously, the master timeline takes precedence.

The first button pressed lights green as the reference region, and any 
subsequently pressed buttons light amber.
Pressing one of the amber-lit buttons, while holding down [EFF], turns the 
button green to indicate its corresponding region as the new reference 
region.

For details of the precedence order for becoming the reference region, see 
“Regions” (page 233) and “Registers” (page 235).

The display shows the name of the reference region, and the number of the 
last register recalled for this region.

3 Enter the number of the register you want to recall, using the numeric 
keypad.

To find an empty register, instead of entering a number, press the [.] 
(period) button. To search for an empty register common to all currently 
selectable regions, press the [.] button again.
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To search for an empty register in the 100 range, press [1], [0], [0], [.] 
(period) in this order. Similarly, to search for an empty register in the 200 
range, press [2], [0], [0], [.] (period), and to search for an empty register in 
the 300 range, press [3], [0], [0], [.] (period).
The register number appears in the display. If the number is followed by a 
letter ‘e’ or ‘E,’ this indicates the following.
e: The selected register is empty for the regions selected in step 2.
E: The selected register is empty for all currently selectable regions.

4 To apply a temporary attribute (effect dissolve), press the [+/–/EFF DISS] 
button.

Note
It is not possible to apply temporary attributes to the master timeline.

5 Press the [ENTER] button.

This recalls the specified register.
When the master timeline is recalled, the region selection buttons light 
according to the saved region information.

To undo the recall of a register
Immediately after recalling the register, press the [UNDO] button to undo the 
operation.

Note
After recalling the master timeline, you cannot undo the recall.

Recalling the master timeline in the Flexi Pad control block
Whichever block you recall the master timeline from, the region set when it 
was saved is recalled.
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Flexi Pad control block (standard type)

1 In the Flexi Pad control block, press the [EFF] button.

This assigns the Flexi Pad control block to master timeline operation.
The previously selected bank number and last recalled register number 
appear in the numeric display.

2 Using any of the following methods, select the bank to be recalled.

To select bank 0: press the [BANK 0] button.
To select bank 1: press the [BANK 1] button.
To select any of banks 0 to 9: press the [BANK SEL] button; the memory 

recall section display changes as shown in the following figure; press 
one of 0 to 9.

7

WIPE

DME

SNAP
SHOT

EFF

MCRO

SHOT
BOX

UNDO

STORE
STATS

TRANS
RATE

BNAK
0

BANK
1

BANK
SEL

XPT HOLD
A B U1 U2 1 2 3 4

8 9

4 5 6

1 2 3

0 AUTO
TRAN

EFF
DISS

EFF button Numeric display

Memory recall section

Bank selection buttons
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The selected bank number appears in the numeric display.
The memory recall section buttons show the register names corresponding 
to the selected bank, and the register status.
Note that by a setting in the Setup menu, you can select either register 
names or register numbers to be displayed.
Lit orange: register holding the master timeline
Lit yellow: last recalled register
Off: empty register

3 Press the button in the memory recall section which shows the desired 
register name.

The button you pressed lights yellow, and the master timeline is recalled. 
The numeric display shows the bank number, followed by the selected 
register number.

7 8 9

4 5 6

1 2 3

0 RE
WIND RUN
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Recalling a register from the Multifunction Flexi Pad control 
block

1 Press the [EFF] button, turning it on.

2 Press the button corresponding to the region you want to select, turning it 
on. 
You can also press more than one button.

[M/E 1], [M/E 2], [P/P]: These select the corresponding M/E-1, M/E-2, 
and PGM/PST regions.

[USER 1] to [USER 8]: These select the User regions.
[DME 1], [DME 2], [DME 5] to [DME 8]: These select the DME 

channels.
[P-BUS]: This selects P-Bus.
[GPI]: This selects GPI.
[MCRO]: This selects Macro.
[DEV 1] to [DEV 12]: This selects device.
[ALL]: This selects all valid regions.
[MSTR]: This selects the master timeline (see “Creating and Saving a 

Master Timeline” (page 298)).

EFF button

Alphanumeric display

Region selection buttons

Memory recall section
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Note
The regions that can be selected simultaneously are those assigned to the 
region selection buttons in the Multifunction Flexi Pad control block, and 
those displayed on the memory recall section buttons when the [MORE] 
button is pressed. (See “Assigning a Region to a Region Selection Button 
in the Numeric Keypad Control Block or Multifunction Flexi Pad Control 
Block” in Chapter 19 (Volume 3).)
When [MSTR] and other regions are selected simultaneously, the master 
timeline takes precedence.
The first button pressed lights green as the reference region, and any 
subsequently pressed buttons light amber.
Pressing one of the amber-lit buttons, while holding down [EFF], turns the 
button green to indicate its corresponding region as the new reference 
region.

For details of the precedence order for becoming the reference region, see 
“Regions” and “Registers” in Chapter 1 (Volume 1).

The display shows the name of the reference region, and the number of the 
last register recalled for this region.

3 Enter the number of the register you want to recall, using the numeric 
keypad.

To find an empty register, instead of entering a number, press the [.] 
(period) button. To search for an empty register common to all currently 
selectable regions, press the [.] button again.
To search for an empty register in the 100 range, press [1], [0], [0], [.] 
(period) in this order. Similarly, to search for an empty register in the 200 
range, press [2], [0], [0], [.] (period), and to search for an empty register in 
the 300 range, press [3], [0], [0], [.] (period).

The register number appears in the display. If the number is followed by a 
letter ‘e’ or ‘E,’ this indicates the following.
e: The selected register is empty for the regions selected in step 2.
E: The selected register is empty for all currently selectable regions.

4 Press the [ENTER] button.

This recalls the specified register.
When the master timeline is recalled, the region selection buttons light 
according to the saved region information.

To recall the master timeline

1 In the Multifunction Flexi Pad control block, press the [EFF] button.
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This switches the Multifunction Flexi Pad control block to the effect 
operation mode.

2 Press the [MSTR RCLL] button.

This switches the memory recall section to the master timeline recall 
mode.

3 Press the [BANK SEL] button.

This switches the memory recall section to the bank selection mode.
Recalling a Register



  C
hapter 13 

K
eyfram

e E
ffects
4 Press the number of the desired bank.

This selects the bank, and the buttons in the memory recall section show 
the register states as follows.
Lit yellow: Last recalled register
Lit orange: Register holding data
Off: Empty register

5 Press the number of the desired register.

The button you pressed lights yellow, and this recalls the master timeline.
The alphanumeric display shows the selected bank and register numbers.
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Specifying the Region and Edit Points

Selecting the Region in Which Editing Applies

Selecting by control panel
Select the region in which the editing is applied by the effect consisting of 
keyframes, using the region selection buttons in the numeric keypad control 
block or Multifunction Flexi Pad control block. (See step 2 (page 256) in 
“Recalling a Register.”)

Selecting by menus
This is convenient for selecting some of the regions assigned to the numeric 
keypad control block or changing the reference region.

Note
The function of region selection buttons in the numeric keypad control block 
or Multifunction Flexi Pad control block is linked to the menu. If you carry out 
region selection by pressing a region selection button, then all the regions 
assigned to that button are selected.

1 In the Key Frame menu, press HF7 ‘Region Select.’

The Key Frame >Region Select menu appears.
On the left of the status area, region selection buttons appear.
Depending on the region selection state, the following indications appear.
Green text: the assigned regions include the reference region.
Orange text: one of the assigned regions is selected.
White text: no assigned region is selected.

When any one or more of the regions assigned to the region selection 
buttons is not selected, a red bar appears within the button indication. The 
[STORE] and [RCALL] buttons in the numeric keypad control block flash 
amber.
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When using the CCP-6224/6324 Control Panel, the buttons in the <Flexi 
Pad Module> group appear at the lower left of the status area, and if you 
press either [Region Sel Btn Area] or [Mem Rcl Btn Area] button, you can 
select a region assigned to a region selection button in the Multifunction 
Flexi Pad control block or a button in the memory recall section.

Selection screen for regions assigned to region selection buttons

Selection screen for regions assigned to buttons in the memory 
recall section
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2 Press a button indication on the left of the status area, to select the button 
you want to assign.

The regions currently assigned to the button you pressed appear on the 
right side of the status area.

3 In the <Region Select> group, press the button for the region you want to 
select, turning it on.

4 In the <Ref Region Select> group, press the button indication you want to 
make the reference region.

The button you pressed lights green.
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Setting the Edit Points

Keyframe control block

To set the edit points, use any of the following operations in the keyframe 
control block.
• To move the edit point to the keyframe immediately after the current time 

(the position at which the effect is currently stopped), press the [NEXT KF] 
button.

• To move the edit point to the keyframe immediately before the current time, 
press the [PREV KF] button.

• To move the edit point to a keyframe specified by number, press the [GO TO 
KF] button, then enter the keyframe number with the numeric keypad in the 
numeric keypad control block or Multifunction Flexi Pad control block, and 
press the [ENTER] button to confirm.

• To move the edit point to a specified timecode, press the [GO TO TC] button, 
then enter the timecode value with the numeric keypad in the numeric 
keypad control block, or Multifunction Flexi Pad control block and press the 
[ENTER] button to confirm.

To enter a difference value
When moving to a point specified with the [GO TO KF] button or [GO TO TC] 
button, you can also enter the difference from the current keyframe number or 
timecode value.

STOP
NEXT

KF

NORM REV

NORM
/REV

EFF
LOOP

EDIT
ENBL

KF
DUR

DELAY

EFF
DUR

COPY PASTE

DEL

SHIFT INS
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MOD UNDO

CONST
DUR

AUTO
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TURN
OVER
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LOOP
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WIND

RUN

EDIT ENBL button

Buttons used for editing

CONST DUR button
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Press the numeric keypad [+/–] button, and enter the difference, then press the 
[TRIM] button. Each time you press the [+/–] button, it toggles between plus 
(+) and minus (–).

Note
You can also specify edit points in the Multifunction Flexi Pad control block. 
For details of the operation, see “Keyframe Creation and Editing in the 
Multifunction Flexi Pad Control Block” (page 281).
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Creating and Editing Keyframes

For this operation you can use the numeric keypad control block and keyframe 
control block, or the Multifunction Flexi Pad control block. In the following, 
the case of using the numeric keypad control block and keyframe control block 
is described as an example.

Note
For details of Multifunction Flexi Pad control block, see “Keyframe Creation 
and Editing in the Multifunction Flexi Pad Control Block” (page 281).

Creation

Creating new keyframes
To create new keyframes, after recalling an empty register, use the following 
procedure to create and insert each new keyframe. Use the keyframe control 
block for carrying out the operation.

1 Press the [EDIT ENBL] button, turning it on.

This enables effect editing in the keyframe control block.

2 Create the image you want to be the first keyframe.

3 Press the [INS] button.

This takes the current image as the first keyframe.
You can make a setting in the Setup menu so that when you recall an empty 
register, the system state at that point is automatically captured as the first 
keyframe.

4  Create the image you want to be the next keyframe.

5 Press the [INS] button.

This inserts the current image as the second keyframe after the first 
keyframe.

Repeat steps 4 and 5 to create the required number of keyframes.
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To insert a new keyframe before an existing keyframe
Hold down the [SHIFT] button and press the [INS] button, to insert a new 
keyframe before the current keyframe.

Insertion

Inserting keyframes
To insert a keyframe in an existing effect, use the following procedure in the 
keyframe control block.

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect at the desired edit point.

3 Create the image for the keyframe you want to insert.

4 Press the [INS] button.
When the edit point is on a keyframe, to insert the new keyframe before 
the existing keyframe, hold down the [SHIFT] button and press the [INS] 
button.

This inserts the current image as the new keyframe.
Inserting a keyframe may change the total duration of the effect. (See 
“Time Settings” (page 239).)

Modification

Modifying keyframes
Use the following procedure in the keyframe control block.

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect at the desired edit point.

When the edit point is on a keyframe, this is what you modify. If the edit 
point is between two keyframes, the previous keyframe is what you 
modify.

Note
In constant duration mode (see page 239) modification is only possible 
when the edit point is on a keyframe.
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3 Using image transformations or adding special effects, modify the 
keyframe.

4 Press the [MOD] button.

This modifies the keyframe.

Modifying more than one keyframe simultaneously
You can modify a number of keyframes simultaneously. There are three 
different cases for this operation.
• Modifying from the edit point to a particular keyframe
• Modifying all keyframes in the effect
• Modifying the keyframes in a specified range
The different procedures for these cases are now described.

To modify from the edit point to a particular keyframe

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect at the first keyframe of the range to be modified.

3 Carry out the necessary modifications.

4 Press the [FROM TO] button, turning it on.

The display in the numeric keypad control block shows the current 
keyframe number, followed by “TO.”

5 Enter the number of the last keyframe to be modified from the numeric 
keypad control block and press the [ENTER] button to confirm.

6 Press the [MOD] button. Alternatively, hold down the [SHIFT] button and 
press the [MOD] button.

For the difference in the result, see “Differences in the changes when a 
number of keyframes are modified” (page 272).

This makes the modification simultaneously to all keyframes from the edit 
point to the specified keyframe.

To modify all keyframes in the effect

1 Press the [EDIT ENBL] button, turning it on.

2 Carry out the necessary modifications on any keyframe.
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3 Press the [ALL] button, turning it on.

4 Press the [MOD] button. Alternatively, hold down the [SHIFT] button and 
press the [MOD] button.

For the difference in the result, see “Differences in the changes when a 
number of keyframes are modified” (page 272).

This makes the modification simultaneously to all keyframes in the effect.

To modify the keyframes in a specified range

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect at any keyframe within the range to be modified.

3 Carry out the necessary modifications.

4 Press the [FROM TO] button, turning it on.

The display in the numeric keypad control block shows the current 
keyframe number, followed by “TO.”

5 Using the numeric keypad in the numeric keypad control block, carry out 
the following operations.

• To set the first keyframe in the range to be modified, press the [CLR] 
button, then enter the keyframe number, and press the [ENTER] button 
to confirm.

• To set the last keyframe in the range to be modified, enter the keyframe 
number from the numeric keypad, and press the [ENTER] button to 
confirm.

6 Press the [MOD] button. Alternatively, hold down the [SHIFT] button and 
press the [MOD] button.

For the difference in the result, see “Differences in the changes when a 
number of keyframes are modified” (page 272).

This makes the modification simultaneously to all keyframes in the 
specified keyframe range.

Differences in the changes when a number of keyframes are 
modified

When you select a number of keyframes to modify, and press the [MOD] 
button alone or in combination with the [SHIFT] button, the result of the 
operation differs as shown below.
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Modifying the keyframes by pressing the [MOD] button alone
The modified parameter values are taken as absolute values, and applied to all 
of the selected keyframes.

Modifying the keyframes by holding down the [SHIFT] button and 
pressing the [MOD] button
The modified parameter values are taken as relative values, which modify all 
of the selected keyframes.

: Background A
: Background B

Keyframe 1 Keyframe 2 Keyframe 3 Effect execution

Modify keyframe 2.

(Changing the position of background B in 
the horizontal direction)

Select keyframes 1 to 3 and modify 
simultaneously.

Keyframe 1 Keyframe 2 Keyframe 3 Effect execution

Result: 
The horizontal position of background B in keyframes 1 and 3 is now the same as 
that in keyframe 2.
In all keyframes, the vertical position remains unchanged as the parameter is not 
changed.
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Deletion

Deleting keyframes

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect at the desired edit point.

When the edit point is on a keyframe, this is what you delete. If the edit 
point is between two keyframes, the previous keyframe is what you delete.

: Background A
: Background B

Modify keyframe 2.

(Changing the position of background B in 
the horizontal direction)

Select keyframes 1 to 3 and modify 
simultaneously.

Result: 
Background B of keyframes 1 and 3 is moved in the horizontal direction by the same 
amount as in keyframe 2.

Keyframe 1 Keyframe 2 Keyframe 3 Effect execution

Keyframe 1 Keyframe 2 Keyframe 3 Effect execution
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3 To delete a number of keyframes in a single operation, press the [FROM 
TO] button or the [ALL] button, turning it on.

For how to specify a range of keyframes, see “Modifying more than one 
keyframe simultaneously” (page 271).

4 Press the [DEL] button.

This deletes the keyframe.
Deleting a keyframe reduces the total duration of the effect.
In constant duration mode (see page 280), however, the duration does not 
change.

For details , see “Changes in the effect duration caused by deleting a 
keyframe” (page 241).

Movement

Moving keyframes

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect at the edit point you want to move.

3 To move a number of keyframes in a single operation, press the [FROM 
TO] button, turning it on, to specify the keyframes.

For how to specify a range of keyframes, see “Modifying more than one 
keyframe simultaneously” (page 271).

4 Press the [DEL] button.

This deletes the keyframe, and saves it in the paste buffer.

5 Move the edit point to the position to which you want to move the 
keyframe.

6 Press the [PASTE] button.

This inserts the keyframe you have moved after the current keyframe. In 
constant duration mode, the moved keyframe overwrites the edit point.

To insert the moved keyframe before a keyframe
Hold down the [SHIFT] button, and press the [PASTE] button to insert the 
moved keyframe before the current keyframe.
275Creating and Editing Keyframes



   C
hapter 13 

K
eyfram

e E
ffects

276
Copying

Copying keyframes

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect at the edit point you want to copy.

3 To copy a number of keyframes in a single operation, press the [FROM 
TO] button or the [ALL] button, turning it on.

For how to specify a range of keyframes, see “Modifying more than one 
keyframe simultaneously” (page 271).

4 Press the [COPY] button.

This copies the specified keyframe, and saves it to the paste buffer.

5 Move the edit point to the position where you want to insert the copied 
keyframe.

6 Press the [PASTE] button.

This inserts the keyframe you have copied after the current keyframe. In 
constant duration mode, the copied keyframe overwrites the edit point.

To insert the copied keyframe before a keyframe
Hold down the [SHIFT] button, and press the [PASTE] button to insert the 
copied keyframe before the current keyframe.

Pause

To apply a pause to a keyframe, use the following procedure.

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect on the keyframe to which you want to apply a pause.

3 Press the [PAUSE] button.

This applies a pause to the specified keyframe.
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Keyframe Loop (Repeated Execution of a Specified 
Range)

By setting the range of the loop within the effect, and the number of loop 
executions, you can execute the loop range repeatedly.

Note
It is only possible to set one keyframe loop for each region.

Creating a new keyframe loop
To specify the loop range and loop count, carry out the following procedure.

1 Press the [EDIT ENBL] button, turning it on.

2 Stop the effect on the keyframe you want to make the first of the loop range 
(start point). (Here, by way of example, keyframe 2 is taken as the start 
point.)

3 Press the [KF LOOP] button in the keyframe control block, turning it on.

The numeric keypad control block display shows the start point keyframe 
number as follows.

The example shown means “from (keyframe) 2 to...,” where the end 
keyframe is to follow.

4 With the numeric keypad buttons of the numeric keypad control block, 
enter the number of the last keyframe in the loop range (end point). (Here, 
by way of example, keyframe 5 is the end point.) 

5 Press the [ENTER] button to confirm the entry.

The display changes as follows, prompting you to enter the loop count.

6 Enter the loop count. (Here, by way of example, “15” is entered.)

• To specify a loop count, enter a number in the range 1 to 99.
• To specify an endless loop, enter “0” (zero).

  FM  2 TO    

  FM  2 TO  5 

  COUNT       
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7 Press the [ENTER] button to confirm the entry.

The start point, end point, and loop count that you have set are reflected in 
the Timeline menu.
If you enter the loop count as “0” (endless loop), the count is shown as 
“inf” (infinity).
The numeric keypad control block display changes back to the state shown 
in step 4.

Changing the keyframe loop settings
To change the loop range or count for the currently recalled effect, carry out 
the following procedure.

1 When the [KF LOOP] button in the keyframe control block is lit amber, 
press it, turning it green.

The numeric keypad control block display shows the current loop range.
If, for example, the start point is keyframe 2 and the end point is keyframe 
5, this appears as follows.

2 To change the loop range, press the [CLEAR] button in the numeric 
keypad control block.
To change the loop count only, press the [ENTER] button, then skip to step 
6.

When you press the [CLEAR] button, this appears as follows.

3 Enter the keyframe number for the new start point, and press the [ENTER] 
button.

4 Enter the keyframe number for the new end point, and press the [ENTER] 
button.

The display shows the currently set loop count.

5 To change the setting, press the [CLEAR] button.

This clears the set loop count.

  COUNT    15

  FM  2 TO  5 

  FM    TO    

  COUNT       
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6 Enter the new loop count, and press the [ENTER] button.

Executing a keyframe loop
In the keyframe control block, press the [RUN] button.
The set loop range is executed repeatedly for the set loop count number of 
times.
The screen shows the total loop count and the number of loops remaining. (If 
the loop count is infinite (inf), the remaining number is not shown.)
If the [REV] button is lit, the loop is played in the reverse order.

Canceling keyframe loop execution
Press the [REWIND] button in the keyframe control block.

Changes to the loop range caused by keyframe insertion/
deletion

When a keyframe is inserted or deleted within the loop range, the loop range 
also changes. The following are examples.

Example 1: If keyframe 3 is deleted, the loop end point moves forward as 
follows.

Example 2: If keyframe 3 is added, the end point keyframe number moves 
back.

1 2 3 4 5 6 7

1 2 3 4 5 6 7
Before deletion

After deletion

Deletion

: Loop range
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Example 3: If the keyframe at the end of the loop range (the end point) is 
deleted, the keyframe loop settings are all cleared, as follows, and the [KF 
LOOP] button goes off. The same occurs if the first keyframe in the loop 
range (the start point) is deleted.

Undoing an Edit Operation

To undo a keyframe insert, modify, delete, or paste operation immediately after 
execution, press the [UNDO] button.

Duration Mode Setting

There are two keyframe duration modes: variable duration mode, and constant 
duration mode in which the effect duration is fixed (see page 239).

• To select variable duration mode, turn the [CONST DUR] button off.
• To select constant duration mode, press the [CONST DUR] button, turning 

it on.

1 2 3 4 5 6 7

1 2 3 4 5 6 7
Before addition

After addition

Addition

: Loop range

1 2 3 4 5 6 7

1 2 3 4 5 6 7
Before deletion

After deletion

Deletion

: Loop range
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Transition Mode Settings for User Programmable DME

To create an effect for user programmable DME, it is necessary to set the 
transition mode.

Setting the transition mode

1 In the Key Frame menu, select HF4 ‘DME User PGM.’

The DME User PGM menu appears.

2 In the <Transition Mode> group, select the transition mode according to 
the DME wipe action.

Single: select single transition mode.
Flip/Tumble: select the flip/tumble transition mode.
Dual: select dual transition mode.
P in P: select picture-in-picture mode.
Compress: select compress mode.
Frame I/O: select frame in-out transition mode.
Frame I/O H: select frame in-out transition mode in the horizontal 

direction.
Frame I/O V: select frame in-out transition mode in the vertical direction.

For details of creating an effect for user programmable DME, see 
“Creating User Programmable DME Patterns” in Chapter 6 (Volume 1).

Note
Which DME channel is selected as the reference region (lit green) in the 
numeric keypad control block is reflected in the <Transition Mode> group 
display.

Keyframe Creation and Editing in the Multifunction 
Flexi Pad Control Block

To create and edit a keyframe in the Multifunction Flexi Pad control block, 
press the [EFF] button to switch to effect operation mode, then press the [EDIT 
ENBL] button.
The [EDIT ENBL] button lights red, and the memory recall section switches to 
the effect editing mode as shown in the following illustration.
281Creating and Editing Keyframes



   C
hapter 13 

K
eyfram

e E
ffects

282
In this mode, you can carry out keyframe creation and editing, using the 
following buttons.
[EXIT] button: Forcibly exit editing mode.
[UNDO] button: Undo the last keyframe insertion, modification, deletion, 

paste or other operation.
[PAUS] button: Add a pause setting to a keyframe (see page 276).
[COPY] button: Copy a keyframe (see page 276).
[PSTE] button: Paste a keyframe (see page 275).
[ALL] button: Select all keyframes in an effect (see page 270).
[STOR] button: Save the effect (see page 297).

Buttons in the memory recall section in effect editing mode (first page) 
Press the [PAGE 1/2] button to switch to the next button display.

Buttons in the memory recall section in effect editing mode (second page) 
Press the [PAGE 2/2] button to switch to the previous button display.
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[INS] button: Insert a keyframe (see page 270)
[MOD] button: Modify a keyframe (see page 270).
[DEL] button: Delete a keyframe (see page 274).
[REWIND] button: Move to the first keyframe in the effect (see page 292).
[SHFT] button: Enable the shift function of the button pressed together with 

this one.
[<< PREV] button: Move the edit point to the previous keyframe (see page 

267).
[>> NEXT] button: Move the edit point to the next keyframe (see page 267).
[RUN] button: Run the effect (see page 292).
[EFF DUR] button: Set the effect duration (see page 285).
[KF DUR] button: Set the keyframe duration (see page 284).
[DLY] button: Set a delay (see page 286).
[KF LOOP] button: Set a keyframe loop (see page 277).
[CNST DUR] button: Switch the duration mode (see page 280).
[GOTO TC] button: Move the edit point to the specified timecode position 

(see page 267).
[GOTO KF] button: Move the edit point to the specified keyframe position 

(see page 267).
[FROM TO] button: Switch to the mode for inputting ranges with the 

numeric keypad (see page 271).
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Time Settings

You can determine the execution time of an effect by setting either the 
keyframe durations or the effect duration.

For details of keyframe duration and effect duration, see “Keyframe duration 
and effect duration” (page 239).

Setting the Keyframe Duration

Keyframe control block

Setting the keyframe duration
You can set the value of the keyframe duration independently for each 
keyframe, by the following method.

1 Press the [EDIT ENBL] button, turning it on.

STOP
NEXT

KF

NORM REV

NORM
/REV

EFF
LOOP

EDIT
ENBL

KF
DUR

DELAY

EFF
DUR

COPY PASTE

DEL

SHIFT INS
PREV

KF
NEXT

KF

MOD UNDO

CONST
DUR

AUTO
INS

TURN
OVER

KF
LOOP

GO TO
TC

PAUSE

GO TO
KF

ALL
FROM

TO

FF

RE
WIND

RUN

EFF DUR button

KF DUR button

EDIT ENBL button

DELAY button
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2 Stop the effect on the keyframe for which you want to set the duration.

The time from this keyframe to the following keyframe is what you set.

3 Press the [KF DUR] button, turning it on.

The display in the numeric keypad control block shows “KF DUR” 
followed by the duration of the current keyframe (seconds:frames).

4 Using the numeric keypad in the numeric keypad control block, enter the 
timecode value for the keyframe duration, as a maximum of four digits.

For example, to set 9 seconds and 20 frames, enter 920. You can also use 
the [TRIM] button to enter a difference value. (See “To enter a difference 
value” (page 267).)

5 Press the [ENTER] button to confirm the entry.

This changes the keyframe duration to the new setting.

Note
In addition to the above operation, the keyframe duration may also be 
automatically changed as a result of changing the effect duration. (See the 
next section.)

Setting the Effect Duration

To set the effect duration, use the following procedure.

1 Press the [EDIT ENBL] button, turning it on.

2 Press the [EFF DUR] button, turning it on.

The display in the numeric keypad control block shows “DUR” followed 
by the effect duration (minutes:seconds:frames).

3 Using the numeric keypad in the numeric keypad control block, enter the 
timecode value for the effect duration, as a maximum of six digits.

For example, to set 3 minutes 7 seconds and 15 frames, enter 30715. You 
can also use the [TRIM] button to enter a difference value. (See “To enter 
a difference value” (page 267).)

4 Press the [ENTER] button.

This changes the effect duration to the new setting.
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Note
In addition to the above operation, the effect duration may also be changed 
as a result of inserting or deleting keyframes. See “Time Settings” (page 
239).

Setting the Delay

To set the delay (see “Time Settings” (page 239)), use the following procedure.

1 Press the [EDIT ENBL] button, turning it on.

2 Press the [DELAY] button, turning it on.

The display in the numeric keypad control block shows “DELAY” 
followed by the delay time (seconds:frames).

3 Using the numeric keypad in the numeric keypad control block, enter the 
timecode value for the delay, as a maximum of four digits.

You can also use the [TRIM] button to enter a difference value. (See “To 
enter a difference value” (page 267).)

4 Press the [ENTER] button to confirm the entry.

This changes the delay setting.
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Path Setting

The term “path” refers to the specification of how interpolation is carried out 
from one keyframe to the next.

For details of the notion of path, see “Paths” (page 243).

Set keyframe paths in the Key Frame >Path menu.

To access the Key Frame>Path menu
In the menu control block, press the top menu selection button [KEY FRAME], 
then select HF3 ‘Path.’

Basic Procedure for Path Settings

Selecting the category
From the 16 buttons in the function button area, select the category for which 
you want to make the setting.
First row: path settings for the switcher M/E1, M/E2, and PGM/PST banks
Second and third rows: path settings for User1 to User8
Fourth row: path settings for DME local channel and global channel 3D 

transforms and effects

Making switcher path settings
This section describes settings for M/E-1 Key1 as an example.
The area for the VF buttons shows the names of items.
A B sign by a button indicates that pressing it opens a more detailed setting 
menu.
The status area shows the settings for Xpt, Hue, and Curve. However, 
depending on the item, these parameters may or may not be present.

Note
Whenever you set a path or modify its setting, be sure to press the [MOD] 
button in the keyframe control block. The setting does not become effective 
unless the [MOD] button is pressed.
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Changing the path type for Curve

1 In the Path menu, press [M/E-1].

The M/E-1 menu appears.

2 Press the Curve path type indication for the Key1 item that you want to 
change.

A path selection window appears.

3 Press the indication for the desired path type, to select it.

OFF: Executing the effect causes no change.

Step: There is no interpolation between keyframes, so that the 
effect parameters are updated each time a keyframe is passed.

Linear: Linear interpolation between keyframes, resulting in 
constant speed movement.

S-Curve: The rate of change accelerates and decelerates before and 
after a keyframe, so that the rate of change is maximum midway 
between two keyframes.

Spline: The effect follows a smooth curved path from each 
keyframe to the next.

The status area reflects the selected path type.
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At this point, depending on the setting for Curve, the effect for Hue and 
Xpt is also affected as shown in the following table. In the menu, the Hue 
and Xpt settings do not change, but the path type indication is dimmed out.

4 If you selected Spline as the path type, set the following parameters, using 
the knobs.

Changing the path type for Hue

1 Press the Hue path type indication for the item that you want to change.

2 Turn knob 1 to change the Hue path type.

The path type indications shown in the menu represent the change in hue 
as seen on a Vectorscope.

CW: Rotate clockwise.

CCW: Rotate counterclockwise.

Short: The hue changes in whichever of the clockwise and 
counterclockwise directions is shorter.

Long: The hue changes in whichever of the clockwise and 
counterclockwise directions is longer.

Changing the path type for Xpt

1 Press the Xpt path type indication for the item that you want to change.

A path selection window appears.

2 Press the indication for the desired path type, to select it.

Xpt Hold off: When replaying a keyframe, change the inputs to the 
settings saved in memory.

Curve setting Hue change Xpt change

OFF Does not change Hold

Step Changes as with the Step setting Is not affected

Knob Parameter Adjustment Setting values

1 Tens Spline interpolation tension –4.00 to +4.00

2 Bias Spline interpolation bias –4.00 to +4.00

3 Cont Spline interpolation continuity –4.00 to +4.00
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Xpt Hold on: When replaying a keyframe, do not change the 
inputs.
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Executing Effects

By means of the [RUN] button in the keyframe control block, you can play an 
effect as a continuously varying image. This is referred to as effect execution.

See also “Effect Execution” (page 249).

It is also possible to execute an effect from the device control block, the 
standard type Flexi Pad control block or the Multifunction Flexi Pad control 
block (see Chapter 2 (Volume 1)).

Executing Effects in the Keyframe Control Block

Keyframe control block

STOP
NEXT

KF

NORM REV

NORM
/REV

EFF
LOOP

EDIT
ENBL

KF
DUR

DELAY

EFF
DUR

COPY PASTE

DEL

SHIFT INS
PREV

KF
NEXT

KF

MOD UNDO

CONST
DUR

AUTO
INS

TURN
OVER

KF
LOOP

GO TO
TC

PAUSE

GO TO
KF

ALL
FROM

TO

FF

RE
WIND

RUN

Effect execution section

REWIND button

FF button

RUN button
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Executing an effect automatically

1 Select the region in which you want to execute the effect, using the region 
selection buttons in the numeric keypad control block. (See step 2 (page 
256) of “Recalling a register.”)

2 With the numeric keypad, enter the number of the register in which the 
effect you want to execute is saved, and press the [ENTER] button to 
confirm.

This recalls the effect saved in the register.

3 In the keyframe control block, press the [RUN] button.

The [RUN] button lights amber and the effect is executed automatically.

Executing an effect manually 
In step 3 above, operate the fader lever.

To use the transition control block fader lever as a keyframe fader
Press the [KF] button in the transition control block, turning it on, to execute a 
keyframe effect with the fader lever in the same control block.
You can also assign the [KF] button to a transition type selection button in the 
transition control block.

Notes
• For the operation of assigning the [KF] button to the transition type selection 

buttons, see “Overall Control Panel Settings (Config Menu)” in Chapter 19 
(Volume 3).

• It is not possible for the [KF] button to be on for multiple banks (M/E or 
PGM/PST) at the same time. If you press the [KF] button in more than one 
bank, only the last button pressed remains on.

• If a macro is assigned to the transition control block fader lever, then while 
in use as a keyframe fader the macro is not executed.

Moving to the first keyframe of the effect
To move to the first keyframe of the effect, press the [REWIND] button.

Moving to the last keyframe of the effect
To move to the last keyframe of the effect, press the [FF] button.
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Setting the Run Mode

You can set the run mode in which an effect is executed when you press the 
[RUN] button.

Specifying the effect execution direction
To specify the effect execution direction, press the [NORM] button or the 
[REV] button, turning it on. When you press one, turning it on, the other 
automatically goes off.
To execute the effect so as to obtain the effects of the [NORM] and [REV] 
buttons alternately, press the [NORM/REV] button, turning it on.
When the [NORM] button is lit: The effect is executed in the direction from 

the first keyframe to the last keyframe.
When the [REV] button is lit: The effect is executed in the direction from the 

last keyframe to the first keyframe.
When the [NORM/REV] button is lit: Each time the effect is executed, the 

direction reverses.

Executing an effect up to the next keyframe

1 Press the [STOP NEXT KF] button, turning it on.

2 Press the [RUN] button.

This executes the effect as far as the next keyframe. When the [REV] 
button is lit, it is executed as far as the previous keyframe.

Repeating an effect

1 Press the [EFF LOOP] button, turning it on.

2 Press the [RUN] button.

This executes the effect repeatedly, from the first keyframe to the last 
keyframe.
When the [REV] button is lit, the effect is executed in the reverse direction.

3 To stop the repeating effect, press the [EFF LOOP] button, turning it off, 
or press the [REWIND] button.
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Executing an Effect in the Flexi Pad Control Block

Executing an effect
To execute an effect recalled from the numeric keypad control block in the 
Flexi Pad control block, use the following procedure.

1 In the Flexi Pad control block, press the [EFF] button.

This assigns the Flexi Pad control block to effect operation, and the 
[REWIND] button and [RUN] button appear in the memory recall section.
The previously selected bank number and last recalled register number 
appear in the numeric display.

2 Press the following buttons to execute the effect.

REWIND: Press this button to move to the first keyframe of the currently 
recalled effect.

RUN: Press this button to run the currently recalled effect.

Executing an Effect in the Multifunction Flexi Pad 
Control Block

1 In the Multifunction Flexi Pad control block, press the [EFF] button.

This changes the Multifunction Flexi Pad control block to effect operation, 
and the [REWIND] button and [RUN] button appear in the memory recall 
section.
The previously selected bank number and last recalled register number 
appear in the numeric display.
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2 Press the following buttons to execute the effect.

REWIND: Press this button to move to the first keyframe of the currently 
recalled effect.

RUN: Press this button to run the currently recalled effect.

Setting the execution mode
Press the [EXEC MODE] button to switch the memory recall section to the 
execution mode setting mode, and set the execution mode with the 
following buttons, then execute the effect.

[EFF LOOP] button: Execute the effect repeatedly.
[STOP NEXT] button: Execute the effect and stop at the next keyframe.
[NORM] button: Execute the effect from the first keyframe to the last 

keyframe.
[NORM/REV] button: Execute the effect as far as the first or last 

keyframe, then reverse direction.
[REV] button: Execute the effect from the last keyframe to the first 

keyframe.
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Saving Effects

When you recall an effect, the currently recalled effect is automatically saved 
in a register. This is referred to as the auto save function.
You can disable the auto save function in a Setup menu.
By means of the following operation, you can also specify a register and save 
an effect in it.

Saving an effect in a specified register
Specify the register using the numeric keypad control block. 

1 Press the [EFF] button, turning it on.

This assigns the numeric keypad control block to keyframe operations.

2 Press the region selection button corresponding to the region for which you 
want to save the register, turning it on.
See step 2 (page 256) of “Recalling a Register.”

3 Press the [STORE] button, turning it on.

4 With the numeric keypad, enter the number of the register in which you 
want to save the effect.

To find an empty register, instead of entering a number, press the [.] 
(period) button. To search for an empty register common to all currently 
selectable regions, press the [.] button again.
To search for an empty register in the 100 range, press [1], [0], [0], [.] 
(period) in this order. Similarly, to search for an empty register in the 200 
range, press [2], [0], [0], [.] (period), and to search for an empty register in 
the 300 range, press [3], [0], [0], [.] (period).

The register number appears in the display. If the number is followed by a 
letter ‘e’ or ‘E,’ this indicates the following.
e: The selected register is empty for the regions selected in step 2.
E: The selected register is empty for all selectable regions.

5 To add an attribute (effect dissolve), press the [+/–/EFF DISS] button, 
turning it on.

For details of attributes, see “Effect Attributes” (page 237).

6 Press the [ENTER] button.
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This saves the current effect in the specified register, and turns off the 
[STORE] button. The [RCALL] button and [STORE STATS] button both 
light.

To undo the saving of an effect
Immediately after saving an effect, hold down the [STORE STATS] button and 
press the [UNDO] button to undo the save.

Saving an effect with the Multifunction Flexi Pad control block

1 Press the [EFF] button, turning it on.

This assigns the memory recall section to effect operations.

2 Press the region selection button corresponding to the region for which you 
want to save the register, turning it on.

See step 2 (page 256) of “Recalling a Register.”

3 Press the [EDIT ENBL] button.

This assigns the memory recall section to effect editing operations.

4 Press the [STOR] button, turning it on.

5 With the numeric keypad, enter the number of the register in which you 
want to save the effect.

To find an empty register, instead of entering a number, press the [.] 
(period) button. To search for an empty register common to all currently 
selectable regions, press the [.] button again.
To search for an empty register in the 100 range, press [1], [0], [0], [.] 
(period) in this order. Similarly, to search for an empty register in the 200 
range, press [2], [0], [0], [.] (period), and to search for an empty register in 
the 300 range, press [3], [0], [0], [.] (period).

The register number appears in the display. If the number is followed by a 
letter ‘e’ or ‘E,’ this indicates the following.
e: The selected register is empty for the regions selected in step 2.
E: The selected register is empty for all selectable regions.

6 Press the [ENTR] button.

This saves the current effect in the specified register, and turns off the 
[EDIT ENBL] button.
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Creating and Saving a Master Timeline

Creating and Saving a Master Timeline Using the 
Buttons in the Numeric Keypad Control Block

Creating and saving a master timeline
You can save region information (information on any regions, including the 
register numbers associated with the regions) referred to as a master timeline 
in a dedicated register. By recalling that register, you can manipulate the 
regions and registers together.

1 Press the [EFF] button, turning it on.

This assigns the numeric keypad control block to keyframe effect 
operations.

2 Recall the register number of the effect you want to save on the master 
timeline for each region. (See “Recalling a Register” (page 255).)

3 Of the region selection buttons, press those buttons for the regions you 
want to save on the master timeline, turning them on.

4 Press the region selection button [MASTR], turning it on.

The display shows the number of the register last used for master timeline 
register operation.

5 Press the [STORE] button, turning it on.

6 With the numeric keypad buttons, enter the number of the register in which 
you want to save the master timeline.

To find an empty register, instead of entering a number, press the [.] 
(period) button. 

The display shows the register number. If the number is followed by a 
letter “E,” the register is empty.

7 Press the [ENTER] button.
Creating and Saving a Master Timeline



  C
hapter 13 

K
eyfram

e E
ffects
The regions selected in step 3 and the register numbers recalled in those 
regions are saved in the master timeline register, and the [STORE] button 
goes off. At the same time, the [RCALL] button lights.

Notes
• It is not possible to undo a master timeline save.
• Saving the master timeline does not carry out a save of effects. Save the 

effects for each region first, then carry out the master timeline save.

Changing a master timeline
You can change information already saved in a master timeline.
As an example, to change the M/E-1 register from Effect 5 to Effect 10, use the 
following procedure.

Information in master timeline register 1 before change

Information in master timeline register 1 after change

1 Recall the master timeline register you want to change. (See “Recalling a 
Register” (page 255).)

This simultaneously recalls M/E-1 register 5 and P/P register 5, and the 
[M/E-1] and [P/P] region selection buttons light.

2 Press the region selection button [MASTR], turning it off.

3 Turn on only the button for the region you want to change (here, [M/E-1]), 
and recall the desired register (here, Effect 10).

This recalls M/E-1 register 10, while on P/P register 5 remains selected.

4 Press the buttons for the regions you want to save on the master timeline 
(here, [M/E-1] and [P/P]), turning them on.

5 Press the region selection button [MASTR], turning it on.

Region Register 

M/E-1 Effect 5

P/P Effect 5

Region Register 

M/E-1 Effect 10

P/P Effect 5
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The display shows the register number last used for master timeline 
operation.

6 Press the [STORE] button, turning it on.

7 With the numeric keypad buttons, enter the number of the register (here 
“1”) in which you want to save the master timeline, and press the [ENTER] 
button.

This saves M/E-1 register 10 and P/P register 5 in master timeline register 
1, and the [STORE] button goes off. At the same time, the [RCALL] 
button lights.

Checking the regions saved on a master timeline
For example in the course of changing a master timeline, you can check which 
regions are saved in the register. With the [MASTR] button in the numeric 
keypad control block lit, hold down the [STORE] button. While it is held down, 
the buttons for the saved regions light. When the button is released, the state 
before it was held down is restored.

Creating and Saving a Master Timeline Using the 
Buttons in the Multifunction Flexi Pad Control Block

Creating and saving a master timeline

1 Press the [EFF] button, turning it on.

This assigns the memory recall section to keyframe effect operations.

2 Recall the register number of the effect you want to save on the master 
timeline for each region. (See “Recalling a register from the numeric 
keypad control block” (page 255).)

3 Of the region selection buttons, press those buttons for the regions you 
want to save on the master timeline, turning them on.

4 Press the region selection button [MSTR], turning it on.

The display shows the number of the register last used for master timeline 
register operation.

5 Press the [EDIT ENBL] button.
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This assigns the memory recall section to keyframe effect editing 
operations.

6 Press the [STOR] button, turning it on.

7 With the numeric keypad buttons, enter the number of the register in which 
you want to save the master timeline.

To find an empty register, instead of entering a number, press the [.] 
(period) button. 

The display shows the register number. If the number is followed by a 
letter “E,” the register is empty.

8 Press the [ENTER] button.

The regions selected in step 3 and the register numbers recalled in those 
regions are saved in the master timeline register.

Notes
• It is not possible to undo a master timeline save.
• Saving the master timeline does not carry out a save of effects. Save the 

effects for each region first, then carry out the master timeline save.

Changing a master timeline
You can change information already saved in a master timeline.
As an example, to change the M/E-2 register from Effect 11 to Effect 15, use 
the following procedure.

1 Recall the master timeline register you want to change. (See “Recalling a 
register from the numeric keypad control block” (page 255).)

This simultaneously recalls M/E-2 register 11 and P/P register 11, and the 
[M/E-2] and [P/P] region selection buttons light.

2 Press the region selection button [MSTR], turning it off.

3 Turn on only the button for the region you want to change (here, [M/E-2]), 
and recall the desired register (here, Effect 15).

This recalls M/E-2 register 15, while on P/P register 11 remains selected.

4 Press the buttons for the regions you want to save on the master timeline 
(here, [M/E-2] and [P/P]), turning them on.

5 Press the region selection button [MSTR], turning it on.
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The display shows the register number last used for master timeline 
operation.

6 Press the [EDIT ENBL] button.

This assigns the memory recall section to keyframe effect editing 
operations.

7 Press the [STOR] button, turning it on.

8 With the numeric keypad buttons, enter the number of the register (here 
“1”) in which you want to save the master timeline, and press the [ENTR] 
button.

This saves M/E-2 register 15 and P/P register 11 in master timeline register 
1. At the same time, the [MSTR RCLL] button lights green.

Creating and Saving a Master Timeline With the Menu

You can save a master timeline using the Effect >Master Timeline >Store 
menu.

Recalling the Store menu

1 Do either of the following.

• In the menu control block, press the top menu selection button [EFF].
• In the numeric keypad control block, press the [EFF] button twice in 

rapid succession.

The Effect menu appears.

2 Press VF1 ‘Master Timeline’ and HF1 ‘Store.’

The Master Timeline >Store menu appears.
The status area shows the master timeline register names, register lock 
status, register number for each region, and so on.

3 If required, press the following buttons in the status area to change the 
region display.

M/E, P/P: indicate assignment of M/E-1 (“M/E1”), M/E-2 (“M/E2”)  and 
P/P (“P/P”).
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User: indicate assignment of User1 (“USR1”), User2 (“USR2”), User3 
(“USR3”), User4 (“USR4”), User5 (“USR5”), User6 (“USR6”), 
User7 (“USR7”), and User8 (“USR8”).

DME: indicate assignment of DME ch1 (“DME1”), ch2 (“DME2”), ch5 
(“DME5”), ch6 (“DME6”), ch7 (“DME7”), and ch8 (“DME8”).

DEV1-8: indicate assignment of Device1 (“DEV1”), Device2 (“DEV2”), 
Device3 (“DEV3”), Device4 (“DEV4”), Device5 (“DEV5”), Device6 
(“DEV6”), Device7 (“DEV7”), and Device8 (“DEV8”).

DEV9-12: indicate assignment of Device9 (“DEV9”), Device10 
(“DEV10”), Device11 (“DEV11”), and Device12 (“DEV12”).

Misc: indicate assignment of P-Bus (“PBUS”), GPI (“GPI”), and Macro 
(“MCRO”).

Creating and saving a master timeline
To save a master timeline register with the menu, use the following procedure.

1 In the Store menu, using any of the following methods, select the register 
in which you want to save the master timeline.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

2 Press [Edit].

The Edit menu appears, and you can now save the master timeline in the 
specified register. In this menu again, you can turn the knob to select the 
master timeline register.
The status area shows the status of each region in this master timeline.

3 Using any of the following methods, select the region. Multiple selections 
are also possible.

• Press directly on the display in the status area.
• To cancel the selection, press once more to return to the normal display.
• To select all regions, press [ALL].

To select all switcher-related regions (M/E, P/P, User), press [SWR 
ALL].

4 Press [Assign], turning it on.

• If the selected register is locked, a confirmation message appears asking 
whether or not to cancel the operation. Press [OK] to return to the 
previous menu display without carrying out the registration.

Knob Parameter Adjustment Setting values

1 Master Reg Master timeline register 
number

1 to 99
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• If the operation is carried out, the region selected in step 3 is registered 
on the master timeline, and the parameters are now valid.

5 Turn the knob to select the number of the effect register.

6 Repeat steps 3 to 5 as required to set all regions and register numbers to be 
saved on the master timeline.

7 In the <Store> group, press [Store].

This saves the settings.

To return to the state before saving the master timeline content
In the <Store> group, press [Undo].

Knob Parameter Adjustment Setting values

3 Effect Reg Effect register number 1 to 399
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Register Operations in the Menus

Using the Effect menu, you can carry out the following effect register 
operations.
• Attribute setting
• Status display
• Register editing

To display the Effect menu
Press the top menu selection button [EFF] in the menu control block.

The menus for editing registers are divided up by registers. Here the menu for 
registers 1 to 99 is described as an example, but you can carry out operations 
in the same way on registers 101 to 199, 201 to 299, and 301 to 399, using VF3 
to VF5.

Effect Attribute Settings

Applying effect dissolve
To apply the “effect dissolve” attribute to a keyframe effect, use the following 
procedure.

1 In the Effect menu, press VF2 ‘Effect 1-99’ and HF1 ‘Attribute.’

The Attribute menu appears.
The status area shows the region names, register numbers and status, and 
attribute settings.

2 Press the region display in the upper part of the list, and in the selection 
window select the region. Selecting multiple regions is also possible.
To select all regions, press [ALL].

3 Press [OK].

The selected region name appears in the upper part of the list.

4 Using any of the following methods, select the register.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.
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• To select all registers, press [ALL].

5 Press [Effect Dissolve], turning it on.

6 Turn the knob to set the duration.

Setting the duration for a temporary attribute
To set the duration for a temporary attribute set in the numeric keypad control 
block, turn knob 5.

Effect Status Display

The Effect >Effect 1-99 menu displays the following information.

Region name: The selected region name appears in the upper part of the list.
Register number
Register name
Write-protected status: When the register is write-protected, a letter “L” 

appears. 
Empty status: When the register is empty, a letter “E” appears.

Effect Register Editing

You can carry out the following editing on effect registers and master timeline 
registers.
• Lock: Write-protect the contents of the register.
• Copy: Copy the contents of one register to another register.
• Merge: Merge the data of two registers. It is not possible to merge master 

timeline registers.

Knob Parameter Adjustment Setting values

1 Register Register number 1 to 99

3 Num Select number of registers 1 to 99

Knob Parameter Adjustment Setting values

4 Eff Diss 
Duration

Dissolve duration 1 to 999 (frames)

Knob Parameter Adjustment Setting values

5 Temp Dur Temporary attribute 
dissolve duration

0 to 999 (frames)
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• Move: Move the contents of one register to another register.
• Swap: Swap the contents of two registers.
• Delete: Delete the contents of a register.
• Name: Attach a name to a register.

Write-protecting the contents of the effect register

Note
It is not possible to write-protect an empty register.

1 In the Effect menu, press VF2 ‘Effect 1-99’ and HF2 ‘Lock.’

The Lock menu appears.

2 Press the region display in the upper part of the list to display a selection 
window, then select the region in the selection window. Selecting multiple 
regions is also possible.
To select all regions, press [ALL].

3 Press [OK].

The selected region name appears in the upper part of the list.

4 Using any of the following methods, select the register.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

• To select all registers, press [ALL].

5 Press [Lock], turning it on.

To unlock the register
Select the register you want to unlock, and press [Lock], turning it off.

Copying, moving, and swapping effect register data
This section describes the procedure for copying. You can move or swap 
registers using a similar procedure.

1 In the Effect menu, press VF2 ‘Effect 1-99’ and HF3 ‘Copy/Merge.’

Knob Parameter Adjustment Setting values

1 Register Register number 1 to 99

3 Num Select number of registers 1 to 99
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• The Copy/Merge menu appears.
• The left side of the status area shows the register number of the copy 

source, and the right side shows the register number of the copy 
destination.

2 Press the region display in the upper part of the list to display a selection 
window, then select the region in the selection window. Selecting multiple 
regions is also possible.
To select all regions, press [ALL].

Operation between regions
Operation between regions is possible in the following cases.
• Two of the M/E-1, M/E-2 and P/P regions
• Two of the User1 to 8 regions of the same configuration 
• Two of the DME ch1, ch2 and ch5 to 8 (including Global) regions

3 Press [OK].

The selected region name appears in the upper part of the list.

4 Using any of the following methods, select the desired registers.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

• To select all registers, press [ALL]. 

5 To copy without transferring the name, in the <Copy> group, press [W/o 
Name], turning it on.

6 In the <Copy> group, press [Copy].

This carries out the copy.
If, for example, the copy destination register is write-protected or the same 
register is specified both as the copy source and destination registers, a 
confirmation message appears. Press [OK] to cancel the copy.

Merging effect registers

1 In the Effect menu, select VF2 ‘Effect 1-99’ and HF3 ‘Copy/Merge.’

• The Copy/Merge menu appears.

Knob Parameter Adjustment Setting values

1 From Reg Copy source register number 1 to 99

2 To Reg Copy destination register number 1 to 99

3 Num Select number of registers 1 to 99
Register Operations in the Menus



  C
hapter 13 

K
eyfram

e E
ffects
• The left side of the status area shows a list for the register coming 
afterward when merged. The right side shows a list for the register 
coming before when merged.

2 Press the region display in the upper part of the list, and in the selection 
window select the region. Selecting multiple regions is also possible.
To select all regions, press [ALL].

3 Press [OK].

The selected region name appears in the upper part of the list.

4 Using any of the following methods, select the register.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

5 Press [Merge].

This carries out the merge.

Deleting data from effect registers

1 In the Effect menu, press VF2 ‘Effect 1-99’ and HF6 ‘Delete.’

The Delete menu appears.

2 Press the region display in the upper part of the list to display a selection 
window, then select the region in the selection window. Selecting multiple 
regions is also possible.
To select all regions, press [ALL].

3 Press [OK].

The selected region name appears in the upper part of the list.

4 Using any of the following methods, select the desired registers.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

Knob Parameter Adjustment Setting values

1 From Reg The register coming afterwards when 
merged

1 to 99

2 To Reg The register coming before when merged 1 to 99
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• To select all registers, press [ALL].

5 Press [Delete].

Attaching a name to an effect register

1 In the Effect menu, press VF2 ‘Effect 1-99’ and HF7 ‘Rename.’

The Rename menu appears.

2 Press the region display in the upper part of the list to display a selection 
window, then select the region in the selection window. Selecting multiple 
regions is also possible.
To select all regions, press [ALL].

3 Press [OK].

The selected region name appears in the upper part of the list.

4 Using any of the following methods, select the register you want to name.

• Press directly on the list in status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

The selected register appears in reverse video.

5 Press [Rename].

A keyboard window appears.

For details of keyboard window operation, see “Menu Operations” in 
Chapter 2 (Volume 1).

6 Enter the name, of not more than eight characters, and press [Enter].

The set name is reflected in the status area.

Note
The following names cannot be used.

Knob Parameter Adjustment Setting values

1 Register Register number 1 to 99

3 Num Select number of registers 1 to 99

Knob Parameter Adjustment Setting values

1 Register Register number 1 to 99
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CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9

Displaying a List of Effect Registers for Editing

You can display a list of effect registers including status information (whether 
data is present and so on), then carry out lock, copy, delete, and rename 
operations.

Displaying the list of effect registers with status information
Press the menu title button at the top left of the Effect menu.
The Effect >Status menu appears. The status area shows a list of effect registers 
(1 to 99).

Register name displays
For the same number, the register name for the M/E-1 region takes precedence.
If there is no data for the M/E-1 region, then the register name appears in the 
sequence M/E-2 >P/P >User1 to User8 >DME ch1, DME ch2, DME ch5 to 
DME ch8 >Device1 to Device12 >P-Bus >GPI >Macro.

Indication colors
Each register has a color-coded border, indicating its status.
Selected register: pale blue border
Register containing data: shown amber within the border. If, however, there 

are one or more locked regions, the display is in red.

Write-protecting the contents of the register (lock function)
(This applies to all regions.)

In the Effect >Status menu, use the following procedure.

1 Using any of the following methods, select the register you want to lock.

• Press directly on the corresponding register indication in the status area.
• Turn the knob.

Knob Parameter Adjustment Setting values

1 Register Register selection 1 to 99
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2 Press [Lock].

The register is locked, and the background of the register indication 
appears in red.

To release the lock
Press [Lock] once more, turning the contents of the frame to amber.

Copying the contents of a register
(This applies to all regions.)

In the Effect >Status menu, use the following procedure.

1 Using any of the following methods, select the copy source register.

• Press directly on the corresponding register indication in the status area.
• Turn the knob.

2 In the <Copy> group, press [From __ ].

3 Select the copy destination register.

4 In the <Copy> group, press [To __ ].

This executes the copy.

Deleting the contents of a register
(This applies to all regions.)
In the Effect >Status menu, use the following procedure.

1 Using any of the following methods, select the register you want to delete.

• Press directly on the corresponding register indication in the status area.
• Turn the knob.

2 Press [Delete].

This deletes the data from the register.

Knob Parameter Adjustment Setting values

1 Register Register selection 1 to 99

Knob Parameter Adjustment Setting values

1 Register Register selection 1 to 99
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Renaming a register
(This applies to all regions.)

In the Effect >Status menu, use the following procedure.

1 Using any of the following methods, select the register you want to 
rename.

• Press directly on the corresponding register indication in the status area.
• Turn the knob.

2 Press [Rename].

A keyboard window appears.

3 Enter a name of up to eight characters, and press [Enter].

This changes the name.

Knob Parameter Adjustment Setting values

1 Register Register selection 1 to 99
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Overview

The term “snapshot” refers to a function whereby the various settings required 
to apply a particular effect to an image are saved in memory as a set of data, for 
recall as required, to recover the original state.
You can carry out snapshot operations using the numeric keypad control block 
(see page 319), the Flexi Pad control block (see page 324), the Multifunction 
Flexi Pad control block (see page 330), and the Snapshot menu (see page 337).

Note
If the M/E bank has the Inhibit setting (see “Overall Control Panel Settings 
(Config Menu)” in Chapter 19 (Volume 3)), it is not possible to recall a 
snapshot on that M/E bank.

Snapshot Types

Snapshots are divided as follows.

Snapshots applying to a particular region (functional block of the 
switcher or DME)
The term “snapshot” alone usually refers to this type of snapshot. This only 
applies to regions assigned to region selection buttons in the numeric keypad 
control block and Multifunction Flexi Pad control block.

For details about a region, see “Regions” (page 233).

Master snapshot: This applies to the selected regions and the register numbers 
saved in the regions. A master snapshot can be saved and recalled using the 
numeric keypad control block and the Multifunction Flexi Pad control 
block.

Snapshots applying only to particular functions
This type of snapshot includes the following.
Key snapshot: This includes the key on/off state and all key settings other than 

key priority for each keyer. (See “Key Snapshots” in Chapter 4 (Volume 
1).)

Wipe snapshot: This includes the wipe settings of each of the M/E-1 to M/E-
3 and PGM/PST banks. (See “Wipe Snapshots” in Chapter 5 (Volume 1).)

DME wipe snapshot: This includes the DME wipe settings of each of the M/
E-1 to M/E-3 and PGM/PST banks.
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The rest of this section describes the snapshots that apply to a particular region 
or regions.

Snapshot Attributes

An individual snapshot may also have attached special conditions relating to 
switcher or DME operation when the snapshot is recalled.
These conditions are called “attributes” of the snapshot, and can be added when 
the snapshot is saved or recalled.

Types of attribute
There are five snapshot attributes, as follows.
Cross-point hold: When the snapshot is recalled, the cross-point button 

selection remains unchanged. This can be set independently for each bus.
Key disable: When the snapshot is recalled, the key settings remain 

unchanged. This can be set independently for each keyer. A Setup menu 
allows you to select whether or not the key on/off state should also remain 
unchanged.

For details of the setting operation, see “Settings Relating to Keys, Wipes, 
Frame Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in the 
Chapter 20 (Volume 3). 

Effect dissolve: The transition from the state before the snapshot recall to the 
snapshot settings is carried out smoothly, by a dissolve. The dissolve 
duration can be set in the Snapshot menu.

Auto transition: An auto transition starts the instant the snapshot is recalled. 
The auto transition setting is valid only for M/E-1, M/E-2 and PGM/PST.

Note
If both effect dissolve and auto transition are selected as attributes, the auto 
transition takes precedence.

GPI output: A GPI output is sent to the allocated GPI port the instant the 
snapshot is recalled.
The trigger type depends on the switcher GPI output settings made in the 
Setup menu.

For details, see “Interfacing With External Devices (Device Interface 
Menu)” under “Switcher Setup” in Chapter 20 (Volume 3).

Clip event: Recall a frame memory clip immediately after the snapshot is 
recalled.
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Auto play: Play a frame memory clip immediately after the snapshot is 
recalled.

Table of available attributes
The attributes that can be used depend on the region, as follows.

Yes: Can be used   No: Cannot be used

Attribute display
You can view the attributes of a snapshot in the Snapshot menu.

For more details, see “Snapshot Operations in the Menus” (page 337).

Temporary attributes
When recalling a snapshot, you can temporarily apply attributes distinct from 
the attributes set for each register. These are called “temporary attributes.”
You can set temporary attributes when recalling a snapshot.

Bus override
If you recall a snapshot while holding down an A or B bus button, the selection 
of the signal on the A or B bus does not change when the snapshot is recalled. 
This function is called “bus override.”
This function is effective when cross-point hold is off, and you want to 
temporarily maintain the cross-point setting. When cross-point hold is on, the 
above operation is not necessary.

Attribute Region

M/E-1, M/E-2, and PGM/
PST

User 1 to User 8 DME ch 1, ch 2 
and ch 5 to ch 8

Cross-point hold Yes Yes Yes

Key disable Yes No No

Effect dissolve Yes Yes Yes

Auto transition Yes No No

GPI outputs Yes Yes No

Clip event No Yes No

Auto play No Yes No
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Snapshot Operations From the Numeric 
Keypad Control Block

Saving and Recalling Snapshots

Snapshot operations with the numeric keypad control block use the following 
buttons.

Numeric keypad control block

Saving a snapshot from the numeric keypad control block

1 Make the settings for the state you want to save as a snapshot.

2 In the numeric keypad control block, press the [SNAPSHOT] button, 
turning it on.

This allocates the numeric keypad control block to snapshot operations, 
and the [RCALL] button lights.

EFF

M/E
1

USER
1

DME
1

DME
5

SNAP
SHOT

M/E
2

USER
2

DME
2

DME
6

SHOT
BOX

M/E
3

USER
3

DME
3

DME
7

MCRO

P/P
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4

DME
4
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TRANS
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RTR

DEV
1
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2

UNDO
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STORE
STATSMASTR ALL P-BUS GP1

STORE

RCALL

7 8 9

4 5 6

1 2 3

0

+/-
EFF

TRIM

CLR
AUTO

DISS

TRANS

ENBL
GPI

ENTER

SNAPSHOT button
Display

+/–/EFF DISS button

CLR/AUTO 
TRANS button

TRIM/GPI ENBL
 button

Numeric keypad

STORE button

RCALL button

STORE STATS button

UNDO button

Region selection buttons
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3 Press the region selection button corresponding to the region for which you 
want to save, turning it on. You can select more than one region.

[M/E 1], [M/E 2], [P/P]: These select the corresponding M/E-1, M/E-2 
and PGM/PST regions.

[USER 1] to [USER 8]: These select the User regions.
[DME 1], [DME 2], [DME 5] to [DME 8]: These select the DME 

channels.
[RTR]: This selects the Router region.
[ALL]: This selects all regions.

Note
The regions that can be selected simultaneously are those assigned to the 
region selection buttons in the numeric keypad control block. (See 
“Assigning a Region to a Region Selection Button in the Numeric Keypad 
Control Block” in Chapter 19 (Volume 3).)

The first button pressed lights green as the reference region, and any 
subsequently pressed buttons light amber.
Pressing one of the amber-lit buttons, while holding down [SNAPSHOT], 
turns the button green to indicate its corresponding region as the new 
reference region.

For details of the precedence order for becoming the reference region, see 
“Regions” (page 233) and “Registers” (page 235).

The display shows the name of the reference region and the number of the 
register previously recalled for that region.

4 Press the [STORE] button, turning it on.

5 Enter the desired register number from the numeric keypad.

To find an empty register, instead of entering a number, press the [.] 
(period) button. To search for an empty register common to all currently 
selectable regions, press the period button again.

Note
If you choose a register which already contains a snapshot, and save a 
snapshot, then the existing register contents are overwritten.

The register number appears in the display. If the number is followed by a 
letter ‘e’ or ‘E,’ this indicates the following.
e: The selected register is empty for the regions selected in step 3.
E: The selected register is empty for all currently selectable regions.
The entered register number appears in the display.
Snapshot Operations From the Numeric Keypad Control Block
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6 To apply attributes, press the following buttons, turning them on.

a) The GPI port that can be set is 1 (fixed).

For details of attributes, see “Snapshot Attributes” (page 317).

Note
In the numeric keypad control block, it is not possible to apply the cross-
point hold. For details, see “Applying snapshot attributes” (page 337).

7 Press the [ENTER] button.

This saves the snapshot, and the [STORE] button goes off. The [RCALL] 
and [STORE STATS] buttons light.

To cancel a snapshot save operation
After saving a snapshot, to cancel the save, hold down the [STORE STATS] 
button and press the [UNDO] button.

Recalling a snapshot from the numeric keypad control block

1 In the numeric keypad control block, press the [SNAPSHOT] button, 
turning it on.

This allocates the numeric keypad control block to snapshot operations, 
and the [RCALL] button lights.

2 Press the region selection button corresponding to the region you want to 
recall, turning it on. Multiple selections are also possible.

[M/E 1], [M/E 2], [P/P]: These select the corresponding M/E-1, M/E-2 
and PGM/PST regions.

[USER 1] to [USER 8]: These select the User regions.
[DME 1], [DME2], [DME5] to [DME 8]: These select the DME 

channels.
[ALL]: This selects all regions.
[RTR]: This selects the Router region.
[MASTR]: This selects a master snapshot.

Attribute to apply Button

Effect dissolve [+/–/EFF DISS] button

Auto transition [CLR/AUTO TRANS] button

GPI output a) TRIM/GPI ENBL] button
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Note
The regions that can be selected simultaneously are those assigned to the 
region selection buttons in the numeric keypad control block. (See 
“Assigning a Region to a Region Selection Button in the Numeric Keypad 
Control Block” in Chpater 19 (Volume 3).)
It is not possible to select [MASTR] and other regions simultaneously. If 
selected simultaneously, the master snapshot takes precedence.

The first pressed button lights green as the reference region, and 
subsequently pressed buttons light amber.
Pressing one of the amber-lit buttons, while holding down [SNAPSHOT], 
turns the button green to indicate its corresponding region as the new 
reference region.

For details of the precedence order for becoming the reference region, see 
“Reference region” (page 234).

The display shows the name of the reference region and the number of the 
register previously recalled for that region.

3 Enter the desired register number from the numeric keypad.

See step 5 (page 320) in “Saving a snapshot from the numeric keypad 
control block.”

The entered register number appears in the display.

4 To apply temporary attributes, press the following buttons, turning them 
on.

a) When Xpt Hold mode is selected in setup. 

Control block Temporary 
attribute to apply

Button

Cross-point control 
block

A/B bus cross-point 
hold

[XPT HOLD] button in the 
background A/B bus

Key cross-point hold [XPT HOLD] button in the key bus a)

Key disable [XPT HOLD] button in the key bus b)

Numeric keypad 
control block

Effect dissolve [+/–/EFF DISS] button

Auto transition [CLR/AUTO TRANS] button
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b) When Key Disable mode is selected in setup. 

For the setup setting, see “Settings Relating to Keys, Wipes, Frame 
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 
(Volume 3).

For details of temporary attributes and available attributes, see “Snapshot 
Attributes” (page 317).

Notes
• The cross-point hold and key disable settings are maintained until you 

next press the [XPT HOLD] button.
• Applying temporary attributes does not affect the contents of the 

register.
• It is not possible to apply temporary attributes to a master snapshot.

5 Press the [ENTER] button.

This recalls the specified snapshot, and the reference region name and 
recalled register number appear in the display.
If you applied the effect dissolve or auto transition temporary attributes in 
step 4, the corresponding buttons go off.
When a master snapshot is recalled, the region selection buttons light 
according to the saved region information.

To cancel a snapshot recall operation
After saving a snapshot, to cancel the recall, press the [UNDO] button.

Note
It is not possible to cancel recalling a master snapshot.

Creating and saving a master snapshot with the numeric keypad 
control block

To create and save a master snapshot with the numeric keypad control block, 
refer to the operations in “Creating and Saving a Master Timeline Using the 
Buttons in the Numeric Keypad Control Block” (page 298). Note, however, 
that in place of the [EFF] button in the numeric keypad control block, the 
[SNAPSHOT] button is used.
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Snapshot Operations in the Flexi Pad 
Control Block

In the Flexi Pad control block (standard type or simple type) on each M/E bank 
and PGM/PST banks, you can only carry out operations on snapshots for that 
bank. It is therefore not necessary to select a region.

Banks and Registers

In a standard type Flexi Pad control block or Multifunction Flexi Pad control 
block, in order to handle the 99 registers, they are considered in groups. These 
groups are called “banks,” and there are ten banks, numbered from 0 to 9.
The correspondence between banks and registers is shown in the following 
table.

7
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DME

SNAP
SHOT

EFF

MCRO

SHOT
BOX

UNDO

STORE
STATS

TRANS
RATE

BNAK
0

BANK
1

BANK
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XPT HOLD
A B U1 U2 1 2 3 4

8 9

4 5 6

1 2 3

0 AUTO
TRAN

EFF
DISS

WIPE

DME

SNAP
SHOT

UNDO

1 2

3 4

5 6

XPT HOLD
A B U1 U2 1 2 3 4

7 8

 SNAPSHOT button Numeric display

UNDO button

STORE STATS button

Bank selection buttons

Memory recall section

Flexi Pad control block (standard type) Flexi Pad control block (simple type)

SNAPSHOT button

Numeric display

UNDO button

Memory recall section
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Example: When you select bank 3, the register numbers allocated to the 
memory recall section are as follows.

Operations with a simple type Flexi Pad control block
With a simple type Flexi Pad control block, the registers that can be handled 
are numbers 1 to 8. Bank operations are therefore not possible. It is also not 
possible to apply attributes, or to cancel a snapshot save or recall operation 
once carried out.
To use registers 9 to 99, or to cancel a snapshot save operation, use the numeric 
keypad control block.

Bank number Register numbers

Bank 0 1 to 10

Bank 1 11 to 20

Bank 2 21 to 30

Bank 3 31 to 40

Bank 4 41 to 50

Bank 5 51 to 60

Bank 6 61 to 70

Bank 7 71 to 80

Bank 8 81 to 90

Bank 9 91 to 99

37 38 39

34 35 36

31 32 33

40
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Saving and Recalling Snapshots

Saving a snapshot in the Multifunction Flexi Pad control block
As an example, to save a snapshot on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 bank, make the settings for the state you want to save as a 
snapshot.

2 In the M/E-1 bank Flexi Pad control block, press the [SNAPSHOT] button.

This assigns the Flexi Pad control block to snapshot operations. The 
numeric display shows the last selected bank number and the register 
number last recalled on the bank.

3 Use any of the following methods to select the bank for saving the 
snapshot.
(On a simple type Flexi Pad control block, there are no banks, and this 
operation is not necessary.)

To select bank 0: Press the [BANK 0] button.
To select bank 1: Press the [BANK 1] button.
To select any bank from 0 to 9: Press the [BANK SEL] button, changing 

the memory recall section display as in the following figure; select a 
number from 0 to 9.

The selected bank number appears in the numeric display.
The buttons in the memory recall section change to show the names of the 
registers in the selected bank, together with the register status.
Using the Setup menu, it is possible to specify which to display, the 
register name or register number. 
Lit orange: register containing a snapshot
Lit yellow: last recalled register

7 8 9

4 5 6

1 2 3

0
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Not lit: register not containing anything

4 To apply an attribute, hold down the [SNAPSHOT] button, and in the 
memory recall section, press a button as follows, turning it on.

For details of attributes, see “Snapshot Attributes” (page 317).

Note
In the Flexi Pad control block, it is not possible to apply the cross-point 
hold or GPI output attributes. In a simple type Flexi Pad control block, it 
is not possible to apply any attributes. To add these attributes, use a menu 
operation. (See page 337.)

5 Still holding down the [SNAPSHOT] button from step 4, press the 
memory recall button corresponding to the register in which you want to 
save.

Recalling a snapshot in the Flexi Pad control block (standard 
type or simple type)

Note
When an M/E bank is not assigned to any region selection button in the 
numeric keypad control block in a setup setting, it is not possible to recall a 
snapshot with the Flexi Pad control block of that M/E bank. (See “Assigning a 
Region to a Region Selection Button in the Numeric Keypad Control Block” in 
Chapter 19 (Volume 3).)

As an example, to recall a snapshot on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 bank Flexi Pad control block, press the [SNAPSHOT] button.

This assigns the Flexi Pad control block to snapshot operations. The 
numeric display shows the last selected bank number and the register 
number last recalled on the bank.

2 Select the bank for recall.

See step 3 (page 326) in “Saving a snapshot in the Multifunction Flexi Pad 
control block.”

Attribute to apply Button

Effect dissolve [EFF DISS] button

Auto transition [AUTO TRANS] button
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3 To apply temporary attributes, press the following buttons, turning them 
on.

a) When Xpt Hold mode is selected in setup. 
b) When Key Disable mode is selected in setup. 

For details of the operation mode of the [XPT HOLD] button, see 
“Selecting the Bank to Make the Settings” in Chapter 20 (Volume 3).

For details of temporary attributes and available attributes, see “Snapshot 
Attributes” (page 317).

Notes
• The cross-point hold and key disable settings are maintained until you 

next press the [XPT HOLD] button.
• Applying temporary attributes does not affect the contents of the 

register.

4 Press the button in the memory recall section which shows the desired 
register name.

The button you pressed lights yellow, and this recalls the snapshot.
The numeric display shows the selected register number after the bank 
number.

Deleting a snapshot in the Flexi Pad control block (standard type 
or simple type)

As an example, to delete a snapshot on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 bank Flexi Pad control block, press the [SNAPSHOT] button.

This assigns the Flexi Pad control block to snapshot operations. The 
numeric display shows the last selected bank number and the last recalled 
register number on the corresponding bank.

Control block Temporary 
attribute to apply

Button

Cross-point control 
block

A/B bus cross-point 
hold

[XPT HOLD] button in the 
background A/B bus

Key cross-point hold [XPT HOLD] button in the key bus a)

Key disable [XPT HOLD] button in the key bus b)

Flexi Pad control 
block

Effect dissolve [EFF DISS] button

Auto transition [AUTO TRANS] button
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2 Select the bank for the register containing the snapshot you want to delete.

See step 3 (page 326) in “Saving a snapshot in the Multifunction Flexi Pad 
control block.”

3 Hold down the [STORE STATS] button, then hold down the button in the 
memory recall section displaying the number of the corresponding 
register.

The button you pressed goes off, and this deletes the snapshot. The 
[STORE STATS] button lights amber.

Note
On a simple type Flexi Pad control block, it is not possible to delete a snapshot.
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Snapshot Operations in the Multifunction 
Flexi Pad Control Block

Carry out snapshot operations on the Multifunction Flexi Pad control block of 
the CCP-6224 or CCP-6324 Control Panel as follows.

Saving and Recalling Snapshots

Saving a snapshot in the Multifunction Flexi Pad control block
As an example, to save a snapshot on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 bank, make the settings for the state you want to save as a 
snapshot.

[EFF] button

Alphanumeric display

Region selection buttons

Memory recall section
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2 In the Multifunction Flexi Pad control block, press the [SNAPSHOT] 
button.

This assigns the Multifunction Flexi Pad control block to snapshot 
operations. The numeric display shows the last selected bank number and 
the register number last recalled on the bank.

3 Press the region selection button corresponding to the region for which you 
want to save, turning it on. You can select more than one region.

[M/E 1], [M/E 2], [P/P]: These select the corresponding M/E-1, M/E-2 
and PGM/PST regions.

[USER 1] to [USER 8]: These select the User regions.
[DME 1], [DME 2], [DME 5] to [DME 8]: These select the DME 

channels.
[RTR]: This selects the Router region.
[ALL]: This selects all regions.

Note
The regions that can be selected simultaneously are those assigned to the 
region selection buttons in the memory recall section. (See “Assigning a 
Region to a Region Selection Button in the Numeric Keypad Control Block 
or Multifunction Flexi Pad Control Block” in Chapter 19 (Volume 3).)

The first pressed button lights green as the reference region, and any 
subsequently pressed buttons light amber.
Pressing one of the amber-lit buttons, while holding down [SNAPSHOT], 
turns the button green to indicate its corresponding region as the new 
reference region.

For details of the precedence order for becoming the reference region, see 
“Regions” (page 233) and “Registers” (page 235).

The display shows the name of the reference region and the number of the 
register previously recalled for that region.

4 Press the [BANK SEL] button, and select the desired bank with the 
numeric keypad buttons in the memory recall section.

5 Hold down the [SNAPSHOT] button, and press the button in the memory 
recall section corresponding to the register in which you want to save.

Note
If you press a button which is lit orange or yellow, this overwrites the 
contents of the corresponding register.
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The button you pressed lights yellow, and this completes saving. The 
[STORESTATS] button lights amber, and the numeric display shows the 
bank number followed by the number of the selected register.

To enter the number of the desired snapshot save destination 
register using the numeric keypad
After step 2 above, press the [10 KEY] button in the memory recall section. 
This switches the memory recall section to the numeric keypad input mode, 
and after pressing the [STOR] button, lighting it yellow, you can enter the 
desired register number from the numeric keypad. The number you entered 
appears in the alphanumeric display.
To find an empty register, press the [ . ] button without entering a number, and 
the number of an empty register appears in the alphanumeric display.
Confirm the displayed number by pressing the [ENTR] button. This saves the 
data in the specified register.

To cancel a snapshot save operation
After saving a snapshot, to cancel the save, hold down the [STORE STATS] 
button and press the [UNDO] button.
The light of [STORE STATS] button changes from amber to green.

Note
With a simple type Flexi Pad control block, it is not possible to cancel saving 
a snapshot.

Adding attributes in the Multifunction Flexi Pad control block

1 Press the [EDIT ENBL] button.

The button indications in the memory recall section change as shown in the 
following illustration.
To cancel adding attributes, press the [EDIT ENBL] button once more, or 
press the [EXIT] button.
Snapshot Operations in the Multifunction Flexi Pad Control Block
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• When the reference region is M/E-x (x is a number) or P/P

• When the reference region is other than M/E-x or P/P, and effect 
dissolve settings are possible

2 Add attributes with the following buttons.

[TEMP ATTR] button: Set a temporary attribute. Set this to Off to add 
an attribute.

[EFF DISS] button: Add the effect dissolve attribute.
[DUR xxx] button: Set the effect dissolve duration.

The current setting is shown by “xxx.” When you press this button, the 
memory recall section switches to numeric keypad input mode, and 
you can enter the setting value.

[AUTO TRNS] button: Add the auto transition attribute.
[XHLD xxx] button: Add the bus cross-point hold attribute.

The affected bus is shown by “xxx.”

For details of attributes, see “Snapshot Attributes” (page 317).
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Recalling a snapshot in the Multifunction Flexi Pad control block
As an example, to recall a snapshot on the M/E-1 bank, use the following 
procedure.

1 In the Multifunction bank Flexi Pad control block, press the [SNAPSHOT] 
button.

This assigns the Multifunction Flexi Pad control block to snapshot 
operations. The numeric display shows the last selected bank number and 
the register number last recalled on the bank.

2 Press the region selection button corresponding to the region you want to 
recall, turning it on. Multiple selections are also possible.

[M/E 1], [M/E 2], [P/P]: These select the corresponding M/E-1, M/E-2 
and PGM/PST regions.

[USER 1] to [USER 8]: These select the User regions.
[DME 1], [DME2], [DME5] to [DME 8]: These select the DME 

channels.
[ALL]: This selects all regions.
[RTR]: This selects the Router region.
[MASTR]: This selects a master snapshot.

Note
The regions that can be selected simultaneously are those assigned to the 
region selection buttons in the memory recall section. (See “Assigning a 
Region to a Region Selection Button in the Numeric Keypad Control Block 
or Multifunction Flexi Pad Control Block” in Chpater 19 (Volume 3).)
It is not possible to select [MASTR] and other regions simultaneously. If 
selected simultaneously, the master snapshot takes precedence.

The first pressed button lights green as the reference region, and 
subsequently pressed buttons light yellow.
Pressing one of the amber-lit buttons, while holding down [SNAPSHOT], 
turns the button green to indicate its corresponding region as the new 
reference region.

For details of the precedence order for becoming the reference region, see 
“Regions” (page 233) and “Registers” (page 235).

The display shows the name of the reference region and the number of the 
register previously recalled for that region.

3 Select the bank for recall.

See step 3 (page 331) in “Saving a snapshot in the Multifunction Flexi Pad 
control block.”
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4 To add a temporary attribute, press the [EDIT ENBL] button to switch to 
editing mode, then press the [TEMP ATTR] button; you can now select the 
temporary attribute with the following buttons.

[EFF DISS] button: Effect dissolve.
[DUR xxx] button: Effect dissolve duration. The current setting is shown 

by “xxx.”
[AUTO TRNS] button: Auto transition.
[XHLD xxx] button: Bus cross-point hold. The affected bus is shown by 

“xxx.”

For details of the operation mode of the [XPT HOLD] button, see 
“Selecting the Switcher Bank to Make the Settings” in Chapter 20 (Volume 
3).

For details of the temporary attribute and which attributes can be used, 
see “Snapshot Attributes” (page 317).

Note
Adding a temporary attribute does not affect the attribute settings saved in 
registers.

To add a temporary attribute with the cross-point control block buttons, 
press the following buttons, turning them on.

a) When setup setting is Xpt Hold mode
b) When setup setting is Key Disable mode

Note
This setting is maintained until the next time the [XPT HOLD] button is 
pressed.

5 Press the button in the memory recall section which shows the desired 
register name.

The button you pressed lights yellow, and this recalls the snapshot.
The numeric display shows the selected register number after the bank 
number.

Temporary attribute to 
be added

Button to press

A/B bus cross-point 
hold

[XPT HOLD] button in background A/B 
bus

Key cross-point hold Key bus [XPT HOLD] button a)

Key disable Key bus [XPT HOLD] button b)
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To cancel a snapshot recall operation
After recalling a snapshot, to cancel the recall, press the [UNDO] button.

To enter the number of the register to be recalled using the 
numeric keypad
After step 1 above, press the [10 KEY] button in the memory recall section. 
This switches the memory recall section to the numeric keypad input mode, 
and after pressing the [RCLL] button, lighting it yellow, you can enter the 
desired register number from the numeric keypad. Confirm the displayed 
number by pressing the [ENTR] button.

Deleting a snapshot in the Multifunction Flexi Pad control block
As an example, to delete a snapshot on the M/E-1 bank, use the following 
procedure.

1 In the Multifunction Flexi Pad control block, press the [SNAPSHOT] 
button, press region selection button to select [M/E1] only.

This assigns the Multifunction Flexi Pad control block to snapshot 
operations. The numeric display shows the last selected bank number and 
the last recalled register number on the corresponding bank.

2 Select the bank for the register containing the snapshot you want to delete.

See step 3 (page 331) in “Saving a snapshot in the Multifunction Flexi Pad 
control block.”

3 Hold down the [DEL] button, then hold down the button in the memory 
recall section displaying the number of the corresponding register.

The button you pressed goes off, and this deletes the snapshot.
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Snapshot Operations in the Menus

Operations in the Snapshot menu
You can also set snapshot or key snapshot attributes in the Snapshot menu, 
which also displays the status of the registers. To access the Snapshot menu, 
press the top menu selection button [SNAPSHOT] in the menu control block.
In the Snapshot menu, as well as setting snapshot attributes, you can carry out 
editing operations on snapshots, including copy and delete.

See “Snapshot Register Editing” (page 343).

Operations in the Misc >Snapshot menu

For M/E and PGM/PST snapshots only, you can carry out saving, recalling, 
applying attributes, and so on using the same menu. (See page 344.)

Selecting a Region or Reference Region in a Menu

During snapshot operations, you can select a region in the menu. This is 
convenient for selecting some of the regions assigned to the numeric keypad 
control block or changing the reference region.

For details of the operations, see “Selecting by menus” (page 264).

Setting Snapshot Attributes

Applying snapshot attributes

1 In the Snapshot menu, press VF2 ‘Snapshot’ and HF1 ‘Attribute.’

The Snapshot>Attribute menu appears.
The status area shows the region names, register numbers, and the status 
and attributes set.

2 Press the region display in the upper part of the list to display a selection 
window, then select the region in the selection window. Selecting multiple 
regions is also possible. To select all regions, press [ALL].

3 Press [OK].
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The selected region name appears in the upper part of the list.

4 Using any of the following methods, select the register.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

• To select all registers, press [ALL].

5 In the <Attribute> group, press the buttons for the attributes you want to 
apply, turning them on. 

Carry out the following procedures for each of the attributes.

To apply the cross-point hold attributes

Note
Applying the key disable attribute (so the key state is not reflected) to cross-
point hold requires a setting in setup. For details, see “Selecting the Bank to 
Make the Settings” in Chapter 20 (Volume 3).

1 Press [XPT Hold].

The Snapshot>Attribute>Xpt Hold menu appears. The status area shows a 
list of the currently selected regions and bus names.

2 Using any of the following methods, select the register.

• Press directly on the list in the status area. To select one or more buses, 
press [Plural] and then select buses.

• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

a) Appears when the region is RTR.
b) Appears when the region is other than RTR.

• To select all registers, press [ALL].

3 When the region is set to RTR (Router) only, press [RTR Level].

Knob Parameter Adjustment Setting values

1 Register Register number 1 to 99

2 Num Select number of registers 1 to 99

Knob Parameter Adjustment Setting values

2 Destination a) Destination selection 1 to 128

3 Bus b) Bus name selection –
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A window appears for selecting the router level.

4 Press the level for which you want to set the cross-point hold, turning it on, 
and press [OK]. To select all levels, press [ALL].

5 Press [On].

This enables cross-point hold on the selected bus or buses.
To switch cross-point hold off, press [Off].

To apply the effect dissolve attribute

1 Press [Effect Dissolve], turning it on.

2 Turn the knob to set the effect dissolve duration.

To set the duration for a dissolve set as a temporary attribute 
effect
To set the duration for a dissolve set as a temporary attribute effect in the 
numeric keypad or Flexi Pad control block, turn the knob.

To apply the auto transition attribute
Press [Auto Transition], turning it on.

To apply the GPI output attribute

1 Press [GPI Output], turning it on.

2 Turn the knob to set the port number.

Knob Parameter Adjustment Setting values

3 Eff Diss Duration Dissolve duration 0 to 999 (frames)

Knob Parameter Adjustment Setting values

5 Temp Dur Temporary attribute 
dissolve duration

0 to 999 (frames)

Knob Parameter Adjustment Setting values

4 GPI Out 
Port

GPI output port number 1 to 8
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To apply the clip event attribute

Note
The following operating procedure can be used only for the frame memory 
channels assigned to a user region.

For details of frame memory assignment, see “Setting User Regions” in 
Chpater 20 (Volume 3).

1 Press [Clip Event].

The Snapshot >Attribute >Clip Event menu appears.

2 In the <Frame Memory Select> group, press the desired button.

On the left of the status area, the name and content of the selected region 
(for example, USER1) are shown. On the right, the content of the clip of 
the current frame memory is shown.

3 Press [Clip Event], turning it on.

The clip event attribute is applied.

4 To select the clip of the current frame memory, press [Set].

5 To play the clip as soon as it is recalled, press [Auto Play], turning it on.

For details of attributes and available attributes, see “Snapshot Attributes” 
(page 317).

Snapshot Status Display

The Snapshot >Attribute menu displays the following information.

For details of how to access the Snapshot >Attribute menu, see page 337.

Region name: The selected region name appears in the upper part of the list.
Register number
Register name
Write-protected status: When the register is write-protected, an “L” (for 

“lock”) appears.
Empty status: When the register is empty, an “E” (for “empty”) appears.
Attribute settings: The attributes set for a register are shown by the following 

character codes.
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When the cross-point hold is set:

When an effect dissolve is set:

When an auto transition is set:

When a GPI output is set:

When a clip event is set:

Displayed 
character codes

Attributes set

A, B Cross-point hold is set for the A or B background bus.

1, 2, 3, 4 Cross-point hold is set for key bus 1, 2, 3, or 4.

U Cross-point hold is set for the utility bus.

D2 Cross-point hold is set for video bus selected for 2nd DME 
channel.

FvFkBvBk Cross-point hold is set for all of the DME front video bus, DME 
front key bus, DME back video bus, and DME back key bus.

Aux Cross-point hold is set for one of the AUX buses.

Mon Cross-point hold is set for one of the monitor buses.

Fm1, Fm2 Cross-point hold is set for one of the frame memory 1 and 2 
buses.

Ccr1, Ccr2 Cross-point hold is set for one of the CCR 1 and 2 buses.

RTR Cross-point hold is set for the Router region.

Displayed 
character codes

Attributes set

Duration value The effect dissolve attribute is set, with the displayed duration.

Displayed 
character codes

Attributes set

T Auto transition is set.

Displayed 
character codes

Attributes set

Port number GPI output is set for the port of the displayed number.

Displayed 
character codes

Attributes set

On Clip event is set.
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Setting Key Snapshot Attributes

Applying key snapshot attributes

1 In the Snapshot menu, press VF5 ‘Key Snapshot’ and HF1 ‘Attribute.’

The Snapshot >Key Snapshot >Attribute menu appears.
The status area shows the region names, register numbers, and whether the 
registers are locked or not.

2 Press the region display in the upper part of the list to display a selection 
window, then select the region in the selection window. Selecting multiple 
regions is also possible.

3 Press [OK].

The selected region name appears in the upper part of the list.

4 Using any of the following methods, select the register.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

5 In the <Recall Mode> group, select one of the following modes for save 
and recall operations.

XPT: Only the key material selection data is saved or recalled.
Modifier: Only the key modifier settings are saved or recalled.
Transition: Only the independent key transition settings are saved or 

recalled.

Creating and Saving a Master Snapshot

To save a master snapshot in the Snapshot menu, after recalling the Snapshot 
>Master Snapshot >Store menu, refer to the operations in “Creating and 
Saving a Master Timeline With the Menu” (page 302).

Recalling the Store menu

1 Do either of the following.

Knob Parameter Adjustment Setting values

1 Register Register number 1 to 4
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• In the menu control block, press the top menu selection button 
[SNAPSHOT].

• In the numeric keypad control block, press the [SNAPSHOT] button 
twice in rapid succession.

The Snapshot menu appears.

2 Press VF1 ‘Master Snapshot’ and HF1 ‘Store.’

The Master Snapshot >Store menu appears.
The status area shows the master snapshot register names, register lock 
status, register number for each region, and so on.

3 If required, press the following buttons in the status area to change the 
region display.

M/E, P/P: indicate assignment of M/E-1 (“M/E1”), M/E-2 (“M/E2”), and 
P/P (“P/P”).

User: User1 (“USR1”) to User8 (“USR8”)
DME: indicate assignment of DME ch1 (“DME1”), ch2 (“DME2”), ch5 

(“DME5”) to ch8 (“DME8”).
Misc: RTR (“Router”)

Snapshot Register Editing

You can carry out the following editing on snapshot registers.
(You can use similar procedures also on master snapshot, wipe snapshot, DME 
wipe snapshot and key snapshot registers.)
• Lock: Write-protect the contents of the register.
• Copy: Copy the contents of one register to another register.
• Move: Move the contents of one register to another register.
• Swap: Swap the contents of two registers.
• Delete: Delete the contents of a register.
• Name: Attach a name to a register.

For details of snapshot register operations, see “Effect Register Editing” 
(page 306).

Displaying a List of Snapshot Registers for Editing

You can display a list of snapshot registers including status information 
(whether data is present and so on), then carry out lock, copy, delete, and 
rename operations.
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Displaying the list of snapshot registers with status information
Press the menu title button at the top left of the Snapshot menu.
The Snapshot >Status menu appears. The status area shows a  list of snapshot 
registers (1 to 99).

For details of lock, copy, delete, and rename operations, see “Displaying a List 
of Effect Registers for Editing” (page 311).

Register name displays
For the same number, the register name for the M/E-1 region takes precedence.
If there is no data for the M/E-1 region, then the register name appears in the 
sequence M/E-2 >P/P >User1 to User8 >DME ch1 DME ch2 >DME ch5 to 
DME ch8 >RTR.

Operations in the Misc >Snapshot menu

Recalling a snapshot

1 In the Misc menu, press [Snapshot].

The Snapshot menu appears.

2 As required, change the bank (see page 345).

3 Press the button for the number or name you want to recall.

This recalls the snapshot, and the button you pressed lights green.
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Saving a snapshot

1 Display the Misc >Snapshot menu.

2 Set the state you want to save as a snapshot.

3 Press [Store].

The button lights amber.

4 As required, change the bank (see page 345).

5 Press the button for the number or name you want to save.

This saves the snapshot, and the button goes off.

Changing the bank
Change the combination shown on the memory recall buttons (the bank).

1 Press [Bank Sel].

2 Select the bank in the numeric keypad window.

For example, to show the numbers or names corresponding to registers 11 
to 20, select “1” in the numeric keypad window.

Applying attributes
To apply an attribute to the snapshot represented by a lit-green memory recall 
button, use the following procedure.

1 To apply the cross-point hold attribute, in the <Attribute Xpt Hold> group 
select the appropriate bus.

Note
A setting in the Setup menu determines whether key disable is applied to 
cross-point hold or not. For details, see “Setting the Operation Mode of the 
Key Bus [XPT HOLD] Button” in Chpater 20 (Volume 3).

2 Select the following attributes in the <Attribute> group as required.

Effect Dissolve: Apply effect dissolve.
Auto Transition: Apply auto transition.
GPI Output: Apply GPI output. When this is selected, select the GPI 

number with the knob.
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Deleting a snapshot

1 In the Misc >Snapshot menu, press [Delete].

The button lights amber.

2 As required, change the bank.

3 Press the button for the number or name you want to delete.

This deletes the snapshot, and the button you pressed goes off.

Renaming a snapshot register

1 In the Misc >Snapshot menu, press [Rename].

The button lights amber.

2 As required, change the bank.

3 Press the button for the number you want to rename.

A keyboard window appears.

4 Enter the register name, and press [Enter].

The new name appears on the memory recall button.
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Utility Execution

The utility function refers to a function whereby you can assign an arbitrary 
action or a shortcut for frequently used menu to a particular button, then 
instantly recall the action or menu by pressing the button.
The functions you can assign include menu shortcuts, enabling/disabling 
functions (recalling utility commands), and recalling (shotbox registers or 
macro registers).
Carry out the button assignment in the Setup menu.

For details of the operation, see “Setting Button Assignments (Prefs/Utility 
Menu)” in Chapter 19 (Volume 3).

You can carry out the utility function in the utility/shotbox control block (see 
page 349), in the cross-point control block (see page 350), or using the user 
preference buttons in the menu control block (see page 348).

For details of the menu control block, utility/shotbox control block, and cross-
point control block see “Menu Control Block”, “Utility/Shotbox Control 
Block”, and “Cross-Point Control Block” in Chapter 2 (Volume 1).

For details of the settings for assigning functions to buttons, see “Setting 
Button Assignments (Prefs/Utility Menu)” in Chapter 19 (Volume 3).

Executing a Utility With the User Preference Buttons 
(Menu Control Block)

In the setup menu, you can assign any 16 actions to the user preference buttons 
in the menu control block.

To execute an assigned action
Press the corresponding user preference button ([PREFS 1] to [PREFS 16]).
• In the case of a function on/off action, the button you pressed lights amber, 

and this enables the function.
To disable the function, press the button once more.

• For other actions, the button you pressed momentarily lights amber, and then 
the function is executed.
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Executing a Utility in the Utility/Shotbox Control Block

Utility/shotbox control block

By default, the memory recall buttons in the utility/shotbox control block are 
assigned to shotbox registers 1 to 96, in banks 1 to 4 (see page 364), but in the 
setup menu, you can assign these to any 96 actions.

To execute an assigned action

When the action is to execute a shotbox register, follow the procedure in 
“Shotbox Execution in the Utility/Shotbox Control Block” (page 364).

1 Press one of the bank selection buttons [BANK1] to [BANK4] to select a 
bank.

• The bank selection button you pressed lights amber.
• For the selected bank, the memory recall buttons show the button 

numbers and corresponding button states. If a button has been given a 
name in the setup menu, this name appears.
Not lighted: buttons with nothing saved
Lit orange: buttons saving a utility command or menu shortcut

2 Press the memory recall button for which the action you want to execute 
has been registered.

1
BANK

1 2 3 4

7
BANK

2

BANK
3

BANK
4

5 6

8 9 10 11 12

13 14 15 16 17 18

19 20 21 22 23 24

Bank selection buttons

Memory recall buttons
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• In the case of a function on/off action, the button you pressed lights 
green, and this enables the function.
To disable the function, press the button once more.

• For other actions, the button you pressed momentarily lights green, and 
then the function is executed.

Executing Utilities With the Cross-Point Buttons in the 
Key 2 Row

You can use the key 2 row of each of the M/E-1 to M/E-3, and PGM/PST banks 
in the same way as the buttons in the utility/shot box control block.

Note
To use this function, it is first necessary to assign the utility/shot box mode 
switching function to the control panel [PRE MCRO] button.

For details of the assignment operation, see “Assigning the Utility/Shot Box 
Mode Switching Function” in Chapter 19 (Volume 3).

Cross-point control block in the PGM/PST block

You can assign any action to the cross-point buttons.

M/E
1

M/E
1

SHIFT

SHIFT
XPT

HOLD

XPT
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KEY3

KEY4

POST
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M/E
2
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3
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3

M/E
3
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SHIFT
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Bank switching buttons
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For details of the assignment operation, see “Assigning a Function to the Key 
2 Row Cross-Point Buttons” in Chapter 19 (Volume 3).

To execute the assigned action

When the action is executing a shot box register, follow the procedure 
“Executing a Shot Box Function With the Key 2 Row Cross-Point Buttons” 
(page 365).

1 Press the [PRE MCRO] button, turning it on.

2 Press one of the bank switching buttons (see previous figure), to select the 
bank.

These buttons correspond to banks 1 to 5 in sequence from the left.

3 Press the cross-point button to which the desired action is assigned.

This executes the action.
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Shotbox

The term “shotbox” refers to a function whereby for each specified region any 
snapshot or keyframe effect can be recalled simultaneously.
The simultaneous recall setting data such as region names, snapshot numbers 
and keyframe effect numbers are stored in “registers.” There are 99 registers 
for each control panel.

The previous figure shows schematically the settings in the 99 shotbox 
registers.
Each register may contain any combination of the regions to which the register 
applies, with the snapshots or effects to be recalled.
The Auto Run function is an attribute which can be set for each register. When 
this is set to On, an effect recalled by a shotbox operation is automatically run.
• When register 1 is executed, this recalls M/E-1 snapshot 1, User2 effect 5, 

and DME ch3 effect 1. For register 1, auto run is On, and therefore the User2 
and DME ch3 effects are run as soon as they have been recalled.

• When register 3 is executed, M/E-1 effect 1, P/P effect 90, and User1 effect 
1 are recalled. For register 3, auto run is off, and therefore to run the recalled 
effects, press the [RUN] button in the keyframe control block.

Register #1

M/E-1: Snapshot #1
User2: Effect #5
DME ch3: Effect #1

Auto Run: On

Register #2

M/E-1: Snapshot #1
DME ch1: Snapshot #15
GPI: Effect #1

Auto Run: Off

Register #3

M/E-1: Effect #1
P/P: Effect #90
User1: Effect #1

Auto Run: Off

Register #99

P/P: Effect #2
DME ch1: Snapshot #1

Auto Run: On

Shotbox registers
Shotbox
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Shotbox Register Creation

You can create (save) shotbox registers in the following control blocks.
• Numeric keypad control block (See “Numeric Keypad Control Block” in 

Chapter 2 (Volume 1).)
• Menu control block (See “Menu Control Block” in Chapter 2 (Volume 1).)
• Multifunction Flexi Pad control block (See “Multifunction Flexi Pad 

Control Block” in Chapter 2 (Volume 1).)

Creating a Shotbox Register in the Numeric Keypad 
Control Block

When you create a shotbox register in the numeric keypad control block, you 
carry out separate operations in respect of the snapshot setting data and the 
effect setting data, and save in the register. The procedure described here 
makes the snapshot settings first, followed by the effect settings.

Creating a shotbox register

1 In the numeric keypad control block, press the [SNAPSHOT] button, 
turning it on.

This assigns the numeric keypad control block to snapshot operations.

2 Specify the register number of the snapshot you want to save in a shotbox 
register, and then recall it for each region.

For details of the procedure for recalling a register, see “Recalling a 
snapshot from the numeric keypad control block” (page 321).

3 Press the [SHOTBOX] button, turning it on.

This assigns the numeric keypad control block to shotbox operations.

4 Press the [STORE] button, turning it on.

The [SNAPSHOT] button lights green.
If not lighted, press the [SNAPSHOT] button to turn it on.
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Note
Only in [SHOTBOX] operation mode with the [STORE] button lit, the 
[SNAPSHOT] button or [EFF] button lights green to indicate that a setting 
operation is in progress for the purpose of saving snapshot data or effect 
data in a shotbox register.

5 Press the region button for the snapshot you want to save, turning it on.

6 Enter the desired shotbox register number with the numeric keypad 
buttons.

To find an empty register, instead of entering a number, press the [.] 
(period) button.

The display shows the relevant register numbers. When a register number 
is postfixed with an “E,” the register is empty.

7 Press [ENTER].

This saves the region you turned on in step 5, and the register number you 
recalled for that region as a snapshot setting in a shotbox register, and the 
[STORE] button goes off. At the same time, the [RCALL] button lights.

8 In the numeric keypad control block, press the [EFF] button, turning it on.

9 Specify the register number of the keyframe effect you want to save in a 
shotbox register, and then recall it for each region.

For details of the procedure for recalling a register, see “Recalling a 
Register” (page 255).

10Referring to steps 3 to 5, carry out the setting operation for effect register 
saving. In step 4, however, press the [EFF] button, lighting it green.

11Enter the shotbox register number specified in step 6 using the numeric 
keypad buttons.

12Press the [ENTER] button.

This saves the effect setting in a shotbox register, and the [STORE] button 
goes off. At the same time, the [RCALL] button lights.

To change the contents of a shotbox register
After recalling the shotbox register you want to change, referring to the 
previous item “Creating a shotbox register,” change the contents of the 
shotbox register, and save.
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To check the region saved in a shotbox register
During operations to change the contents of a shotbox register, to check which 
region is saved in the register, use the following procedure.

1 With the [SHOTBOX] button lit, press the [STORE] button, turning it on.

2 Press the required button, as follows, turning it on.

To check the snapshot region: [SNAPSHOT] button
To check the effect region: [EFF] button

3 Hold down the [STORE] button.

While this button is held down, the button for the saved region lights.
Releasing the button returns you to the state before holding down the 
[STORE] button.

Note
While the [STORE] button is lit, the mode selection buttons ([TRANS RATE] 
button and so on) in the numeric keypad control block do not operate. To 
change the mode, press the [RCALL] button or [SHOTBOX] button so that the 
[STORE] button goes off.

Creating a Shotbox Register in the Multifunction Flexi 
Pad Control Block

1 In the Multifunction Flexi Pad control block, press the [SNAPSHOT] 
button, turning it on.

This changes the Multifunction Flexi Pad control block to snapshot 
operation mode.

2 Specify the register number of the snapshot you want to save in a shotbox 
register, and then recall it for each region.

For details of the procedure for recalling a snapshot, see “Recalling a 
snapshot in the Multifunction Flexi Pad control block” (page 334).

3 Press the [SHOTBOX] button, turning it on.

This changes the Multifunction Flexi Pad control block to shotbox 
operations.

4 Press the [EDIT ENBL] button.
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This changes the Multifunction Flexi Pad control block to shotbox editing 
mode.

5 Press the [STORE] button, turning it on.

The [SNAPSHOT] button lights green.
If not lighted, press the [SNAPSHOT] button to turn it on.

Note
In shotbox editing mode, when you press the [STOR] button, the 
[SNAPSHOT] button or [EFF] button lights, to indicate that snapshot data 
will be saved in the shotbox register, or that effect data will be saved.

6 Specify the region for the snapshot to be saved, with the region selection 
buttons.

7 Enter the number of the shotbox register where you want to save with the 
memory recall section numeric keypad buttons.

To select an empty register, press the [ . ] button without entering a 
number.
The number of the selected register appears in the alphanumeric display. 
An “E” after the number indicates an empty register.

8 Press [ENTER].

This saves the region you turned on in step 6, and the register number you 
recalled for that region as a snapshot setting in a shotbox register, and the 
[STORE] button goes off. At the same time, the [RCALL] button lights.

9 Press the [EFF] button, turning it on.

10Specify the register numbers to recall the keyframe effects for each region 
that you want to save in the shotbox register.

For the procedure for recalling keyframe effects, see “Recalling a register 
from the Multifunction Flexi Pad control block” (page 260).

11Referring to steps 3 to 6, carry out the procedure to save the recalled 
keyframe effect data.

In step 5, however, press the [EFF] button instead of [SNAPSHOT] 
button, lighting it on.

12Enter the shotbox register number specified in step 7 using the numeric 
keypad buttons in the memory recall section.

13Press the [ENTER] button.
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This saves the snapshot data, followed by the keyframe effect data, in the 
specified shotbox register, and the [STOR] button goes off and then the 
[RCLL] button lights up.

To change the contents of a shotbox register
After recalling the shotbox register you want to change, referring to the 
previous item “Creating a shotbox register in the Multifunction Flexi Pad 
control block,” change the contents of the shotbox register, and save.

To check the region saved in a shotbox register
When changing the contents or so for a shot box register, to check the region 
saved in the register press and hold the following buttons.
To check the snapshot region: [SNAPSHOT] button
To check the keyframe effect region: [EFF] button
The memory recall section buttons change as shown in the following 
illustration, and the region for the saved data lights.

To recall an assigned effect and simultaneously execute it
Press the [AUTO RUN] button, lighting it green, then save the region data in 
the register.

Creating a Shotbox Register Using the Menus

Accessing the Shotbox menu
Carry out creation and editing of shotbox registers in the Shotbox menu.
To access the Shotbox menu, use either of the following methods.
• In the menu control block, press the top menu selection button [SHOTBOX].
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• In the numeric keypad control block, press the [SHOTBOX] button twice in 
rapid succession.

Creating a shotbox register

1 In the Shotbox menu, press VF1 ‘Register’ and HF1 ‘Store/Recall.’

The Store/Recall menu appears.
In the status area, the settings for each register appear as follows.
Region settings: Appear as “Sxxx” when a snapshot is allocated, and as 

“Exxx” when an effect is allocated. (xxx is the register number.) The 
register name also appears. If nothing is allocated, nothing appears in 
the display.

Register lock setting: When the register is write-protected, an “L” (for 
“lock”) appears.

Empty status: When the register is empty, an “E” (for “empty”) appears.
Auto run setting: When this is enabled, so that an effect is executed 

simultaneously with recall, “AR” appears.
Shotbox register name: This shows the shotbox register name.

2 If necessary, switch the region display by pressing one of the following 
buttons in the status area.

M/E, P/P: Shows the allocations for M/E-1 (“M/E1”), M/E-2 (“M/E2”), 
and P/P (“P/P”).

User: Shows the allocations for User1 (“USR1”) to User8 (“USR8”).
DME: Shows the allocations for DME ch1 (“DME1”), ch2 (“DME2”), 

ch5 (“DME5”) to ch8 (“DME8”).
DEV1-8: Shows the allocations for Device1 (“DEV1”) to Device8 

(“DEV8”).
DEV9-12: Shows the allocations for Device9 (“DEV9”) to Device12 

(“DEV12”).
Misc: Shows the allocations for P-Bus (“PBUS”), GPI (“GPI”), Router 

(“RTR”), and Macro (“MCRO”).

3 Using any of the following methods, select the register you want to create 
(or edit).

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

4 Press [Edit].

Knob Parameter Adjustment Setting values

1 Shotbox Reg Shotbox register number 1 to 99
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The Edit menu appears, and it is now possible to make the settings for the 
specified register.
You can also use knob 1 to select the register in this menu.
In the status area, the shotbox register status for each region appears.

5 Using any of the following methods, select the desired region. You may 
select more than one region.

• Press directly on the region display in the status area, turning it to reverse 
video.

• Press [ALL] to select all regions.
• To select all switcher-related regions (M/E, P/P, User), press 

[SWR ALL].
• To cancel a selection, press once more to return to the normal display.

6 In the <Assign> group, select the snapshot or effect to be allocated to the 
region.

Snapshot: Allocate a snapshot register.
Effect: Allocate a keyframe effect.

• If the selected register is locked, a confirmation message appears asking 
whether or not to cancel the operation. Press [OK] to return to the 
previous menu display without carrying out the registration.

• If the operation is carried out, the region selected in step 5 is registered 
on the master timeline, and the parameters are now valid.

7 Depending on the selection in step 6, set the parameters as follows.

• When a snapshot is selected

• When an effect is selected

a) For the DME region, you can also set register numbers 101 to 199, 201 to 299, and 301 to 
399.

8 To run the allocated effect as soon as it is recalled, press [Auto Run], 
turning it on.

9 Repeat steps 5 to 8 as required.

10In the <Store> group, press [Store] to save the setting.

Knob Parameter Adjustment Setting values

3 Snapshot Snapshot register number 1 to 99

Knob Parameter Adjustment Setting values

3 Effect Keyframe effect number 1 to 99 a)
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To return to the state before saving the setting
In the <Store> group, press [Undo].

To execute the settings to check them
Press [Recall] to execute the shotbox.
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Shotbox Execution

You can recall (and run) shotbox registers from the following control blocks.
This section describes the various methods of operation.
• Numeric keypad control block (see page 361)
• Flexi Pad control block (see page 362)
• Multifunction Flexi Pad control block (see page 362)
• Cross-point control block (see page 365)
• Utility/shotbox control block (see page 364)

Shotbox Execution From the Numeric Keypad Control 
Block

Numeric keypad control block

EFF

M/E
1

USER
1

DME
1

DME
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RCALL button

SHOTBOX button Display

UNDO button
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1 In the numeric keypad control block, press the [SHOTBOX] button, 
turning it on.

• This allocates the numeric keypad control block to shotbox operations.
• The [RCALL] button lights amber.
• The display shows the last recalled register number.

2 With the numeric keypad buttons, enter the desired register number.

• The display now shows the entered register number.
• If the specified register is empty, an “E” automatically appears after the 

register number.

3 Press the [ENTER] button.

• This runs the specified shotbox register.
• The number of the recalled register appears in the display.
• The region selection buttons corresponding to the regions for which the 

effect is set light.
• If auto run is set for the specified shotbox register, on recall the effect is 

immediately executed.
• If you recall an empty register, then shotbox execution has no effect.

When auto run is not set for the recalled register
Simply recalling the register does not run the effect. To do this, in the 
keyframe control block, press the [RUN] button.

Shotbox Execution in the Multifunction Flexi Pad 
Control Block or the Flexi Pad Control Block

Note
In the simple type of Flexi Pad control block, shotbox operations are not 
possible. You can carry out shotbox operations with a standard type or 
multifunction type Flexi Pad control block.

1 In the Flexi Pad control block, press the [SHOTBOX] button, lighting the 
[SHOTBOX] button amber.

• This allocates the Flexi Pad control block to shotbox operations.
• The previously selected bank number and the last recalled register 

number appear in the numeric display.

2 Using any of the following methods, select the bank.

• To select a register in bank 0, press the [BANK 0] button.
• To select a register in bank 1, press the [BANK 1] button.
Shotbox Execution



  C
hapter 15 

U
tility/S

hotbox

• Press the [BANK SEL] button, and when the memory recall section 

display changes as follows, press the button from 0 to 9 corresponding 
to the bank you want to select.

• The numeric display shows the selected bank number.
• The buttons in the memory recall section show the names and states of 

the registers corresponding to the selected bank.
Off: register in which nothing is saved
Lit orange: register holding shotbox settings
Lit yellow: last executed register

3 Press the button in the memory recall section corresponding to the register 
you want to run.

• The selected shotbox register is executed.
• The pressed button lights yellow.
• The numeric display shows the bank number followed by the selected 

register number.

7 8 9

4 5 6

1 2 3

0 RUNREWIND

Flexi Pad control block (standard type)

7 8 9

4 5 6

1 2 3

0 RUNREWIND

Multifunction Flexi Pad control block )
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• If the selected shotbox register has auto run set, on recall the effect is 
immediately executed.

When auto run is not set for the recalled register
Simply recalling the register does not run the effect. To do this, press the 
[RUN] button.

Shotbox Execution in the Utility/Shotbox Control Block

Utility/shotbox control block

In the utility/shotbox control block, as the default setting the memory recall 
buttons have registers 1 to 96 allocated to banks 1 to 4.

1 Press one of the bank selection buttons [BANK1] to [BANK4] to select the 
bank.

Bank Register allocation to memory recall buttons

1 1 to 24

2 25 to 48

3 49 to 72

4 73 to 96

1
BANK

1 2 3 4

7
BANK

2

BANK
3

BANK
4

5 6

8 9 10 11 12

13 14 15 16 17 18

19 20 21 22 23 24

Bank selection buttons

Memory recall buttons
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• The pressed bank selection button lights amber.
• The memory recall buttons show the names and states of the registers 

corresponding to the selected bank.
Off: register in which nothing is saved
Lit orange: register holding shotbox settings
Lit yellow: last recalled register

2 Press the memory recall button to which the shotbox register you want to 
run is allocated.

• The shotbox execution is carried out.
• The pressed button lights yellow.
• The numeric keypad control block [SHOTBOX] button lights, and the 

region selection button corresponding to the region for which the effect 
is set also lights.

• If the selected shotbox register has auto run set, on recall the effect is 
immediately executed.

When auto run is not set for the recalled register
Simply recalling the register does not run the effect. To do this, press the 
[RUN] button in the keyframe control block.

Executing a Shot Box Function With the Key 2 Row 
Cross-Point Buttons

You can use the key 2 row of each of the M/E-1 to M/E-3, and PGM/PST banks 
in the same way as the buttons in the utility/shot box control block.

Note
To use this function, it is first necessary to assign the utility shot box mode 
switching function to the control panel [PRE MCRO] button.

For details of the assignment operation, see “Assigning the Utility/Shot Box 
Mode Switching Function” in Chapter 19 (Volume 3).

You can assign any shot box register to the cross-point buttons.

For details of the assignment operation, see “Assigning a Function to the Key 
2 Row Cross-Point Buttons” in Chapter 19 (Volume 3).

1 Press the [PRE MCRO] button, turning it on.

2 Press one of the bank switching buttons (see the figure on page 350), to 
select the bank.
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3 Press the cross-point button to which the desired shot box is assigned.

This executes the shot box function.
Shotbox Execution



  C
hapter 15 

U
tility/S

hotbox
Shotbox Register Editing

You can carry out the following editing on shotbox registers.
• Lock: Write-protect the contents of the register.
• Copy: Copy data from one register to another.
• Move: Move data from one register to another.
• Swap: Swap the contents of two registers.
• Delete: Delete the contents of a register.
• Name: Attach a name to a register.

The procedures for shotbox register editing are similar to the procedures 
described in “Effect Register Editing” (page 306). 
Unlike in effect register editing, however, it is not necessary to specify a region 
in shotbox register editing.
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Overview

The term “macro” refers to the function whereby a sequence of signal 
selections and other operations on the control panel is saved as data in memory, 
so that it can be recalled as required to automatically execute the same 
sequence of operations.
To record menu operations in memory, use a menu macro (see page 429).

Macro registers
The area of memory that holds a macro is termed a “macro register.” For each 
control panel there are 99 macro registers, numbered 1 to 99.

Events
The individual control panel operations constituting a macro are termed 
“events.” One macro can contain a maximum of 99 events.
The following table shows the operations for each control block of the control 
panel that can be saved as events in a macro.

Control block Event

Auxiliary bus control block Cross-point selection

Cross-point selection in router control mode

Cross-point control block
(including when the AUX 
panel-less function is set)

• Cross-point selection
• Recalling a function assigned to a key 2 row button
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Transition 
control block

standard type • Auto transition and cut for the transition execution 
section

• Auto transition and key on/off for the independent 
key transition execution section a)

• Next transition setting
• Transition type selection
• Pattern limit on/off
• Key snapshot recall
• VTR/disk recorder/Extended VTR /frame memory 

clips playback b)

• VTR/disk recorder/Extended VTR /frame memory 
clips stop b)

• VTR/disk recorder/Extended VTR /frame memory 
clips cue-up b)

simple type • Transition execution section take
• Tansition type selection
• Pattern limit on/off

compact type • Transition execution section auto transition and cut 

• Independent key transition execution section auto 
transition a)

• Next transition setting
• Transition type selection
• Pattern limit on/off
• VTR/disk recorder/Extended VTR /frame memory 

clips playback b)

• VTR/disk recorder/Extended VTR /frame memory 
clips stop b)

• VTR/disk recorder/Extended VTR /frame memory 
clips cue-up b)

Independent key transition 
control block
(simple type)

• Independent key transition execution section take 
and key on/off a)

• Key snapshot recall
• Selection of independent key transition type

Control block Event
Macros
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Flexi Pad 
control block

standard type Recalling the following data
• Snapshots
• Wipe snapshots
• DME wipe snapshots

simple type Recalling the following data
• Snapshots
• Wipe snapshots
• DME wipe snapshots

Multifunction 
type

• Effect
• Snapshots
• Shotbox
• Wipe snapshots
• DME wipe snapshots
• Key snapshots
Following operations
• Effect rewind
• Effect execution
• Effect fast forward
• Selection of effect execution direction
• Independent key transition execution section auto 

transition and cut a)

• Pattern limit on/off

Numeric keypad control block Recalling the following data
• Effects
• Snapshots
• Shotbox
• Master snapshots
• Master timeline

Keyframe control block • Effect rewind
• Effect execution
• Effect fast forward
• Selection of effect execution direction

Device control block
(trackball)
(joystick)
(search dial) c)

• VTR/disk recorder/Extended VTR/frame memory 
clips start point setting

• VTR/disk recorder/Extended VTR/frame memory 
clips playback

• VTR/disk recorder/Extended VTR/frame memory 
clips stop

• VTR/disk recorder/Extended VTR/frame memory 
clips cue-up

• VTR/disk recorder/Extended VTR/frame memory 
clips fast forward

• VTR/disk recorder/Extended VTR/frame memory 
clips rewind

• VTR/disk recorder record
• Frame memory clip loop setting

Downstream key control block • Independent key transition execution section auto 
transition and cut a)

• Key snapshot recall

Fade to black control block Execution of fade to black transition

Control block Event
373Macros



374

   C
hapter 16 

M
acros
a) In the case of an event that inserts or deletes a key, the key state at the time of event registration 
(inserted or not inserted) is also saved in the macro. When the macro is executed, the event is 
only replayed if the key state matches the saved state. (Example: For a macro with an event that 
deletes a key, when the macro is executed, if the key is inserted it is deleted, but otherwise 
nothing occurs as concerns keying.)

b) Function valid only when [PLAY], [STOP], and [CUEUP] have been set in the Setup menu.
c) When using the device control block (search dial), this operates as a reference module. When 

not used, this operates on the module selected in the Panel >Config menu.
For details of reference module selection, see “Overall Control Panel Settings (Config Menu)” 
in Chapter 19 (Volume 3).

Macro Creation and Editing

You can create or edit a macro by recalling a macro register.
To create a new macro, recall an empty macro register, and create the desired 
sequence of events (by executing the sequence of operations on the control 
panel that you want to save as events in the macro).
To add an event to an existing macro, recall the register holding the macro, and 
create the event you want to add. 

Note
While editing a macro, it is not possible to execute another macro.

Creating a macro

To include all information associated with an operation when 
registering a macro event
When registering an auto transition operation as an event, you can register the 
auto transition event to include the transition rate and background A/B bus 
selection status. When registering an effect execution, rewind, or fast forward 
as an event, you can also save the region to which this applies.
To use this capability, assign the following functions to user preference buttons 
in the menu control block or buttons in the utility/shotbox control block, and 
turn the relevant button on before you start an event to register.

Menu control block • Disk recorder/Extended VTR file recalling
• Recalling the functions assigned to [PREFS 1] to 

[PREFS 16] buttons
• Execution of a menu macro
• Recalling frame memory clips

Utility/Shotbox control block Recalling the functions assigned to memory recall 
buttons

Control block Event
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Macro AT with Rate (Macro Auto Trans Event with/without Rate): When 
registering an auto transition macro event in one of the M/E banks or the 
PGM/PST bank, include the transition rate.

Macro AT with A/B Bus (Macro Auto Trans Event with/without A/B Bus): 
When registering an auto transition macro event in the transition control 
block, include the background A/B bus cross-point.

Macro TL with Region (Macro Timeline with Region): When registering an 
effect execution, rewind, or fast forward as a macro event, save the 
affected region together in the macro.

For details of the method of assigning these functions to buttons, see “Setting 
Button Assignments (Prefs/Utility Menu)” in Chapter 19 (Volume 3).

Events requiring adjustment when creating a macro
The following events require time for execution to complete, and therefore 
when executed within a macro sequence, a pause event must be inserted to 
adjust the timing.
• Rewinding effects involving external device control
• VTR/disk recorder/Extended VTR cue-up

For example, create a macro to cue up a VTR and then play back as follows.

Auto insert mode on/off setting
You can switch on or off the mode (auto insert mode) in which at the same time 
that a control panel operation is carried out, the event is automatically saved in 
a macro. 

Editing a macro
You can carry out the following macro editing operations.

Event insertion
Insert the control panel operation as an event in a macro.

Event modification
Modify any event. You can modify all events within a macro, or events within 
a specified range in a single operation.

Macro event execution order:

Macro events:
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Event deletion
Delete any one event. You can delete all events within a macro, or events 
within a specified range in a single operation. You can then paste the deleted 
event using the paste function.

Event copy
Copy any one event. You can copy all events within a macro, or events within 
a specified range in a single operation.

Event paste
Paste a copied or deleted event at a desired position within a macro.

Undoing an editing operation
You can undo the last event insertion, modification, deletion, or paste 
operation.

Macro merging
During macro editing, you can recall and copy another register to merge it with 
the macro being edited.

For example, while editing macro register 2 you can recall and copy register 1 
to merge it as shown in the following figure.

41 2 3 1 2 3

1 2 3

1 2 3 4 5 6 7

Recall macro register 2, and 
move to another event. Recall register 1.

Macro being edited (register 2) Newly recalled macro (register 1)

Copy contents of 
register 1 and add 
after current event 
(register 2).

Contents of 
register 1 remain 
unchanged.
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Macro Execution

To execute a macro, recall the register in which the macro is held. 
Simultaneous with the register recall, all events stored in the macro are played 
back (executed) in sequence without pause.

Pausing and restarting macro execution
It is also possible to execute a macro in the following ways.

Pause event
To adjust the execution timing of a particular event (to delay the start of 
execution of the event by a particular time interval), you can store a special 
event which pauses macro execution. This event is called a “pause event.” 
When you store a pause event, you can set the interval for which the macro is 
paused (the pause length) to any value in the range 1 to 999 frames. When the 
set time has elapsed, the macro is automatically executed.

Pause zero event
By including a pause event with the time set to zero, you can make macro 
execution pause at the pause event.

Step execution (requires a Setup menu setting)
By selecting step execution mode in the Setup menu, you can make macro 
execution pause every time an event is executed.

Take operation
When a paused macro is restarted, this is referred to as a “Take” operation.

Macro take operation using a GPI input
You can carry out a macro take operation using a GPI input on the control panel 
and DCU.

For GPI input settings, see “Interfacing With External Devices (Device 
Interface Menu” in Chapter 19 (Volume 3) and “GPI Input Setting (GPI Input 
Assign Menu)” in Chapter 22 (Volume 3).
377Macros



378

   C
hapter 16 

M
acros
Macro Operations in the Numeric Keypad 
Control Block and the Keyframe Control 
Block

This section describes macro operations carried out in the numeric keypad 
control block and the keyframe control block.

Note
For a macro take operation (see “Macro Execution” (page 377)), the numeric 
keypad control block and keyframe control block are not used. Use the [Take] 
button in the Flexi Pad control block.

For an overview of macros, see “Macros” (page 371).

For macro operations in the numeric keypad control block, use the following 
buttons. (See the figure on next page.)
Macro Operations in the Numeric Keypad Control Block and the Keyframe Control Block
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For macro operations in the keyframe control block, use the following buttons. 
(See the following figure.)
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Recalling a Macro Register and Executing a Macro

To carry out a macro operation, recall a macro register. Recalling an empty 
register allows you to carry out macro editing operations. Recalling a register 
holding a macro executes the macro immediately.
To recall a macro register, use the following procedure.

1 In the numeric keypad control block, press the [MCRO] button, turning it 
on.

This assigns the numeric keypad control block to macro operations, and 
the [RCALL] button lights.

2 Enter the number of the register to be recalled with the numeric keypad 
buttons.

To search for an empty register, instead of entering a number, press the [.] 
(period) button.
The display shows the corresponding register number. A letter “E” after 
the number indicates that the corresponding register is empty.
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3 Press the [ENTER] button.

This recalls the specified register.

When you recall an empty register
This assigns the numeric keypad control block and keyframe control block to 
macro editing.

For details of macro editing, see “Creating and Editing a Macro” (see below).

When you recall a register holding a macro
This immediately executes the macro. While the macro is executed, the 
[RCALL] button flashes.

Notes
• It is not possible to execute more than one macro at a time.
• During macro execution, recalling the same register again stops the macro 

being executed.
• Individual events stored in a macro are executed according to the settings in 

setup. If you change the settings in setup, a saved macro may not have the 
expected effect.

• During macro execution, if you switch the control panel to macro editing 
mode, the macro being executed stops.

• During macro editing it is not possible to execute a macro.
• While executing a macro using the Flexi Pad control block or the button with 

a macro attachment set, it is not possible to recall and execute a different 
macro from the numeric keypad control block.

Creating and Editing a Macro

Use the numeric keypad control block and keyframe control block to create and 
edit a macro.
After carrying out creation and editing, be sure to carry out a save operation 
(see page 388), using the numeric keypad control block.

Switching auto insert mode on or off for macro creation/editing
In the auto insert mode, when creating or editing a macro, an operation carried 
out on the control panel is automatically registered as an event.
When this mode is off, it is necessary to press the [INS] button in the keyframe 
control block for each operation to register the event.
To switch auto insert mode on or off, press the [AUTO INS] button in the 
keyframe control block.
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Note
When you start macro editing using the numeric keypad control block with the 
macro execution mode set to “Normal” (see “Setting the Macro Execution 
Mode” in Chapter 19 (Volume 3)), the auto insert mode is automatically on. 
When “Step” is selected as the macro execution mode, the auto insert mode is 
automatically off.

Creating a new macro

1 Recall an empty register.

For details of the method of operation, see “Recalling a Macro Register 
and Executing a Macro” (page 380).

This assigns the numeric keypad control block and keyframe control block 
to macro editing, and the [MCRO] button in the numeric keypad control 
block and the [EDIT ENBL] button in the keyframe control block light red. 
The [STORE] button in the numeric keypad control block flashes red.

2 If required, press the [AUTO INS] button in the keyframe control block to 
toggle the auto insert mode on or off.

3 Create the events (carry out the control panel operations to be registered as 
events in the macro).

You can include pause events (see page 387).

For details of events that can be registered, see “Events” (page 371).

• When auto insert mode (see page 381) is on, execution of a control panel 
operation automatically registers an event in the macro.

• When auto insert mode is off, proceed to step 4.

Notes
• During macro editing, if you press any of the mode selection buttons in 

the numeric keypad control block other than the [MCRO] button 
([TRANSRATE] button, and so on), the executed operation is also 
registered as an event. In this case, the [MCRO] button stays lit red.

• Even during macro editing, you can carry out keyframe operations using 
the fader lever in the keyframe control block and the following buttons:

[EFF LOOP], [STOP NEXT KF], [NORM], [REV], [NORM / REV], 
[FF], [REWIND], [RUN]

• During macro editing, if you press a button for which a macro 
attachment is set, the outcome is as described in the next item.
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4 When auto insert mode is off, press the [INS] button in the keyframe 
control block to register the event.

5 Repeat steps 2 and 3 to register the required events in the macro.

This registers the events in the macro, in the order the operations were 
carried out on the control panel.

6 Press the [STORE] button.

Macro editing finishes, and the [MCRO] button and [STORE] button in the 
numeric keypad control block light amber. The keyframe control block 
returns to the state before starting macro editing.

Note
While carrying out macro editing in the numeric keypad control block and 
keyframe control block, no macro operation other than macro recalling is 
possible in the Flexi Pad control block.

Merging a macro for which a macro attachment is set
While creating/editing a macro, if you press a button for which a macro 
attachment is set, the macro in the register assigned to the button is recalled, 
and the following occurs.
• When auto insert mode is on, it is merged with the macro being edited. 

However, the macro assigned to the button is not executed.
• When auto insert mode is off, it is copied to the paste buffer. Pressing the 

[PASTE] button in the keyframe control block merges it with the macro 
being edited.

Specifying an edit point 
To specify an edit point with the numeric keypad control block and keyframe 
control block, use the following procedure.

1 Recall the register of the macro you want to edit.

For details of the method of operation, see “Recalling a Macro Register 
and Executing a Macro” (page 380).

2 In the numeric keypad control block, hold down the [MCRO] button, and 
press the [STORE] button.

This assigns the numeric keypad control block and keyframe control block 
to macro editing, and the [MCRO] button in the numeric keypad control 
block and the [EDIT ENBL] button in the keyframe control block light red. 
The [STORE] button in the numeric keypad control block flashes red.
383Macro Operations in the Numeric Keypad Control Block and the Keyframe Control Block



384

   C
hapter 16 

M
acros
3 Using any of the following methods, specify the edit point.

• To move the edit point to the event immediately following the current 
macro event, press the [NEXT KF] button in the keyframe control block.

• To move the edit point to the event immediately preceding the current 
macro event, press the [PREV KF] button in the keyframe control block.

• To move to an edit point by specifying an event number (the number 
showing the position of the event in the macro execution sequence), 
press the [GO TO KF] button in the keyframe control block, then in the 
numeric keypad control block, enter the target number and confirm with 
the [ENTER] button.

Inserting an event

1 Specify the edit point. (See page 383.)

2 If required, press the [AUTO INS] button in the keyframe control block to 
toggle the auto insert mode on or off.

3 Create the event.

• When auto insert mode (see page 381) is on, the event is automatically 
added to the macro.

•  When auto insert mode is off, proceed to step 4.

4 When auto insert mode is off, press the [INS] button in the keyframe 
control block.

5 Repeat steps 2 and 3 to insert the required events in the macro.

Modifying a single event

1 Specify the edit point. (See page 383.)

2 If the [AUTO INS] button is lit, press it to turn off the insert mode.

3 Create the event.

4 Press the [MOD] button in the keyframe control block.

Modifying a particular range of events

1 Carry out steps 1 to 3 of the procedure in “Modifying a single event” (the 
previous item).
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2 Press the [FROM TO] button in the keyframe control block, turning it on.

The numeric display in the numeric keypad control block shows the 
current event number and the indication “TO.”

3 To set the start of the range to other than the current event number, press 
the [CLR/AUTO TRANS] button in the numeric keypad control block, 
then enter the desired event number with the numeric keypad and press the 
[ENTER] button. (This operation is not required when using the current 
event number.)

4 Enter the event number for the end of the range and press the [ENTER] 
button.

5 Press the [MOD] button in the keyframe control block.

This modifies the specified range of events simultaneously.

Modifying all events at the same time 

1 Carry out steps 1 to 3 of the procedure in “Modifying a single event” (page 
384).

2 Press the [ALL] button in the keyframe control block, turning it on.

3 Press the [MOD] button.

This modifies all events in the specified range simultaneously.

Deleting an event

1 Specify the edit point. (See page 383.)

2 To delete multiple events simultaneously, carry out either of the following 
operations. (This operation is not required to delete the event at the edit 
point only.)

• To specify a range to be deleted, press the [FROM TO] button in the 
keyframe control block, then enter the event numbers from the numeric 
keypad control block.

• To delete all events within this macro, press the [ALL] button, turning it 
on.

3 Press the [DEL] button.

This deletes the specified events.
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Moving events

1 Specify the edit point for the start of the range to be moved. (See page 383.)

2 To move multiple events simultaneously, press the [FROM TO] button in 
the keyframe control block, then specify the range in the numeric keypad 
control block.

3 Press the [DEL] button.

This temporarily deletes the specified events from the macro, and copies 
them to the paste buffer.

4 Move to the edit point which is the destination within the macro to which 
you want to move the events.

5 To paste the contents of the paste buffer after the edit point, press the 
[PASTE] button in the keyframe control block.
To paste before the edit point, hold down the [SHIFT] button in the 
keyframe control block and press the [PASTE] button.

This pastes the events from the paste buffer.

Copying events

1 Specify the edit point for the start of the range to be copied.

2 To copy multiple events simultaneously, press the [FROM TO] button or 
[ALL] button in the keyframe control block, then specify the range in the 
numeric keypad control block.

3 Press the [COPY] button.

This copies the specified events into the paste buffer.

4 Move to the edit point which is the destination within the macro to which 
you want to copy the events.

5 To paste the contents of the paste buffer after the edit point, press the 
[PASTE] button in the keyframe control block.
To paste before the edit point, hold down the [SHIFT] button in the 
keyframe control block and press the [PASTE] button.

This copies the events from the paste buffer.
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Inserting a pause event

1 Press the [PAUSE] button in the keyframe control block, lighting it green.

The indication “PAUSE” appears in the numeric keypad control block 
display. 

2 If required, press the [AUTO INS] button in the keyframe control block to 
toggle the auto insert mode on or off.

3 Enter the pause duration with the numeric keypad control block (0 or 1 to 
999 (frames)).

4 Press the [ENTER] button.

• If auto insert mode is on, this sets the pause duration, and inserts the 
pause event.

• When auto insert mode is off, continue to step 5.

5 When auto insert mode is off, press the [INS] button in the keyframe 
control block to insert the pause event.

Merging macro register data

1 Specify the edit point. (See page 383.)

2 Press the [RCALL] button in the numeric keypad control block, lighting it 
amber.

3 Enter the number of the macro register you want to copy using the numeric 
keypad buttons.

The display shows the register number.

4 Press the [ENTER] button.

The [RCALL] button goes off, and the specified register data is copied to 
the paste buffer.
• When auto insert mode is on, the data from the specified register is 

included after the edit point.
• When auto insert mode is off, continue to step 5.

5 When auto insert mode is off, to include after the edit point, press the 
[PASTE] button in the keyframe control block.
To include before the edit point, hold down the [SHIFT] button in the 
keyframe control block, and press the [PASTE] button.
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In place of steps 2 to 4, you can specify the register with the Flexi Pad control 
block. (See “Recalling a Macro Register and Executing a Macro” (page 390).
The same effect is obtained if you use a button which has a macro attachment 
set. In this case, the data from the assigned macro register is copied into the 
paste buffer.

Undoing a macro editing operation with the numeric keypad 
control block

Immediately after inserting, modifying, deleting, or pasting an event, you can 
undo the operation by pressing the [UNDO] button in the numeric keypad 
control block.

Saving a Macro

Use the following procedure to save the register after creating or editing/
modifying a macro.

1 In the numeric keypad control block, press the [MCRO] button, turning it 
on.

This assigns the numeric keypad control block to macro operations.

2 Press the [STORE] button, turning it on.

3 Enter the number of the register in which you want to save the macro with 
the numeric keypad buttons.

To search for an empty register, instead of entering a number, press the [.] 
(period) button.
The display shows the corresponding register number. A letter “E” after 
the number indicates that the corresponding register is empty.

4 Press the [ENTER] button.

This saves the macro data in the specified register, and the [STORE] button 
goes off.
The [RCALL] and [STORE STATS] buttons light.

To cancel the saving of a macro
To cancel the saving of a macro immediately after performing it, hold down the 
[STORE STATS] button and press the [UNDO] button.
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Macro Operations in the Standard Type 
Flexi Pad Control Block

This section describes how to carry out macro operations in a standard type 
Flexi Pad control block.

For an overview of macros, see “Macros” (page 371).

Using the <Flexi Pad Edit Mode> group buttons in the Engineering Setup 
>Panel >Operation >Macro menu, you can set the macro execution mode to 
“Pause Only” or “Full Editing” (see “Setting the Macro Execution Mode” in 
Chapter 19 (Volume 3)).
The display of the standard type Flexi Pad control block changes as follows, 
depending on the selected mode of macro execution.

When entering macro editing mode with “Pause Only” selected
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When entering macro editing mode with “Full Editing” selected

About operations in Full Editing mode, see “Macro Operations in the Simple 
Type Flexi Pad Control Block” (page 397).

Banks and registers
To allow operations on the 99 registers, the standard type Flexi Pad control 
block treats the registers in groups. These groups are called banks, and there 
are 10 banks, numbered from 0 to 9.

For details of the correspondence between banks and registers, see “Banks 
and Registers” (page 324).

Recalling a Macro Register and Executing a Macro

Carrying out a macro operation in the normal mode
Use the following procedure to recall a macro register.

1 In the Flexi Pad control block, press the [MCRO] button, turning it on.
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This assigns the Flexi Pad control block to macro operations.
The numeric display shows the previously selected bank number and the 
last recalled register number.

2 Use any of the following operations to select the bank for recall.

To select bank 0: Press the [BANK0] button.
To select bank 1: Press the [BANK1] button.
To select any of banks 0 to 9: Press the [BANK SEL] button, changing 

the memory recall section display as in the following figure; select a 
number from 0 to 9.

The selected bank number appears in the numeric display.
Each button in the memory recall section shows the corresponding register 
name and register status for the selected bank.
Note that in the Setup menu, you can select whether to display register 
names or register numbers.
Lit orange: Register holding macro data
Lit yellow: Last recalled register
Off: Empty register

3 Press the button in the memory recall section showing the name of the 
register to be recalled.

The button you pressed lights yellow, the macro register is recalled, and 
the macro is executed.
During macro execution, the button you pressed remains yellow, but 
flashes. When macro execution completes, it returns to permanently on.
The numeric display shows the bank name followed by the selected 
register number.

Notes
• It is not possible to execute more than one macro at a time.
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• During macro execution, recalling the same register again stops the 
macro being executed.

• Individual events stored in a macro are executed according to the 
settings in setup. If you change the settings in setup, a saved macro may 
not have the expected effect.

• During macro execution, if you switch the control panel to macro editing 
mode, the macro being executed stops.

• During macro editing it is not possible to execute a macro.
• If you start execution of a macro by operating the Flexi Pad control block 

for an M/E or PGM/PST bank, the numeric keypad control block, 
Multifunction Flexi Pad control block or a button for which a macro 
attachment is set, then before the end of execution of that macro you 
cannot recall and execute a separate macro from the Flexi Pad control 
block for a different bank.

Executing a macro in normal execution mode (with pause events 
set)

When execution of a macro is paused, the [Take] button is assigned to the 
memory recall section.
To restart the macro execution, press the [Take] button.

You can switch the normal execution mode and step execution mode in the 
Setup menu. See “Setting the Macro Execution Mode” in Chapter 19 (Volume 
3).

Executing a macro in step execution mode
To recall a macro register and execute the macro in step execution mode, use 
the following procedure.

1 In the Flexi Pad control block, recall the macro register.

For details of recalling macro registers, see “Recalling a Macro Register 
and Executing a Macro” (page 390).

The Flexi Pad control block memory recall section is assigned to the 
display of the [Take] button and macro execution status, as in the following 
figure.
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2 Press the [Take] button.

This executes one event within the macro, then stops.
The number of events executed, as shown in the memory recall section 
status display, is incremented by one.

3 Repeat step 2, executing the macro event by event.

When all events in the macro have been executed, the [Take] button goes 
off.

Creating and Saving a Macro

1 In the Flexi Pad control block, press the [MCRO] button, turning it on.

This assigns the Flexi Pad control block to macro operations.

2 Select the bank of the register in which you want to save the macro.

For details of the method of operation, see step 2 in the previous item 
“Recalling a Macro Register and Executing a Macro” (page 390).

3 Hold down the [MCRO] button in the Flexi Pad control block, and press 
the button in the memory recall section showing the desired register name.
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This assigns the Flexi Pad control block to macro editing, and the auto 
insert function is enabled. The [MCRO] button lights red.
As an example, when register 12 is specified, the buttons in the memory 
recall section appear as in the following figure.

4 In the same way as in the numeric keypad control block, create the events 
you want to save in the macro.

For details, see step 2 (page 382) of “Creating a new macro.”

5 Repeat step 4 to save the desired events in the macro.

The operations you carry out on the control panel are saved as a sequence 
of events in the macro.
The numeric display appears as follows.

6 Press the [STORE XX] button in the memory recall section (where XX is 
the register number).

The [STORE STATS] button lights amber.
This saves the created macro in the register, and macro editing ends.
The Flexi Pad control block returns to the state before macro editing began.
The [MCRO] button lights amber.

Notes
• During macro editing, you can press a mode selection button in the Flexi Pad 

control block other than the [MCRO] button (for example, the [WIPE] button 
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or [DME] button) to record the executed operation as an event. In this case, 
the [MCRO] button remains lit red.

• During macro editing, if you press a button for which a macro attachment is 
set, the macro within the register assigned to the button is merged into the 
macro being edited. However, the macro assigned to the button is not 
executed.

• While carrying out macro editing in the Flexi Pad control block, absolutely 
no macro operations are possible in the Flexi Pad control blocks for other M/
E and PGM/PST banks. Macro operations from the numeric keypad control 
block or Multifunction Flexi Pad control block are also not possible.

To cancel the saving of a macro
To cancel the saving of a macro immediately after performing it, hold down the 
[STORE STATS] button and press the [UNDO] button.

Inserting a pause event

1 Press the [PAUS] button in the memory recall section.

The buttons in the memory recall section change as follows.

2 Enter the length of pause you want to set (0 to 999 frames).

3 Press the [PAUS ENTR] button.

This sets the pause length, and inserts the pause event.
The memory recall section display returns to its former state.

Deleting a macro

1 In the Flexi Pad control block, press the [MCRO] button.

This assigns the Flexi Pad control block to macro operations.
The numeric display shows the previously selected bank number and the 
number of the last recalled register.
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2 Select the bank of the register holding the macro you want to delete.

For details of the method of operation, see step 2 (page 391) of “Recalling 
a Macro Register and Executing a Macro.”

3 Hold down the [STORE STATS] button, and then press the button in the 
memory recall section showing the corresponding register number.

The button you pressed in the memory recall section goes off, and this 
deletes the macro. The [STORE STATS] button lights amber.
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Macro Operations in the Simple Type Flexi 
Pad Control Block

This section describes the macro operations carried out in the simple type Flexi 
Pad control block.

Use the following buttons.

To use the MCRO button
To enable the [MCRO] button for use as in the above figure, it is necessary in 
the Setup menu to switch the [UNDO] button to the [MCRO] button.

For more details, see “Setting the assignment of macro operation buttons” in 
Chapter 19 (Volume 3).

Note
In a simple type Flexi Pad control block, only registers 1 to 6 can be used for 
operations. There are no “bank” operations.
For registers 7 to 99, use the numeric keypad control block.
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Recalling a Macro Register and Executing a Macro

Executing a macro in normal execution mode

1 In the simple type Flexi Pad control block, press the [MCRO] button, 
turning it on.

This assigns the Flexi Pad control block to macro operation.
The numeric display shows the number of the last recalled register.

The buttons of the memory recall section show the selected register status.
Lit orange: register holding macro data
Lit yellow: last recalled register
Off: empty register

2 Press the button in the memory recall section showing the register to be 
recalled.

The button you pressed lights yellow, the macro register is recalled, and 
the macro is executed.
During the macro execution, the button pressed remains yellow, but 
flashes, and when the macro execution completes it changes to 
permanently lit.
The numeric display shows the selected register number.

Notes
• Only one macro can be executed at a time.
• During macro execution, if you recall the same register again, execution 

of the macro stops.
• Individual events registered in a macro are executed according to the 

setup settings. If you change the setup settings, the content of the macro 
may not be played back.

• During macro execution, if you switch the control panel to macro editing 
mode, the macro currently being executed stops.

• It is not possible to execute a macro during macro editing.

Executing a macro in normal execution mode (with pause events 
set)

When the macro execution is paused, the [Take] button is assigned to the 
simple type Flexi Pad memory recall section.
Press the button to restart macro execution.
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Executing a macro in step execution mode
After recalling the macro register, to execute a macro in step execution mode, 
use the following procedure.

Note
To execute a macro in step execution mode requires setting the step execution 
mode in the Setup menu.

For details of the method of setting, see “Setting the Macro Execution Mode” 
in Chapter 19 (Volume 3).

1 In the simple type Flexi Pad control block, press the [MCRO] button, 
turning it on.

This assigns the Flexi Pad control block to macro operation.

2 Press the button in the memory recall section showing the register to be 
recalled.

3 Press the [Take] button.

This executes one event within the macro, then stops.
The number of events executed, as shown in the memory recall section 
status display, is incremented by one.

4 Repeat step 3, executing the macro event by event.

When all events in the macro have been executed, the [Take] button goes 
off.

Creating and Editing a Macro

Creating a macro

1 In the simple type Flexi Pad control block, press the [MCRO] button, 
turning it on.

This assigns the Flexi Pad control block to macro operation.

2 While holding down the [MCRO] button in the Flexi Pad control block, 
press the button in the memory recall section showing the desired register 
name.

This assigns the Flexi Pad control block to macro editing.
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As an example, when register 1 is specified, the memory recall section 
buttons appear as in the following figure.

3 Carry out the control panel operation to be registered as an event in the 
macro.

For details of the events that can be registered, see “Events” (page 371).

Note
In the Flexi Pad control block, it is not possible to set a pause event. To set 
a pause event, use the numeric keypad control block.

4 Press the [INS] button.

This registers the operation carried out in step 3 as an event within the 
macro.

5 Repeat steps 3 and 4 to register the required events in the macro.

The numeric display shows the last registered event position, and the total 
number of events.

6 Press the [STOR 1] button in the memory recall section.

This saves the created macro in the register and ends the macro editing 
mode; the [MCRO] button lights amber.

Notes
• During macro editing, if you press any of the mode selection buttons in the 

Flexi Pad control block other than [MCRO] button (the [WIPE] button, 
[DME] button, and so on), the executed operation is also registered as an 
event. In this case, the [MCRO] button stays lit red.

• While carrying out macro editing in the Flexi Pad control block, pressing a 
button to which a macro attachment is set does not execute the macro.

• In the simple type Flexi Pad control block, it is not possible to undo a macro 
save.

EXIT STOR
1

ALL DEL

INS MOD

NEXTPREV

“1” is register number
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Specifying an edit point

1 In the Flexi Pad control block, press the [MCRO] button, turning it on.

This assigns the Flexi Pad control block to macro operation.

2 While holding down the [MCRO] button in the Flexi Pad control block, 
press the button in the memory recall section showing the desired register 
name.

3 Specify the edit point by the following operation.

• To move the edit point to the event immediately following the current 
macro event (the macro event specified as the current edit point), press 
the [NEXT] button.

• To move the edit point to the event immediately preceding the current 
macro event, press the [PREV] button.

Inserting an event
To add an event to an already created macro, use the following procedure.

1 Specify the edit point. (See above.)

2 Carry out the event to be added on the control panel.

For details of events that can be registered, see “Events” (page 371).

3 In the memory recall section, press the [INS] button.

This adds the new event after the event specified in step 1.

Modifying an event

1 Specify the edit point. (See above.)

2 Carry out the event you want to modify on the control panel.

3 Press the [MOD] button.

This modifies the event at the specified edit point as carried out in step 2.

Deleting an event

1 Specify the edit point. (See above.)

2 Press the [DEL] button.
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This deletes the event specified in step 1.

Deleting all events within a macro register

1 Specify the edit point. (See page 401.)

2 Press the [ALL] button, lighting it green.

3 Press the [DEL] button.

This deletes all events within the register.

Saving a Macro

In the memory recall section, press the [STOR X] (X=register number) button 
to save the edited macro in a register.

To return to the state before editing, without saving the macro 
editing results
Press the [EXIT] button to recall the same register again. This returns to the 
state before editing, without saving the macro editing results.
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Macro Operations in the Multifunction Flexi 
Pad Control Block

This section describes macro operations carried out in the Multifunction Flexi 
Pad control block.
Use the following buttons.

Recalling a Macro Register and Executing a Macro

1 Press the [MCRO] mode selection button, turning it on. 

This switches the Multifunction Flexi Pad control block to macro 
operation mode.

2 Enter the register number with the numeric keypad buttons, and press the 
[ENTR] button to recall the register.

[MCRO] button

Numeric keypad buttons

[DRCT MODE] button
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3 Press the [DRCT MODE] button, to switch to the direct recall mode in 
which a macro can be recalled with the buttons in the memory recall 
section. 

The button indications in the memory recall section change as shown in the 
following illustration.

4 Use one of the following operations to select the bank.

To select bank 0: Press the [BANK0] button.
To select bank 1: Press the [BANK1] button.
To select any of banks 0 to 9: Press the [BANK SEL] button, then press 

the desired bank button (any of [0] to [9]).

This selects the bank, and the buttons in the memory recall section show 
the macro register state as follows.
Lit yellow: Last recalled register
Lit orange: Register holding macro data
Off: Empty register

5 Press the button for the number of the register to be recalled.

The button you pressed lights yellow, and the macro held in the 
corresponding register is recalled and executed.
The button you pressed flashes yellow as the macro execution starts, and 
returns to constantly lit yellow when the execution ends.
The alphanumeric display shows the numbers of the selected bank and 
register.

Notes
• You can only execute one macro at a time.
• During macro execution, if you recall the same register again, this stops the 

executing macro.
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• The individual events registered in the macro are executed according to the 
setup settings. If you change the settings in setup, the registered content may 
not be reproduced.

• During macro execution, if you switch the control panel to macro editing 
mode, this stops the executing macro.

• It is not possible to execute a macro during macro editing.
• While executing a macro from the Flexi Pad control block, or with a button 

having a macro attachment set, it is not possible to recall and execute a 
different macro from the Multifunction Flexi Pad control block.

Macro execution modes
You can execute a macro in normal execution mode or step execution mode.
Normal execution mode: In this mode the macro events are automatically 

executed in sequence. However, if there is a pause event set at some point, 
execution pauses at that point. Then pressing the [TAKE] button in the 
memory recall section resumes execution.

Step execution mode: The macro events are executed one at a time with 
pauses in between. Execute the events in sequence by repeatedly pressing 
the [TAKE] button.

You can select normal execution mode or step execution mode by a selection 
in the Setup menus. See “Setting the Macro Execution Mode” in Chapter 19 
(Volume 3).

Creating and Editing a Macro

To create or edit a macro, first recall the register in which the created macro 
will be saved, or the register holding the macro to be edited, then press the 
[EDIT ENBL] button.
The [MCRO] button and [EDIT ENBL] button light red, and the memory recall 
section switches to the macro editing mode as shown in the following 
illustration.

For the method of recalling an empty register, see “Recalling a Macro 
Register and Executing a Macro” (page 390). 
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In this mode, you can use the following buttons for macro creation, editing, 
saving, and deletion.
[EXIT] button: Forcibly exit editing mode.
[UNDO] button: Undo the last macro event insertion, modification, deletion, 

paste, or other operation.
[PAUS] button: Insert a pause event (see page 387).
[AUTO INS] button: Toggle auto insert mode on or off (see page 381).
[COPY] button: Copy a macro event (see page 386).
[PSTE] button: Paste a macro event (see page 387).
[ALL] button: Select all macro events (see page 385).
[STOR] button: Save the macro (see page 388).
[INS] button: Insert a macro event (see page 384).
[MOD] button: Modify a macro event (see page 384).
[DEL] button: Delete a macro event (see page 385).
[FROM TO] button: Switch to the mode for entering a value range with the 

numeric keypad (see page 384).
[SHFT] button: Move a macro event (see page 386).
[<< PREV] button: Move the edit point to the previous event (see page 401).
[>> NEXT] button: Move the edit point to the next event (see page 401).
[GOTO EVNT] button: Switch to the mode for specifying an event to move 

to with the numeric keypad (see page 383).
Macro Operations in the Multifunction Flexi Pad Control Block



  C
hapter 16 

M
acros
Macro Editing Using Menus

Using any of the menus in the following table, you can edit macro registers and 
macro events.

Macro Register Editing

You can display the current state of a macro register using the Macro >Register 
menu.
The items displayed are the same as under “Effect Status Display” (see page 
306), with the exception that the region name is not displayed and that the total 
number of macro events saved in the register is displayed.

In the Macro >Register menu, you can do the following editing operations on 
macro registers.
• Lock: Write-protect the contents of the register.
• Copy: Copy the contents of one register to another register.
• Delete: Delete the contents of a register.
• Name: Attach a name to a register.
The operations for macro register editing are the same as those for effect 
register editing (see page 306) except the region selection operation, which is 
not necessary for macro register editing.

Online Editing of Macro Events

Using the On Line Edit menu, you carry out online editing of macro events.

Menu Function Operations

Register menu (macro 
register editing)

Carry out macro register editing. • Locking a register
• Copying a register
• Deleting a register
• Naming a register

On Line Edit menu 
(online editing of 
macro events)

Edit events in a macro register, using 
the control panel and menus.

• Inserting an event
• Deleting an event
• Modifying an event

Off Line Edit menu 
(offline editing of 
macro events)

Edit events in a macro register, on 
the hard disk, or on a memory card, 
using the menus.

• Inserting an event
• Adding an event
• Deleting an event
• Creating a new 

macro
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In the On Line Edit menu, you can check the control panel operating sequence 
in the menu. You can also carry out editing using the control panel and menu.

To display the On Line Edit menu

1 Recall the macro register you want to edit with the control panel, and select 
the macro editing mode 1).

1) With the numeric keypad control block, keyframe control block, Flexi Pad control block, 
or Multifunction Flexi Pad control block assigned to macro editing (see step 2 in 
“Specifying an edit point” (page 383), step 3 in “Creating and Saving a Macro” (page 
393), and step 2 in “Creating a macro” (page 399))

2 In any of the following menus, select the same register as the register 
recalled in step 1, and press [On Line Edit] in the button area.

• Macro >Register >Lock menu
• Macro >Register >Delete menu
• Macro >Register >Rename menu
• File >Shotbox, Macro >Macro >File Edit menu

The On Line Edit menu appears, and you can now carry out online editing 
of the events held in the recalled register. Meanwhile, the control block of 
the control panel operated in step 1 is assigned to control editing 
operations.

Note
In the following cases, [On Line Edit] is disabled, and it is not possible to 
display the On Line Edit menu.
• When the recalled register and the register selected in the menu are 

different.
• When a device other than [Register] is selected ([HDD] or [Memory 

Card]) in the File >Shotbox, Macro >Macro >File Edit menu.
• If the recalled register is locked.
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On Line Edit menu

a Register number
Shows the number of the register being edited.

b Register name
Shows the name of the register being edited.

1 Register number

2 Register name

3 Event number

5 Macro register listing

4 Remaining Memory

6 ALL button

7 Macro creation event list

8 Insert Before button

9 Insert After button

0 Delete button

qa Modify button

qs <Prev button

qd >Next button
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c Event number
Shows the current event number. When the [FROM TO] button in the 
keyframe control block is pressed to select a range of events, this appears as a 
range, “From X To Y.”
The event number reflects the position of the cursor in the macro register 
listing.

d Remaining Memory
Shows the percentage of memory still available for recording events.

e Macro register listing
When a macro is stored in the register, this shows a list of the macro events. 
Each macro event consists of the following components, which you can check 
in the list.
• Contents: Identifies this as an Event statement, Continue statement, or event 

number
• Symbol: Type of event (ASCII character string)
• Data: Event details in the form of parameters and data

For details of the event components, see “Macro File Editing Rules” (page 
481).

The cursor shows the current event in the list, in reverse video. You can turn 
knob 1 to scroll the list, but this does not change the cursor position. Depending 
on the switcher status, the cursor color changes as follows.
• Yellow: in macro editing mode
• Gray: when the editing mode is exited by a control panel operation
• Blue: during macro execution

f ALL button
Selects all events in the macro register listing.

g Macro creation event list
Shows the event being created or executed in the control panel.

h Insert Before button
Inserts a created event immediately before the selected event in the macro 
register listing.

i Insert After button
Inserts a created event immediately after the selected event in the macro 
register listing.

j Delete button
Deletes the selected event in the macro register listing.
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k Modify button
Replaces the selected event in the macro register listing with a created event.

l <Prev button
Moves the cursor to the event immediately before the selected event in the 
macro register listing.

m >Next button
Moves the cursor to the event immediately after the selected event in the macro 
register listing.

Carrying out online editing of macro events
In the On Line Edit menu, you can carry out the following editing operations 
on the events in the macro register.
• Insert: Insert a macro event.
• Delete: Delete a macro event.
• Modify: Modify a macro event.

Note
It is not possible to save editing results using this menu alone. Carry out the 
necessary control panel operations to save the edited register.

To insert an event

1 On the control panel, if auto insert mode is on, switch it off.

2 On the control panel, create a macro event.

The created event appears in the macro creation event list.

For more details of the display, see “Macro File Editing Rules” (page 
481).

3 In the macro register listing, press [<Prev] or [>Next] to select the position 
where you want to insert the created event.

4 Carry out either of the following.

To insert before the event selected in the list: Press [Insert Before].
To insert after the event selected in the list: Press [Insert After].

This inserts the created event either before or after the specified event.

Note
In the following cases, [Insert Before] and [Insert After] are disabled, and 
it is not possible to insert the event.
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• If the memory or register is full.
• The size of the created macro event is larger than the memory or register 

space available.
• When multiple events are selected.
• When the number of events has reached 99.
• When not in macro editing mode. 1)

1) While a macro is being executed on the control panel, when macro saving has been 
executed, or when the [EXIT] button in the Flexi Pad control block or Multifunction Flexi 
Pad control block has been pressed

5 Operate the control panel to save the editing result.

To delete an event

1 In the macro register listing, press [<Prev] or [>Next] to select the event 
you want to delete.

To select all events in the register
Press [All].

2 Press [Delete].

This deletes the selected event.

Note
If not in macro editing mode 1), [Delete] is disabled, and it is not possible 
to delete the selected event.

1) While a macro is being executed on the control panel, when macro saving has been 
executed, or when the [EXIT] button in the Flexi Pad control block or Multifunction Flexi 
Pad control block has been pressed

3 Operate the control panel to save the editing result.

To modify an event

1 On the control panel, if auto insert mode is on, switch it off.

2 In the macro register listing, press [<Prev] or [>Next] to select the event 
you want to modify.

3 On the control panel, modify the macro event.

The modified event appears in the macro creation event list.

For more details of the display, see “Macro File Editing Rules” (page 
481).
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4 Press [Modify].

This modifies the event selected in the list.

Note
If not in macro editing mode 1), [Modify] is disabled, and it is not possible 
to modify the event.

1) While a macro is being executed on the control panel, when macro saving has been 
executed, or when the [EXIT] button in the Flexi Pad control block or Multifunction Flexi 
Pad control block has been pressed

5 Operate the control panel to save the editing result.

Offline Editing of Macro Events

Using the Off Line Edit menu, you carry out offline editing of macro events.
In the Off Line Edit menu, you can carry out editing in the menu only, unrelated 
to operation of the control panel.

To display the Off Line Edit menu
In any of the following menus, select the register or device holding the macro 
you want to edit, and press [Off Line Edit] in the button area.
• Macro >Register >Lock menu
• Macro >Register >Delete menu
• Macro >Register >Rename menu
• File >Shotbox, Macro >Macro >File Edit menu

This recalls the selected macro register or macro file, and offline editing is now 
possible.

Note
If the selected register is locked, [Off Line Edit] is disabled, and it is not 
possible to display the Off Line Edit menu.
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Off Line Edit menu

a Register or file number
Shows the number of the register or file being edited.

b Register or file name
Shows the name of the register or file being edited.

1 Register or file number

2 Register or file name

3 Macro listing 4 Editing button group

5 Macro editing candidate list

6 Insert Before button

7 Append button

8 Delete button

9 Set button

0 Store button

qa Exit button
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c Macro listing
Lists the macro events that are saved in the register or file. The cursor moves 
to the selected event. Each macro event consists of the following components, 
which you can check in the list.
• Contents: Event statement, Continue statement, comment (#), or event 

number, as selected in the editing button group [Contents]
• Symbol: Event type (ASCII character string), as selected in the editing 

button group [EVNT]
• Data: Parameters and data as set in the editing button group

For more details of the event components, see “Macro File Editing Rules” 
(page 481).

d Editing button group
This row of buttons shows the components of an event. To carry out event 
editing: (1) press an editing button, then (2) select an item from the list of 
macro editing candidates, and repeat this process as required.

e Macro editing candidate list
Shows the list of editing candidates for the selection from the editing button 
group.

f Insert Before button
Inserts immediately before the event selected in the macro listing.

g Append button
Adds an empty row at the end of the macro listing.

h Delete button
Deletes the event selected in the macro listing.

i Set button
Reflects the item selected in the macro editing candidate list, in the macro 
listing and editing buttons.

j Store button
Saves the results of the macro register or macro file editing.

k Exit button
Closes the Off Line Edit menu without saving the results of the macro register 
or macro file editing, and returns to the File Edit menu.

Carrying out offline editing of macro events
In the Off Line Edit menu, you can carry out the following editing operations 
on the events in the macro register or macro file.
• Insert: Insert a macro event.
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• Add: Add a macro event.
• Delete: Delete a macro event.

You can also create a new macro.

To insert an event

1 In the macro listing, select the event immediately after the position where 
you want to insert an event.

2 Press [Insert Before].

This inserts a blank row before the event selected in step 1.

3 Press [Contents] in the editing button group.

The following event types appear in the macro editing candidate list.
• Event: Event
• Continue: Event continuation
• #: Comment

For details of the items, see “Macro File Editing Rules” (page 481).

4 Select the desired item from the macro editing candidate list, and press 
[Set].

The selected item appears at the event insertion position in the macro 
listing, as an event component. Additionally, in the leftmost blank position 
of the editing button group (to the right of [Contents]), a button appears, 
corresponding to the item in the macro editing candidate list. For example, 
if “Event” is selected, an [EVNT] button appears.

5 In the editing button group, press the button that has just appeared.

The item corresponding to the button appears in the macro editing 
candidate list.
If you press the [EVNT] button, the symbol indicating the event contents 
appears.

For details of symbols, see “Correspondence Between Events and 
Symbols” (page 484).
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6 Select the desired item from the macro editing candidate list, and press 
[Set].

At the event insertion position of the macro listing, the selected item is 
added as an event component. Additionally, in the next blank position of 
the editing button group, a button appears, corresponding to the item in the 
macro editing candidate list. For example, if “MEAutoTransition” is 
selected, a button for the parameters and data for the MEAutoTransition 
appears.

Note
If you select an item from the macro editing candidate list, be sure to press 
[Set]. If [Set] is not pressed, the selection is not confirmed.

7 Repeat steps 5 and 6, to edit the event components.

At the event insertion position of the macro listing, the confirmed item is 
added as an event component.

To further add an event
Repeat steps 1 to 7.

To close the Off Line Edit menu without saving the editing results
Press [Exit] to return to the menu that was on the screen immediately 
before the offline editing.

8 Press [Store].

The numeric keypad window appears.

9 Enter the register number as required, and press [Enter].

The current macro is stored in the register.
The menu screen switches to the menu that was on the screen immediately 
before the offline editing.

To append an event
This adds an event at the end of the macro.

1 Press [Append].

A blank row is added at the end of the macro listing.
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2 Carry out steps 3 to 8 of the previous item, “To insert an event,” to edit an 
event.

To delete an event

1 In the macro listing, select the event you want to delete.

2 Press [Delete].

This deletes the selected event.
If a deleted Event statement is followed by a Continue statement, the 
Continue statement is converted to an Event statement.

To close the Off Line Edit menu without saving the editing results
Press [Exit] to return to the File Edit menu.

3 Press [Store].

This saves the results of the macro register or macro file editing, and 
returns to the File Edit menu.

To create a new macro

1 From the list in any of the following menus, select an empty register or file, 
and press [Off Line Edit] in the button area.

• Macro >Register >Lock menu
• Macro >Register >Delete menu
• Macro >Register >Rename menu
• File >Shotbox, Macro >Macro >File Edit menu

The Off Line Edit menu appears.

2 Carry out steps 3 to 8 of the procedure “To insert an event” (page 416), to 
create an the event.
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Macro Attachment Assigning

Macro attachment is a function whereby a macro register is assigned to a 
control panel button or a particular position of a fader lever, linking the 
execution of the button function or a fader lever operation with a macro 
execution.

Setting a macro attachment to a button
Select one of the following three linking modes to make the macro attachment.
Pre-macro: Mode in which the button function is executed after macro 

execution has completed
Post-macro: Mode in which the macro is executed after carrying out the button 

function
Macro only: Mode in which the button function is not executed, and the macro 

only is executed

The selection of pre- or post-macro mode is carried out in the cross-point 
control block of the PGM/PST bank or the M/E banks. For the macro-only 
mode, assign the selection function to a utility/shotbox control block button or 
user preference button, and make the selection by pressing the button. 
Alternatively, without pressing the button, you can make the selection simply, 
by simultaneously pressing the pre-macro and post-macro selection buttons in 
the cross-point control block. 

You can assign any one of the 99 macro registers to a button.
For a button whose function is switched by delegation, you can make a separate 
macro attachment for each function.
For each control panel, you can make up to 1000 macro attachment settings.
The macro attachment setting is possible for the following bus buttons. 

For button locations, see Chapter 2 “Menus and Control Panel” (Volume 1).
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Block Button

PGM/PST or M/E bank • Background A row cross-point buttons  
• Background B row cross-point buttons 
• Key 1 bus cross-point buttons 
• Key 2 bus cross-point buttons 
• Key 3 bus cross-point buttons 
• Key 4 bus cross-point buttons 
• Utility 1 bus cross-point buttons 
• Utility 2 bus cross-point buttons 
• DME external video bus cross-point buttons 
• DME utility 1 bus cross-point buttons 
• DME utility 2 bus cross-point buttons 
• [AUTO TRANS] button a) 
• [CUT] button 
• [KEY1 ON] to [KEY4 ON] buttons a) 
• The button to which the same function as that of 

VTR/disk recorder/Extended VTR/frame memory 
clips play, cue, and stop buttons 

• Memory recall buttons i)

• Buttons set to “Inhibit” 
• Auxiliary bus cross-point row j)

Auxiliary bus control block • Cross-point button1st row b) 
• Cross-point button 2nd row b) 

Keyframe control block • [RUN], [REWIND] and [FF] buttons 
• [NORM], [REV], and [NORM/REV] buttons 

Device control block (trackball, 
joystick)

The buttons to which the same functions as those of 
VTR/disk recorder/Extended VTR/frame memory 
clips play, cue, stop, and start tc buttons 

Device control block (search 
dial) 

[PLAY], [CUE], [STOP] and [START TC] buttons

Downstream key control block • [DSK1 ON] to [DSK4 ON] buttons a) 
• [TAKE] button a) 
• [MIX], [WIPE], [DME], and [CUT] buttons

Transition control block • [PTN LIMIT] button c) d) 
• [LIMIT SET] and [KF] buttons c) d) 
• [NORM], [NORM/REV], and [REV] buttons c) e)

• [MIX], [NAM], [SUPER MIX], [PST COLOR MIX], 
[WIPE], and [DME] buttons

• [MIX], [WIPE], and [DME] buttons d) 
• [ALL], [KEY PRIOR], [BKGD], and [KEY1] to  

[KEY4] buttons
• [CUT] button f)

Fade to black control block [FTB] button

Downstream key/fade to black 
control block

• [DSK1 ON] and [DSK2 ON] buttons
• [AUTO TRANS] button
• [FTB] button

Utility/shotbox control block Memory recall buttons

Menu control block [PREFS 1] to [PREFS 16] buttons 
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a) In the case of an event that inserts or deletes a key by an independent key transition, the key state 
at the time of event registration (inserted or not inserted) is also saved in the macro. When the 
macro is executed, the event is only replayed if the key state matches the saved state. (Example: 
For a macro with an event that deletes a key, when the macro is executed, if the key is inserted 
it is deleted, but otherwise nothing occurs as concerns keying.)

b) Cross-point buttons of the bus assigned by AUX delegation setting.
c) Macro attachment can be set with these buttons only when they are assigned to [Play/Stop/Cue] 

in the Engineering Setup >Panel >Config >Program Button >Transition Module menu and when 
the [DEV] button in the device control block is lit.

d) Buttons on the standard type module only.
e) Buttons on the standard type module and compact type module only.
f) Independent key transition control block (simple type only).
g) “KEYx” refers to any of KEY1 to KEY4 and DSK1 to DSK4, depending on the key assigned in 

setup.
h) When there are a number of control blocks on the control panel, and the keys assigned to them 

in setup are the same, then the macro attachment settings for the above buttons are the same.
The keys being the same includes cases such as “Key1,2”  assigned to PGM/PST being the same 
as “DSK1,2”, “Key1,2”  assigned to M/E-1 being the same as “M/E-1 Key1,2”, and so on.

i) Only when key row is operated in the utility/shotbox mode
j) When the auxiliary control mode is on

Notes
• After setting a macro attachment to a cross-point button in the auxiliary bus 

control block, if in the Setup menu you change the assignment of buses to the 
AUX delegation buttons, the macro attachment setting disappears.

• After setting a macro attachment to a button for which you can perform 
function replacement or function assignment, if you change the function 
assignment to the button, the macro attachment setting disappears.

• After setting a macro attachment to a cross-point button in the cross-point 
control block, if you change the function assignment to the button, the macro 
attachment setting disappears.

Enabling and disabling macro attachment
You can temporarily disable the macro attachment settings. When a macro 
attachment is disabled, pressing the button does not cause execution of the 
assigned macro.
You can enable and disable macro attachments for the PGM/PST bank and M/
E banks individually.

Setting a macro attachment to a fader lever
You can set a macro attachment to any particular position of a fader lever in the 
transition control block.

Independent key transition 
control block (simple type) h)

• [KEYx ON] button a) g)

• [TAKE] button a)

• [MIX], [WIPE], [DME], and [CUT] buttons

Multifunction Flexi Pad control 
block

• [AUTO TRANS], [KEY ON], [RUN], [REWIND], 
[NORM], [REV] and [NORM/REV] buttons

Block Button
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Notes
• In macro-only mode it is not possible to set a macro attachment.
• It is not possible to set a macro attachment to a fader lever in the keyframe 

control block or downstream key control block.
• For a split fader, you can set a macro attachment to the main split fader.

For details of a split fader, see “Split Fader” in Chapter 3 (Volume 1).

Clearing the macro attachments
You can clear all of the macro attachments in a single operation.

Displaying the macro attachment list
You can display the macro attachment settings in the form of a list in the menu 
display to check them.

Setting and Canceling a Macro Attachment

Setting a macro attachment to a button 
This section describes the example of setting a macro attachment for the 
background A row cross-points.

See “Setting a macro attachment to a button” (page 419) for the buttons for 
which a macro attachment can be set.

1 Recall the macro register you want to assign to the button.

For details of recall, see page 380.

2 To set in pre macro mode, hold down the [PRE MCRO] button in the cross-
point control block, and to set in post macro mode, hold down the [POST 
MCRO] button, and then press the desired button in the background A row.
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The cross-point button you pressed flashes amber, and the register you 

recalled in step 1 is assigned to the button.

If you make both pre macro and post macro settings for the same 
button
The later setting is valid.

To set a macro attachment without changing cross-points
When you set a macro attachment to a cross-point button, you can make the 
setting without changing the bus cross-points. Carry out this selection in the 
Engineering Setup >Panel >Operation menu. For details, see “Setting the 
Macro Execution Mode” in Chapter 19 (Volume 3). 

To make a macro attachment setting in macro only mode

Note
To carry out this operation, it is first necessary to assign the “Macro Only Set” 
function to the user preference buttons in the menu control block or the utility/
shotbox control operation. Carry out this assignment in the Eng Setup >Panel 
>Prefs/Utility menu. (For details, see “Setting Button Assignments (Prefs/
Utility Menu)” in Chapter 19 (Volume 3).)

To make a macro attachment in macro only mode, use the following procedure.

M/E
1

M/E
1

SHIFT

SHIFT
XPT

HOLD

XPT
HOLD

PRE
MCRO

KEY3

KEY4

POST
MCRO

XPT
HOLD

XPT
HOLD UTIL

M/E
1

M/E
1

M/E
2

M/E
2

M/E
2

M/E
2

M/E
3

M/E
3

M/E
3

M/E
3

SHIFT

SHIFT

SHIFT

MCRO
ATTCH
ENBL

PRE MCRO button

POST MCRO button

Background A row

Background B row MCRO ATTCH ENBL button
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1 Recall the macro register you want to assign to the button.

For details of recall, see page 380.

2 Press the button to which [MCRO ONLY SET] is assigned, turning it on.

3 Hold down the cross-point control block [PRE MCRO] button or [POST 
MCRO] button, and press the desired button in the background A row.

The cross-point button you pressed flashes green, and the register you 
recalled in step 1 is assigned to the button. The [MCRO ONLY SET] 
button goes off.
Without switching to macro only mode in step 2, if you hold down the 
[PRE MCRO] and [POST MCRO] buttons together and press the desired 
button, it is possible to set a macro attachment in macro only mode for that 
button. 

To check macro attachment settings
Hold down the [PRE MCRO] button or [POST MCRO] button. While it is held 
down, buttons for which macro attachments are set flash as follows.
While the [PRE MCRO] button is held down:

• Buttons set in pre macro mode: flash amber
• Buttons set in macro only mode: flash green

While the [POST MCRO] button is held down:
• Buttons set in post macro mode: flash amber
• Buttons set in macro only mode: flash green

Setting a macro attachment to a fader lever
You can set a macro attachment to any particular position of a fader lever in the 
transition control block.

Notes
• In macro only mode it is not possible to set a macro attachment.
• It is not possible to set a macro attachment to a fader lever in the keyframe 

control block or downstream key control block.
• For a split fader, you can set a macro attachment to the main split fader.

For details of split faders, see Chapter 3, “Split Fader” (Volume 1).

1 Recall the macro register that you want to assign to the fader lever.

For details of recall see page 380.

2 Move the fader lever to the position where you want to set the macro 
attachment.
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3 Hold down the [PRE MCRO] or [POST MCRO] button 1) in the cross-
point control block, and press the [LIMIT SET] or [PRIOR SET] button in 
the control block containing the fader lever operated in step 2.

1) Only when setting a macro attachment to the start point or end point of fader lever 
operation, use [PRE MCRO] and [POST MCRO] in distinction, as follows.
To set the operation start point (0%): hold down [PRE MCRO] for the operation.
To set the operation end point (100%): hold down [POST MCRO] for the operation.

This assigns the register recalled in step 1 to the fader lever position 
selected in step 2.

To check a macro attachment setting
Hold down the [PRE MCRO] or [POST MCRO] button in the cross-point 
control block. While it is held down, the fader lever position where the macro 
attachment is set appears in the following places.
• Transition indicator in the transition execution section: The indicator 

lights at the position where the macro attachment is set.
• Transition rate indication in the transition execution section: This shows 

the fader lever position where the macro attachment is set, as a percentage 
value. (Fader lever start position as 0%, end position 100%)

Removing macro attachment settings

To cancel a macro attachment to a button
Hold down the [PRE MCRO] button or [POST MCRO] button, and press a 
button that is flashing in the background A row. The button for which the 
macro attachment is set stops flashing and goes off, and this removes the 
setting.

To cancel a macro attachment to a fader lever
Hold down the [PRE MCRO] or [POST MCRO] button in the cross-point 
control block, and press the [LIMIT SET] or [PRIOR SET] button in the 
control block containing the fader lever having the macro attachment set.

To remove all macro attachment settings in a single operation
You can remove all macro attachment settings in a single operation. 

1 In the Macro menu, select VF2 ‘Attachment.’

2 Press [All Clear].

A confirmation message appears.

3 Select [Yes].

This deletes all macro attachment setting data.
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Displaying the Macro Attachment List

In the Macro >Attachment menu, you can display the macro attachment list to 
check the macro attachment settings.

The macro attachment list includes the following columns.
• Block: Shows the names of control panel blocks.
• Button: Shows the names of macro attachment assigned buttons (of up to 30 

characters).
• Reg: Shows the names of assigned registers.
• Name: Shows the names of macro registers.
• Mode: Shows the names of macro modes (Pre/Post/Only/--- 1)).
Above the list is shown the names of the block and macro attachment assigned 
button currently selected in the list.

1) When no macro mode is set

For details of the macro modes, see “Setting a macro attachment to a button” 
(page 419).

For details of the macro attachment list display, see “About the Macro 
Attachment List Display” in the Appendix (page 494).

Moving quickly within the macro attachment list from one block 
to another

When you are viewing the macro attachment settings for a block in the macro 
attachment list, you can move quickly from the current block to another block 
to check the settings for that block by pressing the following buttons in the 
<Block Select> group.
• P/P: Move to a block in the PGM/PST bank.
• M/E-1: Move to a block in the M/E-1 bank.
• M/E-2: Move to a block in the M/E-2 bank.
• M/E-3: Move to a block in the M/E-3 bank.
• Aux: Move to a section in the auxiliary bus control block.
• Others: Move to a block/section in a location other than the PGM/PST bank, 

M/E-1 to M/E-3 banks, and the auxiliary bus control block.

Scrolling the list
To scroll the macro attachment list, do one of the following.

• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.
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Executing a Macro by Macro Attachment

Note
For execution on any of the M/E and PGM/PST banks, use the [MCRO 
ATTCH ENBL] button in the cross-point control block. To execute a macro 
according to a macro attachment set elsewhere, assign “MCRO ATTCH 
ENBL” to a utility/shotbox control block or user preference button, then use 
that button.

Executing a macro assigned to a button

1 Depending on the location of the button you want to use, press the [MCRO 
ATTCH ENBL] button, turning it on.

2 Press the desired button for which a macro attachment has been set.

This recalls the macro register assigned to the button, and the macro is 
executed as follows, according to the operation mode.
Pre macro mode: The macro is executed first, and then the button 

function is executed.
Post macro mode: The button function is executed first, and then the 

macro is executed.
Macro only mode: The button function is not executed, and the macro 

only is executed.

During macro execution, the button you pressed flashes.

Notes
• It is not possible to execute more than one macro at a time. Therefore, even 

if you simultaneously press multiple buttons for which macro attachments 
are set, only one macro is executed.

• During macro execution, recalling the same register again stops the macro 
being executed. Therefore, pressing twice a button for which a macro 
attachment is set stops the macro being executed.

• Individual events stored in a macro are executed according to the settings in 
setup. If you change the settings in setup, a saved macro may not have the 
expected effect.

• During macro execution, if you switch the control panel to macro editing 
mode, the macro being executed stops.

Knob Parameter Adjustment Setting values

1 No Macro attachment settings scrolling 1 and upwards
427Macro Attachment Assigning



428

   C
hapter 16 

M
acros
• During macro editing, pressing a button for which a macro attachment is set 
does not execute the macro.

To disable macro attachment settings
Depending on the location of the button you want to disable, press the [MCRO 
ATTCH ENBL] button, turning it off.
In this state, pressing a button for which a macro attachment is set does not 
execute the macro.

Executing a macro assigned to a fader lever

1 In the cross-point control block for the fader lever on which you want to 
execute the macro, press the [MCRO ATTCH ENBL] button, turning it on.

2 Move the fader lever from the start position to the end position.

When the fader lever passes the position at which the macro attachment is 
set, the macro register is recalled, and the macro is executed.

Notes
• Unless you move the fader lever to the end position (completing the travel), 

it is not possible to execute the macro again.
• When the preset color mix stroke mode is Normal (see “Settings Relating to 

Video Switching (Transition Menu)” in Chapter 20 (Volume 3)), the first 
lever operation executes the macro, but the second lever operation does not.

• During macro execution, it is not possible to execute another macro.
• Individual events stored in a macro are executed according to the settings in 

setup. If you change the settings in setup, a saved macro may not have the 
expected effect.

• During macro execution, if you switch the control panel to macro editing 
mode, the macro being executed stops.

• During macro editing, even if you operate a fader lever with a macro 
attachment set, the macro is not executed.

To disable a macro attachment setting
In the cross-point control block for the fader lever on which you want to disable 
the macro, press the [MCRO ATTCH ENBL] button, turning it off.
In this state, operating a fader lever with a macro attachment set does not 
execute the macro.
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Menu Macros

The term “menu macro” refers to the function whereby a sequence of menu 
operations is saved as data in memory, so that it can be recalled as required to 
automatically execute the same sequence of operations.
Using any of the menus in the following table, you can edit menu macro 
registers and menu macro events.

Menu macro registers
The area of memory that holds a menu macro is termed a “menu macro 
register.” For each control panel there are 99 menu macro registers, numbered 
1 to 99. You can manipulate these in the menu macro register menu.

Menu macro events
The events that can be recorded in a menu macro are operations carried out in 
a menu.

For menu operations which are not recorded in menu macros, see “Menu 
Operations Not Recorded in a Menu Macro” (page 502).

Menu macro creation and editing
Carry out menu macro creation and editing in the menu.

Executing menu macros
You execute a menu macro after recalling a menu macro register.
You can recall and execute simultaneously. You can also recall and execute a 
menu macro from a macro recalled on the control panel.

Menu Function Operations

Menu Macro Register 
menu (menu macro 
register editing)

• Carry out menu macro register 
editing.

• Recall a menu macro register and 
execute a menu macro.

• Recalling a register 
and executing a 
menu macro

• Locking a register
• Copying a register
• Deleting a register
• Naming a register

Menu Macro Edit 
menu (editing of menu 
macro events)

Edit events in a menu macro 
register.

• Inserting an event
• Deleting an event
• Modifying an event
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Recalling a Menu Macro Register and Executing a Menu 
Macro

Menu macro operation is carried out by recalling a menu macro register.

Notes
• Menu macros and macros recalled with a control panel button operate 

independently. Therefore, to synchronize these, adjustment of the execution 
timing is required.

• Events saved in a menu macro are executed according to the settings in setup, 
and therefore if you change the setup settings, it may not be possible to replay 
an event. 

• When two menu macros are recalled successively, the later coming macro is 
ignored as far as the first macro is being executed.

Recalling a Menu Macro Register

1 In the Macro menu, select VF3 ‘Menu Macro Register’ and HF1 ‘Recall 
& Run.’

The Recall & Run menu appears.
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2 Using any of the following methods, select the register to be recalled.

• Press directly on the menu macro register list.
• Press the arrow keys on the right list to scroll the reverse video cursor.
• Turn the knob.

3 Press [Recall & Run x] or [Recall x ] (x is the number of the register 
selected in the menu macro register list).

• To execute the menu macro at the same time as recalling the register, 
press [Recall & Run x].

• To recall the register only, press [Recall x].

Register number and name

L/E indication: “L” indicates “the register is 
locked.” “E” indicates an empty register.

Selected event number / total number of events

Menu macro configuration list

Currently recalled 
register

Number of register selected on the menu 
macro register list

Knob Parameter Adjustment Setting values

1 Menu Macro 
Register

Register selection 1 to 99
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Executing a menu macro
In the Macro >Menu Macro Register >Recall & Run menu, check that you are 
not in macro editing mode, then use the following procedure.

1 Using any of the following methods, specify the event from which you 
want to execute.

• Press directly on the menu macro register configuration list.
• Press the arrow keys on the right list to scroll the reverse video cursor.
• Turn the knob.

2 Press [Run].

This executes the menu macro from the specified event.

To stop execution of a macro
Press [Stop].

To move to the start of a menu macro event
Press [Rewind].

Recalling a menu macro register from a macro register
Menu macro recall and execution operations can be saved as events in a control 
panel macro, and then recalled.
If with the control panel in macro editing mode you execute a menu macro, 
then this operation is recorded as an event.

For details of recording operations, use the following references, depending 
on the control panel or menu used.

• Using the numeric keypad control block and the keyframe control block: 
page 380

• Using the standard type Flexi Pad control block: page 390
• Using the simple type Flexi Pad control block: page 398
• Using the Multifunction Flexi Pad control block: page 438
• Using menus: page 413

Menu Macro Creation and Editing

Create or edit menu macro registers.

Knob Parameter Adjustment Setting values

3 No Select start event 1 and upwards
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Note
It is not possible to execute a menu macro during editing. To run the macro, 
first press the [Store] button to end editing. 

Creating a new menu macro

1 In the Macro >Menu Macro Register >Recall & Run menu, select an 
empty register in the menu macro register list.

For details of the method of operation, see “Recalling a Menu Macro 
Register” (page 430).

2 Press [Menu Macro Edit].

The menu macro register is recalled, and the system is now in menu macro 
editing mode.
The Menu Macro Edit menu appears.

3 If required, press [Auto Insert] to switch the auto insert mode on or off.

Menu macro register 
number Event numberMenu macro 

register name Remaining Memory

Menu macro creation event list

Menu macro register 
configuration list
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In the auto insert mode, when you carry out a menu operation, this is 
automatically recorded as an event in the menu macro.

4 Create an event (carry out the menu operation you want to record as an 
event in the menu macro).

For details of menus that can be recorded, see page 429.

• When auto insert mode (see page 381) is on, carrying out a menu 
operation automatically saves the event in a menu macro.

• When auto insert mode is off, skip to step 5.

5 When auto insert mode is off, press [Insert Before] or [Insert After] to save 
the event.

6 Repeat steps 4 and 5, to record the required events in the menu macro.

7 Press the [Store] button.

The numeric keypad window appears.

8 Enter the menu macro register number as required, and press [Enter].

The menu macro is saved with the specified number.
The menu returns to the state in step 1.

To set a pause duration
During menu macro editing, use the following procedure.

1 Enter the pause duration with the knob.

2 Press [Pause Set].

• When auto insert mode (see page 381) is on, this sets the pause duration, 
and inserts the pause event. 

• When auto insert mode is off, use the same operations as in step 5 of 
“Creating a new menu macro” (page 433) to save the event.

Editing a menu macro
To edit the content of a menu macro, use the following procedure.

Knob Parameter Adjustment Setting values

4 Pause Time (Sec) Pause duration 0.1 to 99.9 (sec)
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1 In the Macro >Menu Macro Register >Recall & Run menu, select the 
desired register on the menu macro register list.

For details of the menu macro register list, see “Recalling a Menu Macro 
Register” (page 430).

2 Press [Menu Macro Edit].

The Menu Macro Edit menu (see previous figure) appears. The menu 
macro register is recalled, and the system is now in menu macro editing 
mode.

3 Select the event you want to edit.

• Press directly on the menu macro register configuration list.
• Press the arrow keys on the right list to scroll the reverse video cursor.
• Turn the knob.

• To select all events, press [All Event Select].

4 If required, press [Auto Insert] to switch the auto insert mode on or off.

• When auto insert mode (see page 381) is on, a new menu is 
automatically inserted after the event selected in step 3.

• When auto insert mode is off, skip to step 5.

5 Carry out the editing, using any of the following methods.

• To delete the selected event, press the [Delete] button.
• To overwrite the selected event, carry out the new menu operation, then 

press the [Modify] button.
• To insert an event before the selected event, carry out the new menu 

operation, then press the [Insert Before].
• To insert an event after the selected event, carry out the new menu 

operation, then press the [Insert After].

6 With the same operation as steps 7 and 8 of “Creating a new menu macro,” 
save the register.

Exiting the Menu Macro Edit menu without saving the results of 
editing

In the Menu Macro Edit menu, press [Exit].

Knob Parameter Adjustment Setting values

1 No Event number 1 and upwards
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Scrolling event display using the menu macro listing

1 Move the cursor to the event you want to display.

2 Turn the knob.

About the menu macro editing mode display
If while in menu macro editing mode you switch to another menu, the display 
is as shown in the following figure.

Knob Parameter Adjustment Setting values

2 H Scroll Scroll the characters in the 
“Data” field.

1 and upwards
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Screen when the keyframe status is displayed

The keyframe status section appears as follows.
• Menu macro register number
• Menu macro register name
• Current event number / total number of events
• Remaining memory

The Previous page button shows one of the following:
• When [Auto Insert] is on, “Menu Macro Auto Insert” 

appears.
• When [Auto Insert] is off, “Menu Macro Insert After” 

appears, but operates as [Insert After].

Menu shortcut button to Menu Macro Edit menu
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Screen when the keyframe status is not displayed

Menu Macro Register Editing

You can display the current state of a menu macro register using the Menu 
Macro menu.
The items displayed are the same as under “Effect Status Display” (see page 
306), with the exception that the region name is not displayed.

In the Menu Macro menu, you can do the following editing operations on menu 
macro registers.
• Lock: Write-protect the contents of the menu macro register.
• Copy: Copy the contents of one menu macro register to another menu macro 

register.
• Delete: Delete the contents of a menu macro register.
• Name: Attach a name to a menu macro register.

The Previous page button shows one of 
the following:
• When [Auto Insert] is on, “Menu 

Macro Auto Insert” appears.
• When [Auto Insert] is off, “Menu 

Macro Insert After” appears, but 
operates as [Insert After].

The Default Recall button shows the 
following.

Menu shortcut button to Menu 
Macro Edit menu
Menu Macros



  C
hapter 16 

M
acros
The operations for menu macro register editing are the same as those for effect 
register editing (see page 306) except the region selection operation, which is 
not necessary for menu macro register editing.
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Macro Timeline

By recording macro recall and execute action on a timeline, in the same way as 
for key frames in an effect, you can automatically execute them in a sequence. 
This timeline is called a “macro timeline,” and one macro timeline can have up 
to 99 macros being executed simultaneously in parallel. 
There are 99 registers in the Macro region that can be recorded on the macro 
timeline, numbered 1 to 99. These registers are distinct from the registers 
where individual macros are stored.

Note
If you use a macro timeline to superimpose more than one macro, the macros 
may not be executed according to the timing information registered in the 
timeline.

Available key frame functions
The following lists the key frame functions that can be used on the macro 
timeline. 
• RECALL(1 to 99), STORE(1 to 99), RECALL UNDO, STORE UNDO, 

search for empty register, AUTO SAVE, RECALL MODE (RECALL, 
RECALL & REWIND)

• EDIT ENABLE, EDIT UNDO
• CONST DUR, EFF DUR, KF DUR, DELAY, PAUSE, INSERT BEFORE, 

INSERT AFTER, MODIFY, DELETE, COPY, PASTE BEFORE, PASTE 
AFTER, FROM TO, ALL

• PREV KF, NEXT KF, GOTO TC, GOTO KF, RUN, REWIND, FF, STOP 
NEXT KF, NORMAL, JOG, KF FADER

The following key frame functions cannot be used 
• KF LOOP, EFFECT LOOP, REVERSE, NORMAL/REVERSE
• PATH

Saving to a register
Set the recall and execute actions for the macros to be registered in the timeline, 
using the Macro Timeline menu. The setting data can be saved in a register as 
key frame data. You can manipulate this data by recalling the register in which 
it is saved, and using the key frame control block.

For details, see “Recalling a Menu Macro Register and Executing a Menu 
Macro” (page 430). 
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Note
An action set for a key frame is only executed when the key frame effect is 
executed in the forward direction. It is important to remember that the action is 
not executed in the reverse direction when executing simultaneously with  
switcher and DME key frame effects. 

Forcibly ending a macro timeline
• If the timeline has completed but a macro is still executing, press the  

[REWIND] or [RUN] button in the key frame control block to forcibly end 
the macro timeline. 

• In a macro timeline, since a take operation is not possible, if a macro included 
in the timeline has a pause event with a pause time of zero, the remainder of 
the timeline after the pause is ignored, and the macro timeline ends at that 
point. 

Register editing functions
You can use the following editing functions on a register in which a macro 
timeline is stored. 

• Copy
• Move
• Swap
• Merge
• Lock
• Name
• Delete

File-related functions
You can save and recall a created macro timeline as effect data, in the File 
menu. 

Timeline operations are carried out on a macro timeline in the same way as for 
normal effects. 

For details of timeline operations, see “Chapter 13 Keyframe Effects” (page 
231). 

Note
When using a macro timeline, note the following.
• To use a macro timeline, the Macro region must be assigned to a region 

selection button in the numeric keypad control block. For details of region 
assignment operations, see “Assigning a Region to a Region Selection Button 
in the Numeric Keypad Control Block” in Chapter 19 (Volume 3). 
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• On a macro timeline, only macro recall and execution actions are stored. The 
data for a macro to be recalled on the macro timeline is not held on the 
timeline. It is necessary to create the macro data first. 

• A macro timeline can be saved and recalled on the master timeline or a 
shotbox register, but cannot be saved as a snapshot. 

Creating and Editing a Macro Timeline

This section describes how to set actions, and add keyframe points. Note that 
path settings are not needed on the macro timeline.

For details of keyframe operations, see “Creating and Editing Keyframes” 
(page 269). 

Saving a keyframe
For the operations, use the Macro Timeline menu and the [INS] button in the 
keyframe control block. 

1 Press the [EDIT ENBL] button, turning it on. 

This enables timeline editing in the keyframe control block. 

2 In the Macro menu, select VF4 ‘Timeline’ and HF1 ‘Timeline.’

The Macro Timeline menu appears.

3 Select “Recall-1” that appears on the right. 

As required, turn the knob to select the number of the macro register. 

4 Press the [Set] button. 

“Recall-1” appears in the Action column on the left. 

5 Press the [INS] button in the keyframe control block. 

This creates the keyframe “Recall-1” on the macro timeline. 

To set the action for a rewind operation
On the macro timeline, when the [REWIND] button in the keyframe control 
block is pressed the action set for the first keyframe is not executed; when the 
[RUN] button is pressed, then the first keyframe action is executed.
To execute an action when the [REWIND] button is pressed, it is necessary to 
set this action (Rewind Action). To carry out this setting, in the Macro 

Knob Parameter Adjustment Setting values

3 Recall No Selection of macro register 1 to 99
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>Timeline >Timeline menu, press [Rewind Action] to recall the Rewind 
Action menu. In this setting screen, use the same setting method as in the 
screen for setting an action on the macro timeline.

Alternatively, you can select the reverse arrangement, whereby when the
[REWIND] button is pressed, this executes the action set for the first keyframe, 
and when the [RUN] button is pressed the first keyframe action is not executed. 
In this case, the Rewind Action setting is still valid.

For details of the setting, see “Setting the First Keyframe When a Rewind is 
Executed” in Chapter 19 (Volume 3).
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Overview of File Operations

You can save register data, including setup information and snapshot 
information, as a file on a hard disk or memory card, and recall it as required.
You can operate on individual files or registers, or together in a batch.
Regarding frame memory, it is possible to capture image data stored in an 
external device into frame memory. You can also convert the format of image 
data in frame memory into a different format and save it in an external device.

Files that can be manipulated
The following files can be saved and recalled.
• Operation mode setup data for system as a whole and individual devices
• Device status data for system startup
• Key memory setting data
• Video process memory setting data
• Keyframe effect setting data
• Snapshot setting data
• Wipe snapshot setting data
• DME wipe snapshot setting data
• Key snapshot setting data
• Shotbox setting data
• Macro setting data
• Macro attachment data
• Menu macro setting data
• Frame memory image data

File operations
You can carry out the following file operations.

When operating on individual files or registers
Save: Save the data in a register to the hard disk or memory card.
Load: Load a file from the hard disk or memory card.
Copy: Copy a file within a directory or from one directory to another. When a 

remote panel is used, this function applies to it, too.
Rename: Rename a file on the hard disk or memory card.
Delete: Delete a file from the hard disk or memory card.

When operating on files or registers in a batch
The Save, Load, Copy and Delete operations are performable.
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Notes on transferring multiple frame memory files together to a 
memory card
• Transferring all of the files within frame memory together fails if the 

capacity of the memory card is too small to hold all of the images. In this 
case, replace with a larger capacity memory card, or delete files until saving 
is possible.
The following table roughly shows the relation between memory card 
capacity and number of files that can be saved.

Note that when transferring to the hard disk, there is ample capacity, so that 
problems such as this do not occur.

• If you cancel the operation during a data transfer between frame memory and 
hard disk or memory card, then an image which was not completely 
transferred will not be reproducible. Avoid canceling such operations.

• When loading a file from hard disk or memory card, if [Freeze Enable] in the 
Freeze menu is on, the loaded file may sometimes be overwritten by the 
frame memory input image.
To avoid this when loading a file, ensure that [Freeze Enable] is turned off.

Importing or exporting files to or from frame memory
Import: Import a file in a different format from hard disk or memory card into 

frame memory after changing its format.
Export: Export a file in a register to hard disk or memory card after changing 

its format.

You can import TIFF, BMP, and TARGA files as follows into frame memory. 

a) Windows is a registered trademark or trademark of Microsoft Corporation in the United States 
and/or other countries.

Memory card capacity Number of files that can be saved

SD system HD system

256 MB 214 46

File type Format File name Notes

TIFF file RGB 
uncompressed 
format

Maximum eight 
characters, plus 
extension .tif required

• Layers cannot be used.
• If an alpha channel is 

present, two files are 
created as a pair.

BMP file Windows a) 24-
bit format

Maximum eight 
characters, plus 
extension .bmp required

–

TARGA file RGB 
uncompressed/
compressed 
format

Maximum eight 
characters, plus 
extension .tga required

• Layers cannot be used.
• If an alpha channel is 

present, two files are 
created as a pair.
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Note
This functionality has been tested and confirmed to work with TIFF files 
created by Photoshop, but it may not be possible to use TIFF files created
with some other software. (Photoshop is a trademark of Adobe Systems 
Incorporated.)

About import image size
Pay attention to the following, depending on the signal format which you use.

SDTV (480i)
Images 720 × 487 pixels in size are exactly the size which fills the full screen.
The following figure shows how an import image is processed when the 480i/
59.94 format is used.
Images are placed with the upper left of the screen as the origin.
When an image is smaller than the screen, the remainder of the screen is filled 
with black. When it is larger, parts which extend beyond the screen are 
discarded.

No pixel ratio conversion is performed when images are imported for the 
SDTV format. 
When the signal format is 480i/59.94, if you create an image with a size of 720 
× 540 on a computer and then import it just as it is, the image will be too tall. 
To maintain the shape of the image, first create it as a 720 × 540 image and then 
use computer software tools to compress the vertical dimension to 487 pixels 
before importing it.

720 pixels

487 pixels

Position of small picture

Section filled with black for 
a small picture

Parts discarded when 
image is too large
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HDTV (1080i)
Images of 1920 × 1080 pixels in size are exactly the size which fills the full 
screen.
Like SDTV, images are placed with the upper left of the screen as the origin.
When an image is smaller or larger than the screen, processing is the same as 
for SDTV.
Since the pixel ratio of the HDTV format is 1:1, files created on computers are 
imported in their original shapes.

The following table shows the image sizes which exactly fill the full screen for 
the various signal formats.

Importing 720P movie material
To import movie material in 720P format, it is necessary to treat each frame as 
a separate image file. 

Directory operations
You can create a new directory within a hard disk or memory card, and carry 
out other operations, such as renaming and deleting.

For details of operations, see “Directory Operations” (page 468).

File copying between different unit IDs
Switcher and DME files within the hard disk or memory card are managed by 
unit ID.
To copy files between different unit IDs, use the Unit ID Copy menu.

For details of operations, see “Copying Files Between Different Unit IDs” 
(page 470).

 Saving data recalled by autoload
At power on, you can automatically recall data previously stored on the hard 
disk. (Autoload function)

Signal format Image size (H × V)

480i/59.94 720 × 487

576i/50 720 × 576

1080i/50 1920 × 1080

1080i/59.94

720P/50 1280 × 720

720P/59.94
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The following data can be loaded by the autoload function.
• Keyframe effect setting data
• Snapshot setting data
• Wipe snapshot setting data
• DME wipe snapshot setting data
• Key snapshot setting data
• Shotbox setting data
• Macro setting data
• Macro attachment data
• Frame memory image data

To use the autoload function, the data required must first be saved.

For the on/off setting of the autoload function, see “Selecting the State After 
Powering On (Start Up Menu)” in Chapter 18 (Volume 3).

For details of saving operations, see “Saving Files Recalled by Autoload” 
(page 472).
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Operations on Individual Files

You can save or load the contents of an individual file or register. Carry out 
these operations in the File menu.

Displaying the Individual File Operation Menus

1 In the menu control block, press the top menu selection button [FILE].

2 Depending on the type of file to be manipulated, select the following ‘VF’ 
and ‘HF’ combination.

The following description refers to the example of carrying out operations on 
snapshot files, but the procedure is similar in the other menus.

Viewing Detailed File Information

As an example, to view detailed snapshot file information, carry out the 
following procedure.

1 In the File menu, select VF3 ‘Snapshot’ and HF1 ‘Snapshot.’

The Snapshot menu appears.
The status area shows the device status, and a list of files present on the 
device.

Button HF1 HF2 HF3 HF4

VF1 Setup Initial Status Key Memory Video Proc 
Memory

VF2 Effect 1-99 Effect 101-199 Effect 201-299 Effect 301-399

VF3 Snapshot Wipe Snapshot DME Snapshot Key Snapshot

VF4 Shotbox Macro Macro 
Attachment

–

VF5 Frame Memory – – –
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2 Press [File Edit].

The file details appear (reference region file name, creation date, regions 
including data) in table form.

File Edit buttons

Device selection area

Detail display area

Region selection area
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Selecting a particular file displays more detailed information about that file 
in the detail display area at the top right of the file list.
In the Frame Memory menu, the following items are also shown.
Pair: In the case of a pair file, “P” is shown.
Ext: In the case of an extended clip file, “Ext” is shown.

Selecting Regions

You can carry out a file operation on a number of regions simultaneously. 
However, a region selection is not required for the following files.
• Key memory
• Video process memory
• Shotbox
• Macro
• Macro attachment
• Frame memory
• Setup
• Initial status

In the above list, for frame memory in Dual Simul mode you can select the 
switcher to be used for the operation in a way similar to the region selection. 
For setup and initial status, you can similarly separate the files to be operated 
on by device.

To make a region selection

1 Press the region selection area at the top right of the screen (see page 452).

The region selection window appears.

2 Press the region names you do not want to select, turning them off.

3 Press [OK].

Selecting a Device for Operations

To carry out file operations, you need to specify the device holding the data (or 
file), as one of the following: register, hard disk, memory card, and so on. You 
can then further select a directory.
453Operations on Individual Files



   C
hapter 17 

F
iles

454
Notes
• Files saved on the hard disk may be lost if the hard disk fails. Always keep 

separate backup copies of important files on a memory card.
• Format a memory card before using it for the first time.

For details on formatting a memory card, see “Using a Memory Card” in 
Chapter 18 (Volume 3).

As an example, to select a memory card, use the following procedure.

1 In the File menu, press the device selection indication above the file list 
(default is [HDD] (hard disk)).
(If [Memory Card] appears, then since the memory card is already 
selected, steps 1 and 2 are not necessary.)

A pull-down menu appears.

2 Press [Memory Card].

A list of directories on the memory card appears. (Maximum 40 per page)

The maximum number of directories is 120 on a memory card, or 200 on 
an internal hard disk. 

3 As required, press the b or B button, to switch directory pages. 

4 Press the name of the directory you want to use.

This selects the specified directory on the memory card to be manipulated.

Saving Files

As an example, to save snapshot register data to hard disk or memory card, use 
the following procedure.

1 In the File menu, select VF3 ‘Snapshot’ and HF1 ‘Snapshot.’

2 In the device selection area on the left, select [Register].

3 In the device selection area on the right, select [HDD] or [Memory Card], 
then select a directory.

See “Selecting a Device for Operations” (page 453).

4 Using either of the following methods, select the data to be saved, and the 
file in which to save it.
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• To select all files within the list, press [ALL] below the list.
• To select multiple files, turn the knobs to select in the following ranges.

• To select a single file, press the arrow keys to scroll the reverse video 
cursor, or press directly on the list in the status area.

5 Press [t Save].

This saves the selected register data in the specified location.
If there is already data in the specified location, a confirmation message 
appears.
• Select “Yes” to overwrite the data.
• Select “No” to cancel saving all of the data.

Saving frame memory files
Between steps 3 and 4 of the procedure above, “Saving Files,” do as follows.

1 To select the frame memory folder, press [Default] in the device selection 
in the list on the left.

A pull-down menu appears.

2 Press the required folder name.

3 Carry out the same operations as in steps 1 and 2 on the list on the right.

4 Select the type of data to be displayed.

• To display still image files, press [Still].
• To display clip files, press [Clip].

Loading Files

As an example, to load a snapshot file from hard disk or memory card to a 
register, use the following procedure.

1 In the File menu, select VF3 ‘Snapshot’ and HF1 ‘Snapshot.’

Knob Parameter Adjustment Setting values

1 List L Select the first register whose data is to 
be saved

1 to 99

2 List R Select the first file to which data is to be 
saved

1 to 99

3 Num Number of registers to be selected 1 to 99
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2 In the device selection area on the left, select [Register].

3 In the device selection area on the right, select where the file is held 
([HDD] or [Memory Card]), and then specify a directory.

See “Selecting a Device for Operations” (page 453).

4 Using any of the following methods, select the register to which you want 
to load, and the file to be loaded.

• To select all files within the list, press [ALL] below the list.
• To select multiple files, turn the knobs to select in the following ranges.

• To select a single file, press the arrow keys to scroll the reverse video 
cursor, or press directly on the list in the status area.

5 Press [T Load].

This loads the contents of the selected file from the specified location. 
(Setup data is first loaded.)

Loading frame memory files
Between steps 3 and 4 of the procedure above, “Loading Files,” do as follows.

1 To select the frame memory folder, press [Default] in the device selection 
in the list on the left.

A pull-down menu appears.

2 Press the required folder name.

3 Carry out the same operations as in steps 1 and 2 on the list on the right.

4 Select the type of data to be displayed.

• To display still image files, press [Still].
• To display clip files, press [Clip].

Knob Parameter Adjustment Setting values

1 List L Select the first register into which the data 
is to be loaded

1 to 99

2 List R Select the first file in which data is held 1 to 99

3 Num Number to be selected 1 to 99
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Copying Files

You can copy files either within a directory or between directories, on the hard 
disk, or memory card.
As an example, to copy a snapshot file from memory card to hard disk, use the 
following procedure.

1 In the File menu, select VF3 ‘Snapshot’ and HF1 ‘Snapshot.’

2 In the device selection area on the left, specify the location of the file to be 
copied (in this case [Memory Card] and a directory). (See page 453.)

3 In the device selection area on the right, select the destination of the copied 
file (in this case [HDD] and a directory).

4 Using any of the following methods, select the source and destination files.

• To select all files within the list, press [ALL] below the list.
• To select multiple files, turn the knobs to select in the following ranges.

• To select a single file, press the arrow keys to scroll the reverse video 
cursor, or press directly on the list in the status area.

5 Press [t Copy].

This copies the selected file or files to the specified destination.
If there is already data in the specified location, a confirmation message 
appears.
• Select “Yes” to overwrite the data.
• Select “No” to cancel copying all of the files.

Copying frame memory files
Between steps 3 and 4 of the procedure above, “Copying Files,” do as follows.

1 To select the frame memory folder, press [Default] in the device selection 
in the list on the left.

A pull-down menu appears.

2 Press the required folder name.

Knob Parameter Adjustment Setting values

1 List L Select the first copy source file 1 to 99

2 List R Select the first destination file 1 to 99

3 Num Number to be selected 1 to 99
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3 Carry out the same operations as in steps 1 and 2 on the list on the right.

4 Select the type of data to be displayed.

• To display still image files, press [Still].
• To display clip files, press [Clip].

Renaming Files

You can rename a file on the hard disk or memory card and a register. As an 
example, to rename a snapshot file, use the following procedure.

1 In the File menu, select VF3 ‘Snapshot’ and HF1 ‘Snapshot.’

The Snapshot menu appears. The status area shows the device status, and 
a list of files present on the device.

2 Press [File Edit].

A detailed list appears. Here too, you can select a device or specify a 
directory. (See page 453.)

3 Using any of the following methods, select the file you want to rename.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

4 Press [Rename].

The keyboard window appears. (See “Menu Operations” in Chapter 2 
(Volume 1).)

5 Enter a name of not more than eight characters, and press [Enter].

The name you have entered is reflected in the status area.

Notes
• Within the switcher, the names for Initial Status and Setup data are fixed. 

You can change the file names on the hard disk or memory card, but the next 
time they are reloaded they will revert to the default names.

• The following names cannot be used. 

Knob Parameter Adjustment Setting values

1 List File selection 1 to 99
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CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9, LPT0, LPT1, LPT2, 
LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9

Renaming frame memory files

1 In the File menu, select VF5 ‘Frame Mem’ and HF1 ‘Frame Memory.’

The Frame Memory menu appears. The status area shows the device 
status, and a list of files present on the device.

2 Press [File Edit].

3 Select the type of data to be displayed.

• To display still image files, press [Still].
• To display clip files, press [Clip].

4 Using any of the following methods, select the file you want to rename.
(When you selected [Clip] in step 3, you cannot select multiple files.)

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

5 Press [Rename].

The keyboard window appears.

6 Depending on the selections of steps 3 and 4, enter a name as follows and 
press [Enter].

• When you selected a single file with [Still]: Enter a name of not more 
than eight characters.

• When you selected more than one file with [Still]: Enter a name of not 
more than four characters.

• When you selected a clip file: Enter a name of not more than four 
characters.

The name you have entered is reflected in the status area.

Knob Parameter Adjustment Setting values

1 List L File selection in the left list 1 and upwards

2 List R File selection in the right 
list

1 and upwards

3 Num Number to be selected 1 and upwards
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Note
If you select [Register] in the operation device selection block, then with [Still] 
select multiple files and change a file name, these still images are converted to 
a clip.

Deleting Files

You can delete data from the hard disk or memory card and snapshot or effect 
data from a register. As an example, to delete a snapshot file, use the following 
procedure.

1 In the File menu, select VF3 ‘Snapshot’ and HF1 ‘Snapshot.’

The Snapshot menu appears. The status area shows the device status, and 
a list of files present on the device.

2 Press [File Edit].

A detailed list appears. Here too, you can select a device or specify a 
directory. (See page 453.)

3 Using any of the following methods, select the file you want to delete.

• To select all files within the list, press [All] below the list.
• To select multiple files, turn the knobs to select in the following ranges.

• To select a single file, press the arrow keys to scroll the reverse video 
cursor, or press directly on the list in the status area.

4 Press [Delete].

A confirmation message appears.
• Select “Yes” to delete.
• Select “No” to cancel the deletion.

Deleting frame memory files
Between steps 2 and 3 of the procedure above, “Deleting Files,” do as follows.

1 To select the frame memory folder, press [Default] in the device selection 
in the list.

Knob Parameter Adjustment Setting values

1 List Select the first file 1 to 99

3 Num Number to be selected 1 to 99
Operations on Individual Files



  C
hapter 17 

F
iles
A pull-down menu appears.

2 Press the required folder name.

3 Select the type of data to be displayed.

• To display still image files, press [Still].
• To display clip files, press [Clip].

Creating a frame memory folder on the device (HDD or Memory 
Card)

1 In the File menu, press VF5 ‘Frame Mem’ and HF2 ‘Frame Memory 
Folder.’

The Frame Memory Folder menu appears. The status area shows the 
device status, and a list of files present on the device.

2 In the pull-down menu of the device selection section, select [HDD] or 
[Memory Card], and then specify the directory.

3 Press [New].

A keyboard window appears. (See the section “Menu Operations” in 
Chapter 2 (Volume 1).)

4 Enter a name of up to eight characters, and press [Enter].

The name entered appears in the status area as a frame memory folder.

Notes
• The following names cannot be used.

Default, Flash1, Flash2
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9, LPT0, LPT1, LPT2, 
LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9

• It is not possible to create 12 or more directories in the frame memory folder.

To rename a frame memory folder

1 Using any of the following methods, select the folder.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.
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2 Press [Rename].

A keyboard window appears. (See the section “Menu Operations” in 
Chapter 2 (Volume 1).)

3 Enter a name of up to eight characters, and press [Enter].

The name entered appears in the status area as a frame memory folder.

To delete a frame memory folder

1 With the same operations as in step 1 of the procedure “To rename a frame 
memory folder,” select the folder.

2 Press [Delete].

A confirmation message appears; select “Yes” to carry out the deletion.

Knob Parameter Adjustment Setting values

1 List L Folder selection 1 and upwards
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File Batch Operations

You can batch process all files or registers. Carry out these operations using the 
File>All, External File>All menu.

Displaying the Batch Operation Menu

1 Press the top menu selection button [FILE].

2 Select VF6 ‘All, External File’ and HF1 ‘All.’

The All menu appears.

Batch Saving Files

To save the data of all registers to hard disk or memory card, use the following 
procedure.

Notes
• Files saved on the hard disk may be lost if the hard disk fails. Always keep 

separate backup copies of important files on a memory card.
• Format a memory card before using it for the first time.

For details on formatting a memory card, see “Using a Memory Card” in 
Chapter 18 (Volume 3).

1 In the device selection area of the All menu, select the destination for 
saving the files ([HDD] or [Memory Card] and directory). (See page 453.)

2 If there are registers you do not want to save, in the <Category> group, 
exclude them from the operation. To select all registers, press [All Select].

For details of the data to which operations apply, see “Files that can be 
manipulated” (page 446).

Note
The frame memory is not selected when you press [All Select]. To apply 
the setting to frame memory, press [Frame Memory], turning it on. When 
frame memory is selected, it is not possible to apply settings to the 
<Category> group data.
463File Batch Operations



   C
hapter 17 

F
iles

464
3 Press [t Save].

A confirmation message appears.
• Select “Yes” to carry out the batch save.
• Select “No” to cancel the batch save.

Batch Loading Files

To load files from hard disk or memory card, use the following procedure.

1 In the device selection area of the All menu, select where the files are held 
([HDD] or [Memory Card] and directory). (See page 453.)

2 If there are files you do not want to load, in the <Category> group, exclude 
them from the operation. To select all files, press [All Select].

For details of the data to which operations apply, see “Files that can be 
manipulated” (page 446).

Note
The frame memory is not selected when you press [All Select]. To apply 
the setting to frame memory, press [Frame Memory], turning it on. When 
frame memory is selected, it is not possible to apply settings to the 
<Category> group data.

3 Press [T Load].

A confirmation message appears.
• Select “Yes” to carry out the batch load. (Setup data is first loaded.)
• Select “No” to cancel the batch load.

To execute the load after clearing the data in the destination 
regions
Before pressing [T Load], press [CLR Before Load], turning it on.
The following categories of data can be cleared before execution of the load.

Effect, Snapshot, Wipe Snapshot, DME Wipe Snapshot, Key Snapshot, 
Shotbox, and Macro

Note
When frame memory is selected for the setting, the data is always deleted 
before recalling.
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Batch Copying Files

To copy files between the hard disk and a memory card, use the following 
procedure.

1 In the operating device selection section to the left of the All menu, select 
the storage location ([HDD] or [Memory Card] and directory) of the 
source files (see page 453).

2 In the operating device selection section to the right of the All menu, select 
the destination storage location ([HDD] or [Memory Card] and directory) 
(see page 453).

3 If there are files you do not want to copy, remove them from the selection 
in the <Category> group. To select all files, press [All Select].

For details of the data to which the operation applies, see “Files that can 
be manipulated” (page 446).

Note
The frame memory is not selected when you press [All Select]. To apply 
the setting to frame memory, press [Frame Memory], turning it on. When 
frame memory is selected, it is not possible to apply settings to the 
<Category> group data.

4 Press [t Copy].

This copies the selected files to the specified destination.
If there is already data present in the destination location, a confirmation 
message appears.
• Select “Yes” to overwrite.
• Select “No” to cancel copying all of the files.
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Importing and Exporting Files

You can import or export frame memory image data from or to external media.
Import: to transfer a file in a different format from hard disk or memory card 

to frame memory as image data.
Export: to change the file format of register data and save the data on hard disk 

or memory card.
To carry out these operations, use the File >All,External File >Import/Export 
menu.

For details of the formats supported for import and export, see “Importing or 
exporting files to or from frame memory” (page 447).

Displaying the Import/Export Menu

In the File menu, select VF6 ‘All, External File’ and HF2 ‘Import/Export.’
The list on the left shows the frame memory registers, and the list on the right 
shows the content of the external recording media.

Importing Frame Memory Data

As an example, to import data in a bitmap format from a memory card to a 
frame memory register, use the following procedure.

About the points you should take note of when importing data, see “About 
import image size” (page 448).

Note
The imported file is created in the “Default” folder.

1 In the Import/Export menu, press the device selection area on the left to 
select [Frame Memory (.BMP)].

2 Press the device selection area on the right to select [Memory Card]. 
It is not possible to select a directory.

3 Using any of the following methods, select the register into which the data 
is to be imported and the file.

• Press directly on the list in the status area.
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• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

4 Press [T Import].

This transfers the external file to the frame memory register.

Exporting Frame Memory Data

As an example, to save image data from frame memory in a bitmap format on 
a memory card, use the following procedure.

1 In the Import/Export menu, press the device selection area on the left to 
select [Frame Memory (.BMP)].

2 Press the device selection area on the right to select [Memory Card]. 
It is not possible to select a directory.

3 Using any of the following methods, select the data you want to export 
from the list on the left.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

4 Press [t Export].

This adds the image data from the frame memory in a bitmap format on the 
memory card.
Executing export creates a file in the MVS_EXP directory immediately 
under root directory. If the directory does not exist, it is automatically 
created.
If the specified destination file name already exists, an overwriting 
confirmation message appears.
• Select “Yes” to overwrite the data.
• Select “No” to cancel the whole file export operation.

Knob Parameter Adjustment Setting values

1 List L Register selection 1 and upwards

2 List R File selection 1 and upwards

Knob Parameter Adjustment Setting values

1 List L Register selection 1 and upwards

2 List R File selection 1 and upwards
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468
Directory Operations

You can create a new directory on hard disk or memory card, rename, or delete 
a directory.
To carry out these operations, use the File >Configure >Directory menu.

Displaying the Directory Menu

In the File menu, select VF7 ‘Configure’ and HF1 ‘Directory.’
The Directory menu appears.

Creating a New Directory

You can create a maximum of 120 directories on a memory card, or 200 on an 
internal hard disk. 

1 In the device selection pull-down menu, select [HDD] or [Memory Card]. 
(See page 453.)

2 Press [New].

The keyboard window appears. (See “Menu Operations” in Chapter 2 
(Volume 1).)

3 Enter a name of not more than eight characters, and press [Enter].

A new directory with the name you have entered appears in the status area.

Note
The following names cannot be used for directories:

CON, PRN, AUX, CLOCK$, and NUL
COM0, COM1, COM2, COM3, COM4, COM5, COM6, COM7, 
COM8, and COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, and 
LPT9
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Renaming a Directory

1 In the device selection pull-down menu, select [HDD] or [Memory Card]. 
(See page 453.)

2 Using any of the following methods, select the directory.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

3 Press [Rename].

The keyboard window appears. (See “Menu Operations” in Chapter 2 
(Volume 1).)

4 Enter a new name of not more than eight characters, and press [Enter].

The new name appears in the status area.

Deleting a Directory

1 In the device selection pull-down menu, select [HDD] or [Memory Card]. 
(See page 453.)

2 Using any of the following methods, select the directory.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob.

3 Press [Delete].

A confirmation message appears.
• Select “Yes” to delete the directory.
• Select “No” to cancel the deletion.

Knob Parameter Adjustment Setting values

1 List Directory selection 1 and upwards

Knob Parameter Adjustment Setting values

1 List Directory selection 1 and upwards
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Copying Files Between Different Unit IDs

Switcher and DME files on the hard disk or a memory card are handled 
separately for each unit ID.
With the normal file copy operation, it is not possible to copy files between 
different unit IDs. To copy files between different unit IDs, use the following 
procedure.

For details of unit IDs, see “Setup for the Whole System” in Chapter 18 
(Volume 3).

Displaying the Unit ID Copy menu
In the File menu, select VF7 ‘Configure’ and HF2 ‘Unit ID Copy.’
The Unit ID Copy menu appears.

Copying files between different unit IDs
To copy files between different unit IDs, grouped by category, use the 
following procedure.

1 In the Unit ID Copy menu, press the category selection section at the top 
right of the screen.

2 Press the categories you do not want to select, turning them off.

3 Press [OK].

4 In the operating device selection section on the left list, select the storage 
location of the source files, and in the operating device selection section on 
the right list, specify the destination storage location (see “Selecting a 
Device for Operations” (page 453)).

5 Using either of the following methods, select the copy source and copy 
destination unit IDs.

• Press directly on the list for the copy source on the left of the status area, 
and on the right for the copy destination.

• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

Knob Parameter Adjustment Setting values

1 List L Selection of copy source unit ID 1 to 4

2 List R Selection of copy desitination unit ID 1 to 4
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6 Press [tCopy].

A confirmation message appears.
• Select “Yes” to carry out the copy to the specified destination of the 

selected file categories.
• Select “No” to cancel the copy.

Note
If there is already data present in the copy destination, note that this will 
overwrite all of the data.
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472
Saving Files Recalled by Autoload

If you save effect setting data, frame memory image files and so on in the 
PWON_LD directory on the hard disk, then when the system is powered on this 
data is recalled automatically. This is known as the autoload function.
To save the data to be recalled by the autoload function, use the menu for 
operations on individual files.

For the data recalled by the autoload function, see “Saving data recalled by 
autoload” (page 449).

For the setting enabling or disabling the autoload function, see “Setting 
Automatic Loading of Register Data at Power On (Autoload Function)” in 
Chapter 18 (Volume 3).

For example, to save snapshot data, use the following procedure.

1 In the File menu, select VF3 ‘Snapshot’ and HF1 ‘Snapshot.’

The Snapshot menu appears.

2 In the device selection area on the left, select [Register].

3 In the device selection area on the right, select [HDD].

Be sure to select [HDD] as the saving destination.

4 Select the PWON_LD directory.

The PWON_LD directory is automatically created when [Power On File 
Load] is set to On in the System >Start Up menu. If set to Off, the directory 
does not appear.

5 Using any of the following methods, select the data to be saved, and the 
file in which to save it.

• To select all files within the list, press [ALL] below the list.
• To select multiple files, turn the knobs to select in the following ranges.

Knob Parameter Adjustment Setting values

1 List L Select the first register whose data 
is to be saved

1 to 99

2 List R Select the first file to which data is to 
be saved

1 to 99

3 Num Number of registers to be selected 1 to 99
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• To select a single file, press the arrow keys to scroll the reverse video 
cursor, or directly press on the list in the status area.

6 Press [tSave].

The data from the selected registers is saved in the specified destination.
If the specified destination already contains data, a confirmation message 
appears.
• Select “Yes” to overwrite the existing data.
• Select “No” to cancel the entire saving operation.
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SpotLighting

Texture Patterns

Material provided by Digital Archive Japan, INC
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Shape Patterns

1 2
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Functional Differences With Models of DME

Function Menu 
number

MVE-8000A MKS-6470 MVE-9000 See

Selection of signal 
to insert in the 
border

4111 Flat Color only Flat Color only Flat Color
Ext Video
Mix Color

page 56

Key Border 4113 No No Cannot be turned 
on when Glow is 
on.

page 61

Art Edge 4114 No No Yes page 62

Flex Shadow 4115 No No Yes page 70

Wipe Crop 4116 No No Yes page 78

Color Mix 4117 No No Yes page 82

Defocus/Blur 4121 Cannot be 
turned on 
when Glow is 
on.

Cannot be 
turned on 
when Glow is 
on.

Yes page 84

Mask 4127 Yes b) Yes a) Yes page 100

Wave 4141.1 Yes No Yes page 105

Adjustment of 
entire image 
brightness in 
Lighting/
Spotlighting 
(parameter Total 
Ambient)

4151
4156

No No Yes page 134
page 155

Setting the bar 
mode of the 
highlight area

4151 No No Yes page 137

Adjustment of 
color of the diffuse 
light area 
(parameter Bar 
Diffuse Color)

4151 No No Yes page 137

Selection of signal 
to insert in the trail 
afterimage portion

4152 Freeze Video 
Flat Color 
Hue Rotate

Freeze Video 
Flat Color 
Hue Rotate

Without limitation page 139

Combine process 
for Trail

4152 No No Yes page 141

Defocus function 
for Trail

4152 No No Yes page 141
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Combine process 
for Keyframe 
Strobe

4154 No No Yes page 146

Wind 4155 No No Yes page 146

Spotlighting 4156 No No Yes page 148

Selection of signal 
to insert in the 
background

4161 Flat Color only Flat Color only Flat Color
Ext Video
Mix Color

page 166

Key source 
selection

4162 Ext Key b)

Int Key
Lum Key b)

Int Key Ext Key b)

Int Key
Lum Key b)

page 170

Shaped Video 4162 Yes only 
when SDI 
interface is 
used

No Yes only when 
SDI interface is 
used

page 167

Interpolation 
settings

4163 Yes only for 
SD

Yes only for 
SD 

Yes both for SD 
and HD

page 171

Anti-moire filter 4163 Yes only for 
HD

Yes only for 
HD

No page 173

Flex shadow axis 
settings

4164 No No Yes page 37

Outputting 
graphics to the 
monitor

4164 Yes only 
when SDI 
interface is 
used

Yes only when 
SDI interface is 
used

Yes page 37

Dim and Fade 4173 No No Yes page 97

Glow 4174 Cannot be 
turned on 
when 
Defocus/Blur 
is on.

Cannot be 
turned on 
when Defocus/
Blur is on.

Cannot be turned 
on when Key 
Border is on.

page 99

Combiner depth 
settings (three-
dimensional 
crossing function) 
(parameter Depth)

4211 No No Yes

Brick 4212 Yes No Yes page 185

Adding user 
texture patterns 
(for Spotlighting)

7316.9 No No Yes “Adding User 
Texture Patterns” 
in Chapter 18 
(Volume 3)

Function Menu 
number

MVE-8000A MKS-6470 MVE-9000 See
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480
a) Drop shadow is automatically set to off when the function of trail, motion decay, keyframe 
strobe or window is on.

b) Effect groups 1 and 2 cannot be selected at the same time. Pattern 304 (round corner) is not 
supported.

c) When Shaped Video is off.
d) It is not possible to make settings for external input signals.

Setting AUX bus 
output/re-entry 
input

7337.7 It is not 
possible to 
make settings 
for DME 1 to 8 
Ext In.

No When using the 
DME dedicated 
interface, it is not 
possible to make 
settings for DME 
1 to 8 Video/Key.

“Setting the 
Interface Between 
the DME and the 
Switcher” in 
Chapter 20 
(Volume 3)

TBC window 
center position

7341.1 Yes only 
when SDI 
interface is 
used. c)

No Yes only when 
SDI interface is 
used.

“Setting the TBC 
Window Center 
Position” in 
Chapter 21 
(Volume 3)

Adjustment of 
monitor output 
video clip level

7343 Yes only 
when SDI 
interface is 
used.

No Yes only when 
SDI interface is 
used.

“Adjusting the 
Monitor Output” in 
Chapter 21 
(Volume 3)

Monitor output 
signal settings

7343.1 Yes only 
when SDI 
interface is 
used.

No Yes “Setting the 
Monitor Output” in 
Chapter 21 
(Volume 3)

Function Menu 
number

MVE-8000A MKS-6470 MVE-9000 See
Functional Differences With Models of DME
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Macro File Editing Rules

When editing a macro file, follow the rules described below.

Macro File Syntax

The macro file syntax is as follows.

File format
The file is in CSV (comma-separated value) format.

Newline code
CR (ASCII code 0D), LF (ASCII code 0A), or CRLF may be used.

Statement syntax
There are four types of statement, each terminated by a newline code.
File header: This must always appear as the first line of the file. It comprises 

28 characters, as follows.
Example: PNL (space) 0001PNL_rrrr.PMRnnnnnnnn
rrrr: macro register number (0001 to 0099)
nnnnnnnn: In a file created on the switcher, this is a register name 
automatically set by the switcher.
When creating a new file, it is recommended to set this to be the same as 
the file name (see page 483).
The name is limited to eight characters. 
The following characters may not be used.

space, \, /, :, ;, , (comma), . (dot), <, >, *, ?, “ ”
Comment: Begins with “#”. The content of the line following the “#” up to the 

next newline has no effect on macro execution, and can be used as a 
comment.

Note
You can only use comments in files saved to the hard disk or a memory 
card. When you load a macro file into a register, the comments are 
discarded.

Event statement: Begins with “Event?”, and defines the macro event. (See 
next item, “Syntax of Event and Continue Statements.”)

Continue statement: Begins with “Continue?”, and defines the macro event. 
(See next item, “Syntax of Event and Continue Statements.”)
481Macro File Editing Rules



   A
ppendix (V

olum
e 2)

482
Some events cannot be used. (See “Correspondence Between Events and 
Symbols” (page 484).)

Syntax of Event and Continue Statements

An event can be written with an Event statement only, or with an Event 
statement followed by any number of Continue statements. The Event 
statements and Continue statements have the following syntax.

Word separator character
Use “,” (comma).

Ignored
Spaces and tabs are ignored. There is no distinction between lowercase and 
uppercase. If two or more separator characters appear consecutively, later ones 
are ignored. Separator characters at the beginning of a line are also ignored.

Content of line
Must begin with “Event?” or “Continue?”, followed by symbols and 
parameters.

Event?,[symbol], [parameter], [parameter], ...
Continue?,[symbol], [parameter], [parameter], ...

symbol: ASCII character string showing the type of event. (See 
“Correspondence Between Events and Symbols” (page 484).)

parameter: Shows details of an event. Consists of parameter names and 
arguments, and these must appear in pairs. The number and type of 
parameters depends on the event. (See “Symbols and Parameters” (page 
485).)
If the same parameter appears twice or more, the last occurrence is valid.

How to use Continue statements
When a single parameter has more than one argument, use a Continue 
statement. The following example is of a snapshot event.
An event to recall a snapshot in region M/E-1 is written as:

Event?,Snapshot,Region?,ME1,Register?,1,Attribute?,Off,Time?,Current

In the Event statement, only one region can be specified.
To specify both regions M/E-1 and DME1, use a Continue statement, thus:

Event?,Snapshot,Region?,ME1,Register?,1,Attribute?,Off,Time?,Current
Continue?,Snapshot,Region?,DME1,Register?,1,Attribute?,Off,Time?,Current
Macro File Editing Rules
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To specify more than one argument for a region parameter, follow the Event 
statement by a Continue statement on the next line.

File Name

Set the file name as follows.

Example: nnnnnnnn.PNL_rrrr.PMR
nnnnnnnn: In a file created on the switcher, this is a register name 

automatically set by the switcher.
The name is limited to eight characters. 
The following characters may not be used.

space, \, /, :, ;, , (comma), . (dot), <, >, *, ?, “ ”
rrrr: macro register number (0001 - 0099)

Saving and Recalling a File

For a newly created file, if you create a directory on the memory card (see 
figure below), and move the file to the prescribed location, you can then recall 
it in the File >All, External File menu.

Note
When amending a file saved on the switcher, be sure to save it in the original 
directory.

Path example: Memory Card\Sample\MACRO\CTRLCPU\ 
nnnnnnnn.PNL_rrrr.PMR

Memory card Any directory

MACRO

CTRLCPU

nnnnnnnn.PNL_rrrr.PMR
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484
Errors

If any of the following problems occur, it is not possible to recall the file. 
Attempting to recall the file will produce an error message.
• If there is a syntax error.
• If a required parameter is not present.

For details of error messages, see “Error Messages” in Appendix (Volume 3).

Correspondence Between Events and Symbols

For details of events, see “Events” (page 371).

Event Symbol Using Continue

Cross-point selection in the auxiliary 
bus control block

AuxXpt No

Cross-point selection in the auxiliary 
bus control block in router control 
mode

RouterXpt Yes

Cross-point selection in the cross-
point control block

MEXpt Yes

Auto transition and take in the 
transition execution section

MEAutoTransition Yes

Cut in the transition execution section MECut No

Transition type selection TransitionType No

Next transition setting NextTransition No

Pattern limit on/off PatternLimit No

Fade-to-black execution FadeToBlack No

Auto transition and take in the 
independent key transition execution 
section

KeyAutoTransition Yes

Key insertion and deletion in the 
independent key transition execution 
section

KeyCut Yes

Independent key transition type 
selection

KeyTransitionType No

VTR/DDR/clip start point setting StartTc Yes

VTR/DDR/clip playback Play Yes

VTR/DDR/clip stop Stop Yes

VTR/DDR/clip cue-up Cue Yes

VTR/DDR/clip fast forward FF Yes

VTR/DDR/clip rewind Rewind Yes
Macro File Editing Rules



  A
ppendix (V

olum
e 2)
a) For details of pause events, see “Macro Execution” (page 377).

Symbols and Parameters

n: indicates a numeral 0 to 9.
x: indicates an alphanumeric character.

Disk recorder/Extended VTR file recall DiskFileLoad No

Recall snapshot Snapshot Yes

Recall key snapshot KeySnapshot Yes

Recall wipe snapshot WipeSnapshot Yes

Recall DME wipe snapshot DMEWipeSnapshot Yes

Recall shotbox Shotbox No

Recall master snapshot MasterSnapshot No

Recall master timeline MasterTimelineRecall No

Recall effect TimelineRecall Yes

Execute effect TimelineRun Yes

Rewind keyframe TimelineRewind Yes

Fast forward effect TimelineFF Yes

Effect execution direction selection 
(normal)

TimelineDirectionNormal Yes

Effect execution direction selection 
(reverse)

TimelineDirectionReverse Yes

Effect execution direction selection 
(normal/reverse on)

TimelineNormalReverseOn Yes

Effect execution direction selection 
(normal/reverse off)

TimelineNormalReverseOff Yes

Pause a) Pause No

Recall of function assigned to memory 
recall button/user preference button

UtilityButton No

Recall of function assigned to the key 
2 row cross-point buttons

Key Bus Utility Button No

Frame memory clip loop on/off FMLoop Yes

Menu macro recall and execution MenuMacroRun No

Recall of frame memory clip ClipRecall No

Record with device DeviceRecord Yes

Event Symbol Using Continue
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Symbol Parameter name Arguments Description

MEXpt ME? ME1 to ME3, PP Control blocks on the 
applicable bank

MEBus? A, B, Key1 to Key4, 
Key1Source to 
Key4Source, Utility1, 
Utility2 a), 
DMEExternalVideo

Applicable bus

Xpt? 1 to 128 Main table cross-point 
button number set in the Xpt 
Assign menu

VideoKey? Video, Key Signal type selected on the 
applicable bus (video signal 
or key signal)

AuxXpt AuxBus? EditPreview, AUX1 to 
AUX48, Monitor1 to 
Monitor8, 
FrameMemory1, 
FrameMemory2, 
DME1Video to 
DME8Videob), 
DME1Key to 
DME8Keyb), 
DME1Video2nd to 
DME8Video2nd (a)b), 
DME1Key2nd to 
DME8Key2nd (b)b), 
DMEUtility1b), 
DMEUtility2 b), CCR1, 
CCR2

Applicable AUX bus
(a): DMEnVideo2nd= Bus 
for selecting back video 
signal of DMEn channel 
(n=1 to 8),
(b): DMEnKey2nd= Bus for 
selecting back key signal of 
DMEn channel (n=1 to 8)

Xpt? 1 to 128 Cross-point button number 
in the main table set in the 
Xpt Assign menu

VideoKey? Video, Key Type of signal (video signal 
or key signal) to be selected 
on the applicable bus
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MEAutoTransition ME? ME1 to ME3, PP Control blocks on the 
applicable bank

Time? Current (a), 0 to 999 Transition rate (number of 
frames)
(a): Mode in which the 
current value set on the 
transition control block is 
used

ABusXpt? Current (a), 1 to 128 A bus or B bus cross-point 
button number. Use the 
button number of the main 
table set in the Xpt Assign 
menu.
(a): Mode in which the cross-
point number set for the 
current A bus or B bus is 
used

BBusXpt? Current (a), 1 to 128

MECut ME? ME1 to ME3, PP Control blocks on the 
applicable bank

KeyAutoTransition ME? ME1 to ME3, PP Control blocks on the 
applicable bank

Key? Key1 to Key4 Key of the applicable 
independent key transition 
control block

Time? Current (a), 0 to 999 Transition rate (number of 
frames)
(a): Mode in which the 
current value set on the 
independent key transition 
control block is used

Direction? ToOn (a), ToOff (b), 
Any (c)

Transition execution mode
(a): Key is inserted
(b): Key is deleted
(c): Transition is always 
executed

KeyCut ME? ME1 to ME3, PP Control blocks on the 
applicable bank

Key? Key1 to Key4 Key of the applicable 
independent key transition 
control block

Direction? ToOn (a),
ToOff (b),
Any (c)

Transition execution mode
(a): Key is inserted
(b): Key is deleted
(c): Transition is always 
executed

Symbol Parameter name Arguments Description
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Play Device? 1 to 12, 
FrameMemory1Clip 
to 
FrameMemory8Clip

Applicable device

Mode? Normal (a), 
Recue (b), 
Loop (c)

Playback mode
(a): Normal mode
As for Frame Memory 1 Clip 
to Frame Memory 8 Clip, 
settings are ignored and 
operation mode is fixed to 
“Normal.”
(b): Recue mode
(c): Loop mode

Cue Device? 1 to 12, 
FrameMemory1Clip 
to 
FrameMemory8Clip

Applicable device

Timecode? Current (a), 
hh:mm:ss:ff

Start point timecode
hh=hours (00 to 23)
As for Frame Memory 1 Clip 
to Frame Memory 8 Clip, hh 
is fixed to “01.”
mm=minutes (00 to 59)
ss=seconds (00 to 59)
ff=frames (00 to 29)
(a): Mode in which the 
currently set timecode is 
used

Stop Device? 1 to 12, 
FrameMemory1Clip 
to 
FrameMemory8Clip

Applicable device

FF Device? 1 to 12, 
FrameMemory1Clip 
to 
FrameMemory8Clip

Applicable device

Rewind Device? 1 to 12, 
FrameMemory1Clip 
to 
FrameMemory8Clip

Applicable device

DiskFileLoad Device? 1 to 12 Applicable device

FileName? File Name Name of file being set (max. 
23 characters)

Symbol Parameter name Arguments Description
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Snapshot Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
Router

Applicable region

Register? 1 to 99 Applicable register number

Attribute? Off, Dissolve, 
AutoTransiton, 
Dissolve&AutoTransit
ion

Applicable snapshot 
attributes

Time? Current (a), 0 to 999 Duration of effect dissolve 
(number of frames)
(a): Mode in which the 
currently set value is used

KeySnapshot ME? ME1 to ME3, PP Control blocks on the 
applicable bank

Key? Key1 to Key4 Applicable key

Register? 1 to 4 Applicable register number

WipeSnapshot ME? ME1 to ME3, PP Control blocks on the 
applicable bank

Register? 1 to 10 Applicable register number

DMEWipeSnapshot ME? ME1 to ME3, PP Control blocks on the 
applicable bank

Register? 1 to 10 Applicable register number

TimelineRecall Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
PBus, Device1 to 
Device12, GPI

Applicable region

Register? 1 to 399 Applicable register number

TimelineRun Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
PBus, Device1 to 
Device12, GPI, 
Current (a)

Applicable region
(a): Mode in which operation 
takes place in the region 
currently specified in the 
numeric keypad control 
block

TimelineRewind Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
PBus, Device1 to 
Device12, GPI, 
Current (a)

Applicable region
(a): Mode in which operation 
takes place in the region 
currently specified in the 
numeric keypad control 
block

Symbol Parameter name Arguments Description
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490
TimelineFF Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
PBus, Device1 to 
Device12, GPI, 
Current (a)

Applicable region
(a): Mode in which operation 
takes place in the region 
currently specified in the 
numeric keypad control 
block

Shotbox Register? 1 to 99 Applicable register number

Pause Time? 0 to 999 Time for which macro is 
paused (number of frames)

StartTc Device? 1 to 12, 
FrameMemory1Clip 
to 
FrameMemory8Clip

Applicable device

MasterSnapshot Register? 1 to 99 Applicable register number

MasterTimelineRecall Register? 1 to 99 Applicable register number

RouterXpt DestinationButton? 1 to 128 Router cross-point button

Source? 1 to 1024 Router source number

Level? 1 to 8 Router level selection

PatternLimit ME? ME1 to ME3, PP Control blocks on the 
applicable bank

Status? ToOn (a), ToOff (b), 
Any (c)

Pattern limit status
(a): Pattern limit applies
(b): Pattern limit does not 
apply
(c): The pattern limit status 
always changes

TransitionType ME? ME1 to ME3, PP Control blocks on the 
applicable bank

TransitionType? Mix, NAM, SuperMix, 
PresetColorMix, 
Wipe, DMEWipe,
FM1&2Clip, 
FM3&4Clip, 
FM5&6Clip, 
FM7&8Clip

Transition type

Symbol Parameter name Arguments Description
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KeyTransitionType ME? ME1 to ME3, PP Control blocks on the 
applicable bank

Key? Key1 to Key4 Key of the applicable 
independent key transition 
control block

Direction? On (a), Off (b), Any 
(c)

Independent key transition 
execution mode
(a): Key is inserted
(b): Key is deleted
(c): Transition is always 
executed

KeyTransitionType
?

Mix, Wipe, DMEWipe, 
Cut

Transition type of the 
independent key transition 
control block

NextTransition ME? ME1 to ME3, PP Control blocks on the 
applicable bank

All? On, Off Applicable next transition

KeyPriority? On, Off Applicable next transition

BKGD? On, Off Applicable next transition

Key1? to Key4? On, Off Applicable next transition

FadeToBlack Time? Current (a), 1 to 999 Transition rate (number of 
frames)
(a): Mode in which the 
current value set on the fade 
to black control block is used

TimelineDirectionNormal Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
PBus, Device1 to 
Device12, GPI, 
Current (a)

Applicable region
(a): Mode in which operation 
takes place in the region 
currently specified in the 
numeric keypad control 
block

TimelineDirectionReverse Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
PBus, Device1 to 
Device12, GPI, 
Current (a)

Applicable region
(a): Mode in which operation 
takes place in the region 
currently specified in the 
numeric keypad control 
block

TimelineNormalReverseOn Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
PBus, Device1 to 
Device12, GPI, 
Current (a)

Applicable region
(a): Mode in which operation 
takes place in the region 
currently specified in the 
numeric keypad control 
block

Symbol Parameter name Arguments Description
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a) For MVS-6000, the utility bus appears as “UTIL1 Bus”, and the utility 2 bus is not supported.
b) For MVS-6000, the following parameters are not available.

DME3Video, DME4Video, DME3Key, DME4Key, DME3Video2nd, DME4Video2nd, 
DME3Key2nd, DME4Key2nd, DMEUtility1, DMEUtility2

c) For MVS-6000, DME3 and DME4 are not available.

TimelineNormalReverseOff Region? ME1 to ME3, PP, 
User1 to User8, 
DME1 to DME8c), 
PBus, Device1 to 
Device12, GPI, 
Current (a)

Applicable region
(a): Mode in which operation 
takes place in the region 
currently specified in the 
numeric keypad control 
block

UtilityButton UtilityModule? UserPrefs, UtilityBox Applicable control block

Button? 1 to 96 Applicable button

UtilityStatus? On, Off, Current (a) Status of function assigned 
to button
(a): Operates according to 
currently assigned function

FMLoop Device? FrameMemory1Clip 
to 
FrameMemory8Clip

Applicable clip

FMLoopMode? On (a), Off (b) Frame memory clip loop on/
off
(a): Loop is enabled
(b): Loop is disabled

MenuMacroRun Register? 1 to 99 Applicable register number

KeyBusUtilityButton ME? ME1 to ME3, PP Control blocks on the 
applicable bank

BANK? Bank1 to Bank5 Applicable bank

KeyBusUtilityButto
n?

1 to 32 Applicable button

UtilityStatus? On, Off, Current (a) Status of function assigned 
to button
(a): Operates according to 
currently assigned function

ClipRecall Device? FrameMemory1Clip 
to 
FrameMemory8Clip

Applicable clip

ClipType? Pair, Single File type of clip (pair/single)

Clip? Clip Name Name of clip (up to four 
characters)

Device Record Device? 1 to 12 Applicable device

Symbol Parameter name Arguments Description
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Example of File Contents

Line Content Description

1 PNL 0001PNL_0000.PMRMACROREG File header

2 #,Sample, Comment

3 Event?,Snapshot,Region?,ME1,Register?,1,Attribute?,Off,Time?,Current Simultaneously 
recall snapshots 
from register 
number 1 in the 
M/E-1 and 
DME1 regions.

4 Continue?,Snapshot,Region?,DME1,Register?,1,Attribute?,Off,Time?,Current

5 Event?,MEXpt,ME?,ME2,MEBus?,A,Xpt?,121,VideoKey?,Video Select button 
number 121 on 
the M/E-2 A 
bus.
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About the Macro Attachment List Display

The Button column in the macro attachment list displayed in the status area of 
the Macro >Attachment menu screen shows character strings which identify 
macro attachment assigned buttons. Each of these character strings is in fact a 
combination of characters shown in the Button(1), Button(2), and Button(3) 
columns in the following tables. 
For example, if Block and Button(1) to Button(3) are combined as:

Block: P/P XPT
Button(1): UTIL1 Bus
Button(2): V
Button(3): XPT2

The Button column in the macro attachment list in the Macro >Attachment 
menu screen shows “UTIL1 Bus V XPT2,” which means “utility 1 bus, video 
signal, cross-point number 2.”

M/E and PGM/PST Banks

The following table shows only the macro attachment assignable buttons in the 
PGM/PST bank.
For the M/E-1 (M/E-2 or M/E-3) bank, “P/P” in the Block Select and Block 
columns changes to “M/E-1” (“M/E-2” or “M/E-3”) and “DSK” in the 
Button(1) and Button(2) columns changes to “KEY.” The contents of the 
Button(3) column do not change.
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Block 
Select

Block Button(1) Button(2) Button(3)

P/P P/P XPT A Bus
B Bus
DSK1 Bus
:
DSK4 Bus 
DSK1 Src Bus
:
DSK4 Src Bus

Sub A Bus
Sub B Bus

Sub DSK1 Bus
:
Sub DSK4 Bus

Main&Sub A Bus
Main&Sub B Bus

Main&Sub DSK1 Bus
:
Main&Sub DSK4 Bus

Sub DSK1 Src Bus
:
Sub DSK4 Src Bus

Main&Sub DSK1 Src 
Bus

:
Main&Sub DSK4 Src 

Bus

(nothing)
Shift

XPT 1
:
XPT 128
M/E 1 
M/E 2
M/E 3  
P/P 

UTIL1 Busa)

UTIL2 Busb)

EXT DME Bus
DMEUtility1b)

DMEUtility2b)

Sub UTIL1 Busa)

Sub UTIL2 Busb)

Sub EXT DME Bus 
Main&Sub UTIL1 Busa)

Main&Sub UTIL2 Busb)

Main&Sub EXT DME 
Bus

V
K
V Shift
K Shift

Dual A Bus
Dual B Bus
Sub Dual A Bus
Sub Dual B Bus
Main&Sub Dual A Bus
Main&Sub Dual B Bus

V Shift
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P/P P/P XPT Utility/Shotbox
Sub Utility/Shotbox
Main&Sub Utility/
Shotbox

Bank 1-1
:
Bank 1-32
Bank 2-1
:
Bank 2-32
Bank 3-1
:
Bank 3-32
Bank 4-1
:
Bank 4-32
Bank 5-1
:
Bank 5-32

(nothing)

P/P Trans (blank)
DSK1
:
DSK4

Sub

Sub DSK1
:
Sub DSK4

Main&Sub

Main&Sub DSK1
:
Main&Sub DSK4

MIX f) 
NAM f) 
SUPER MIX f) 
PST COLOR MIX f) 
WIPE f) 
DME f)

TAKE d)

AUTO TRANS c) 
CUT c) 
DSK_ON c)

ALL c) 
KEY PRIOR c) 
BKGD c) 
DSK1 c)

:
DSK4 c) 
NORM (PLAY) c) 
NORM/REV (STOP) c)

REV (CUEUP) c)

PTN LIMIT (PLAY) e) 
LIMIT SET (STOP) e) 
KF (CUEUP) e) 
PTN LIMIT 
Fader

Block 
Select

Block Button(1) Button(2) Button(3)
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a) For MVS-6000, the utility bus appears as “UTIL1 Bus”, and the utility 2 bus is not supported.
b) For MVS-6000, these parameters do not appear.
c) For the standard type or compact type transition control block.
d) For the simple type transition control block.
e) For the standard type transition control block.
f) These buttons can be assigned with their functions in the setup menu. The assignable functions 

include four clip transition functions (FM1&2, FM3&4, FM5&6, FM7&8) besides the above 
functions (MIX, NAM, SUPER MIX, PST COLOR MIX, WIPE, DME).

P/P P/P Key 
Trans

DSK1
:
DSK4

Sub DSK1
:
Sub DSK4

Main&Sub DSK1
:
Main&Sub DSK4

MIX 
WIPE 
DME
CUT 
TAKE
DSK_ON 

(nothing)

Block 
Select

Block Button(1) Button(2) Button(3)
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Auxiliary Bus Control Block

Block Select Block Button(1) Button(2) Button(3)

Aux AUX-1
AUX-2

EDIT PVW 
AUX 1
:
AUX 48 
Mon1
:
Mon8
FM1
FM2

V
K
V Shift
K Shift
V 2nd Row
K 2nd Row
V 2nd Row Shift
K 2nd Row Shift

XPT 1
:
XPT 128
M/E 1
M/E 2 
M/E 3  
P/P

DME1V a)

:
DME8V 
DME1K b)

:
DME8K

(nothing)
Shift
2nd Row
2nd Row Shift

DMEUtility1 c)

DMEUtility2 c)

V
K
V Shift
K Shift
V 2nd Row
K 2nd Row
V 2nd Row Shift
K 2nd Row Shift

DME1V2nd d)

:
DME8V2nd
DME1K2nd e)

:
DME8K2nd

(nothing)
Shift
2nd Row
2nd Row Shift

CCR1
CCR2

V
K
V Shift
K Shift
V 2nd Row
K 2nd Row
V 2nd Row Shift
K 2nd Row Shift

P/P UTIL1 f)

P/P UTIL2 g)

M/E-1 UTIL1 f)

M/E-1 UTIL2 g)

M/E-2 UTIL1 f)

M/E-2 UTIL2 g)

M/E-3 UTIL1 f)

M/E-3 UTIL2 g)
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a) For MVS-6000, only DME1V, DME2V, and DME5V to DME8V are available.
b) For MVS-6000, only DME1K, DME2K, and DME5K to DME8K are available.
c) For MVS-6000, these parameters do not appear.
d) For MVS-6000, only DME1V2nd, DME2V2nd, and DME5V2nd to DME8V2nd are available.
e) For MVS-6000, only DME1K2nd, DME2K2nd, and DME5K2nd to DME8K2nd are available.
f) For MVS-6000, the utility bus appears as “UTIL1 Bus”.
g) For MVS-6000, the utility 2 bus is not supported.

Aux AUX-1
AUX-2

DSK1
:
DSK4
M/E-1 KEY1
M/E-1 KEY2
M/E-1 KEY3
M/E-1 KEY4
M/E-2 KEY1
M/E-2 KEY2
M/E-2 KEY3
M/E-2 KEY4
M/E-3 KEY1
M/E-3 KEY2
M/E-3 KEY3
M/E-3 KEY4

(nothing)
Shift
2nd Row
2nd Row Shift

XPT 1
:
XPT 128
M/E 1
M/E 2 
M/E 3  
P/P

DSK1 Src
:
DSK4 Src
M/E-1 KEY1 Src
M/E-1 KEY2 Src
M/E-1 KEY3 Src
M/E-1 KEY4 Src
M/E-2 KEY1 Src
M/E-2 KEY2 Src
M/E-2 KEY3 Src
M/E-2 KEY4 Src
M/E-3 KEY1 Src
M/E-3 KEY2 Src
M/E-3 KEY3 Src
M/E-3 KEY4 Src

V
K
V Shift
K Shift
V 2nd Row
K 2nd Row
V 2nd Row Shift
K 2nd Row Shift

P/P EXT DME
M/E-1 EXT DME
M/E-2 EXT DME
M/E-3 EXT DME

Block Select Block Button(1) Button(2) Button(3)
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Other Blocks

Block Select Block Button(1) Button(2) Button(3)

Others Keyframe RUN
REWIND
FF
NORM
REV
NORM/REV

(nothing) (nothing)

Multi
Function
Flexi Pad a)

DSK1
DSK2
DSK3
DSK4
M/E-1 KEY1
M/E-1 KEY2
M/E-1 KEY3
M/E-1 KEY4
M/E-2 KEY1
M/E-2 KEY2
M/E-2 KEY3
M/E-2 KEY4
M/E-3 KEY1
M/E-3 KEY2
M/E-3 KEY3
M/E-3 KEY4
Sub DSK1
Sub DSK2
Sub DSK3
Sub DSK4
M/E-1 Sub KEY1
M/E-1 Sub KEY2
M/E-1 Sub KEY3
M/E-1 Sub KEY4
M/E-2 Sub KEY1
M/E-2 Sub KEY2
M/E-2 Sub KEY3
M/E-2 Sub KEY4
M/E-3 Sub KEY1
M/E-3 Sub KEY2
M/E-3 Sub KEY3
M/E-3 Sub KEY4

AUTO TRANS
KEY_ON

EFF RUN
REWIND
NORM
REV
NORM/REV
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a) The Multifunction Flexi Pad control block appears as “10KeyPad”.

Others Joystick
Trackball

DEV CLR WORK BUFR (CUEUP)
Y (PLAY)
TRGT (STOP)
AXIS LOC (START TC)

(nothing)

Device Control (nothing) CUE UP
PLAY
STOP
START TC

Utility Box 1
Utility Box 2
Menu

Utility 1
:
Utility 96

(nothing)

DSK/FTB Key1
Key2

AUTO TRANS
KEY_ON
FTB

FTB (blank) FTB

DSK Fader 1
:
DSK Fader 4

P/P
M/E1
M/E2 
M/E3  

KEY1
:
KEY4

MIX
WIPE
DME
CUT
TAKE
KEY_ON

Block Select Block Button(1) Button(2) Button(3)
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Menu Operations Not Recorded in a Menu 
Macro

The menu operations not recorded in a menu macro comprise some operations 
common to all menus and some operations inhibited in individual menus.

Operations not recorded in menu macros, common to all menus
• Recalling a menu
• Delegation operations: region selection, channel delegation, operations 

assigning a parameter to a knob, and so forth
• Parameter setting operations using the knobs, trackball, or joystick (value 

input operations from the numeric keypad are recorded)

Operations not recorded in menu macros, in individual menus

Menu number Menu including operations not recorded

0011 to 0023 All menus under Home

2141 FrameMemory >File >Delete Thumbnail

2142 FrameMemory >File >Delete List

2143 FrameMemory >File >Rename Thumbnail

2144 FrameMemory >File >Rename List

2145 FrameMemory >File >Backup/Restore

2544 FrameMemory >File >Move

2545 FrameMemory >File >Delete

2546 FrameMemory >File >Rename

2547 FrameMemory >File >Backup/Restore

2551 FrameMemory >File >Folder

2561 FrameMemory >External HDD >Format

2562 FrameMemory >External HDD >Backup/Restore

5333 Device >DDR/VTR >File List

5412 to 5437 All menus under Macro

7111 to 7172 All menus under File

7311 to 7317.1 All menus under Engineering Setup >System

7327 All menus under Engineering Setup >Panel >Maintenance
Menu Operations Not Recorded in a Menu Macro
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A
Action setting   196

for rewind   197, 202, 226
Anti-moire filter   173
Art edge settings   62
Attributes   318
Auto

transition   317
Autoload function   449, 472
Axis location   23

B
Background

settings   166
Banks and registers   390
Beveled edge settings   59
Blind settings   118
Blur settings   87
Border

settings   54
Brick settings   185
Broken glass settings   117

C
Channel ID   26
Character Trail settings   132
Circle settings   125
Color Mix settings   82
Combiner settings   176
Contrast settings   92
Coordinate axes   25
Copying   307
Crop settings   56
Cross-point

hold   317
Cueup & Play   212

automatic execution   216
settings in a menu   218

Cylinder settings   127

D
Defocus settings   84
Delay setting   242, 286
Detents   20
Digital multi effects   15
Dim and fade settings   97
Direct store   197
Directory operations   468

creating a directory   468
deleting a directory   469
renaming a directory   469

Disk recorder
control   204
Cueup & Play   212
file operations   227
information check   211
recording to   210
timeline   220
timeline editing   223

DME   13
special effects   40

Duration
effect   240
keyframe   240
modes   239

Duration mode setting   280

E
Edit points   264

setting   267
Effect   237

attribute settings   305
attributes   237
dissolve   238, 317
duration   240
duration setting   285
editing   238
execution   249, 291
execution direction   293

repeating   293
saving   296
saving/recalling   237
status display   306

Effect register
copy/move/swap   307
data deletion   309
editing   306
merge   308
naming   310
write-protecting   307

Explosion settings   128
Extended VTR   204
External

device control   192
External devices

shared control functions   
193

F
File operations   227

autoload function   472
batch operations   463
copying   457, 470
deleting   460
directory operations   468
displaying menus   451
import/export   466
individual files   446
loading   455, 464
renaming   458
saving   454, 463
selecting a device   453
selecting regions   453
viewing detailed 

information   451
Files   446

autoload function   449
operations   446
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   Index
Film effect   104
Fine mode   32
Flag settings   110
Flex shadow settings   70
Flying bar settings   117
Frame

memory data export   467
memory data import   466

Frame memory folder   461
Freeze settings   102
Functions assignable to 

trackball/Z-ring   32

G
Global

coordinate space   17
effect operations   175

Glow settings   99
GPI

device control   200
output port settings   200
timeline creation/editing   

200
GPI output   317
Graphics

outputting to the monitor   
37

Graphics display   25, 36
Grid   26

H
Hard freeze effect   103

I
Interpolation settings   171
Invert settings   170

K
Kaleidoscope settings   122
Key

border settings   61
density settings   170
disable   317
snapshot attributes   342
source selection   170

Keyframe   237, 269
copying   276
creation   269
delay setting   286
deletion   274
duration   240
duration setting   284
effect registers   235
insertion   270
loop   277
modification   270
moving   275
operations   250
path setting   287
pause   276
register operations   305
strobe settings   144

L
Lens settings   123
Lighting settings   133
Local coordinate space   17
Location

size   23
XYZ   21

M
Macro   371

attachment removal   425
attachment setting   422
auto insert mode   381
creating   374
creation/editing   381
creation/saving   393
editing   374, 375
events   371
execution   377, 380, 390
execution by attachment   

427
file editing rules   481
menu macro   429
offline editing   413
online editing   407
overview   371
register recalling   380, 390
registers   371

saving   388
Macro attachment list   426
Macro operations

in Flexi Pad control block   
389

in keyframe control block   
378

in numeric keypad control 
block   378

Macro register
editing   407
recalling   380

Macro timeline   440, 442
Mask settings   100
Master

region   234
timeline registers   235
timelines   249

Master snapshot creation/
saving   342

Master timeline creation/
saving   298

with the menu   302
with the numeric keypad 

control block   298, 300
Melt settings   130
Menu macro   429

creation/editing   432
editing a register   438
executing   430
recalling a register   430

Merging   308
Metal settings   96
Mirror settings   121
Monitor output

graphics   37
Mono settings   90
Mosaic

glass settings   109
settings   93

Motion decay settings   142
Moving   307
Multi

mirror settings   122
move settings   89

Multifunction Flexi Pad 
control block

effect   294
Index
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keyframe   281
macro operations   403
master timeline   300
shotbox   362
snapshot   330

N
Nega settings   92
Nonlinear effects settings   104

P
Page turn

settings   126
Panorama settings   125
Path setting   287
Path type

for Curve   288
for Hue   289
for Xpt   289

Paths   243
DME   245
switcher   243
types   248

Pause
event   395
insertion   395

P-Bus
action setting   196
timeline creation/editing   

195
trigger   198

P-Bus devices   192
control   195

Perspective   24
Posterization   91

R
Recording to VTR/disk 

recorders   210
Reference region   234
Region

selecting   264
Regions   233
Register

displaying list   311, 343
menu macro   430

operations in the menus   
305

recalling   255
Register editing

menu macro   438
Registers   235
Ripple settings   111
Rotation   22
Run mode setting   293

S
Search dial   208
Separate sides settings   167
Sepia settings   90
Shadow settings   188
Shaped video settings   167
Shotbox execution

in the Flexi Pad control 
block   362

in the utility/shotbox 
control block   364

Numeric Keypad Control 
Block   361

Shotbox register creation
in the numeric keypad 

control block   353, 355
using the menus   357

Shotbox register editing   367
Sketch settings   94
Skew   25
Snapshot

attributes   317
banks/registers   324
register editing   343
saving/recalling   319, 326, 

330
status display   340

Snapshot operations
from the numeric keypad 

control block   319
in the Flexi Pad control 

block   324
in the menus   337

Solarization   91
Source

coordinate space   16

Sphere settings   128
Spin   22
Split

settings   119
slide settings   120

Spotlighting settings   148
Swapping   307
Swirl settings   129

T
Tape transport control   205
Target coordinate space   16
Temporary attributes   238, 

318
Three-dimensional

coordinate space   16
parameter display   27
parameters   17
transformations   16

Three-dimensional parameters
display   33
entering   35
values   35

Three-dimensional 
transformation   15

Time
settings   284
strobe effect   103

Timeline menu   251, 253
main parts   251
recalling   251

Trail settings   138
Transformation operation 

modes   21
Transition

mode   239
Twist settings   110

U
User programmable DME

transition mode   281
User regions   233
Utility execution   348

in the utility/shotbox 
control block   349
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   Index
with user preference 
buttons   348

V
Virtual image cancellation   38
VTR

control   204
Cueup & Play   212
information check   211
Loop   219
recording to   210
Recue   219
timeline   220
timeline editing   223

W
Wave settings   105
Wind settings   146
Wipe Crop settings   78
Wire frames   25
Working buffer clearing   36
Wrap Around   39
Write-protecting   307
Index
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